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Foreword

 

How to Start Your Genealogy Project

 

Get the Facts First

 

In compiling your genealogy, you are looking for information—names, dates, relationships, and 
places. You can be sure that you had a great-great grandmother, and that she was born and died on spe-
cific days. The facts are out there. The challenge of genealogy lies in finding them.

There are literally hundreds of sources of genealogical information which can assist you in your 
search, and the facts you discover can lead to exciting, and often unexpected revelations. Sometimes 
trivial details mask profound events which are disclosed by persistent investigation.

 

Now Consider the Source

 

Genealogy engages you in a struggle between the need for uncompromising accuracy and the natural 
urge for unrestrained imagination. Both imagination and accuracy are essential: without imagination, 
enthusiasm wanes; without accuracy, the search flounders on false leads.

It helps to keep one distinction in mind while searching. There are at least two sides to everyone’s 
personality—a public and a private side. The private side encompasses life in the home—marriage, 
family, hobbies, reflections, domestic concerns. The public side emerges outside, where everyone 
wears a slightly different face and clothing. Sometimes records of the private and public sides of an 
ancestor may seem to conflict. Together they represent a whole person.

When you cease to be an eyewitness to an event, you must rely heavily on the word of others. 
The people on whose word you rely may not have been eyewitnesses either. The greater the distance 
between you and the information you seek—whether the distance is measured in miles or genera-
tions—the greater the need to rely on the word of someone else. In each transfer of information lies the 
opportunity for misinterpretation—a typographical error, a conscious exaggeration, an inadvertent slip 
of the tongue. Always look for the possibility of error in any source. Many were never meant to be 
used for historical research.

Be aware of biases or what a person might want to gain by telling a story one way or another. 
When you spend time interviewing relatives, you need to know what to believe and what not to 
believe. You are asking a member of the family about another member of the family, living or dead. 
Consider the relationship between the two. Wishful thinking or resentment or a failure of memory 
could color the story. Sometimes what is omitted can be of great significance. Family misunderstand-
ings of a deeply-rooted nature can lead to the expulsion of an individual from living memory. The 
tenacity of a genealogical researcher can reestablish the presence of these “black sheep” and restore 
them to the family tree.

Cross check with as many sources as possible. Some written records are more reliable than oth-
ers, but on the surface, this might not be easy to assess. Both public and private sources need to be 
carefully and critically evaluated. With written sources, it is important to ask the same questions you 
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would with a living source. What were the authors’ motivations? What did they have to gain by writing 
this story? How did they obtain the story in the first place?

In the case of public records—military records, court records, real estate documents—the person 
compiling them probably had no stake in the information contained therein. Accuracy may not have 
been the first concern. Often, the same is true for local history books. Amateur circuit-riding historians 
would arrive in a community and offer to write a local history. Some are accurate, others aren’t. It is 
the wise and prudent researcher who approaches public documents and historical accounts with a cer-
tain degree of caution.

 

A Note on the Slipperiness of Language

 

Whether listening to a story in person or consulting written texts, you are using a continually changing 
language. A word that looks familiar may have a completely different meaning in a 200-year-old doc-
ument. Some words are no longer used. Others have acquired a new meaning. Great care must be exer-
cised to avoid misinterpretation.

Remember too, that your family name may have changed with prevailing spelling conventions. 
The name 

 

Smith

 

 may have been spelled 

 

Smyth

 

, 

 

Smythe

 

, 

 

Smeeth

 

, 

 

Smithson

 

, or 

 

Smithington

 

. Ancestors 
may have changed their names to avoid persecution. Quite frequently, the keepers of early church 
records took liberties with spellings, and there was no one to argue with the only literate person within 
miles.

 

Start With Yourself

 

Compiling your genealogy begins with you. Sit down and list what you know about yourself: name, 
date of birth, names of parents, your place of residence, the important events of your life. Then see 
what you know about your ancestry, Seek every last bit of information about where you have come 
from and who has preceded you.

To make sure from the outset that nothing is lost, write everything down. Write it all down. You 
don’t know when you may need it again. Note the source of your information so that if you ever want 
to go back and check a fact, you can check the source at the same time.

 

Home Sources

 

Once you have exhausted the supply of the most readily available information, there will still be holes 
in the pedigree chart and family group sheets. You can take two directions at this point and it doesn’t 
matter which you choose first. You can look for evidence of ancestors in written records and also in the 
memories of living relatives. Shuttle back and forth between the written and the oral, seeking the 
most—and most accurate—information available.

The list of possible sources at home is endless. Look for family histories, family bibles, journals, 
diaries, letters, yearbooks, and scrapbooks. Other sources include legal papers, financial papers, photo-
graphs, and even household items.

 

Conducting an Interview

 

After picking your brain for facts and while searching your home and the homes of others looking for 
written sources of information, you have an opportunity to sit down and talk with people about the 
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past. In this most rewarding part of the genealogical search, you can find out directly from relatives 
what their life has been like and how other people have figured in it.

You are looking for the five Ws—Who, What, Where, When, and Why—but you can come back 
with far more. Find out names, dates, places, and relationships, and then probe. What familial tradi-
tions have disappeared over the years? What do members of the family talk about when they gather for 
reunions? Be patient and resist any temptation to dispute or pass judgment upon anything said.

To record your conversation, take notes or use a tape recorder. Tape is preferable as long as our 
interviewee doesn’t object, but take along a notebook to record nonverbal messages that may not show 
up on the tape.

 

Moving Out With the Search

 

The resources to draw upon next are genealogical and official records in libraries, archives, and repos-
itories scattered throughout the world. Start with your public library. There you will find genealogy 
reference books, directories, and guides, information about local genealogical and historical societies 
and other aids to research.

The largest genealogical collections are found in libraries maintained by The Church of Jesus 
Christ of Latter-day Saints (LDS Church). While the Family History Library in Salt Lake City is the 
largest, check your telephone directory for a local branch.

 

Enjoy Your Genealogical Pursuit

 

Start with the known and seek the unknown. The methods of the genealogical search are much like 
those of any search. First, you define exactly what you want to know, then design a method for carry-
ing out the search. You search, return with data, and then assess whether it is accurate. Once verified, it 
can fit into the framework of what you already know and inspire new searches.

You are looking for as much information about your family as you can find, in as many places as 
you can find it. In the process, you’ll encounter pitfalls and dead ends, but care and accuracy will 
decrease the number of detours. Sometimes picking a path through the past may sound like traipsing 
through a berry patch. That is in fact exactly what it is: a sticky search with steady rewards along the 
way.
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Welcome to Ultimate Family Tree! Ultimate Family Tree is a powerful program that helps you store
organize, and display information about you and your family. The pursuit of family history and c
puting technology are natural partners. From recording simple facts—names, dates, and places
creating documented family histories and preparing multimedia pages for the World Wide Web, 
mate Family Tree provides the software tools you need.

The entire Palladium staff, beta test team, genealogy advisors, and thousands of users ha
contributed ideas and suggestions to make Ultimate Family Tree possible. Since 1980 our deve
ment team has been providing genealogy software for serious family historians, and Ultimate F
Tree represents our most significant product to date.

Thank you for joining the Ultimate Family Tree family.

Help is Always at Your Fingertips
Ultimate Family Tree provides the following help:

• The Ultimate Family Tree User’s Guide

• The Ultimate Family Tree Web Site: http://www.uftree.com

• Online Help—an online reference guide that includes context-sensitive help, extensive cro
erencing, troubleshooting assistance, a guide to error messages, answers to frequently a
questions, and a glossary
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• Wizards—step-by-step assistance for data entry and report creation

• Technical Support

• Ultimate Family Tree Tip of the Day

• What’s This feature

If you have questions about any aspect of the program, follow these steps:

1. Check the table of contents or the index of the Ultimate Family Tree User’s Guide for the subject 
with which you need help, or from the Ultimate Family Tree menu, choose Help followed b
Help Topics. In the resulting window, locate on-screen information about your topic.

2. See Troubleshooting in the Appendix and Online Help for answers to common problems.

3. Go to Palladium’s Web site at http://www.uftree.com.

4. Contact Ultimate Family Tree Technical Support:

• FAX 812-829-1020

• Mail 743 E. Franklin Street, Suite B, Spencer, Indiana 47460

• CompuServe GO GENSUP

• Internet (email) pifamily@palladiumnet.com

• Telephone 812-829-4405 (8 AM–10 PM CST, M–F)

If you call for technical support, please call while you’re at your computer. Technical suppo
offered for questions or problems using Ultimate Family Tree but not for Microsoft Windows or g
alogical research. If you need assistance with Windows, please contact Microsoft Corporation o
sult your Microsoft Windows User’s Guide.

Getting Ready to Install

System Requirements
Ultimate Family Tree is a Windows program designed for systems having an 80386SX or more p
ful processor and 8 megabytes (MB) or more random access memory (RAM), with 16 MB of RA
strongly recommended. You need at least 35 MB of free hard disk space before installing Ultim
Family Tree. The files supplied with the program require approximately 25 MB of hard disk spac
additional 5 MB of disk space is required (approximately 2.5 MB for data and 2.5 MB for tempo
work space) for every 1,000 individuals you add. Ultimate Family Tree can use a TWAIN-compa
device such as a scanner, and a sound card and other multimedia devices. Additional hard disk
may be required to use multimedia features fully. A modem is required to go online.
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Make Sure You Have Everything You Need
Your Ultimate Family Tree package should include:

• CD-ROM disk

• Registration card

• Installation and Software License Agreement

Customer Registration
Fill out and mail the enclosed registration card immediately. This card qualifies you to receive fr
technical support and notification of upgrades.

Installing Ultimate Family Tree 2.0
Ultimate Family Tree 2.0 can be installed as a separate program or as an update to ROOTS V, 
ROOTS IV, Visual ROOTS, or Family Gathering. If you use any of these programs, you need to d
whether or not to install Ultimate Family Tree as an update or in a separate directory. If you hav
other ROOTS or Family Gathering program, simply follow the installation instructions below. If, h
ever, you are using one of these programs, we recommend that you install Ultimate Family Tree
update.

If you choose to install Ultimate Family Tree as an update to Visual ROOTS, the program 
for Visual ROOTS will be deleted after Ultimate Family Tree has been installed, however, all data
will remain intact. You can proceed to use Ultimate Family Tree without additional consideration

If you install Ultimate Family Tree as an update to ROOTS IV, the Ultimate Family Tree libr
files will be installed in the same directory as the ROOTS IV library files, resulting in two sets of
library files. When you install Ultimate Family Tree as an update to ROOTS IV, the ROOTS IV p
gram files are deleted, the data files remain intact, and the library files retain their ROOTS IV nam
you start a new project, you have the option of choosing to create an Ultimate Family Tree or R
IV project. If you choose to create a new Ultimate Family Tree project, the Ultimate Family Tree
library files are used. If you choose to create a ROOTS IV project, your existing ROOTS IV libra
containing the places and sources entered in ROOTS IV, are used. If you have been using ROO
or another genealogy software program, you import your ROOTS III or GEDCOM file and the U
mate Family Tree library files are used.

If you are currently using ROOTS IV and want to have only one set of library files, you sho
install Ultimate Family Tree in a separate directory, create Event GEDCOM files of your existing 
and import them directly into Ultimate Family Tree.

Note ROOTS IV library files are named X_PLBOOK.*, X_SOBOOK.*, X_ELBOOK.*, and
so on. ROOTS V, Visual ROOTS, Family Gathering, and Ultimate Family Tree library files 
named V_PLBOOK.*, V_SOBOOK.*, V_ELBOOK.*, and so on.

When creating a new ROOTS IV project, Ultimate Family Tree looks for ROOTS IV 
library files in the \ROOTS4\LIBRARY directory. If the ROOTS IV library files are located in
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directory other than \ROOTS4\LIBRARY, you cannot create a new project using those files
Ultimate Family Tree. If you want to continue to use ROOTS IV library files for new project
and ROOTS IV is installed in a directory other than ROOTS4, install Ultimate Family Tree 
standard installation and not as an update to ROOTS IV.

The Ultimate Family Tree Install program also installs

• with Ultimate Family Tree Plus, the Family Album Maker program

• with Ultimate Family Tree Deluxe, Family Album Maker, Social Security Death Index, Reco
Requester, and Gazetteer programs

Installation Steps
To install Ultimate Family Tree as a new program or as an update to Visual ROOTS, ROOTS V, 
Family Gathering follow these steps:

Note If you have any problems with the installation, see Installation Troubleshooting.

1. Start Windows.

2. Insert the CD-ROM in the CD drive.

3. If you are running Windows 3.x, from the Program Manager choose File, and then Run. If yo
are running Windows 95, choose Start, and then Run from the Task Bar.

4. Type d:\setup (substitute the correct drive letter for your own CD-ROM drive) and click OK.

5. The Ultimate Family Tree install program begins. It is strongly recommended that you clos
running Windows applications before proceeding. Click CANCEL to stop the setup program
close any running applications or click NEXT to continue.

6.  The Setup program will search for installed components of Visual ROOTS, ROOTS IV, 
ROOTS V, or Family Gathering. The installation program will ask you if you want to update
existing program or install Ultimate Family Tree in a new directory. 

7. Click Yes to update the program or No to install Ultimate Family Tree as a separate progra

Note If you install Ultimate Family Tree as an update to ROOTS IV or Visual ROOTS, the 
program files for those programs will be deleted after Ultimate Family Tree has been success-
fully installed. If you install Ultimate Family Tree as an update to Family Gathering, the Fam
Gathering program files remain so you can continue to access Palladiumnet. In either cas
data files will be overwritten.

8. If you clicked No, the default directory is C:\UFT. Click Browse to specify a different directo

Note If you specify a directory which doesn’t exist, a message appears stating that fact. 
Yes to continue the installation. Do not specify a directory which contains ROOTS IV, Family 
Gathering, Ultimate Family Tree, or Visual ROOTS unless you chose one of the update op
in the previous window. If you do, Ultimate Family Tree will not be installed as an update to tha
program. The program files for the existing program will remain after Ultimate Family Tree
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been successfully installed. No data files will be overwritten, but important control files for
other program will be overwritten.

Note If previous REVENT, Spell Checker, or Event Choice files are found, you are promp
to install new or use existing files. If you have added words to the Spelling Dictionary, add
new REVENT data in ROOTS IV, or added new event types in Visual ROOTS or Ultimate 
ily Tree, do not install the newer files.

9. Choose one of the following options and click Next:

• Typical — Installs the entire suite of programs plus the Kennedy Sample project.

• Minimum — Installs Ultimate Family Tree program and library files without the Kennedy Sam

• Custom — Allows you to install selected files. The Custom option should be used only for 
reinstallation. 

10. You are prompted to select a program folder or group. The default is genealogy. You may enter a 
folder or group name and click Next.

11. Setup tells you that it has enough information to start copying files from the CD-ROM. Clic
Next to continue. Setup installs the Family Album Maker, Ultimate Family Tree, the Ultima
Family Tree Gateway, Records Requester, the Gazetteer, and Browser Setup.

Note If for any reason you need to go back to a previous step, you can click Back.

12. If you are installing over a previous version of Ultimate Family Tree the install program will
you whether you wish to retain or copy over the following:

• Existing spell checker files

• Existing event choice lists

• Existing report configurations

• Existing task lists

• Existing right mouse setups

Warning Answering no will replace these files with program default files and you will lose
any changes you may have made. Before reinstalling over a previously installed version o
Family Gathering or Ultimate Family Tree, please read Reinstalling Ultimate Family Tree below.

13. Once all the files have been updated or installed you may view the Readme file which con
up-to-date information not included in the manual. After closing the Readme file click Finis
end the installation.

14. In the new Genealogy Program Group, up to seven icons are created, depending on the i
tion options you chose and the version of operating system you are using.

• Browser Setup — Identifies a browser for Ultimate Family Tree

• Ultimate Family Tree Gateway — The gateway to the Ultimate Family Tree suite of program
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• Ultimate Family Tree — Starts Ultimate Family Tree

• Kennedy Sample — Starts Ultimate Family Tree with the sample Kennedy project open

• Uninstall Ultimate Family Tree — In Windows 3.x, an additional icon is created to uninstall 
Ultimate Family Tree from your system. In Windows 95, Uninstall is located in the Control 
Panel under Add/Remove Programs. Note that Uninstall cannot remove any files created 
modified after installation such as project or library files.

• Ultimate Family Tree Editor — Opens the powerful Windows word processor supplied with 
Ultimate Family Tree

• Readme file — Opens a text file with any last minute information not available when the man
was created

Browser Setup
In order to use the online features of Ultimate Family Tree you need to run the Browser Setup pr
installed with Ultimate Family Tree. Browser Setup looks for an existing browser on your system
either configures Ultimate Family Tree to use this browser, or lets you install the Netscape brow
from the Ultimate Family Tree CD-ROM. Browser Setup will not change your browser configura
in any way.

1. Exit Ultimate Family Tree.

2. Follow the Browser Setup instructions included separately in the Ultimate Family Tree box

Reinstalling Ultimate Family Tree
To reinstall Ultimate Family Tree, follow these steps.

1. Start Windows.

2. Insert the CD-ROM in the CD drive. 

3. If you’re running Windows 3.x, from the Program Manager choose File, and then Run. If you
running Windows 95, choose Start, and then Run from the Task Bar.

4. Type d:\setup (substitute the correct drive letter for your CD-ROM). Click OK.

5. In the Welcome dialog box, read the information and click Next.

6. Setup will search for installed components and display a message if an existing Ultimate F
Tree installation is found. Click OK. 

Note The directory in which the Ultimate Family Tree executable file was found is display
in the Destination Directory box. Click Browse to change to another directory.

7. You have three installation options:

• Typical — Installs all program files and sample Kennedy database

• Minimum — Install all program and library files
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• Custom — Installs selected files

Select Custom and click Next. 

8. Deselect all products you do not want reinstalled with Ultimate Family Tree. The Gateway
gram is reinstalled by default when you reinstall Ultimate Family Tree.

9. Highlight Ultimate Family Tree by clicking once on the program name. Notice that the 
CHANGE box turns from gray to black. Click CHANGE to select the modules of Ultimate F
ily Tree that you wish to reinstall.

Note If you have added your own images, do not select Image Libraries. Choosing Progr
Files and Printing Support Files reinstalls program files only and will not affect any data fil

Creating an Ultimate Family Tree icon in Win 95
In Windows 95, Ultimate Family Tree can be accessed from the Start, Programs list. If you wan
create an Ultimate Family Tree icon on the Windows 95 Desktop, follow these steps:

1. Click the right mouse button on the Desktop.

2. Click New.

3. Click Shortcut.

4. Click Browse.

5. Change to the \UFT directory and choose UFTREE (UFTREE.EXE).

6. Click Open. UFTREE.EXE appears in the Command line.

7. Click Next.

8. Type Ultimate Family Tree in the name field and click Finish.

Starting Ultimate Family Tree
Before starting Ultimate Family Tree you should be familiar with Microsoft Windows, have Ultim
Family Tree installed on your computer, and have your printer correctly installed and configured 
Windows. If your printer is not set up, consult your Windows manual for assistance.

To start Ultimate Family Tree, follow these steps:

1. Start Windows.

2. Open the group or folder in which you installed Ultimate Family Tree.

3. Double-click the Ultimate Family Tree icon.

The first time you start Ultimate Family Tree after installation, a window appears with the op
to choose the Advanced Editing Mode or the Normal Editing Mode.
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4. Select Use Advanced Mode or Use Normal Mode. This setting is retained until you chang
from the Utilities menu.

Note Two editing modes are available in Ultimate Family Tree, Normal and Advanced. Th
Advanced editing mode changes the normal Events window to an advanced Event Edit wi
New users may want to use the Normal editing mode until they become more familiar with
program.

If you are starting Ultimate Family Tree for the first time or without a project open, the Welc
window appears and tells you that Ultimate Family Tree did not find an open project. You a
offered the following options:

• New—Begin a new project.

• Open—Open an existing Ultimate Family Tree project (This option also opens existing 
ROOTS V, ROOTS IV, Visual ROOTS, and Family Gathering projects).

• Exit—Leave Ultimate Family Tree.

5. Select the appropriate button and click OK.

Ultimate Family Tree Desktop Display
Ultimate Family Tree provides two styles for desktop display. They are Graphics and Windows C
Graphics provides wallpaper on the desktop and windows. Windows Colors establishes desktop
window colors from the Windows Control Panel. If your monitor is set to 16 colors, Windows Co
is used.

Using the Graphics option can reduce the performance of the program. If you suspect tha
mate Family Tree is running more slowly than it should, switch to the Windows Colors mode by
choosing Preferences from the Utilities menu. Choose the colors option for Ultimate Family Tre
according to your personal preference and system performance.

Figure 1-1: Welcome Window
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Figure 1-2: Ultimate Family Tree with Graphics Desktop Display

Figure 1-3: Ultimate Family Tree with Windows Colors Desktop Display
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Creating a New Project
To start a new project in Ultimate Family Tree follow these steps:

1. From the File menu, choose New.

2. In the File Type list, select Ultimate Family Tree and click Open.

Note Choose ROOTS IV to create a project using existing ROOTS IV library files. Choos
Ultimate Family Tree will use Visual ROOTS, Family Gathering, or ROOTS V library files if
Ultimate Family Tree was installed as an update to one of those programs.

3. In the File Name field, type a file name (up to eight characters) with the extension .PRO fo
new project.

4. Select the drive and directory for the new project. Typically, it is \UFT\PROJECTS. The cu
directory name appears above the directory list box.

Note Do not save to a floppy disk. Be sure you have sufficient disk space on the hard driv
before starting a new project. You need at least 2.5 MB of free disk space plus 2.5 MB for 
1,000 individuals.

Figure 1-4: New File Window

Figure 1-5: Save As Dialog Box
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5. Click OK. The project has now been created and the Project Information window is displa

6. Enter a short description of the project, such as a family name, on the Description line. Th
description appears on the title bar of the Ultimate Family Tree window.

7. Enter the name of the principal researcher for this project in the Researcher Field. This fie
optional, but you can have the researcher’s name appear in the footer on printed reports b
ing a name here and choosing Preparer in the Page Setup window. See the note below.

8. Enter the address of the researcher. If desired, this information can be included in the foote
the preparer’s name. You might include Prepared by: before the name to have the footer of you
reports printed in this way.

Note After you have entered a record for yourself, go back to the Project Information win
and enter your record number in the Researcher # field. This number determines the relati
of the preparer (researcher) to the husband or wife on the Family Group reports.

9. Key Families is a list of surnames in the project arranged in the order of frequency of occu
rence. Ultimate Family Tree keeps track of the number of times each surname is encounte
and displays it to the right of the name. This field is blank for a new project. Click the Upda
button to update the Key Families surname list. After new individuals have been entered in
Ultimate Family Tree, click Update to get an accurate count of the surnames.

10. The Comments box displays the source of the data used in this project, including import m
date and time. Enter general information about the project in this box.

11. Click More to view additional statistics about the project. This opens the Additional Projec
Information window.

12. Click OK to close the window and save changes. The Individual Record window appears 
you’re ready to begin.

Figure 1-6: Project Information Window
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Opening an Existing Project
1. Choose File on the menu bar.

2. Click Open.

3. In the Open window, select the drive and directory of the existing project. Select the 
\UFT\SAMPLE directory if you want the Kennedy sample project, or the \UFT\PROJECTS
directory if you’ve already converted or saved a project that you’d like to open.

4. Confirm that the proper drive, directory and subdirectory appear above the directory list.

5. Highlight the project filename to be opened (for example, KENNEDY.PRO).

6. Click OK.

Note Ultimate Family Tree keeps track of the projects you last worked on and lists them a
bottom of the File menu. Up to four projects can be listed. Click the number or name listed 
bottom of the File menu to open the project you want.

See Section 8 for information on opening other projects, GEDCOM files, and ROOTS III fi

Getting Familiar with Ultimate Family Tree
You can use a mouse or keystrokes to execute commands in Ultimate Family Tree menus and 
dows. To use the mouse, position the pointer over a desired option and press the left mouse but
selection is required, double-click the left mouse button. To use the keyboard, press the Tab or 
Tab (Shift+Tab) keys to position the selection bar. If a selection is required, press Enter or the a
priate shortcut key.

Figure 1-7: Open Dialog Box
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Menu Bar
The menu bar contains a list of words extending across the main window. It provides easy acces
aspects of the program.

To view a menu, click once on the menu name. A menu drops down below the menu nam
can also use the keyboard to display menus and select menu items. There are two keyboard m

• Press the Alt key to activate the menu bar and then use the right or left arrow keys to move
the bar to the menu name you want. Press the down arrow key to open the menu.

• Press the Alt key followed by the underlined letter in the menu name.

Note Mnemonic access characters in active windows take precedence.

A similar approach is used for choosing options within each menu. Use one of the following me

• Press the left mouse button, or

• Press the combination of shortcut keys indicated next to an option.

Note At certain times during operation of the program, some menu selections are not ava
and a short menu appears. The tool bar is not active when the short menu bar is displaye

The menu items access a wide range of important functions.

Function and Shortcut Keys
Several of the keyboard function keys help you enter data more efficiently. Others are used to m
and down lists, to find people or places, and to access context-sensitive help. In combination w
Shift key or the Control (Ctrl) key, the function keys perform a wide variety of additional tasks.

Shortcut keys combine the Ctrl or the Alt key with a letter key. Similar to the function keys,
these specialized key strokes facilitate many essential tasks, such as copy, paste, build, and he

The function and shortcut keys are:

• F1 — Help

• F2 — Show Individual List

• F3 — Go up list

• F4 — Go down list

• F5 — View an Individual Record. Highlight a person’s name anywhere in the program and p
F5.

• F6 — View a Family Tree (Pedigree)window

• F7 — View a Family Group window

• F8 — Open the Events window. Select an event and press F8 or choose the numbered bu
the left of the event name. 

Figure 1-8: Menu Bar
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• F9 — Save data in a window

• F10 — Find an individual. Press F10 and type in a person’s record number, or first few lette
the name, and click Find to display the full name. Click OK.

• Shift+F2 — Show All List

• Shift+F3 — Go to the top of a View List

• Shift+F4 — Go to the bottom of a View List

• Shift+F5 — Open an Individual Summary window

• Shift+F6 — Open Place Record window

• Shift+F7 — Go to the Source Record window

• Shift+F8 — View an individual’s Event List

• Shift+F9 — Delete record

• Alt+F4 — Exit program to Windows

• Alt+B — Build menu

• Alt+E — Edit menu

• Alt+F  — File menu

• Alt+G — Go menu

• Alt+H  — Help menu

• Alt+J — Project Information window

• Alt+R — Reports menu

• Alt+S — Search menu

• Alt+W — View menu

• Ctrl+A  — Select all

• Ctrl+B — Check spelling

• Ctrl+C  — Copy

• Ctrl+F  — Find

• Ctrl+G  — Find again

• Ctrl+R — Redo

• Ctrl+U  — Undo

• Ctrl+V  — Paste

• Ctrl+X  — Cut

• Ctrl+F1  — External program 1

• Ctrl+F2  — External program 2

• Ctrl+F3  — External program 3

• Ctrl+F4 — Close window

• Ctrl+F5 — Restore minimized window

• Ctrl+F6 — Next window

• Ctrl+F7 — Move window

• Ctrl+F9  — Minimize window
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Right Mouse
Ultimate Family Tree provides a customizable context-sensitive right mouse button to aid in dat
entry, viewing, searching, and report creation. Press the right mouse button to access popular m
items. You can add your own menu options by choosing Utilities, Preferences, and the Mouse Me

Enter Key and Default Buttons
Ultimate Family Tree windows normally have a default button activated by pressing the Enter ke
example, in the Individual Record window the Event 1 button is the default button when the inse
point is in the main name field. Press Enter to open the Event window for that event. If the inser
point is on a different event line, the default button is the Event button for that line. If the insertio
point is on a name other than the main name, pressing Enter opens the Individual Record for th
vidual. See “Express Data Entry (Advanced Editing Mode)” on page 40 for more shortcut tips.

Tool Bar
Below the menu bar is a tool bar. It contains a set of buttons and icons that you click to perform
cific functions. These functions are also accessible from the menu bar, but the tool bar provides
shortcut if you are using a mouse. The tool bar is not active when the short menu bar is display

You can turn the tool bar on and off, and you can disable the balloon (command descriptio
help associated with the tool bar buttons by choosing Preferences from the Utilities menu.

The arrow buttons on the tool bar serve two functions. They are used to move up and dow
opened from the View menu. They are also used to change from one individual to another in win
where the Find button is active. You can move to the previous, next, first, or last person in the p

Figure 1-9: Right Mouse Menu

Figure 1-10: Tool Bar
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The next person is determined by the order in which you last selected and viewed an individual
you leave an individual search list open, the focus will change to those individuals in the search

Reserved Characters
The following characters are reserved for use by Ultimate Family Tree and must be considered
entering data:

• / forward slash — Used to mark surnames. On ROOTS III and GEDCOM imports, the pipe
bol (|) is substituted for extra forward slash characters in names. Do not use the forward s
character in Ultimate Family Tree names except to delimit the surname.

• # number sign — The number sign is used in Ultimate Family Tree role sentence codes. D
use the number sign in Ultimate Family Tree name, text, event detail, place, or date fields

• { } braces — Used to mark a title in a person’s name. Can be used in other Ultimate Family
fields, subject to the restrictions under Rich Text Format listed below in Rich Text Format 
Printing.

Rich Text Format Printing
Rich Text Format (RTF) is a data exchange format developed by Microsoft to allow formatted te
be moved from one application to another. Fonts, underlining, index information, footnotes, and
other format instructions are preserved.

• \ backslash — Used for control codes in RTF files. Do not use the backslash character in 
mate Family Tree if you will be using the RTF feature.

• { } braces — Used for control codes in RTF files. Do not use the left or right brace charact
Ultimate Family Tree (except to mark a title in a name) if you will be using the RTF feature

International Characters
If your keyboard does not have the accented keys you want for special characters, position the
in the location where you want the character to appear. Hold down the Alt key and use the num
keypad to type the 3-digit ASCII number for the character, or copy and paste the character from
Character Map, programmed as an external program in the Ultimate Family Tree Utilities menu
the Windows manual for a list of available characters and for information on changing Codepag
tings.

The Windows 95 Close Button
The Windows 95 window close button is disabled on most Ultimate Family Tree windows. To clo
window, click OK or Cancel, press Escape to close without saving changes, or press Ctrl+F4.
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Quick Start Tutorial
The Quick Start Tutorial is designed to help you learn how to perform the following tasks:

✓ Add a new individual

✓ Add parents

✓ Create a Birth Event

✓ Create a Marriage Event and add a spouse record

✓ Create other events 

✓ Add evidence, text, and other information

✓ Add a child

✓ Add a sibling

✓ View a family in a Family Tree (Pedigree) window

✓ View a family in a Family Group window

✓ View an Individual Summary

✓ Delete a project

For additional hints and tips, see “Did You Know?” on page 26.

Creating an Individual Record
All information about an individual is entered in the Individual Record window. This is a simple, 
in-the-blanks screen where an individual’s name, sex, parents, spouse, children, siblings, and l
events are entered, as well as any text and footnotes for that person.

Other windows are for medical information, and miscellaneous information such as nation
languages, aliases, and social security numbers. A media window is used to attach images or a
recordings to the individual’s record.

Ultimate Family Tree includes an Individual Record Wizard that walks you through data en
step-by-step. We recommend this method for first-time users.

1. From the Individual Record window, choose Wizard from the Help menu or click the right 
mouse button and select Wizard. (See Figure 1-11.)

2. Choose Individual (not immediately related) and click Next.

3. Enter the name of the new individual and click Next.

4. Select Male, Female, or Unknown for the sex and click Next.

5. Select Yes, No, or Unknown for Living status and click Next.
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6. Enter the birth date and the birth place in the Birth Data window. Click Find Place if the pla
already in the database. Click Next.

7. Enter the father’s given name. Click Find Father if the individual is already in the database
Click Next.

8. Enter the mother’s name. Click Find Mother if the individual is already in the database. Cl
Next.

9. Click the Back button to make any changes or to review the information you have entered

10. Click Finish to open the Individual Record window for that person.

If you choose not to use the wizard, the following exercise shows how to add a new individ
and parents, and create birth and marriage events.

1. If this is a new project, the Individual Record window displays record number 1. If not, click
New Individual button to display a new Individual Record window with the next available rec
number.

2. In the Name field, type your full name given at birth. Ultimate Family Tree automatically m
the surname with slash (/) characters. See Section 2 for more information on entering nam
which include titles.

3. Tab to the Sex field. Type M, F, or U. Alternatively, you can press the down arrow and select 
Male, Female, or Unknown from the drop-down list.

4. Tab to the Living field. Type Y(es), N(o) or U(nknown). Alternatively, you can use the mouse t
select one of these options from the drop-down list.

Figure 1-11: New Individual Wizard
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Note Use the mouse or the Tab key to move forward from field to field in the Individual 
Record window. Shift+Tab moves you in the opposite direction.

Adding Parents
1. Tab to the Father field and type the name of your father.

2. Tab to the Mother field and type the name of your mother.

If you enter a full name in either the Parents or the Spouse fields for an individual that has
already been entered into Ultimate Family Tree, a message appears when the window is being
stating that this name has already been entered. If it is a different person, click New. If the pers
already been entered, highlight the person’s name and choose List to link that individual. If you
to make changes, click Cancel to return to the Individual Record window.

Note If the parents have already been entered and you know their record numbers, ente
record number and press the Tab key to move to the next field. The parent’s name will the
appear in the parent field.

To edit the parents’ records, click the associated button to the right of the parent’s name. C
Fa to edit the father’s record, or Mo to edit the mother’s record.

Creating a Birth Event
1. Tab to the Birth event date field.

2. Type your birth date using any format you want. See Section 8 for information on setting d
preferences.

Figure 1-12: Individual Record Window
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3. Tab to the Place field and type the place of birth.

Note Click the numbered button to the left of the event name to open the Events window
where you can enter more detailed information. See Section 2 for more information on the
Events window.

Creating a Marriage Event and Adding a Spouse
1. If your spouse is not yet in the project, click the New Spouse button to create a new Indivi

Record along with a marriage record. If a marriage event has not yet been created for you
ents, you are given the option to add one now.

2. A new Individual Record opens. Type the name of your spouse in the Name field.

3. Press Tab to move to the date field of the newly created marriage event and type the date
which the marriage took place.

4. Tab to the Place field and type the location of the marriage.

5. Click the Sp button to the right of the spouse’s name field to return to your Individual Reco

Creating Other Events (Normal Mode)
When you first start Ultimate Family Tree, you are given the option to select Advanced or Norm
Editing Mode. The following instructions are for the Normal Editing Mode:

1. Click the New Event button to add another event. The Events window opens.

2. Select any event from the list. To scroll the list, click the down arrow on the scroll bar or typ
first letter of the event you want.

Figure 1-13: Events Window, Normal Mode



Q U I C K  ST A R T  T U T O R I A L 2 1

t date 
ld.

ail-
h you 
 or 
ual 

he 
at can 
ode.

ext-
e 

p or 
s or 
t Text 

dow 
be 
3. With the event highlighted, type the free-form date in the Date field. The structured and sor
fields are automatically calculated and entered when you Tab out of the Free-form date fie

4. Tab to the Place field and type the place name where the event occurred.

5. In Normal Editing Mode, when certain events are created, an event detail line becomes av
able. For example, in the case of graduation, the detail is the institute or school from whic
graduated. Type the detail information in the event detail line and press Enter. A marriage
divorce event activates the Spouse field where you can enter the name of the other individ
linked to this event.

Here is a list of events and their associated details:

6. Click OK to return to the Individual Record window.

Note You can change to the Advanced Editing Mode by choosing Advanced Mode from t
Utilities menu. The editing mode affects how events are created and the amount of data th
be recorded for each event. See Section 2 for more information about Advanced Editing M

Adding Evidence, Text, and Other Information
1. Practice using the Tab key to move around the Individual Record window. Notice the cont

sensitive help that appears at the bottom of your Ultimate Family Tree window as you mov
from field to field.

Note Use the buttons to the right of the Events list or the keyboard arrow keys to move u
down the list. An individual can have a virtually unlimited number of events recorded for hi
her life. Next to the Place field in the Events list are two columns of status boxes for Even
and Event Evidence. An X in a status box indicates the presence of text, evidence, or both.

2. Select the Birth event you created for yourself and click the Text Status box to open a win
where you can type free-form notes about this event. Up to 65,000 characters of text can 

Event Detail

burial cemetery

graduation and education events institution or school

resides street address

resided street address

employment occupation

emigration point of origin

immigration destination

baptism religion

LDS events temple code
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entered here. Type a few words and click OK to save the data and close the text window. X 
shows that text exists for this event.

3. Click the Event Evidence Status box to open a window where you can enter evidence to s
the event, such as a birth certificate. See Section 2 for more information about entering so

4. Click the Text and Evidence buttons to type notes about an individual (up to 65,000 chara
and attach evidence documenting your knowledge of that individual. The Individual Text a
Individual Evidence buttons work the same way as the Event Text and Event Evidence Sta
boxes.

5. Click the More button to open an Individual More window where you are able to select am
several options: Names/Flags, Miscellaneous, Medical, or Media. Choose from the variou
to open windows for recording a wide variety of information about an individual. Record m
cellaneous information about yourself. Type as many facts as you like and click OK to clos
window.

6. Click the More button, and then the Medical tab to open the Medical History window in wh
you can enter physical details and medical conditions. Choose a medical condition to open
ond window where you can type up to 65,000 characters of information about that conditio
Click OK to return to the original Medical History window. Type your weight, height, hair, a
and eye color in the Physical group. Click OK.

7. Click the More button, and then the Media tab to open the Multimedia Link window where
can attach, display, and play image and audio files linked to an individual. See Section 7 f
information about adding and linking media.

8. Click Cancel to close the Multimedia Link window and return to the Individual Record.

Figure 1-14: Individual More Window
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Adding a Child
The Children box lists all children of the selected individual.

1. Add a child by clicking the New Child button at the bottom of your Individual Record windo

2. In the Parent window, specify the name of the other parent and click Selected. A new Indiv
Record window opens with the child’s surname already entered and the parent’s names in
Mother and Father fields.

Note If the correct parent is not listed in the Other Parent window, click None. A new Indi
ual Record window opens for the new child. Enter the correct parent (if known) in the Fath
Mother field.

3. Type your child’s given name before the surname (if shown) in the name field and comple
rest of the information.

Note See “Adding Parents” on page 19 to link children to parents if the child and parent(s
already in the project.

Adding a Sibling
The Siblings window lists all siblings of the subject, including half-siblings.

1. From a child’s Individual Record window, click the New Sibling button to add a brother or si
A new Individual Record window opens for your child’s brother or sister with the sibling’s s
name already entered, along with your name and your spouse’s name in the parent fields

2. Complete the sibling’s name field and the rest of the Individual Record.

Note To use the Sibling button on the Individual Record, you must have entered a paren
you do not know the parents for a group of siblings, enter a name for the father or mother 
of the parent fields. For example, for an individual named John Smith, you could enter a fa
or mother named Unknown /Smith/, or (-----) /Smith/.

You have just entered three generations of individuals in your project and familiarized you
with the Individual Record window. Now you can view your data.

Figure 1-15: Other Parent Window
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Viewing Ancestors in the Family Tree (Pedigree) Window
From the View menu, choose Family Tree to leave the Individual Record window and open the F
Tree window, also known as a Pedigree chart.

3. Click the Find Individual button on the tool bar or press the Find key (F10) to open the Fin
Individual window. Type the number 1 and press Enter (or click Find) to find your name. C
OK. The Family Tree window opens with your name in the focus position with generation 1
played beneath it. You can view up to five generations of a family at once. Your children ar
listed at the top left and, if you have entered any of your siblings, they are listed at the bot
left. A plus (+) sign to the left of a name in the Child or Sibling window means that this per
has descendants. The generation number changes depending on the generation of the fo
person in relation to the original starting person displayed at the upper left of the Family T
window.

4. Double-click your name in the upper-left corner of the window to bring yourself back to the
focus position. Click Close to close the window.

Viewing a Family Group
1. From the View menu, choose Family Group. The husband and his parents (if known) are d

played at the top, the wife and her parents are displayed in the center, and their children a
at the bottom of the window.

Figure 1-16: Family Tree (Pedigree) Window



Q U I C K  ST A R T  T U T O R I A L 2 5

 Hus-
e the 

ut 
2. To change the focus of the window, click the Parents button to move your parents into the
band and Wife fields. Select a child in the Child list box and click the Child button to chang
focus to that child.

3. Select your name and click Close to close the window.

Viewing an Individual Summary
1. From the View menu, choose Individual Summary to view all the information recorded abo

yourself. This window can be sized smaller or larger, for ease of reading.

2. Scroll through the text to review the information that you entered.

Figure 1-17: Family Group Window

Figure 1-18: Individual Summary Window
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3. Close the window by clicking the Close box or by pressing Escape.

If you have entered data for your family during this tutorial session, you can now add to it. I
would like to delete this tutorial project and start anew, follow the steps in the next section.

Deleting a Project
1. Open the project you want to delete and from the File menu, choose Delete Project.

2. A warning window opens with the message “This project has ### records. These records 
permanently deleted if you choose Delete.” Read the warning and click Delete.

3. Another window appears asking “Are you sure? This project will be permanently erased fr
your hard disk.” Click Delete.

Note When you delete a project, only the information that is unique to the individuals in t
project is deleted. Information about places, sources, and media can be shared among m
projects and is, therefore, not deleted.

Did You Know?

Wizards
Ultimate Family Tree includes four wizards that can walk you through data entry and report crea
step-by-step. These include the New Individual Wizard, the New Event Wizard, the New Proof W
and the Family Tree Report Wizard. Access Wizards by choosing Wizard from the Help menu. Yo
also set up the right mouse button to access wizards by choosing that option in the Mouse Men
dow accessed from the Utility, Preferences menu.

What’s This
Ultimate Family Tree provides a miniature help window. Select a field, press the right mouse bu
and choose What’s This to read context-sensitive help for the selected field.

Figure 1-19: Delete Project Warning
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Sticky Notes
Ultimate Family Tree provides a feature to allow you to write reminder notes and attach them to 
ent windows within the program. These notes are designed to help you in your data entry and re
tasks and can be easily viewed and edited.

Go Menu
The Go menu has two functions. It gives you the ability to move through lists and to quickly retu
recently edited records.

Up to ten individual names are displayed in the list. Each time you open an Individual Rec
the name of that individual is moved to the top of the Go List. From the Go menu, choose any na
the list to return to that individual’s record.

Each person’s position in the Go list is determined by the order in which you last selected
viewed the individual in the Individual Record window.

Individuals can be shown in lists. Lists can be displayed in a number of orders, including n
record number, and birth date. Use the following selections on the menu to move through lists:

• Go Top — Moves you to the top of an active list.

• Go Up List — Moves you up an active list.

• Go Down List — Moves you down an active list.

• Go Bottom — Moves you to the bottom of an active list.

New Spouse Button
When you click the New Spouse button, a new Individual Record opens and a marriage event i
matically created. After entering data about the new spouse, click the Sp button to return to the i
ual you were just working on.

Note If the spouse has previously been entered in the project, use the New Event button
than the New Spouse button to create the marriage.

Text and Evidence Status Boxes
Event text and evidence can be added in the Events window (Events Edit window in Advanced E
Mode) or in the Individual Record window. Two columns to the right of the Event Place field in th
Individual Record window contain Text and Evidence status boxes. Click the Text or Evidence s
boxes to open the associated window. An X in a status box indicates that data is present.

Click the numbered button next to an event name to open the Events or Events Edit windo
where you can click the Text and Evidence buttons to enter additional information.

Using Undo
If you click the New Individual, New Spouse, New Child, or New Sibling button and decide not to
ate the new record, choose Undo from the Edit menu or press Escape to delete the record and 



2 8 SE C T I O N 1 : I N T R O D U C T I O N

rses the 

ord is 
.

ormat 
ntered 
enu, 
at you 

ou’ve 
ed.

d the 

uspect 
. 

s may 
e and 
tart 
nitor 

lly.

ever, 
) or 

eld is 
 menu 

 Find 
the 
ame. 
the previous record. Undo deletes a new record if that record has not yet been saved. Undo reve
last action that you performed on any text within a field, record, or file.

Note Undo is not available if the record has been saved. As you enter information, the rec
saved automatically. To delete a saved record, from the File menu, choose Delete Record

Date Preferences
You can specify the date format in the free-form date field. The date displays and prints in this f
in all text reports. You can set your preference to have dates display and print exactly as you’ve e
them (as entered) or you can set a date format default (such as 12 JUL 1943). From the Utilities m
choose Preferences. Scroll through the date options in the General window and select the form
want. If you select any option other than as entered, modifiers will be converted to full words in the 
free-form date field, such as ABT to about.

Note Changes to the way dates display and print affect dates entered or changed after y
selected a preference. Dates entered before selecting a date preference remain unchang

Warning If you set the date preference to MM/DD/YYYY (for example, 07/12/1943) and 
enter a date such as 14/10/1955 for October 14, 1955, the first number will be dropped an
date will convert to 4/10/1955 (April 10, 1955).

Graphics Display
The Ultimate Family Tree Graphics display can reduce the performance of the program. If you s
that Ultimate Family Tree is running more slowly than it should, switch to Windows Colors mode

When you open certain windows while in the wallpaper mode, the message, “Picture color
be incorrect. Do you wish to use Windows Colors?” may appear. Click No to ignore the messag
open the window. Click Yes to change the desktop display to Windows Colors. Exit and then res
Ultimate Family Tree to change to Windows colors. This message will appear if your graphics mo
is set to 256 colors. If your monitor is set to 16 colors, Windows Colors will be used automatica

Quick Edit—Place Names
The Place Record window, accessed through the Build menu is used to edit place records. How
you can also edit place names in the Place field of the Individual Record or the Events (Normal
Event Edit (Advanced) window.

When you edit a place in the Individual Record or Events windows, only the Short Place fi
updated. To edit the long place fields, select the place and choose Place Record from the Build
or press Shift+F6.

Finding Individuals
There are several ways to find new subjects for the Individual Record window besides using the
Individual window. If you select the main name field in the Individual Record window and press 
Find button (F10), a list of all individuals in the project opens. The list is alphabetical by given n
Select a name and click OK to change to that person’s record.
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You can also choose a name from the Individual List. From the View menu, choose Individ
List, and then by Surname. Scroll through the list and double-click the left mouse button on a na
open the Individual Record for that person.

From the Go menu, choose any name to move to that person’s Individual Record. Up to te
recently edited individuals are displayed in the Go list.

Using Existing Records for Parent, Spouse, and Connected Individual Fields
Select “unknown” in the field, type the record number, if known, and press the Tab key to link an
ing individual to a record. If you enter a full name, in either the Parent, Spouse, or Connected In
ual fields, for an individual that has already been entered into Ultimate Family Tree, a message a
when the window is being saved stating that this name has already been entered. If it is a differ
son, click New. If the person has already been entered, highlight the person’s name and click L
link that individual. If you want to make changes, click Cancel to return to the Individual Record
window.
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If you completed the Quick Start Tutorial, you know that information about an individual is entere
the Individual Record window. This is a simple, fill-in-the-blanks screen where an individual’s na
sex, parents, spouse, children, siblings, and events are entered, as well as text and footnotes fo
person.

The Individual Record window also provides an easy way to navigate through your family 
parents to children or children to parents. Because of its importance, the Individual Record wind
always on the desktop, though it can be minimized when desired.

Additional windows are provided for medical information and miscellaneous information su
as nationality, languages, aliases, and social security number. A media window can be opened 
attaching images and audio recordings.

In this section you will learn how to:

✓ Create an Individual Record

✓ Create and add events

✓ Use Normal and Advanced Editing modes

✓ Use express data entry

✓ Use Wizards

✓ Add places

✓ Add roles
3 1
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✓ Create Marriage Records

✓ Add text for individuals and events

✓ Check spelling

✓ Import text

✓ Export text

✓ Add evidence

✓ Create sources

✓ Add children

✓ Add siblings

✓ Add miscellaneous, medical, and media to individuals

For hints and tips, see “Did You Know?” on page 26.

Creating an Individual Record
In Ultimate Family Tree, all data entry and editing for individuals is done in the Individual Recor
window. This window cannot be closed, but it can be minimized by clicking the control menu box
choosing Minimize, by pressing Ctrl+F9, or by clicking the minimize button if using Windows 95

Follow these steps to create an Individual Record:

1. To activate the Individual Record window, click the Edit Individual button on the Toolbar or
press F5 on the keyboard.

2. Click the New Individual button to display a new Individual Record window with the next av
able record number. 

Note Choose Undo from the Edit menu or press Escape before saving the record if you d
want to create a new individual.

3. Use the Tab key to move forward from field to field and Shift+Tab to move in the opposite 
tion. We don’t recommend using the Enter key because its primary function is to choose a
default button or other selected item.

Note Many buttons in the Individual Record window have an underlined letter in their nam
Hold down the Alt key and type that letter to move to the associated field or to choose the
ciated button.

4. Type the person’s complete name. Ultimate Family Tree marks the last name as the surna
enclosing it with slash (/) characters. If you enter names in a different order, you can manu
edit the slash (/) characters. If a name is longer than 52 characters, enter a shortened ver
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here, and enter a name of up to 65,000 characters in the Long Name text box opened from
More, Miscellaneous window.

Note Mark an individual’s title by enclosing it with left and right braces ({}) to distinguish i
from a surname. For example, John /Smith/ {Jr.} or {Dr.} Jane /Smith/. Only one set of curly 
braces and one set of slashes are allowed in an individual’s name. The slashes and curly 
are used by Ultimate Family Tree to separate the components of a name—they do not app
printed reports and can be added or removed from the displayed names in Ultimate Famil
windows by selecting No Slashes in the Name Format window.

5. Tab to the next field and enter the sex of the individual. Type F, M, or U or press the down arrow 
and select Male, Female, or Unknown from the drop-down list.

6. In the Living field, type Y, N, or U to indicate whether or not the individual is still living. Using
the mouse, you can click the down arrow and select from the drop-down list. If a death eve
entered, this field is automatically set to N when you save the record. This field is optional.

Note A record number is automatically assigned when a new record is created. You can 
choose your own record number (any number between 1 and 9,999,999). Ultimate Family
checks to make sure this number is not already in use before accepting it.

Adding Parents
1. To enter parents for the individual, tab to the Father field and type the father’s name, or if 

father is already in the project, you can find his name by typing the first few letters of his n
or simply highlighting -unknown- and clicking the Find button on the Individual Record win-
dow. From the Candidate Individuals list, select the correct individual and click OK.

Figure 2-1: Individual Record Window
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The Candidate Individuals list shows individuals in alphabetical order by given name.
birth and death years (if known) and the record number for the selected individual are disp
at the bottom of the window. For two or more individuals with identical names, check the re
number and birth and death dates to be sure you have selected the correct person. Press
letter of the given name to move quickly to that name in the list.

2. Repeat step 1 for the Mother field.

Individual Record Events List
The Events list shows all events in which this person participated with a principal role. For exam
on the birth event, the child is normally the principal role whereas the parents are not. Even tho
mother participated in her child’s event, the child’s birth is not shown in the Individual Record Ev
list for the mother.

Events are listed in date order, with events having no date appearing first. Dates and plac
be entered and edited on the event line. When entered data is saved, the events are ordered ch
cally. If you change an event date, it is reinserted in the proper order. Ultimate Family Tree save
automatically as you work.

Click the numbered button to the left of any event to open the corresponding Events or Ev
Edit window (Advanced Editing mode). You can also press the Enter key while the insertion poin
an event field to achieve the same effect.

Note A complete list of all events in which a person participated, principal or not, can be 
played by choosing View, Event List, for an Indiv., or simply by pressing Shift+F8. To open
Events window for an event in the list, double-click the event.

Adding Events (Normal Editing Mode)
Two editing modes are available in Ultimate Family Tree, Normal and Advanced. The Advanced
ing mode changes the normal Events window to an advanced Event Edit window. When you sta
mate Family Tree after installation, you have the option to use the Advanced Editing or Normal 
Editing mode. To change the editing mode after you have entered the program, from the Utilitie
Menu, choose Desktop Preferences and then Miscellaneous. Select Advanced Editing mode to
to the more powerful advanced window.

The Events or the Event Edit window is used to record information about the events in peo
lives. Each event recorded is a unique set of information about a single event. That single event 
associated (linked) with a principal role or, in Advanced Editing mode, one or more individuals w
the same project. For example, a birth event (of a child) can be linked with both the birth parent
with the attending physician. The birth event may also be linked with a place from the Place Lib

When you open the Events window while in the Normal mode, possible events are listed a
betically, with the most common events capitalized so they appear first in the list.

1. To open the Events window, click the New Event button or click the numbered button next
none in the Events list of the Individual Record window.

2. Select the event you want from the Library Event list.
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3. Type a free-form date in the Date field. Do not use the number sign (#) in the date field as the
number sign is used internally in Ultimate Family Tree sentence codes. When you move to
another field, the Structured and Sort Date fields are updated.

4. Tab to Place field and type the place name where the event occurred. If you have already 
places, type the first few letters of the place and click the Find button in the Events window
Select the place from the list and click OK.

5. To add evidence to the event, click the Evidence button. 

6. In Normal mode, when certain events are created, an event detail line becomes visible. F
example, in the case of graduation, the detail is the institution from which you graduated. 
the name of the institution in the event detail line and press Enter. Remember not to use th
ber sign (#) in Ultimate Family Tree event detail fields as it is used internally in creating ro
sentences. Instead, use No., Number, and so on to include a building or apartment number.

7. Click OK to close the window.

Note See “Creating a New Event Type (Normal Editing Mode)” on page 49 to add a cust
ized event.

Adding Events (Advanced Editing Mode)

Note The symbol  is used in this guide to denote Advanced Editing mode instructions.

1. From the Utilities menu, choose Advanced Mode.

2. Click the New Event button or click the numbered button next to none in the Events list of the 
Individual Record window. An Add New Event window opens.

Figure 2-2: Events Window (Normal Editing Mode)
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Four radio buttons are available for basic events, plus one for the extended event list. The
include Birth, Marriage, Death, Burial, and Extended.

Note See “Frequently Asked Questions” on page 321 if the OK and Express buttons are

Since most data entry applies to Basic events, Ultimate Family Tree defaults to the next B
event as you enter data. For example, once you’ve entered a birth for an individual, the nex
you open the Add New Events window, the marriage event is selected.

Note The Birth option is dim if a birth event for the individual already exists. To add additio
birth events (for conflicting birth information) use the Birth1 and Birth2 events.

3. Select from the Basic or Extended event list. If you select Extended, scroll through the list
available events by using the scroll bar or pressing the first letter of the event you want.

Note Events are listed alphabetically. To change the event priority in the list, select the e
name and click High. This capitalizes the first letter of the event name and moves it up in th
To lower the priority for capitalized event types, select the event name and click Low whic
moves the event down in the list.

4. Select the role you wish to use from the Associated Principal Roles list. 

Note A list of principal roles for the event type you select is displayed in the Associated P
cipal Roles box. If the individual for whom you are creating the event is male, only male ro
are displayed. If the individual is female, only female roles are displayed. Additional roles 
available in the Event Edit window.

5. Click OK to open the Event Edit window or Express to return to the Individual Record wind

Figure 2-3: Add New Event Window (Advanced Editing Mode)
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Note If you chose Express, type the date and location of the event in the appropriate fiel
the Individual Record. If you chose OK, continue with step 6. The Express button is used 
speed the data entry of events. See “Express Data Entry (Advanced Editing Mode)” on pa

6. Type a free-form date in the Date field. Do not use the number sign (#) in the date field as the
number sign is used internally in Ultimate Family Tree sentence codes. When you move to
another field, the Structured and Sort Date fields are updated.

7. Tab to the Place field and type the place name where the event occurred. If you have alre
entered places, type the first few letters of the place and click the Find button in the bottom
corner of the window. Select the place from the list and click OK, or if you know the record
number of the place, simply type the record number and press the Tab key.

8. Enter information in the Event Detail fields. The Find button allows you to reuse existing de
for this event type.

9. To add another individual to this event, double-click the appropriate role in the Roles list.

10. Type the name of the individual you want to connect to that role in the Connected Individu
field. If the individual is already in your project, select the Connected Individuals field and c
the Find button. This opens a list of all individuals in the project. Select the person you wan
click OK, or if you know the record number of the individual, type the record number and p
the Tab key.

11. Check the Principal box if the selected role is a principal or primary role for this event. The
can be more than one principal role (but at least one) for an event. For example, the bride
groom in a wedding event are both considered principals. Ultimate Family Tree reports ca

Figure 2-4: Event Edit Window (Advanced Editing Mode)
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customized to print text for principals only. The principal roles appear in the role list marke
with an asterisk (*).

Note Be selective when choosing which roles to mark as Principal roles. By default, the m
roles in an event are marked as principals. Several reports include a Principal Roles optio
which, when selected, includes only events in which the individual is marked as a principa

12. To add evidence to the event, click the Evidence button. 

Note The Evidence button at the top of the Event Edit window is used for evidence perta
to the entire event. Evidence added to this window prints as end notes in all reports which
include end notes. Evidence entered by clicking the E button next to a specific field, such as Dat
or Details, will print only if that information is included in a report. For example, the free-fo
date is used in the Family Journal (Genealogy) report but is not used in the Family Group 
report. If evidence is entered in the free-form date Proof window, the footnote will not appe
Family Group Sheets. Do not enter the same evidence in multiple evidence windows withi
single event as this will result in multiple occurrences of the same footnote in reports.

Event Flags Enter any flags that you wish to use for each event. Three event flags are prov
Each flag has two parts: a label and a code. The label can be anything you wish that can be mod
a single-character code. Acceptable codes are (T)rue or (F)alse, or if you type (Y)es or (N)o, Ultimate 
Family Tree converts Y to T, and N to F. You can use the Find button to choose from a list of the fla
you have already entered.

Connected Individuals An unlimited number of roles can be linked to each event. On the rig
hand side of the Event Edit window is a list of roles that are assigned to the current associated 
template. Roles that are already assigned for the event are marked with a plus sign (+). An aste
next to the role label indicates a principal role.

1. To connect an individual to a role in an event, select the role from the Roles list. 

2. In the Connected Individuals field, enter the first name, type the record number, or select 
-unknown- and click the Find button to find an existing individual. If the individual is not in t
project, type the entire name.

Note If you enter a full name in the Connected Individuals field for an individual that has 
already been entered in Ultimate Family Tree, a message appears when the Individual Re
being saved stating that this name has already been entered. If it is a different person, clic
If the person has already been entered, highlight the person’s name and click OK to link th
individual. If you want to make changes, click Cancel to return to the Individual Record or 
Events window.

Using a Role More than Once Roles in any event can be used more than once. For example,
might want to connect more than one usher to the marriage event. After the first usher has been
click the Add button to open the Role window, then select the usher role again. Click OK to leav
role window and return to the Event Edit window. You can now connect another individual to the
tional usher role.
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You can also add roles not already defined for this event type by modifying the Role Temp
for the associated event. See “Adding New Roles to an Event Template” on page 52.

Preview The Preview button in the Event Edit window opens the Role Template window. Th
window provides a way to preview how the selected role will appear in printed reports. You can 
changes to the Role Template text that will be applied to this event and role only. This powerful fe
allows you to fine-tune the wording to accommodate variations in participants, dates, places, an
details. 

The Report Text box includes the text as it will appear in reports, all flags set to true, a list
those participating (in addition to those included in the report text), and the event, footnote, and
research notes text. Text cannot be changed in the Report Text box.

The text in the Text Template can be edited to change how the event text will appear. See
“Report Text Codes” on page 53 for further guidance on how to use the codes in this box. Chan
this box only affect the role for this event. If you wish to make changes to the Role Library (that
apply to all similar events), do so from the Event/Role Template window.

Once you have made changes, click Update to see the changes applied to the report text
Undo to restore the Text Template to the format present when the window was opened. Click Li
to restore the Text Template to the format in the Role Library.

Note The Report Text may not reflect changes made since the Event Edit window was op
If information appears to be out-of-date, close the Role Template and Event Edit window a
then return. All information is updated by this cycle.

Images can be attached to events for inclusion in Family Journal Reports printed to a Rich
Format file. When added to the main event window, only one image can be marked as the prefe
image to be included in the reports. However, if you want to add additional images to the report

Figure 2-5: Role Template Preview Window (Advanced Editing Mode)
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can include a code in the Text Template window to add additional images. The code to add an a
tional image is #Ii. The i is replaced by the image number. Click the Image button in the Preview 
dow to select an image for inclusion. The image number is displayed in the list. Replace the i in the 
Image Code to reflect the record number for the desired image. The image will print in the locat
the code, so if you want the image to print after the sentence for the event, insert the Image Cod
end of the sentence.

Express Data Entry (Advanced Editing Mode)
New individual and event records can be entered quickly and easily by using Ultimate Family Tr
shortcuts. Practice using the following steps to see how easy it is to create a family that include
mother, father, their child, and parents of the father. Birth record and marriage records are adde
matically where appropriate.

Express event entry is available in the Ultimate Family Tree Advanced Editing mode. Turn
Advanced Editing mode on and off by choosing Desktop Preferences, and then Miscellaneous 
the Utilities menu.

1. Press Alt+I (Create New Individual)

2. Type John Smith.

3. Press Tab.

4. Press M (sex is male).

5. Press Tab.

6. Press Y (still living).

7. Press Tab.

8. Press Tab.

9. Type Harold Smith (father’s name).

10. Press Tab.

Figure 2-6: Image List Window
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11. Type Anne Jones (mother’s name).

12. Press Alt+2 (to create a new event).

13. Press Enter (to create new marriage event for parents, Harold and Anne).

14. Press Enter (to acknowledge new marriage record).

15. Press Alt+E (to create an Express marriage record for John and his spouse).

16. Type Jennifer Blake (to add spouse).

17. Press Enter.

18. Press Enter (to acknowledge that a new record will be created).

19. Press Enter (to go back to Individual Record window).

New individual records have now been created for John Smith and his wife Jennifer Blake
his parents Harold Smith and Anne Jones. Marriage records have been created for John and Je
and Harold and Anne. Next we will enter the dates and places for the birth and marriage record

20. Type April 17, 1993 to enter the wedding date for John and Jennifer.

21. Press the up arrow key.

22. Type March 13, 1950 (to enter the birth date for John).

23. Press Tab.

24. Type Harrisburg, PA (to enter the birth place for John).

25. Press the down arrow key.

Figure 2-7: Individual Record
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26. Type Providence, RI (to enter the marriage place for John and Jennifer).

Finally we will add a child for John and Jennifer.

27. Press Alt+C.

28. Press Enter (to accept the other parent).

29. Type Thomas (to name the child).

30. Press Tab.

31. Press M (to specify male).

32. Press Tab.

33. Press Y (to specify still living).

New Individual Wizard
Ultimate Family Tree includes four Wizards that can walk you through data entry and report cre
step-by-step. These include the New Individual Wizard, the New Event Wizard, the New Proof W
ard, and the Family Tree Report Wizard. Wizards are accessed by choosing Wizard from the He
menu. You can also set up the right mouse button to access Wizards by choosing that option in
Mouse menu from the Utilities/Preferences menu.

1. From the Individual Record window, choose Wizard from the Help menu or click the right 
mouse button and select Wizard.

2. Choose Individual and click Next.

Figure 2-8: New Individual Wizard
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3. Enter the name of the new individual and click Next.

4. Select Male, Female, or Unknown for the sex and click Next.

5. Select Yes, No, or Unknown for Living status and click Next.

6. Enter the birth date and the birth place in the Birth Data window. Click Find Place if the pla
already in the database. Click Next.

7. Enter the father’s given name. Click Find Father if the individual is already in the database
Click Next.

8. Enter the mother’s name. Click Find Mother if the individual is already in the database. Cl
Next.

9. Use the Back button to make any changes or to review the information you have entered.

10. Click Finish to open the Individual Record window for that person.

New Individual with Existing Individual Record If you have created an Individual Record for 
someone, you can use the Individual Record Wizard to link another person to that individual.

1. Choose Wizard from the Help menu or click the right mouse button and select Wizard.

2. Specify how a new individual will be related to the person who is the focus of the open Ind
ual Record window and click Next.

3. Enter the name of the new individual and click Next.

Figure 2-9: New Individual Wizard—Specify Relationship
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4. Select Male, Female, or Unknown for the sex and click Next. 

Note If you chose Spouse, Father, or Mother, the sex is already determined for you.

5. Select Yes, No, or Unknown for Living status and click Next. 

6. Enter the birth date and the birth place in the Birth Data window. Click Find Place if the pla
already in the database. Click Next.

7. Enter the father’s given name. Click Find Father if the individual is already in the database
Click Next.

8. Enter the mother’s name. Click Find Mother if the individual is already in the database. Cl
Next.

9. Use the Back button to make any changes or to review the information you have entered.

10. Click Finish to open the Individual Record window for that person.

New Event Wizard
The New Event Wizard is available only in the Normal Editing mode.

1. From the Individual Record window, select Wizard from the Help menu and choose the Ne
Event Wizard. You can also click the right mouse button and select New Event Wizard.

2. Select the event from the list of Existing Events and click Next.

3. Enter a free form date for the event. Click Next.

4. Enter a place for the event or select the place from the Existing Places list and click Finish

Figure 2-10: New Event Wizard
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New Proof Wizard
To create a new source for the proof for an individual or an event, use the New Proof Wizard. Yo
create the proof by creating a new source or by using an existing source.

1. Click on the Evidence button to open the Proof window. Select Wizard from the Help men
click the right mouse button and select Wizard.

2. Select Create a New Source. Click Next.

3. Select the source type from the Available Sources Type list. Click Next.

4. Enter the Abbreviation1 and Abbreviation2. Click Next.

5. Enter the components for that source. Click Finish if in Normal Editing mode or Next if in 
Advanced mode. If in Advanced mode, continue with steps 6 and 7.

6. Select the Source Quality (CDO). Click Next.

7. Select the Citation Sure Level. Click Finish.

New Proof Wizard Using an Existing Source

1. Click the Evidence button to open the Proof window. Select Wizard from the Help menu or 
the right mouse button and select Wizard.

2. Select Use an Existing Source. Click Next.

3. Select an existing source from the Existing Sources list. Click on View Source to preview t
source, then Escape to close the view list. Click Next.

Figure 2-11: New Proof Wizard Window
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4. Enter a component if applicable; a  page number, for example. Click Finish if in Normal Ed
mode or Next if in Advanced mode. If in Advanced mode, continue with steps 5 and 6.

5. Select the Source Quality (CDO). Click Next.

6. Select the Citation Sure Level. Click Finish.

Editing an Existing Event
1. To edit an existing event, click the numbered button to the left of the event name to open 

Events or Event Edit window.

2. Add or edit data in the Events window.

3. After making appropriate changes, click OK to return to the Individual Record window.

To edit nonprincipal events for an individual, press Shift+F8, or from the View menu choos
Event List, For an Indiv. Double-click an event to open the Events window.

Dates
You can enter dates in a variety of ways. If you enter dates word-for-word from original sources
mate Family Tree interprets the free-form date you have entered and displays it in the Structure
and Sort Date fields within the Events window.

Free-Form Date In the Free-form Date field you can enter the date of an event exactly as it wa
found in the original source. This field will accept partial or incomplete dates, date modifiers, and
ranges in any order. If you enter only the year in the Free-form or Structured fields, Ultimate Fa
Tree sets the Sort Date to July 1 of that year. If you enter only the month and year, the Sort Date
the 15th as the day.

Structured Date Ultimate Family Tree converts the date you enter in the Free-form Date field i
several components: a date modifier (BEF [before], AFT [after], CA [Circa] etc.), the day, the mo
and the year in the Structured Date field and the Sort Date field. After entering a free-form date
date field, tab to another field and confirm the results in the Structured and Sort Date fields.

The structured date is used in reports, such as the Family Tree (Pedigree), where space i
limited.

Sort Date Use the sort date to order events when you don’t know the dates but you do know th
order (e.g., the birth order of children). The sort date doesn’t print in reports.

If you do not have a date for an event such as a birth, but you know the birth order of some
children, you can enter an approximate date for the individuals into the Sort Date field. The ord
events will be correct but no dates will print on reports. A full date (MM/DD/YYYY) must be ente
into the Sort Date field.

Entering Unusual Dates The Free-form Date field accepts any variation of a date, for example,
Quaker or Jewish dates. It is also possible to record dates that are normally outside the range o
Ultimate Family Tree. Dates must fall between the limits of 100 AD to 3000 AD to be properly so
by Ultimate Family Tree. It is possible, however, to record BC dates, or dates following any othe
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calendar system, in the free date field. If you want to record BC dates, establish the order of ev
using a fictitious year in the sort date field that is within the normal limits of 100 AD to 3000 AD.
you choose the year 100 for BC dates, 365 separate BC dates can be entered and ordered pro
assigning each BC date a unique sort date (i.e., 01/01/0100 through 12/31/0100). Using this tec
the order of events occurring before the year 100 can be established.

Double Dating If you encounter dates prior to 1752, you will find that a double year might be lis
such as 1725/26. The explanation for double dating involves an alteration to the calendar. In 15
was found that the Julian calendar, which had begun with Julius Caesar, was off by 11 minutes 
seconds per year according to the cycle of the sun and moon. Beginning when the Julian calen
first used in 46 BC, the error accumulated yearly, and in 1582 Pope Gregory XIII corrected the discrep-
ancy. The calendar lost ten days as the Pope decreed that October 4 would be followed by Octo

Countries accepted the new Gregorian calendar at different times; England and the Ameri
colonies did not do so until 1752. By then the discrepancy between the Julian and Gregorian ca
was 11 days. This difference was compounded by the celebration of two New Year’s days by En
and its colonies. The government celebrated New Year’s on March 25, and the masses celebra
holiday on January 1. Depending upon which calendar you used and when you celebrated New
Day, there would be a difference in dating. To satisfy both conventions—until 1752 when the Ja
New Year’s celebration was made official—double dates sometimes were recorded.

You can enter the double date year in the Free-form Date field. The double date will print o
reports, such as the Genealogy report. The Structured date will display the second year in the d
date and will print on structured reports such as the Family Group Report.

Adding a Place
To enter a place for an event, Tab to the place field, type the first few letters of the place and cli
Find button, or simply type a record number if the place you want is already in your project. If th
place is not already in your project, type the entire place name.

Up to 60 characters can be typed for a place name. A place name of that length will not d
entirely in the place field unless you scroll to the right. However, the entire place name will print
text reports such as Family Journal (Genealogy), Text Descendant, and Ancestor (Ahnentafel) r
In structured reports where space is limited, such as the Family Tree (Pedigree) and Family Gr
reports, a long place name is abbreviated. Because of this, it is suggested that you enter a shor
here for use on structured reports and use the Medium and Long Place fields, in the Place Rec
dow, for longer place names that print on text style reports.

Note The number sign (#) is used in Ultimate Family Tree role sentence codes. Do not us
number sign in Ultimate Family Tree place fields.

Adding a Place in the Place Record Window
1. From the Build menu, choose Place Record.

2. Click New to clear the Place Record window.

3. Enter the Short Place name, normally the city, county (if space is available), and state.
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4. Enter up to 30 characters of text in the Place Modifier field. For example, enter 8 miles north of 
if a birth event actually took place 8 miles north of a particular town. If the place modifier is 
30 characters, click the Long button next to the Place Modifier field to open a text window w
you can enter up to 65,000 characters of text. The default modifier is in. Use the Desktop Prefer-
ences window to change the default modifier to one of your choosing.

5. Enter a two-character description (for example at, in, or nr) in the Short place modifier field.

6. Enter the various place levels for the place in the Place Level fields. 

Note If the geographic level for the place you are entering does not match one of those p
vided by Ultimate Family Tree, you can delete an existing label and enter your own. For e
ple, if the event took place on a ship, you might use a Place Level label such as lake, river, or 
ocean. Changing the Place Level label affects only the current place record.

7. If any of the place level names are longer than 30 characters, click the Long button to the r
that level to open a text window where you can enter up to 65,000 characters.

8. Enter the earliest and latest years that a place existed (if known) in the Year Min and Year
fields. Dates in these fields are used by Ultimate Family Tree in consistency checks. A wa
message appears if you link a place to an event that occurred outside the date range spec
that place. The warning message is only an alert and does not prevent you from saving th
mation if you choose.

9. Click the Media button to add media to the place record. See Section 7, Multimedia for more 
information.

10. Click the E button next to the Short Place field or the Long Place button to add evidence to
data. See “Adding Evidence” on page 66.

11. Click Description to enter text describing the place.

12. Click Research Note to enter text about your research into this place.

13. Click Repositories to enter text about the location of the place records.

14. Click OK to save the changes and close the Place Record window.

Figure 2-12: Place Record Window
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Removing a Place from an Event
1. To remove a place from an event, highlight the entire place name.

2. Press the Del (Delete) key on your keyboard, or type a new place name.

Note If you type a new place name, you’ll get a message when saving the record stating
the event place was and what it is now. You are asked if these places are the same. If you 
changing the spelling of the name, click Yes. If you want to create a new place, click No.

Editing a Place Name
To edit a place name, use the Place Record window accessed from the Build menu, or make ch
on the Place field of the Individual Record or Events window.

When you edit a place in the Individual Record or Events windows, only the Short Place fi
updated. To edit the long place fields, select the place and choose Place Record from the Build
or press Shift+F6.

Event Details
You can add important details to events. These events are limited in Normal Editing mode to bu
graduation, education, resides and resided, employment, emigration, immigration, baptism, and
events.

In Normal Editing mode, when you choose one of the above events, the event detail line, d
below the place field, becomes available. Type the detail, such as the name of the cemetery for
burial event, in this field. Use up to 32 characters. Do not use the number sign (#) in the Ultimat
ily Tree event detail fields as it is used internally in creating role sentences. Instead, use No., Number, 
and so on, to include a building or apartment number.

In Advanced Editing mode, two details are available for every event. Select a detail field a
type the detail, or click the Find button to pick from a list of existing details for this event type.

Deleting Event Types (Normal Editing Mode)
You can delete event types from the Event Choices list of the Events window, if you want to sho
the list to include only those event types which you use on a regular basis.

1. Click the New Event button in the Individual Record window.

2. Highlight the event type in the Event Choices List.

3. Click Delete in the Event box.

Note If you want to restore all event types, click Restore. Deleting an event from the list d
not affect existing events you may have already entered.

4. Click Cancel to return to the Individual Record without creating a new event for the individ

Creating a New Event Type (Normal Editing Mode)
1. To create a new event type, click New Event in the Individual Record.
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2. Click New in the Events window. 

3. In the New Event Type window, type the name for an event, the name or abbreviations tha
want to appear on reports, and the role that the individual plays in this new event.

4. Add a GEDCOM tag for the event and the role. GEDCOM (genealogical data communicat
is a standard which allows genealogical data exchange between different genealogy prog

5. Use any name you want, usually four or five uppercase characters, that will be used if you
fer this data via GEDCOM. If the name you choose for an event tag is already in use as a
COM tag, you cannot use it. Try another. See GEDCOM Tags in Online Help for a list of 
recognized tags.

You can create your own event and role tags for export when Event GEDCOM is sele
When creating your own tags, start the GEDCOM tag with an underline character. For exa
use _MEMSER for an event called Memorial Service. The GEDCOM tag should be descrip
of the event or role.

6. Complete the sentence in the Verb box. If you are creating a memorial service event, for 
instance, enter the words was memorialized on the blank field in the Verb box. The role sentenc
might then read, “Mickey was memorialized in Windsor, California, May 1, 1997.”

7. Complete all fields in the window.

Creating a New Event Type
Ultimate Family Tree includes templates for event types, roles in events, and source types. Tem
standardize the data entered for events and sources. You can also customize your family history
ating templates for events, roles, and source types not included in Ultimate Family Tree’s librari

1. Choose Templates from the Build menu, then choose Event/Role.

2. Click New. A message appears reminding you that roles must be added to this event type

3. Type the name of the new event in the List Name field. 

Figure 2-13: New Event Type Window (Normal Editing Mode)
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4. Type the Long Name of the selected event (up to 30 characters) in the Report Name box.
the Medium length abbreviation for this event (up to 4 characters). Enter the Short abbrev
of the event (up to 2 characters).

5. Define the Detail #A and Detail #B labels for this event. Each detail label can contain up t
characters.

6. Enter a Type for this event if desired. The Type can be civil, personal, military, religious, o
whatever you choose, up to 20 characters.

7. Enter a GEDCOM tag for this event (up to 15 characters). The Event GEDCOM tag is a u
tag that identifies this event, used in Event 1.0 GEDCOM export. For a list of approved tag
GEDCOM Tags in Online Help. If there is not an approved GEDCOM tag for an event, prec
your tag with an underline character to establish that it is user-defined. Use wording that c
defines the event. For example, _VACA might be used as a tag for a vacation event.

8. In the LDS field, enter (T)rue or (F)alse to indicate whether or not this is an LDS religious eve

9. In the Year Min and Year Max fields, enter the earliest year this event could have occurred
the latest year this event could have occurred, if appropriate. 

10. Choose Save from the File menu, click the Save button, or press F9 to save the event wit
closing the window. Scroll through the Event List or type the first letter of the event to locate
highlight the event you have created. Double-click your selection to display the information
that event type. Make sure the correct event is displayed in the List name field at the top o
Event Template window.

11. Click the Source button to open the Event Source window. You can enter up to 65,000 cha
of text about the source or sources for this event. 

12. Click the Definition button to open the Event Definition window where you can enter a defi
tion for the event.

Figure 2-14: Event Template Window
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13. Click Edit in the Role List box to enter the Roles for this event. See Adding New Roles to an 
Event Template below for help with this window.

14. Click OK to save the event and close the window, or Cancel to close the window without sa
changes.

Adding New Roles to an Event Template
In Ultimate Family Tree you can create your own roles to add to events. Each person who partic
in an event has an assigned role and text to describe his or her participation. Use the Role Tem
window to create and customize these roles and their associated sentences.

1. In the Event Template window, click Edit in the Role List box to open the Role Template win

2. Click New.

3. Enter the new role name in the Role field. Capitalize the first letter of the role if you want t
position it at the top of a Defined Role list as this list displays roles alphabetically, with role
initial capital letters listed first. This usually signifies the principal role(s) in an event.

4. Enter the youngest and the oldest age considered the norm for individuals in this role, as w
the sex, if applicable. This information is used for consistency checking.

5. Enter a GEDCOM tag for this role. The Role GEDCOM tag is a unique tag that identifies t
role, used in Event GEDCOM export. Precede this tag with an underline character to esta
that it is user-defined. For example, _JUDGE_TRIAL might be used as a tag for the judge in a
trial. Roles can be repeated but not within the same event.

6. Enter report text for the event using the Role number and Text Codes as described below

7. Click New again, and follow the above steps to add additional roles to the event.

8. Click Close to close the window and save the information.

Figure 2-15: Role Template Window
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Role Template The following selections and options are provided in the Role Template window

• Defined Roles — A list of all roles that have been defined for this event. If an event has bee
imported without roles, undefined is used. 

Select a role to edit by double-clicking the role name in the list. The role name appea
the Role field along with its number and the number of times it is used in the current proje

• Role Definition — The definition for this role. More than one role can have the same name,
the definitions may vary from one context to another. The role definition is used in Event G
COM export.

• Role GEDCOM Tag — A unique tag that identifies this role, used in Event GEDCOM export
Precede this tag with an underline character to establish that it is user-defined. For examp
_JUDGE_TRIAL might be used as a tag for the judge in a trial.

• Consistency Checks — Data in the Min Age, Max Age, and Sex fields are used for data entr
checking by Ultimate Family Tree. For example the bride role would have an F for female. Ulti-
mate Family Tree checks individuals linked to the bride role and displays an error message
sex of that individual is not female.

• Report Text — The Role Report Text establishes how the selected role will be expressed in
reports. Codes are used to signify names, dates, places, and event details. See Report Text Codes 
below for more information on using the codes.

The Report Text can be as long and contain as many sentences as you wish. Be sure
a period as ending punctuation in the last sentence.

Note When specific birth and death information is missing, Ultimate Family Tree omits th
birth sentence and simply states, “John is deceased.” To conform to the style for genealog
reports, changes made to the report text for the Child role in the Birth event will not appea
Family Journal reports. All other text style reports will use the report text as entered for the
Child role.

Report Text Codes In the Report Text Field, sentences can begin with the individual’s full name
just the first name, or the name can appear elsewhere in the sentence. More than one sentenc
used to describe an individual’s participation in the event. The Report Text field contains words 
are used to construct sentences about a given role in text reports. The following codes are avai
construct sentences about a person’s participation in an event. Substitute the appropriate role n
for the n. An exclamation point after the date or detail codes will omit the word unknown from the sen-
tence.

• #n (full name) — The full name of the individual linked to the role

• #nF (first name or common name) — The first name or common name (if one is entered) u
reference to the individual linked to the role

• #nP (pronoun) — The appropriate personal pronoun (he or she) used in reference to the individ-
ual linked to the role
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• #nS (possessive) — The appropriate possessive pronoun (his or hers) used in reference to the 
individual linked to the role

• #nM (pronoun) — The appropriate personal pronoun (him or her) used in reference to the indi-
vidual linked to the role

• #nA (age) — The age, at the time of the event, of the individual linked to the role. If the ag
can’t be computed, unknown is substituted.

• #nA! (age) — Inserts the words at nn years of age into the text, where nn is the computed age. If 
the age can’t be computed, nothing is inserted. If partial dates are entered, at approximately nn 
years of age is inserted. Ages calculated under 1 year print at less than one year of age.

Note Remove the words at age and add an exclamation point to the code (e.g., from at age #nA 
to #nA!) to have the age print only when the age can be computed. When the age can be 
puted, the words at xx years of age are used (where xx is the computed age). For example, whe
the age can be computed, the sentence might read, “John graduated from college at 19 y
age.” When the age cannot be computed, the sentence would read, “John graduated from
lege.” If partial dates have been entered, the sentence would read, “John graduated from 
at approximately 19 years of age.”

• #D (date) — The date the event occurred. If a date is not found, the words date unknown are 
used.

• #D! (date) — The date the event occurred. If a date is not found, nothing is inserted.

• #L (location) — The place the event occurred, including any place modifier (in, at, near, etc.). If 
a location is not found, nothing is inserted.

• #A (detail #A) — The text from the Detail #A field of the event. If this field is empty, the wo
detail unknown are inserted (the actual field label is used instead of detail).

• #A! (detail #A) — The text from the Detail #A field. If this field is empty, nothing is inserted

• #B (detail #B) — The text from the Detail #B field of the event. If this field is empty, the wo
detail unknown are inserted (the actual field label is used instead of detail).

• #B! (detail #B) — The text from the Detail #B field. If this field is empty, nothing is inserted

• #Ii (image) — Insert this code if you want to add selected images (other than the preferred
image attached to the event) in the Family Journal report. Replace the i with the record number 
of the image.

Note Images are added only to Rich Text Format reports.

• #! (“No sentence” code) — When this code is added as the only text in the Report Text bo
event can be included for a person in the correct date order using text from the Event Tex
dow. The Event Text option must be selected in the report window for the event text to prin
This option allows you to skip role sentences altogether.



M A R R I A G E S 5 5

 
ay 
etts.”
or 

r was 
 
ffolk 

ame, 
arents 

. For 
08 
n’t be 
pprox-
lt in 

es for 
tence 

n 

 this 
n the 
m-

he 

or by 

 new 
 you 
 agree-
 the 

er the 
cting 
How Report Text Prints in Reports In the Birth event, for example, the Report Text for the child
(role #1) is #1F was born #D, #L. Using the Kennedy family for the example, this code would displ
and print as, “Joseph was born September 6, 1888, in East Boston, Suffolk County, Massachus

More detailed information can be included by choosing from the various codes available. F
example, #1F was born to #2 and #3, #D, #A, #B, #L, when #1S father was #2A and #1S mothe
#3A. In the Kennedy family example, this would display and print as, “Joseph was born to Mary
Augusta Hickey and Patrick Joseph Kennedy, 3:00 PM, 151 Meridian Street, in East Boston, Su
County, Massachusetts, when his father was 30 and his mother was 30.” The individual’s first n
his parents, the details of his birth and his birth site, the location of his birth, and the ages of his p
at birth are all pulled into the text from the information entered into the project.

The alternate text codes (having an exclamation point) can be used for additional flexibility
example, the structure #18F died #D! #18A! would result in the sentence, “John died January 22, 19
at 78 years of age,” if the age can be computed, or, “John died January 22, 1908,” if the age ca
computed. A partial date calculation will result in the sentence, “John died January 22, 1908 at a
imately 78 years of age.” Birth and death dates that are not complete (DD/MMM/YYYY) will resu
partial date calculations.

Note Use the Check window to add the exclamation point to the date and detail sentenc
all roles, or to remove them. The age code cannot be changed automatically since the sen
structures would not be compatible. Open the Check window by choosing Project and the
Check from the Utilities menu.

Note Since the role text for this type of event is used for all individuals who are assigned
role, it is advisable to keep the role text as general as possible. Use the Preview window i
Event Edit window to preview how the text appears for roles in a specific event. The role te
plate for a specific event or role can be changed in the Preview window without affecting t
library.

Marriages
You can create a marriage by clicking the New Spouse button in the Individual Record window 
clicking New Event. In both cases, a marriage event is added.

When you click the New Spouse button, a new Individual Record opens where you enter a
spouse. If you click the New Event button in the Normal mode, the Events window opens where
can choose Marriage from the Events list. The Spouse field is used for engagement, prenuptial
ment, marriage, domestic partnership, annulment, separation, and divorce events. The label for
Spouse field depends on the event and the sex of the individual whose record you’re entering.

Note If an individual is married more than once, use the basic marriage event type to ent
additional marriages. Use the Marriage 2 event type to enter a marriage record with confli
data.

Some of the spouse titles include:

• Fiancee or Fiancé — engagement and premarriage events
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• Bride or Groom — marriage events

• Divorcee or Divorce — divorce events

• Husband or Wife — LDS sealing of spouse, Get (Jewish religious divorce), and separation 
events

• Partner1 or Partner2 — a domestic partnership event

• Man or Woman — an annulment

• Novio or Novia — diligencias matrimoniales, matrimonio, and velacion (Hispanic marriage 
events)

Creating a New Marriage Record (Normal Editing Mode)
Follow these steps to create a new marriage event when the spouse already exists in the projec

1. Click the New Event button in the Individual Record window.

2. Select Marriage from the Event list.

3. Enter the free-form date.

4. Tab to the place field and enter a place name. If the place has already been entered, type 
place name (or simply highlight an unknown location) and click the Find button to open th
Candidate Places list, or if you know the record number of the place, type the record numb
press the Tab key to link the place. Highlight the place name you want to enter for the eve
click OK.

5. Type the spouse’s name in the Spouse field. If the spouse is already in your project, enter
tial name (or simply highlight -unknown-) and click the Find button to open the Candidate Ind
viduals list. Highlight the name and click OK. If you know the record number of the spouse
type the record number and press the Tab key to link the individual.

Note If you enter a full name in the Spouse field for an individual that has already been en
in Ultimate Family Tree, a message appears when the Individual Record is being saved st
that this name has already been entered. If it is a different person, click New. If the person
already been entered, highlight the person’s name and click OK to link that individual. If yo
want to make changes, click Cancel to return to the Individual Record window.

Creating a New Marriage Record (Advanced Editing Mode)
1. In the Advanced Editing mode, click the New Event button and select the Marriage radio b

2. Click OK to open the Event Edit window. The individual for whom you are creating the ma
riage event is automatically linked to the appropriate bride or groom role.

Note If you click Express rather than OK, a Find Individual window opens. Find an existin
person or enter the complete name of a new person. A new individual record will be create
the name you enter is not found.
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3. Select the other role (bride or groom) from the Roles list.

4. Select -unknown- in the Connected Individuals list and click the Find button to open a Candid
Individuals list where you can select the existing spouse. If you know the record number o
spouse, type the record number and press the Tab key to link the individual to the role. If t
spouse has not yet been entered, simply type the spouse’s name in the Connected Individ
field. 

5. Enter the date, location, and details for the marriage event.

6. Click OK to close the Event Edit window and return to the Individual Record.

Adding Text for an Individual or Event
You can add text for every individual and event in your project. To add text for an individual, click
Individual Text button. To enter text for a specific event, select the event and then click the Even
status box or click the numbered button to the left of the selected event to open the Events or E
Edit window. Within the Events window, click Text. Enter up to 65,000 characters in any free-for
text field. Reports such as the Family Journal (Genealogy) reports and Family Group Sheet can 
individual and event text.

Figure 2-16: Event Text Edit Window
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Choose the option you want:

• Text or biographical — Text prints in the body of free-form reports.

• Footnote — Prints selected text as a footnote in reports. The selected text will be displayed
the Edit Text window, but will print only as a footnote.

• Research Notes — Record information about past, ongoing, or future research on this even
individual. Research notes print in research reports.

Choose Underline, Bold, or Italics to format selected portions of text in reports. Highlight t
text first, then choose a format. See “Text Formatting” on page 59 for more information on using
options.

Including Names or Places in the Index (Advanced Editing Mode)
Click Name Index or Place Index if you wish to include in the index a name or place mentioned 
text. You must know the record number of the name or place to use these buttons.

1. Place the cursor next to the name or place you want to include in the index.

2. Enter the record number of the name or place you want referenced.

3. Highlight the record number and click the Name Index button to include the reference in th
Name Index. The name index code is shown as [NI: :NI] .

4. Highlight the record number and click the Place Index button to include the reference in th
Place Index. The place index code is shown as [PI: :PI] .

Print Text as a Footnote in Reports (Advanced Editing Mode)
1. Select the text you want to print as a footnote in reports.

2. Click the Footnote button. The footnote code is displayed as [FO: :FO]  before and after the text 
you selected.

Attaching a Source to Text (Advanced Editing Mode)
1. Insert the cursor where you want to attach a source. This is where the footnote number is

played in the report, or where the source prints as an embedded note. In this case, do no
light the text, but place the cursor behind the text.

2. Click the Citation button to open the Text Citations window.

3. Select the New radio button and click OK to open the Proof window. See “Adding Evidenc
(Advanced Editing Mode)” on page 69 for details on using the Proof window. After closing
Proof window, a citation code is created. It might display as [CI:100:?4:CI] . The CI stands for 
citation; 100 is the citation number; and the ?4 specifies a sure level of 4.

Note You must choose New to enter additional citations to the Text window even if you a
attaching an existing source for that Text window to other text in the same window. 
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Editing an Existing Citation in a Text Window (Advanced Editing Mode)
1. Open the Text window which contains the citation you want to edit.

2. Click the Citation button.

3. Select the Existing radio button and the citation number you want to edit.

4. Click OK.

Note The Citation button is not active in the Events window accessed from the Individual
Record. To add citations to Event text, press Shift+F8 or choose Event List for an Individu
from the View menu. Double-click on the event for which you want to add text citations an
click the Text button.

International Characters
To create special characters, such as accented letters, place the cursor where you want to inse
character. Hold down the Alt key and use the numeric keypad to type the 3-digit ASCII number f
character, or copy and paste the character from the Character Map, set up as an external progra
Ultimate Family Tree Utilities menu. See the Windows manual for a list of available characters an
information on changing Codepage settings.

Text Formatting 
Formatting options instruct Ultimate Family Tree how to display and print the text in reports. You
use the formatting buttons or type the codes in the text windows. Formatting codes are not prin
reports.

Automatic word-wrap occurs at the end of lines unless the Enter key is used to end a line.
lines are preserved in Ultimate Family Tree reports. Press the Space Bar once at the beginning
new paragraph to indent the first line. To have the Biography text always print as a separate par
press the Enter key before entering text and then indent the first sentence by pressing the Spac
before the first word.

Formatting codes appear around the selected text. For example:

[BO:This text is bold.:BO] This text is bold.

[UL:This text is underlined.:UL] This text is underlined.

[IT:This text is italicized.:IT] This text is italicized.

How to Select Text for Formatting Using the Mouse

1. Place the mouse cursor before the first character to be selected.

2. Hold down the left mouse button while you drag the mouse across the text to be selected

3. Release the left mouse button.

How to Select Text for Formatting Using the Keyboard

1. Place the cursor under the first character to be selected.
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2. Hold down the Shift key and press the right arrow key until the text is selected.

3. Release the Shift key.

Do not use the following characters with the Rich Text Format feature because they are R
Control codes:

\ backslash

{ } curly braces — You can use curly braces to mark a title in a name even if you will be us
the RTF feature.

Checking Spelling
The Spell Check feature includes a dictionary of 140,000 words including 10,000 proper names
can be used in most Text windows and text data fields. 

1. To run Spell Check, open a text entry window (Biography, Event Text, Individual Record, M
ical, etc.). Click the Spell button, choose Spell Check from the Edit menu, or press Ctrl+B

2. If Spell Check does not find a misspelled word, the Spell Check window will not open. Wh
Spell Check finds a word that is not in its dictionary, the word is highlighted and displayed i
Word In Context box.

Note Highlighted words are shown in all lowercase letters but are saved as shown in the
Replace With Word field.

Figure 2-17: Spell Check Window
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3. A list of closely matched words is displayed in the Possible Spellings box. If the word you 
to use is in the list, select the word and click Replace.

4. To edit the misspelled word, click Edit. After editing, click Replace.

5. To end the Spell Check session and return to the Edit window, click Done.

The following is a list of buttons in the Spell Check window:

• Add — Adds the word in the Replace With Word field to the dictionary.

• Done — Ends the spell checking session.

• Edit — Allows you to edit the misspelled word.

• Ignore — Ignores the current misspelled word.

• Ignore All — Ignores all occurrances of the misspelled word and continues spell checking.
ignored word will not produce an error during the rest of the spell checking session.

• Look-Up — Checks the spelling of the current text in the Replace With Word field.

• Possible Spellings — Displays the closest matching words.

• Replace — Replaces misspelled word with the current text in the Replace With Word field.

• Replace All — Replaces all occurrences of the misspelled word.

• Suggest more words — Updates the Possible Spellings list box with more suggested words.

• Undo — Reverses the last Replace or Replace All command.

Importing an External Text File
External ASCII text files (up to 65,000 characters in size) can be imported into any Ultimate Fam
Tree text window. The text should not contain any control codes used in word processor files (fo
example, #, { }, \, etc.). See “Reserved Characters” on page 16.

1. Open any Ultimate Family Tree text window.

2. Choose Import.

3. Change to the drive and directory that contains the text file you want to import.

4. Select the file and click Open.

5. From the Edit menu, choose Select All (or highlight selected text).

6. From the Edit menu, choose Copy.

7. Close the external text file by double-clicking the Control-menu box (or pressing Escape).

8. Click the left mouse button in the Text window where you want to insert the text.

9. Choose Paste from the Edit menu.
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10. Click OK to close the Text window.

Exporting Text
Use the following method to create an external text file and copy text from any Ultimate Family 
text window to this file.

1. Open any text window in Ultimate Family Tree.

2. Select the text to export. See Text Formatting for information on selecting text.

3. From the Edit menu choose Copy (or press Ctrl+C).

4. Click OK to close the Text window.

5. From the File menu, choose New to open the New File window.

6. Select Text from the Type list and click Open.

7. Enter the file name in the New Text File field.

8. Select the drive and directory where you want to place the text file.

9. Click OK to open the new external text file.

10. Place the cursor where you want to paste the text.

11. From the Edit menu choose Paste (or press Ctrl+V).

12. If you make changes to the text window, click Yes when closing the text file to save it.

Source Record
The same sources can be used several times in a genealogical project. The source itself, once
is stored in the Source Library. Often, however, there is additional information, such as a page n
that is unique to its use in specific evidence. Sources that might require additional text enable th

Figure 2-18: Open Dialog Box
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button within the Evidence window. In these cases, the additional information must be entered a
The purpose for this text is described in the Edit Text window.

Creating a New Source (Normal Editing Mode) A source can be entered into the Source Librar
either before you add it to an Evidence window or while you are in the Evidence window. Follow 
steps to create a source from the Build menu.

1. From the Build menu, choose Source Record.

2. Click New.

3. Select a template from the 47 templates provided in the Source Type list. The Source Typ
box at the right side of the window provides a description of the template you select. Click
If none of the source types seem to fit, use the Free-form Text source type.

4. Type Abbreviation 1 and 2 names for the type of source you’re entering. For example, if th
source is a book, Abbreviation 1 would be the author and Abbreviation 2 the title. Abbreviat
is used to identify the source in lists. Enter a unique Abbreviation 1 so that the source is e
identifiable in lists. If you must create a duplicate Abbreviation 1, be aware of it when addi
sources to evidence windows.

5. Choose the first component (by double-clicking or highlighting and pressing Enter) and en
the information about that component in the Component Contents box.

6. Repeat step 5 for the remaining component lines.

Note When using the Free-form Text source type, punctuation should be used (if desired
the text is entered in the Main Text component field. This is an exception to the usual prac
Ultimate Family Tree completes the punctuation in other source types.

Figure 2-19: Source Record (Normal Editing Mode)
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7. After completing the components, click Preview to see how your source will look when it’s
printed. Look for source components that are incomplete or that need further editing. Mak
corrections you want in the associated Source Component field.

8. Press Escape to close the Preview window.

9. Click OK to save the source and to close the Source Record window, or click New to crea
another new source.

Creating a New Source (Advanced Editing Mode)

1. From the Build menu, choose Source Record.

2. Click New.

3. Select a template from the 47 templates provided in the Source Types list. If none of the s
types seem to fit, use the Free-form Text source type.

4. Type Abbreviation 1 and 2 names for the type of source you’re entering. Abbreviation 1 is 
to identify the source in lists. Enter a unique Abbreviation 1 so that the source is easily ide
able in lists. If you must create a duplicate Abbreviation 1, be aware of it when adding sour
evidence windows.

5. Choose the first component (by double-clicking or highlighting and pressing Enter) and en
the information about that component in the Component Contents box.

6. Repeat step 5 for the remaining component lines.

7. Update the Edit Status field if you wish. Ultimate Family Tree has added new to the status field 
for you, however you can use any eight-character descriptor you wish.

Figure 2-20: Source Record Window (Advanced Editing Mode)
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8. Click Preview to see how the footnote and bibliographic forms for this source appear in pr
reports. Punctuation is added from the Source Template for this source type. After preview
the text, correct any problems by editing the appropriate fields in the Source Record wind

9. Click More to open the Source Miscellaneous window where you can enter more detailed
mation about the selected source, such as Call Numbers, condition, repositories, annotati
and so on.

10. Click Media to add media to the source. See Section 7, Multimedia, for more information.

11. To save the new source record without closing the Source Record window, choose Save fr
File menu, press F9, or click the Save button on the Toolbar. Click OK to save changes and
the Source Record window, or Cancel to close the window without saving changes.

Entering the Bibliography Form (Advanced Editing Mode) To print sources in Bibliography 
reports, the bibliographic form of the source must be entered.

1. After entering text in the Source Component fields for the Footnote form, click the Copy 
Footnote to Bibliographic button to copy the entered text into the Bibliographic Componen
fields.

Note The Copy Footnote to Bibliographic button allows you to complete the bibliographic
form of the source type without retyping each line.

2. Select the Bibliographic radio button.

3. Click Preview to view the footnote and bibliographic forms of the source.

4. Edit the source components for the Bibliographic form by selecting the appropriate Sourc
Component fields.

Creating a Duplicate Source (Advanced Editing Mode)

1. From the Build menu, choose Source Record.

2. Click the Duplicate Source button.

3. Select the existing source to duplicate from the Choose Source window.

This procedure copies the entire source and creates a duplicate source record. A duplicate
with a new source record number is opened. Edit the source as appropriate.

Finding an Existing Source Record

1. From the Build menu, choose Source Record.

2. Press F10 or click the Find button on the Toolbar to open the Find Source window.

3. Type in any part of Abbreviation 1 or Abbreviation 2 of the source you want to find.

4. Click Exact for all sources with an exact match or click Like, using any characters includin
wild card characters.
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5. Click Show to see the list of sources found. The question mark wild card (?) is used to sub
for a single unknown character. The asterisk wild card (*) is used to substitute for more tha
consecutive character.

6. Select the source from the list and click OK to close the Find Source window.

Evidence
The Evidence window, accessed from the Individual Record and Events windows, provides tool
enter and organize evidence used as proof for information contained in an Ultimate Family Tree
project. Evidence can include formal source citations and free-form notes. In Advanced Editing m
the evidence window is called the Proof window.

Adding Evidence
To enter evidence for an individual, click the Evidence button in the Individual Record window. T
enter evidence for an event, click the Evidence Status box on the event line or click the number
ton to the left of the event name and click the Evidence button in the Events window.

You can create new structured or free-form sources. Existing sources can be also be acce
clicking the Find/Add Structured Source button. The Footnote button creates a footnote from th
source information you have entered. Use the Edit Source button in the Evidence window to ma
editing changes to an existing source.

Figure 2-21: Evidence Window (Normal Editing Mode)
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Adding Evidence (Normal Editing Mode)
1. To add an existing source to the Evidence window, click the Structured button in the Find/

Source group in the Evidence window. The Add Evidence window opens.

2. Scroll through the list of sources to find the correct source, select it and click OK. The sele
source is displayed in the Source Type list.

Note To see a summary for the selected source, click the View button.

3. Click Text in the Edit group (if available) to open the Edit Text window, and then enter the 
appropriate data, such as the specific page number you want to cite for this proof. 

Note Do not type ending punctuation because it is added automatically when the footnote
printed.

4. Click OK to close the Text window and return to the Evidence window.

5. Repeat the above procedure to add additional sources of evidence to the Evidence List fo
proof.

6. Click Save/Build Footnote to create a footnote for this citation.

Creating a New Source from the Evidence Window (Normal Editing Mode) Sources can be 
entered into the Source Library directly through the Evidence window.

1. Open the Individual Record window.

2. Find the person for whom you want to add evidence.

3. Click the Evidence button for the individual or Evidence Status box for the event you want
support.

Figure 2-22: Add Evidence Window (Normal Editing Mode)
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4. Click the Structured button in the Add New Source group.

5. Select the source type you want to create from the Source Types list. If the source type yo
is not in the list, choose the source type Free-form text.

6. Click OK.

7. Type the Abbreviation 1 and Abbreviation 2 names.

8. Choose the first component (by double-clicking or highlighting and pressing Enter) and typ
information about that component in the Component Contents box. 

9. Repeat step 8 for the remaining component lines.

Note Unlike most Ultimate Family Tree source types, punctuation should be entered (if 
desired) after the text entered in the Main Text component field for the Free-form Text sou
type.

10. Click OK.

11. Click Text in the Edit group (if available) to open the Text window, then enter the appropria
data, such as the specific page number you want to cite for this proof (for example, page 29). Do 
not type ending punctuation as it is added automatically when the footnotes are printed.

12. Click OK to close the Text window.

13. Repeat the above procedure to add additional sources of evidence to the Evidence List fo
proof.

Figure 2-23: Source Record (Normal Editing Mode)
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Creating Free Notes (Normal Editing Mode) Use Free Notes as evidence in a proof. 

1. In the Individual Record window, click the Evidence button for the individual or event you w
to support. To add a Free Note to the Source List, click the Free-form button in the Eviden
window.

2. Enter the Free Note in the Text window and use formatting buttons if desired. 

Note Ultimate Family Tree does not add ending punctuation to Free Notes. Add ending p
tuation to the Free Note, if desired.

3. Click OK to save any text entered and return to the Evidence window.

Creating Footnotes (Normal Editing Mode)

1. In the Individual Record window, click the Evidence button for the individual or Evidence St
box for an event.

2. After adding a source, click the Footnote button in the Save/Build group.

3. The footnote appears in the Footnote box. You can customize the footnote by rearranging
ments. See Customizing a Footnote for instructions.

4. Click OK to save and close the Evidence window.

Note Evidence that is formatted as a footnote will appear as end notes. Evidence that ha
been formatted as a footnote will not appear in reports.

Editing a Source from the Evidence Window (Normal Editing Mode) To edit a source from the 
Evidence window, select the source you want to edit. Click the Source button in the Edit group.

Note Changes made to the source record will affect all footnotes using this source.

Deleting a Source from the Evidence Window

1. Select the source to be removed from the Evidence List.

2. Click Selected to remove the selected source or All to remove all sources from the list.

Note If you have already created footnotes, you must manually edit the footnote to remov
source from the footnote window in the Advanced Editing mode. The footnotes are autom
cally rebuilt in the Normal Editing mode.

Adding Evidence (Advanced Editing Mode)
The Proof window, available in the Advanced Editing Mode, provides tools to organize and weig
dence used as proof for information contained in an Ultimate Family Tree field. Open the Proof 
dow by clicking the Evidence button corresponding to that field.

1. Click Existing in the Add group.

2. Select the source you want to include and click OK.

Note To see a summary of the selected source, click the View button.
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Setting Default Sources Ultimate Family Tree provides a convenient way to select a group o
sources as a default. The default can contain one or several sources. You can use the Default S
list to select all the sources for a proof at once, or to select a group of sources to be used in sev
proofs.

1. While in the Proof window, click Add to open the Add Evidence window.

2. Select a source from the Source List on the left.

3. Click Add in the Default group. A plus (+) next to a source indicates a default source.

4. Repeat this procedure for each source you want to use in the default setting.

5. Click Default to link all default sources to the Proof window.

Note The default list you created is available from any Proof window until you change it o
remove the check from the Use check box.

6. To remove a source from the default list, select the source and click Remove. Click Clear 
remove all the sources from the default list.

Evaluating Evidence (Advanced Editing Mode)

• Consistency — The consistency of evidence is an important consideration when determinin
reliability of information. Evidence can support a conclusion, refute a conclusion, or be incl
out of convenience to show that a source was checked but that no pertinent information w
found. Supporting evidence is shown in the evidence list with a +, refuting evidence is sho
with a –, and neutral evidence is shown with a 0.

Figure 2-24: Proof Window
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• Directness — Evidence can be in the form of a direct statement of fact or an implied fact. C
clusions based on direct statements of fact are more reliable than implied or circumstantia
dence. For example, a direct statement is the date of birth for an individual, while circumst
evidence is a birth date implied by a marriage date. A ! is added to the CDO column in the evi-
dence list to show that the evidence is direct, while a ? is used to show that evidence is indirec

• Origin — Evidence is assigned a letter grade to indicate its origin as either primary eviden
secondary evidence, or unknown. Primary evidence is information that was recorded at the
time as (or shortly after) an event. Secondary evidence is information that was recorded at
time, or by someone who did not participate in the event. Unknown quality indicates that th
gin of the evidence is not known. Primary evidence is indicated by an A, Secondary evidence is 
indicated by a B, and unknown is indicated by a C.

To evaluate a piece of evidence, select the source from the Evidence List and then select
appropriate radio button from the Consistency, Directness, and Origin groups.

Justifying and Quantifying the Proof (Advanced Editing Mode) The Evaluation window is 
used to present the argument for the case you are making. Include in your analysis of the evide
weaknesses in the argument and notes for further work.

1. Click the Evaluation button.

2. Enter an argument for the case you are making.

3. Click OK to save and close the window.

Assigning a Sure Level (Advanced Editing Mode) Assigning a sure level is the last step in a 
proof before creating the actual footnotes. The sure level reflects your judgment of how certain y
of the claim being made, based on an analysis of the type, consistency, directness, and origin o
evidence.

Enter a sure level in the Sure field of the Proof window. This sure level will be displayed ne
the Evidence button in the Event Edit window. Assign sure levels using these guidelines:

4 — Clear and convincing proof

3 — Probably conclusive, no conflicting evidence

2 — Probably conclusive, some conflicting evidence

1 — Marginal certainty, weak or conflicting evidence

0 — Reserved for information in your project that has not undergone a formal proof.

Setting CDO, Sure Level Defaults (Advanced Editing Mode) After assigning the CDO group 
and sure level, click the CDO/Sure Set button to set the selections as the default for all future P
windows. This setting is saved when you exit and return to Ultimate Family Tree.

Creating a New Source from the Proof Window (Advanced Editing Mode) To add a source to 
the Evidence List that is not already in the Source Library, click New in the Add group.
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1. Select Source in the Type group.

Note To add a free note, select Free Note in the Type group and click OK to return to the 
window. See Creating Free Notes, Advanced Editing Mode.

2. Select the appropriate template from the Source Types drop-down list.

3. Type the Abbreviation 1 and 2 names (for a book, this is normally the author’s name and t
title).

4. Fill in the component fields. Click the Component button in the Help group for suggestions
entering component information.

5. Click OK to return to the Add Evidence window.

6. With the new source selected in the Add Evidence window, click OK.

Note The Quick Source Entry feature is not available when adding citations to Text wind
Enter the source through the Source Record window before attempting to link it as a citatio
Text window. To create a Bibliographic form of the source, use the Source Record window
accessed from the Build menu.

Creating Free Notes (Advanced Editing Mode)

1. Click the Evidence button for the information you want to support. 

2. Click New in the Add group.

3. Select Free Note in the Type group and click OK. You return to the Proof window and the 
dence List includes free note E***.

Figure 2-25: New Source Quick Entry (Advanced Editing Mode)
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4. In the Proof window, click Edit in the Added Text box to open a text window where you can
enter up to 65,000 characters of text for the Free Note. Use the text formatting commands
(underline, bold, and italics) to format the citation.

5. Repeat the above procedure to add as many Free Notes as you wish to the Evidence List

Creating Footnotes (Advanced Editing Mode) After adding evidence to a Proof window, creat
footnotes for your claim by choosing the Footnote button.

The Footnotes window includes the following:

• List of your evidence preceded by the CDO codes

• All Evidence and Selected Evidence button for inserting all or selected evidence to the Foo
Text box

• Footnote Text box for creating and editing footnotes

• Final Reports and Research Reports options for indicating whether the footnote text is for
or Research Reports

Note Evidence that is formatted as a footnote will appear as end notes. Evidence that ha
been formatted as a footnote will not appear in reports.

1. Select the Final Reports radio button and then click the All Evidence button to insert all of
evidence in the order shown in the Evidence list to the Footnote Text box. The evidence, i
full form from the Source Library, is shown in the Footnote Text box.

2. Click the Selected Evidence button to add only the piece of evidence you have selected to
Footnote Text box.

Figure 2-26: Footnotes Window (Advanced Editing Mode)
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3. To create a footnote for a Research report, select the Research Reports radio button and c
appropriate Insert Evidence button.

4. Click OK to return to the Proof window.

Customizing a Footnote Customizing footnotes is not necessary, but you might want to rearran
footnotes for printing.

1. Create a footnote by following the steps for “Adding Evidence (Advanced Editing Mode)” o
page 69 and “Creating Footnotes” on page 73.

2. Edit the footnote, using the following rules:

• Each source or Free Note included in your footnote is set within code brackets (for examp
[FR: :FR] or [SO#: :SO], with # being the record number of the evidence for that source).

• Do not customize formatting inside the SO: source code brackets. When Ultimate Family Tree
prints a footnote, it reconstructs the footnote from the sources in the Source Library and fr
Free Notes and text added to sources in the Text window in the Evidence window. Change
made within the source or Free Note code brackets in the Footnote text window are not re
in the Source Library record or the Text window and will not be included in end note repor

• Formatting is added automatically to text within the source code brackets according to the
source template for that source type. You can, however, manually customize the formattin
footnote outside the source code brackets by typing the format codes before and after the a
priate text. For example:

[BO:This text is bold.:BO] This text is bold.

[UL:This text is underlined.:UL] This text is underlined.

[IT:This text is italicized.:IT] This text is italicized.

• You can also add information to a source that is unique to a specific piece of evidence, lik
page number in a document. Type this text outside the source code brackets. For exampl
following code [SO12:Harvey Rachlin, [IT:The Kennedy’s, A Chronological History:IT] (New
York, NY: Ballantine Books, 1986):SO], page 43.

• You can cut and paste text inside the footnote to customize the way it displays and prints, a
as you move sources and free notes with their codes.

Note If you make changes outside of the code brackets, these changes will be lost if you
the Rebuild Footnotes option in the Check window.

3. Click OK to save your changes and close the Evidence window, or Cancel to close the Ev
window without saving changes.

Source Template Window
The Source Template window is used to view and edit existing source types or to create new so
templates. Templates are formats used to control what information is entered for a source type,
how that information appears in printed reports.
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By editing a template you can change how punctuation and formatting appear when the s
record is printed. Formatting options include normal text, upper case text, underlining, italics, an
bold. Editing a template affects all sources using that template in any project.

Creating a New Source Template

1. To open the Source Template window, choose Templates from the Build menu, then choo
Source.

2. Click New. 

3. Enter the name of the new source type in the Selected Source Type field, using up to 20 c
ters.

4. Select the Footnote radio button from the Form group.

5. For each source component, enter the label used to identify the source item in the Source
ponent box, such as author, article title, or volume nunber.

6. In the two-character fields before and after the item label, enter any leading and trailing p
ation to be used in the footnote form of the source. Do not enter trailing punctuation for th
component, since Ultimate Family Tree does that for you automatically.

7. After entering the source component labels and punctuation for the footnote form, choose
Bibliography radio button in the Form group.

8. Enter any punctuation needed before and/or after each source component for the bibliogr
form of the source.

Note Do not enter ending punctuation for the last component you enter as a period is au
ically entered when the source prints.

Figure 2-27: Source Template Window
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9. To insert a line between components, position the cursor on the component where you wi
add a line and click Insert.

10. To remove a source component, position the cursor on the selected component and click
Remove.

11. With each source component selected, select the Type field in the Component box to disp
Type list. Select the appropriate type for that component. When you create a GEDCOM fil
these types are used to place the information correctly in the file.

Note The component type note can be used only once in a Source Template. All other Com
nent types can be used for more than one component line within the same template.

12. Select the style for each component from the Style list in the Component box. The style c
normal, underline, italic, bold, or uppercase. The style specified for that component is used
the source is printed.

13. With each source component selected, click Component Help to open a text window whe
can enter your own help for the selected component. This window is displayed when you c
Component from the Help box in the Source Record window with the related component 
selected. 

14. Click Type Help to enter your own help for the source type. Source Type help should desc
what the template is designed for.

15. Click OK to save changes and close the window.

Editing an Existing Source Template

1. Find the source type you wish to edit by scrolling through the Existing Source Types list in
Source Template window. 

2. With the desired source type selected, press Enter or double-click the left mouse button to
the Source Template window for that source type.

3. Make the appropriate changes to the source template.

4. Click OK to save the changes and return to the previous window, or press F9 to save with
closing the window.

Deleting Source Templates To delete a template from the Source Library, click the Delete button
the Source Template window. A message appears indicating how many sources in the current p
use the selected template. Click Cancel to return to the Source Template window without deleti
template or OK to delete the template.

Adding Children
1. To enter a new child for a selected individual, click the New Child button in the Individual 

Record window. Clicking New opens a window where you can indicate the other parent fo
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child. Select the proper parent and click OK. A new Individual Record window opens for th
child with the child’s surname already entered in the name field and the child’s parents (if 
known) already in the Mother and Father fields. Type the remaining information.

2. Choose Undo from the Edit menu before saving the record if you do not want to create a 
child. Choosing Undo will return you to the previous record.

Note If the other parent is not listed, click None in the Other Parent window. A new Individ
Record window opens with the parent who was the subject of the previous window in his o
respective field (mother or father). Enter the other parent in the appropriate parent field.

Note In order to achieve proper text alignment, the text in the Other Parent window appe
a different font.

Adoption
Ultimate Family Tree provides ways in which to indicate that a child is an adopted member of a
ily. If you always want the adoptive parents to print as if they are the birth parents, begin by ente
the adoptive parents as the father and mother in the child’s Individual Record window. You then
add an adoption event for the child with information concerning the birth parents (if known), or t
adoption itself, in the Event Text window. A second method to indicate adoption is simply to use
Miscellaneous window to add an adopted flag for the child. A third way is to use the Family event (se
below).

Family Event
The Family event is used in Ultimate Family Tree to establish nontraditional or social family link
rather than bloodline family links. Each individual is allowed only one Family event in which he or
is linked to the child role. Roles included in the Family event are Child, Parent1 and Parent2, ad
parents, birth parents, foster parents, godparents, sealing parents, social parents, and step par
may add roles to this event, if you choose. To print reports that show adoption or nonbloodline lin
if they were blood links, you must be in Advanced Editing mode. Create a Family event to link th
adopted (nonblood) children to their adopting (nonblood) parents.

Figure 2-28: Other Parent Window
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1. At the Individual Record for the child, click the New Event button.

2. Select Extended and the letter f to move quickly through the Extended Events list.

3. Select family and click OK.

4. Make the following assignments in the family event:

Child — Child

Parent 2 — Adoptive mother (or mother who raised the child)

Parent 1 — Adoptive father (or father who raised the child)

Note Parent 1 and Parent 2 roles are used as substitutes for the birth mother and birth fa
reports. In addition to adoptive parents, Parent 1 and Parent 2 can be a step-father and bi
mother, a foster mother and father, a birth father and adopting mother, and so on. Other ro
such as adopting mother or birth father, can also be linked but are not required to show th
between parents and child.

Printing Reports Showing Adoption Links

1. From the File menu, choose Page Setup.

2. Select Include Family Events in Printed Reports.

3. Click OK.

Note When this option is selected, the family event overrides the birth event in printed re

Children of Unmarried Parents
In Ultimate Family Tree, a marriage is not required for parents to be connected to their children
can enter only one parent if the other parent is not known. When reports print for these families
mention of the parents’ unmarried status is printed in reports. To indicate this fact, use the Unm
event or include the information in the Individual or Event Text windows.

Adding Siblings
1. To enter a new sibling, click the New Sibling button. This opens the Individual Record win

with a new record for the sibling with the child’s surname already entered in the name field
the parents (if known) already in the Mother and Father fields.

2. Choose Undo from the Edit menu before saving the record if you do not want to create a 
sibling. Choosing Undo will return you to the previous record.

Note To use the Sibling button on the Individual Record, you must enter a parent. If you d
know the parents for a group of siblings, enter a name for the father or mother in one of th
ent fields. For example, for an individual named John Smith, you could enter a father or m
named Unknown /Smith/, or (-----) /Smith/.
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Additional Information
Ultimate Family Tree provides a way to add additional information for an individual.

1. In the Individual Record window, click the More button to open the Individual More window

2. Click the Names/Flags tab to open a window where you can record information such as a
nationality, languages, and individual flags.

3. Click the Miscellaneous tab to open the Miscellaneous window where you can record Web
and Email addresses, Mail label information, Birth status, ancestor and descendant intere
els, Immigrant status, Ancestral file number, and Social Security number.

4. Click the Medical tab to open the Medical History window where you can enter informatio
about the individual’s physical characteristics (height, weight, skin, eyes, hair, etc.) as wel
any known medical conditions.

5. Click the Media tab to attach images or audio from the Multimedia Library to the individua
you’re editing.

Names/Flags Information
Ultimate Family Tree provides a way to add miscellaneous information for an individual. In the I
vidual Record window, click the More button and then click the Names/Flags tab to open the Na
Flags Information window.

Note Click on a field and click Find to display a list of previously entered data for that field
reuse data, select the item you wish, then double-click or press Enter.

Figure 2-29: Name/Flag Window
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• Long Name — Click the Long Name button in the Names/Flags window. In the text window
enter a long name of up to 65,000 characters for the selected individual. The long name is
displayed on screen in Build or View windows, but is used in Ultimate Family Tree text rep
Remember to use slash characters (/) to define the surname and curly braces ({}) to define

• Individual Flags — Flags designate special information that you might want to include in yo
project. Ten flags are available for each individual. They can be defined differently for each
vidual. Examples of possible flags include attendance at a certain college, needs more re
or cause of death. Up to ten characters of text can be entered in each Flag field. The Find 
plays a list of the flags that have already been entered.

• Reference — If you have your own system for referencing and would like to use it, enter yo
data in the Reference field. Any combination of letters, numbers, and punctuation marks c
used, up to 20 characters. The Find button displays a list of the data you have entered for 
erence field.

• Common Name — You can enter a commonly used name such as Johnny or Mary Jo. This name 
prints instead of the first name in reports where first names print without a surname. If a re
has limited space for an individual’s name, it is truncated and the common name is substi
for the first name. For example, if a person named Mary Josephine is commonly known as
Jo and Mary Jo is not entered here, Ultimate Family Tree uses Mary as the first name inst
The Find button displays a list of common names you have entered in the project.

• Alias 1 — First alias for the individual. This is a good place to record a woman’s married na
the French Canadian dit name, a nickname, or the way you’d like a person’s given name and
name to appear in printed reports. Remember to use slash characters (/) to define the sur
and curly braces ({}) to define a title. The Find button displays a list of Alias 1 names you h
entered in the project.

• Alias 2 — Second alias for the individual. Use slash characters (/) to define the surname a
curly braces ({}) to define a title. The Find button displays a list of Alias 2 names you have
entered in the project.

• Signature — How the individual signed his or her name, for example, M. A. Smith. The Find but-
ton displays a list of signature names you have entered in the project.

• Nationality — Nationality of this individual. The Find button displays a list of nationalities yo
have entered in the project.

• Language 1 — Primary language for this individual. The Find button displays a list of prima
languages you have entered in the project.

• Language 2 — Second language for this individual. The Find button displays a list of secon
languages you have entered in the project.

• Religion 1 — First religion for this individual. The Find button displays a list of religions you
have entered in the project.
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• Religion 2 — Second religion for this individual. The Find button displays a list of second re
gions you have entered in the project.

• Religious Name — The religious name for this individual. Use slash characters (/) to define
surname and curly braces ({}) to define a title. The Find button displays a list of religious na
you have entered in the project.

Miscellaneous Information
Ultimate Family Tree provides a way to add miscellaneous information for an individual. In the 
Individual Record window, click the More button and then click the Miscellaneous tab to open th
Miscellaneous Individual Information window.

Note Click on a field and click Find to display a list of previously entered data for that field
reuse data, select the item you wish, then double-click or press Enter.

• Web Link — Universal Resource Locator (URL) that links an individual to any other Interne
URL in an Instant Web Page. This link can be to images, sounds, or other genealogies. Fo
example, you can link John F. Kennedy to a genealogy at another Web site. If the genealo
were to be found at URL http//www.anothersite.com/jfk.html, you could enter this address in the
Web Link field for John F. Kennedy. Someone browsing your genealogy could then click o
link to jump to the Web page for JFK. The Find button displays a list of Web links you have
entered in the project.

• E-Mail — Enter your email address in this field.

• Ances. File # — Identifying number for LDS Ancestral File. The Find button displays a list o
Ancestral file numbers you have entered in the project.

Figure 2-30: Miscellaneous Individual Information Window
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• Social Security No. — Individual’s Social Security number. The Find button displays a list of
Social Security numbers you have entered in the project.

• Birth field —Select Normal, Twin, Multiple, Stillborn, Illegitimate, Legitimate, or Unknown 
from the drop-down list. This field is optional.

• Immigrant — Check this field if the individual you are entering was an immigrant.

• Interest — Optional Ancestor and Descendent interest levels are required in Tiny-Tafel rep
The Tiny-Tafel is a summary of your research interests that can be distributed to others so
can find people who are researching family lines in which you have an interest. Ultimate F
Tree interest designations are as follows:

0 — People who will not be used to establish a family line.

1 — People in whom you have no further interest or for whom your data is marginally relia
and therefore of no interest to anyone else. These people can be included in a Tiny-Tafel 
erence to establish a family line.

2 — People in whom you have little interest, but your data is high quality and might be of 
est to other researchers.

3 — People in whom you have moderate interest. The data is either good or poor.

4 — People in whom you have great interest. The data is good or poor.

• Mail Label — Enter an address of up to 34 characters per line and a telephone number fo
individual. You can create mailings such as a newsletter to send to this person. There is als
you can use to designate specific mailings. These can be used in the Mail Search to crea
of individuals to use when printing mailing labels. The name entered in the addressee field
be different from the name in the Individual Record window, such as Mr. and Mrs. Thomas 
Smith.

• Edit Status — This field shows the current status of the record you are viewing. Ultimate Fa
Tree provides flags for identifying the Edit Status as quick, GEDCOM, new, and R3DIRECT. 
You can add to or change these codes to suit your needs.

• Last Edit — The last edit date is the date this record was last saved. Ultimate Family Tree 
your computer’s system date. The last edit date cannot be changed manually.

Medical History
Click the More button in the Individual Record window, and then click the Medical tab to open th
Medical History window where you can enter information about the individual’s physical charact
tics (height, weight, skin, eyes, hair, etc.) as well as any known medical conditions.

Select one of the medical conditions and click the button below the Conditions list to open
free-form text window where you can enter up to 65,000 characters of information. Select the O
Conditions option at the end of the list of medical conditions to add any medical conditions not 
in this window. Use complete sentences, as text will print as entered in reports.



A D D I T I O N A L  I N F O R M A T I O N 8 3

you 

 

Note The name of the text button changes to the name selected in the Conditions list.

Media
Click the More button, and then click the Media tab to open the Multimedia Link window where 
can attach images or audio from the Multimedia Library to the individual you’re entering.

1. To add an image or audio file, in the Add Media Link group, click Existing Media to open a
Media Select window.

Figure 2-31: Medical History Window

Figure 2-32: Media Select Window
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2. In the Media list, highlight the item you want to add and click Add to copy it to the Linked 
Media list.

3. Click OK.

4. Click the Play Image or Audio/OLE button (depending on the type of file) to display or play
file.

5. Click OK to close the Multimedia Link window.

See Section 7 for more information on building a Multimedia Library and the Multimedia L
window.

Task List
Choose Task List from the Build menu to open the Tasks window. This provides a way to track 
manage genealogical research projects. Tasks and associated information can be assigned to 
als, events, places, sources, proofs, and media items.

The example above shows one objective that has been identified for Caroline Kennedy—t
need to document information about her marriage.

Ultimate Family Tree entered the objective for Caroline automatically when the Auto BMD
push button was chosen. Auto BMDB automatically analyzes all birth, marriage, death, and bur
events for this person for lack of evidence regarding these basic events. Auto All analyzes all eve
this individual for lack of evidence. Select a sure level threshold for the Auto Task Add and choo
BMDB or All.

Figure 2-33: Tasks Window
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Accessing Task Information Task information can be accessed and edited from most windows
Ultimate Family Tree to show the active tasks for the currently selected person. Use the table be
a guide to access the Task window for events, places, sources, and media items.

The selected objective in the Objective List box appears at the top of the Task window. Th
objective can be changed in the Selected Objective field at any time. When there are no objectiv
word None appears in the Objective List and most controls on the window are disabled.

Details for the selected objective are shown below the objective list in the Objectives Desc
tion box. The Description box is a free-form text field for an overall note about the objective. Mil
stone dates can be assigned to each objective, along with associated text. The four dates inclu
date that the objective was created, the proposed start date, a date to report progress, and a du
Indicator lights next to each date show that Milestone Description text is present for that milesto
Finally, each objective can be shown as completed or not, and a priority level (high, medium, low
be assigned.

Creating a New Objective for an Individual

1. Display the Individual Record for the person for whom you wish to add an objective.

2. Choose Task List from the Build menu. The Tasks window opens showing the objective lis
the selected person.

3. Click the New push button.

4. The objective name is automatically assigned by Ultimate Family Tree when you create a
objective. If you wish to change the name for this objective, do so in the Objective field at 
top of the window. Use a descriptive objective name that will be helpful when you later exa
objectives in a list.

5. Type the description for the objective in the Description box. Include any information that 
help you recall the details of the objective at a later time. For example, if you know that you
to review a certain microfilm roll at the National Archives, enter the appropriate information

Task Item How to Access

Events, Normal Editing mode Event Record (use Build, Event Record or press F8)
Events (opened from Individual Record window)

Events, Advanced Editing mode Event Record (use Build, Event Record or press F8)
Event Edit (opened from Individual Record window)

Places Place Record (use Build, Place Record or press Shift+F6)

Sources, Normal Editing mode Source Record (use Build, Place Record, or press Shift+F7)
Proof (choose Evidence or E push button)

Sources, Advanced Editing mode Source Record (use Build, Source Record, or press Shift+F7)
Proof (choose Evidence or E push button)

Places Place Record (use Build, Place Record, or press Shift+F6)

Media Multimedia Library (use Build, Multimedia Library)
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here. Later you can search on key words, such as National Archives, to find tasks that need 
attention.

6. Assign a priority (high, medium, low) from the Priority drop-down list.

7. Enter the repository that contains the information you need in the Document Repository fi
Click the Find button to select from existing repositories.

8. Next, assign Milestone dates. The Created date was entered for you when you created th
Click the Start Date radio button and find the date you expect to start the task in the calen
Change the month or year by clicking the associated forward or back arrow push buttons. R
to today’s date by clicking Today. Once you have found the desired start date, click Milesto
transfer the date to the Start radio button. Type any text associated with the Start date in t
Milestone Description text box below the Milestones dates radio buttons.

9. Choose Yes or No in the Completed drop-down list.

Task information can be located using the Tasks Search. It can also be displayed through
ber of browse windows or included in several reports.

Sticky Notes
Ultimate Family Tree allows you to write reminder notes and attach them to windows within the 
gram. These notes are designed to help you in your data entry and research tasks and can be 
viewed and edited.

Creating Sticky Notes 

1. Open the window to which you want to attach a sticky note.

2. From the Build menu, choose Sticky Notes, then Context Notes. You can also add Edit St
Notes to the right mouse menu and click the right mouse button to choose Edit Sticky Note
Mouse Menu for information on customizing your mouse menu.

Figure 2-34: Sticky Notes Window
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3. Click New.

4. Enter a name for the Sticky Note in the Name field. This name will be displayed in the Stic
Notes window. It can also be added to the Mouse menu for easy access.

5. Enter descriptive text for the Sticky Note in the Sticky Text field.

6. Click OK to save your data and close the window.

Note A maximum of five sticky notes are allowed for each window.

Viewing Sticky Notes There are two methods for viewing sticky notes.

1. From the Build menu, choose Sticky Notes, then Context Notes to view the Sticky Notes fo
Active window. Click All Notes to view all Sticky Notes for the current project.

2. Press the right mouse button and select the Sticky Note name in the mouse menu.

Adding Sticky Notes to the Mouse Menu

1. From the Utilities menu, choose Preferences.

2. Click the Mouse Menu tab.

3. Select Sticky Notes and click Add.

4. Place all of the relevant Sticky Notes for the current window on the menu.

Deleting Sticky Notes

1. From the Build menu, choose Sticky Notes, then All Notes.

2. Select the Sticky Note you want to delete and click the Delete button.

Note Sticky Notes are not available in all windows.
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Use the View menu to choose ways to display information you have entered in your project. The
lowing formats are available: Family Tree, Family Group, Individual Summary, Historical Summ
Descendants, Kinship, Slide Show, Media Tree, Photo, Timeline, Calendars, Lists, Task List, an
Sticky Note List. Use the list windows to display information about individuals, marriages, event
roles, and sources in table (row and column) format. Use lists to help analyze data in your proje
well as to locate records for editing. You will learn how to:

✓ Use the Go Menu to quickly find Individual Records

✓ Move around the Family Tree window displaying up to five generations per screen with pic

✓ Display a Family Group window with pictures

✓ View all information entered about an individual in story form

✓ View an Historical Summary for an individual

✓ View the descendants of a selected individual with pictures

✓ Determine the relationship between any two individuals in your project

✓ See a person’s full name and record number

✓ View a Slide Show for an individual or family

✓ View a four-generation Media Tree including pictures and narrative
8 9
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✓ View a photo

✓ View a Timeline

✓ View an Anniversary or Historical Calendar

✓ View the REVENT library

✓ View all individuals in your project by record number, surname, given name, or birth date

✓ View a list of marriages in your project organized by surname or given name, date, or plac

✓ View a list of sources in your project

✓ View a list of events in your project for an individual, by event, date, place or number

✓ View a list of roles in your project by role, name, surname, event, individual number, date, 
or number

✓ View a list of places in your place library

✓ View a Task List

✓ View Sticky Note List

Using the Go Menu
The Go Menu gives you the ability to move through the individual list and quickly return to recen
edited records. Up to ten names are displayed in the Go List. Each time you open an Individual
Record, that individual’s name is placed at the top of the list.

From the Go Menu, choose any name in the list to open that individual’s record. Choose G
to move to the first person in your project. Choose Go Bottom to move to the last person. Choo
or Down to move to the previous or next person in the list. The next person is determined by the
in which you last opened individual records. If a search results list is open, the focus will chang
those individuals in the search list.

Family Tree (Pedigree) Window
The Family Tree (also known as a Pedigree) window displays up to five generations of a family.
window can be used with other windows, such as the Individual Record window, to discover mo
about selected family members.

1. Choose Family Tree from the View menu, or click the Family Tree button on the toolbar.

2. To change the subject of the Family Tree window, click the Find button on the toolbar, or us
Find key (F10) to select an individual.

3. Double-click a name to make that person the focus of the window.
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Note The indicator light, to the right of a name in the far right column, will be on if the line 
that person continues.

4. Click Previous if you want to move back to the previous subject.

5. Choose any person (by double-clicking the left mouse button) in the child list to move that
son to the subject line. Use the scroll bar to move up and down a long list of children, or c
once on any child and use the up and down arrow keys to move through the list. Type the
letter of a name to move up or down the list to that child’s name. 

The number of children in the list is shown at the top of the list. Highlight a child’s nam
and press F5 or the Individual Record button on the toolbar to display the Individual Recor
the selected child. When you return to the Family Tree window, that child will be the focus
the window.

6. Double-click any sibling to make that person the focus. All siblings are listed, including tho
who have only one parent in common. Use the scroll bar or the up and down arrow keys to
up and down a long list of siblings, or type the first letter of the name to move up and dow
list to that sibling’s location. Press F5 to display the Individual Record window for a selecte
sibling.

Note A plus (+) sign is displayed to the left of a subject’s child or sibling if that person ha
descendants.

7. Click the Spouses button to display spouses of the selected individual in the window. Clic
Cancel to return to the Family Tree window for the original person, or OK to return to the F
ily Tree with the selected spouse as the new subject. Click Edit in the Spouses window to
the spouse’s Individual Record window.

Figure 3-1: Family Tree Window
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8. Click the Previous button to return the focus to the previous subject.

9. Click Photo to display the preferred image (if any) for the selected individual. See “Selecti
Preferred Image for Display” on page 261.

Note To return the focus to the original individual, double-click his or her name at the top
the window.

10. Click Close to close the Family Tree window and return to the Individual Record window. T
last selected individual in the Family Tree window will be the new focus.

Family Group Window
The Family Group window displays a family unit including a husband, wife, their parents, and th
children.

1. Choose Family Group from the View menu or click the Family Group button on the toolbar
open the Family Group window.

2. Press F10 or click the Find button on the toolbar to find a new subject, and click OK to retu
the Family Group window with your selected person as the Start person. Remember, you 
press F5 or click the Individual Record button on the toolbar if you’d like to display the Ind
ual Record window for this or any selected individual.

Note If a marriage record for the husband and wife is found, the date and location of the
riage is shown in the center of the Family Group window. Otherwise, you’ll see marriage record 
not found.

Figure 3-2: Family Group Window
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3. Click Other Wives or Other Husbands to display a list of spouses or parental partners. Sel
spouse or parental partner from the list to display his or her associated family, or click Can
return to the Family Group window. These buttons are dim if no other spouses are found.

Note Parents who are not married or do not have a marriage record are considered pare
partners.

4. Click Parents of Husb or Parents of Wife to display the family for the husband’s or wife’s p
ents. These buttons are dim if no parents are found.

5. To shift the family display forward one generation, highlight the child in the child list box, c
the Child button, or double-click the name. When no children appears in the Child list box, the 
Child button is dim.

Note The children for this husband and wife are shown in the list box next to Child and th
number of children is displayed under Child. This list contains all common children for this
ple. Use the scroll bar or the up and down arrow keys to move up and down a long list of c
dren. You can also type the first letter of the name to move down the list to that child’s nam
plus (+) sign in front of a child’s name indicates that his or her descendant line continues. T
plus sign to move up or down the list to a name with a plus sign.

6. Click Photo to display the preferred image (if any) for the selected individual.

7. Click Close to close the Family Group window and return to the Individual Record window

Individual Summary
To view all the information you’ve entered for an individual, follow these steps.

1. Select an individual in any window, and then choose Individual Summary from the View m
press Shift+F5 on the keyboard, or click the Individual Summary button on the toolbar.

Figure 3-3: Individual Summary Window
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2. The selected individual’s information is displayed in story form. Individual text, plus footno
and research notes, are shown in their entirety.

3. Information in the Individual Summary window can be viewed but not edited. To change 
information appearing in the Individual Summary, edit the information in the Individual Rec
window.

4. To close the Individual Summary window, press Escape or click the Close box.

Note Some event details might be displayed twice. This is normal. The duplication will no
print in reports.

Historical Summary
The Historical Summary window shows a list of all events in an individual’s life in one column, hi
ical events from the REVENT library in the second column, and dates in the third column. Use 
window to gain an historical perspective on an individual’s life.

1. Select an individual in any window and then choose Historical Summary from the View me

2. The selected individual’s events are shown in the timeline.

3. Double-click an individual’s event in the list to open the event window and edit the event.

4. Double-click an historical event to open the REVENT Edit window to edit or add historical
events.

Figure 3-4: Historical Summary Window
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Descendants Window
The Descendants window shows a list of descendants, one generation at a time, for a selected
ual. For example, you can use the Descendants window to view all grandchildren of a selected p
Up to 100 generations can be viewed.

1. Choose Descendants from the View menu.

Note To find a new starting person for the Descendants window, press F10 or click the F
button on the toolbar to open the Find Individual window.

2. Choose a generation number from the Generation Gauge on the left side of the window to
the descendants in a specific generation. To choose a generation number, highlight the num
corresponding number line in the gauge, or Tab to the gauge and use the up and down ar
keys.

3. Use the scroll bar if the list of descendants in a generation is longer than the box. Individu
each Generation List are shown in alphabetical order by given name. The number of pers
that generation are shown above the list, as is their relationship to the ancestor. The paren
the selected person, if known, are displayed at the bottom of the window.

Note To edit an individual record, select the individual and press F5 or click the Individua
Record button on the toolbar to open the Individual Record window.

4. Click Close to exit the window.

Figure 3-5: Descendant Window
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Kinship
You can find the relationship between any two individuals through birth or marriage. If a relation
exists, Ultimate Family Tree displays a list of common ancestors. The relationship between the 
selected individuals is computed through 16 generations. Two individuals (subjects 1 and 2), ar
selected as the subjects for a relationship check.

1. Choose Kinship from the View menu.

Note In order to maintain proper text alignment, the text in this window appears in a diffe
font.

2. Start with subject 1. A Lock button is next to the name field. Uncheck the Lock button if it 
checked. Click the Find Person button on the toolbar or press F10 to find a new individual. 
the desired individual is found, click OK in the Find Individual window.

3. Check Lock to lock in subject 1.

4. Uncheck the Lock button for subject 2. Click the Find button on the toolbar or press F10 to
the second subject for the relationship check. When the person is found, click OK.

Note You must unlock a subject before the Find Individual and arrow buttons on the toolb
will work. Be sure to lock subject 1 before moving on to subject 2.

5. Click Start to compute the relationship between the two subjects.

6. The Related Thru group displays how the two individuals are related through birth or marr
as well as any events they may have in common. Select Birth to find a blood relationship. 
Marriage to display relationships through marriage. Select Events to display the events th
two individuals have in common.

Figure 3-6: Kinship Window
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7. To find the nearest common ancestor of the two subjects, select Birth from the Related Th
group and Nearest in the Show group.

8. Select Redundant1 from the Show group to display the redundant ancestors and the num
generations from Subject 1 to all individuals in the list. To display the redundant ancestors
the number of generations to subject 2, select Redundant2.

Note Birth must be selected to access the Redundant options. Redundant ancestors resu
relationships in which there is more than one line from an individual to his or her ancestor
Redundant lines result when cousins marry. If subjects 1 and 2 have common redundant 
tors, the number of generations to both is displayed. If the number 999 is displayed after a
vidual, there is no relationship between the selected subject and the individual in the list.

9. Select Generation from the Number group to display the number of generations from eac
ancestor to each subject. The resulting Relationship list contains the nearest common anc
of the two subjects, and the number of generations from subject 1 and subject 2. This is th
default selection when the Kinship window is first opened. Birth and Nearest must be selec
access the Generation option.

10. In the Number Group, select Ahnentafel to display the Ahnentafel numbers for subjects 1 
Birth and Nearest must be selected to access the Ahnentafel option.

11. To display the degrees of consanguinity (kinship) between each ancestor and subject, se
Consan from the Number group. Birth and Nearest must be selected to access the Consa
option.

12. Click Close to close the Kinship window.

Name and Record Number
Choose Name and Record Number from the View menu or press Ctrl+S to display that individu
full name and record number. Click OK to close the window. This feature is useful to rapidly det
mine the record number of a selected individual in your project.

Slide Show
Use the Slide Show window to view slide shows that you have created.

1. Choose Slide Show from the View menu to open this window.

2. Highlight one of the shows in the Slide Show list and click Preview to see the slides for tha
show displayed eight at a time. This allows you to review the show before viewing the show
slide at a time. See “Creating a New Slide Show” on page 264.
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3. To view the slides manually or automatically, select the appropriate option in the Mode gro
you choose Manual, you must advance each slide by pressing the Escape key. If you cho
Automatic, the program advances the slides for you.

4. Check the Sound Effects box to turn sound effects on.

5. Click Selected to view the show you highlighted, or click All to view all of the shows.

Media Tree
The Media Tree displays four generations of a family with pictures and recordings attached to e
individual.

1. Choose Media Tree from the View menu.

2. To change the start person for the tree, click the Find Individual button or press the F10 k
find a new subject.

3. Select Narrative from the Multimedia drop-down list and choose an individual’s name on t
Media Tree to hear a recording that has been linked to that person.

4. Select Photo and Narrative from the drop-down list and then choose an individual’s name 
an enlargement of the preferred image and play a narrative, if present.

Note If more than one image is linked to an individual and none have been selected as th
ferred image, the first image linked to the individual is displayed in the Media Tree.

5. Choose Close to close the Media Tree.

Figure 3-7: Slide Show Window
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Viewing a Photo
Choose Photo from the View menu to display the preferred image for the selected individual. If 
images linked to this individual have been selected as the preferred image, this feature is not av
See “Selecting a Preferred Image for Display” on page 261.

Timeline
The Timeline window allows you to compare the events in the lives of two individuals, or the eve
for one individual with REVENT historical events that occurred during that person’s life. Use the
Timeline window to learn how two lives may be related through their events, or how one individu
life compares to events happening in the world at that time.

Note The REVENT library is not available if the REVENT radio button is dim. Either load t
REVENT library again using the Ultimate Family Tree Installation program, or create your 
REVENT library.

1. Choose Timeline from the View menu.

2. To view an individual’s timeline, unlock a check box in the Timeline window and click the F
button under a name field to find an individual.

3. Check the Lock box to lock this individual in the window. 

Note When a new individual is selected, the timeline automatically recalibrates to display
from five years before the earliest event to five years after the latest event in that person’s

4. Click the Find button under the individual with whom you wish to make a comparison.

Figure 3-8: Timeline Window
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5. A timeline showing the event spans of the two individuals is in the center of the window. S
up or down to change the year.

6. The arrows on the timeline indicate that an event took place in that year for the individual o
right or left. Since the timeline shows years, more than one event may be indicated by an 
To view the events that took place in a given year, choose the arrow for that year. The eve
displayed in the Event List. The Event Detail box displays information about the first event
occurred during the selected year.

7. Choose the REVENT radio button to view a list of events that occurred in the world during
lifetime of the individual displayed on the left of the Timeline window.

Note When the REVENT radio button is dim, this indicates that a REVENT library is not 
open. Choose Open from the File menu to open an existing REVENT library, use the Ultim
Family Tree Installation program to load the REVENT library, or choose New from the File
menu to create your own REVENT library.

8. Choose the Person radio button to replace REVENT with the individual locked on the righ

9. Click Close or press the ESC key to exit the Timeline window and return to the previous win

Anniversary Calendar
The Anniversary Calendar window shows a list of events that occurred on a specific date, along
description of those events. The first time you open the Anniversary Calendar it automatically dis
your computer’s internal date unless you have selected a date in your project. Thereafter, the w
opens to the last date you viewed.

The events that occurred on that date appear, along with brief descriptions. You can move
ward or backward in the calendar to view the events and descriptions for any date.

Figure 3-9: Anniversary Calendar
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A calculator is included for determining dates in the past or future. An Event list shows a li
all the events that occurred on a specific date. To view a description of an event, choose that eve
the list. The description includes the year the event occurred and the number of years ago, or th
ber of years in the future, the event occurred. It also includes the place the event occurred and 
viduals involved in the event.

1. Choose Calendars from the View menu, then choose Anniversary.

2. Choose the date about which information is desired by clicking the New button to open the
Date window. The New Date window allows you to go forward or backward in time by day
months and or years.

3. Select the appropriate radio button to indicate whether you wish to go forward (+) or back
(-) in time, then specify how many days, months, and years you wish to move.

4. Click the Show button to display the day of the week and date found in the Result Is field.
can also enter a specific date in the Go To field.

5. Click OK to accept the Result Is date, close the New Date window and return to the previo
window. The first event that occurred on the Result Is date is displayed. If no events happe
that date, the closest event is displayed.

6. Click the left arrow button next to the displayed month to go back a month, or the right arr
button to go forward a month. To move one year at a time, click the left and right arrow bu
next to the displayed year. Click the Today button to return to today’s date.

7. To view the Calendar of the specified event date from the perspective of that date in the p
click the Then button.

8. To view a description of a specific event, choose that event from the Event List.

9. To view the Event, press F8, the right mouse button, or choose Event Record from the Bu
menu.

Figure 3-10: New Date Window
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Note The Event Edit window which opens from this window allows editing of all fields exc
roles. To edit the event for connected individuals, select the individual and click the Go bu

10. Click Close to exit.

Historical Calendar
The Historical Calendar window displays a list of historical events that occurred on a specific da
along with a description of each event. You can move forward or backward in the calendar to di
events that took place on other dates. 

Each event description includes the year the event occurred, the number of years ago or i
future that the event happened or will happen, and a short description. The Historical Calendar 
includes a calculator for determining dates in the past or future. 

Events can be viewed for either the current year or for all years. Events from the Historica
endar can be included in the text for an individual by using the Copy and Paste commands in th
menu.

The information shown in the Historical Calendar comes from Ultimate Family Tree’s REVE
(ROOTS Events) library. You can also create your own REVENT library.

1. Choose Calendars from the View menu, then choose Historical.

The window includes a Calendar and a Historical Events list showing the year each e
occurred, the number of years in the past or future, and a short description of the event. U
up and down arrow keys or the scroll bar to view the entire list of events that occurred on 
cific date.

Note The Historical Calendar window opens to any date selected from the last active win
Thereafter, it opens to the last date selected in the Historical Calendar. If no date was sele

Figure 3-11: Historical Calendar
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the first time you open the Historical Calendar it automatically defaults to your computer’s 
nal date.

2. Click the left arrow button next to the displayed month to go back a month, or the right arr
button to go forward a month. To move one year at a time, click the left and right arrow bu
next to the displayed year. Click the Today button to return to today’s date.

3. To view the events that occurred on a specific date, click New to open the New Date wind
Enter the date you wish to view in the Go To box and click OK. If no listed events occurred
the specific date, no events appear.

4. When the All years radio button is selected, the Events List displays all the events that oc
on that date in any year. To view only the events which occurred on that date in a selected
select the This year radio button.

5. To include details about an historical event in the text for an individual, select the event inf
tion you wish to include, and choose Copy from the Edit menu. Next, open the appropriate
window and move the cursor to the location where you wish to insert the historical event 
description. Choose Paste from the Edit menu.

6. Click Close to exit the Historical Calendar window and return to the previous window.

REVENT Library
REVENT (for ROOTS Events) is an historical book of days. The REVENT library, REVENT.REV
contains information about important events in history. The USHOL.REV Library contains the h
days observed in the United States. You can view REVENT events for a specific date by choosi
endar, and then Historical from the View menu. You can also compare historical events to the ev
an individual’s life by choosing Timeline from the View menu.

The REVENT Library window is used to add, modify, or delete records from the current 
REVENT library. To open the REVENT Library window, choose REVENT Library from the Build
menu.

Note If the REVENT menu option is dim, it means there are no REVENT libraries availab
on your hard drive. Use the Ultimate Family Tree Installation program to install the REVEN
libraries, or see “Creating a REVENT Library” on page 104.

Opening an Existing REVENT Library
1. From the File menu, choose Open.

2. Select REVENT database from the List Files of Type field.

3. Change to the \UFT\REVENT directory.

4. Select the REVENT file you want and click Open.
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Creating a REVENT Library
1. Choose New from the File menu to open the New File window.

2. Select REVENT from the File Type list and click Open. The directory should default to the
REVENT subdirectory.

3. Enter a file name of 8 characters or fewer, without an extension, for the new REVENT libr
Ultimate Family Tree automatically adds the .REV extension.

4. Click OK to create the library and return to the current project.

5. To add information to the new REVENT library, choose REVENT Library from the Build me

Creating a New REVENT Event
1. Choose REVENT Library from the Build menu.

2. Click the New button.

3. In the Headline field, enter a headline of up to 20 characters describing the event.

4. Enter the approximate date for the event.

5. Enter an unlimited description of the event in the Event Text field. Do not enter trailing pun
tion as it is added automatically in reports.

6. Select the appropriate radio button in the Day box. Select the Depends on date radio butt
events that occur on the same day and month every year (a birth event, for example). Sel
Same every year radio button for events that occur on the same day of the week every yea
as Thanksgiving). Enter the day of the week (using the three character abbreviation) in theon 
field.

Figure 3-12: REVENT Library Window
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Note The Same every year option is dim unless the year 0100 is entered in the Date fiel

7. Choose Save from the File menu, click the Save button on the toolbar, or press F9 to save
event to the REVENT library without closing the REVENT Library window. 

8. Click OK to save the event and close the window, or click Cancel to close the window with
saving any changes.

Finding an Existing REVENT Event
There are three methods for finding REVENT events.

1. Choose REVENT Library from the Build menu.

2. In the REVENT Library window, click the Browse button to open a list of all events in the o
REVENT library. The events are sorted in date order.

3. Double-click the event or choose REVENT Library from the Build menu to change the focu
the REVENT Library window to the selected event.

Another method for finding REVENT Events uses the Find button.

1. In the REVENT Library window, click Find.

2. In the Find field, enter up to 31 characters of text to be searched in the Event Text field.

3. Use the date boxes to specify a date range for the search. Enter a starting date in the Afte
and an ending date in the Before field.

4. Click Find. This locates the first record matching the text and date range you’ve entered.

Figure 3-13: Find REVENT Text Window
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5. Click Next to find each additional event that meets the search criteria. The Headline field 
plays the headline of each record as it is found. The date of the record is displayed in the 
field below the headline, and the text for the record is displayed in the Text field.

6. When the event you are looking for is displayed, click OK to display the found event in the
REVENT Library window. Click Cancel to return to the REVENT Library window without 
bringing up the event.

The third method for finding REVENT events uses the Jump button.

1. Click Jump in the REVENT Library window.

2. Select the appropriate radio button to indicate whether you wish to go forward (+) or back
(-) in time, then specify how many days, months, and years you wish to move.

3. Click the Show button to display the day of the week and date found in the Result Is field.
can also enter a specific date in the Go To field. 

4. Click OK to accept the Result Is date, close the New Date window, and return to the previ
window. The first event that occurred on the Result is date is displayed. If no events happe
that date, the closest event is displayed. 

5. Click OK to accept the result and return to the REVENT Library window.

Viewing Lists
List windows allow you to view information in either of two formats. When you open a list windo
the information is organized horizontally, with each record taking up one row in the table.

When the right side of a list window is opened, the information in a record is displayed ver
cally and you can view all fields in a record. To open the right side of a list window, position the c
on the resize box on the lower-right corner of the list window. Hold down the left mouse button a
drag the pointer to the left.

When text is available in a text or note field, you’ll see Memo in the list with an uppercase M. 
When no text is available, memo is displayed with a lowercase m. If text is available, you can view the
text by pressing Ctrl+PgDn with Memo selected.

Text in list windows can be viewed, but not changed. To edit text, events, sources, and oth
information displayed in an Individual List window, select the field and press F5, or double-click
left mouse button to open the respective Build window. Click the appropriate button to access te
event, place, or source windows and make editing changes. In a Marriage List, double-click the 
on the left side of the list. In a Source List, double-click a selected field to open the Source Rec
window.

Use the vertically positioned arrows to scroll up and down the list. Use the arrows along th
tom of the window to scroll horizontally through the list.
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The Individual List displays a list of all individuals in your project. To open the Individual List, cho
Individual from the View menu and choose one of the options: By Record Number, By Surname
Given Name, or By Birth Date.

Additional options are available in the Individual List submenu: Custom and Design.

Custom List The Custom option (F2 on the keyboard) opens the Individual List you specified in
Order and Contents window accessed by choosing Design in the Individual List submenu.

Figure 3-14: Individual List Window

Figure 3-15: Order and Contents
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Design List The Design List option allows you to specify the order and contents of an Individua
List. From the View menu, choose Individual List and then Design.

1. Select the order in which you want to display the list from the Order group.

2. Select the type of individuals for the list from the Contents group. For example, select Des
dants to view the descendants of a selected individual, or select Grouping to view those in
uals in the Grouping list.

3. Select Search in the Contents group and then select a search type from the Search list to
the list to display the last results of the selected search.

4. Click OK to close the window and save the changes.

5. To view the contents of the search list you designed, press F2, or from the View menu cho
Individual List and then Custom.

Marriage List 
Provides a list of the marriages in your project. To open the Marriage List, choose Marriage List
the View menu and choose one of the options: By Husband Surname, By Wife Surname, By Hu
Given, By Wife Given, By Date, or By Place.

Event List
The Event List provides a convenient way to browse through the events in your project. The Eve
includes several options. Events can be viewed for a selected individual, by event, by place, by d
by number. You can also choose to see all the events in your project, or use Ultimate Family Tre
search routines to limit the events in your list. To open the Event List window, choose Event List
the View menu.

Finding Events for a Selected Person To view events for a selected person, select the person in 
window. From the View menu, choose Event List and then For an Indiv., or simply press Shift+F8
list window displays the list of events in the selected person’s life in date order. Those events w
dates are first in the list. Double-click the event name to open the Event Record window for the
selected event.

Role List 
The Role List provides a way to browse through the roles in your project. Individuals are assign
roles through the Event Edit window. The Role List can be viewed in order by role, given name,
name, event, Individual Record Number, date, place, or number. Open the Role List submenu b
choosing Role List from the View menu. 

Select All to view all roles or Principal Only to display only roles marked as Principal. Sele
Only Grouping to view roles for those individuals in the Grouping list only.
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Place List 
The Place List provides a convenient way to browse through all the places in your project. Plac
listed alphabetically. When you select the Place List while another window is active, the current
selected place (if any) is highlighted in the list. All places can be viewed from any place level. F
example, you can view places by city (All places), county (Level 2), state (Level 3), country (Lev
or number. Select Only Place Search list to view the results of the last Place Search.

Source List
The Source List provides a list of all your sources in the Source Library. From the View menu, ch
Source List, then Sources by Name or Sources by Number.

To view the contents of the last Source Search, choose Source List and then Only Source
Search List from the View menu.

Task List
The Task List provides a list of tasks and associated information that is assigned to individuals, e
places, sources, and media items. From the View menu, choose Task List, then By Task, By Pr
By Creation Date, By Due Date, Show All Tasks, or Exclude Completed Tasks.

Sticky Notes
The Sticky Notes List provides a list of sticky notes. Sticky notes allow you to write reminder no
and attach them to different windows within the program. These notes are designed to help you 
data entry and research tasks and can be easily viewed and edited.

From the View menu, choose All by Individual, All by Sticky Note, or All by Window.
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Ultimate Family Tree provides a set of powerful search routines designed to locate individuals, e
places, and sources in a project. In this section you will learn how to use search criteria to find:

✓ Name and/or SOUNDEX code

✓ Citations

✓ Duplicate individuals

✓ Events in an individual’s life

✓ User-defined flags

✓ Mailing label information

✓ Linked pictures or audio recordings

✓ Information contained in the Medical window

✓ Information contained in the Miscellaneous window (long names, aliases, religion, nationa
social security number, and more)

✓ Modifications

✓ Presence of an individual at a certain place

✓ Starting and ending event ranges
1 1 1
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✓ Relationships

✓ Biographical, research, or footnote text

✓ Vital statistics (age at marriage, sex, living, related, unrecorded parents, and more)

✓ Events

✓ Places

✓ Sources

✓ Tasks

✓ Grouping

Using Search Windows
Ultimate Family Tree provides searches for Individuals, Events, Places, and Sources. Each sea
dow provides options for defining the scope of your search. Ultimate Family Tree locates all rec
for which the contents of the specified field matches the search criteria. Information entered in a 
window is retained when you close the window. You can close a search window and then open i
to conduct another search using either the same or modified search criteria.

Search windows contain drop-down lists with the following options:

• Replace the list with those found — Starts a new search list. This option replaces an existing
search list with the results from the current search list. Individuals, events, places, or sour
already in the list are removed, and the new list is saved.

• Replace the list with those not found – Starts a new search list. This option, available only in t
Events, Places, or Sources search windows, replaces an existing search list with events, 
or sources not found using the current search criteria.

• Add them to the list — Builds a composite list from two or more searches. This option adds 
results of the current search to an existing search list. For example, if five individuals are a
in the list from a previous search, and seven new individuals are found and saved with this
option, the new list will contain twelve individuals.

• Remove them from the list — Narrows an existing search list. This option removes the results
the current search from an existing search list. For example, if five individuals are in an ex
list, and two individuals from a new search are already in that list, they will be removed. Th
new search list will contain three individuals.

• Keep if already in the list — Matches items in an existing search list. This option keeps the 
results of the search if they are already in the existing search list. For example, if five indivi
are in an existing list and a new search finds two who are already in that list, the new list w
contain two individuals.
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Other options common to all search windows are:

• Close — Closes the search window

• Search — Creates the Search list

• Results — Views the results of the last search

• History — Shows how the search list was built

• Preview — Displays the results of a search without committing the results to the search lis

Conducting a Search
The following basic steps are used to conduct a search.

1. Open any search window from the Search menu.

2. Make selections for defining the search. The search criteria are shown at the top of the se
window as you make your selections. This information is also added to the History window
a search is complete.

3. Choose one of the options from the drop-down list at the bottom of the window to Replace,
Remove, or Keep the resulting list. (Descriptions of these options are listed above.)

4. To check the search without committing the results to the permanent search list, click Pre
Press Escape to return to the Search window.

5. Click Search to create the Search list and view the results.

6. Click Group to replace the Grouping list with the results of the current search.

Note The Group button is available only in Individual Search windows.

7. Click Close or press Escape to close the Search Window.

Note Click Results to show the last completed search list. Double-click any name to ope
Individual Record for that person in an Individual Search. Double-click an event, place, or 
source in the Event, Place, and Source searches to open those respective Build windows
History to see a summary of how the search list was built.

Searching for Individuals

Name Search
You can locate an individual in an Ultimate Family Tree project by name or names. Various opti
provide flexibility in defining the Name search and the Grouping option allows you to merge sea
lists generated through the Individual Search routines.



1 1 4 SE C T I O N 4 : SE A R C H I N G

and 

hn 

d to 
. 
, 

r.

ode. 
 field. 
r that 

 
ch 
rst let-
Rules for Name Searches The following rules apply when entering names in the Name Search 
Find Individual windows:

• Use either uppercase or lowercase letters—name searches are not case sensitive.

• Enter more than one name for a person if you want. For example, if you are looking for Jo
Fitzgerald Kennedy in your project, you can type john fitzgerald in the top field.

• Type either full or partial names. For example, you can type hn fit to locate John Fitzgerald 
Kennedy.

• Use special characters called wildcards. The question mark wild-card character (?) is use
substitute for a single unknown character. For example, jo?n finds all those named John or Joan
The asterisk (*) is used to substitute for more than one consecutive character. For exampleho*r 
finds Howard and Homer.

• Use forward slash characters (/) to specify surnames. For example, by typing /smith/ you find all 
those individuals having the surname Smith. If you enter smith without slash characters, Ulti-
mate Family Tree finds all individuals whose name contains smith anywhere in their name.

• Use braces to specify titles. For example, typing {Sr.} finds all those individuals having the title S

• Search for surnames in the top text field of each Name Specification box by SOUNDEX c
Enter a surname without the slash characters or a valid SOUNDEX code in the first name
If you enter a surname, Ultimate Family Tree converts the name to the SOUNDEX code fo
name, and replaces the name in the text field with the code.

Note SOUNDEX is a code used by the United States Government to index early census
records. It is used to find names with the same sound, no matter how they are spelled. Ea
SOUNDEX code is made up of a letter and three numbers. The letter is the same as the fi
ter of the surname.

Figure 4-1: Name Search Window
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Searching for a Simple Name
1. From the Search menu, choose Individual, and then Names.

2. Type a name in the first name field of the top Name Specification box. Use wildcards if de
and any combination of uppercase and lowercase letters.

3. Complete the search as described in “Conducting a Search” on page 113.

Searching for a Surname by SOUNDEX

1. Enter a surname (without slashes) or a valid SOUNDEX code in the first name field. If you
a surname, Ultimate Family Tree converts the name to the proper SOUNDEX code for you
SOUNDEX search only finds surnames.)

2. Check the SOUNDEX check box in the appropriate Name Specification box.

3. Make sure all other name fields are empty.

4. Complete the search as described in “Conducting a Search” on page 113.

Completing a Complex Name Search

1. Enter the search information using any combination of the four name fields available. Sele
SOUNDEX and the NOT conditions that you want to use. The two name fields in each Na
Specification box are used together.

2. Check the NOT box to exclude names from the search.

Note The characters entered in both fields must be present in an individual’s name for th
individual record to be included in the search list. If the OR Name Specification field’s lowe
Name Specification box are is with the upper Name Specification Box, a record must matc
or the other to be included.

Figure 4-2: Name Search Window
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3. Specify surnames by using the forward slash, for example, /Smith/, and titles by using braces, for
example, {Jr.} .

4. Complete the search as described in “Conducting a Search” on page 113.

Searching for Individuals Linked to Citations
The Citation Search locates individuals who are connected through a citation to specific sources
Source Library. Open the Citation Search window by choosing Individual and then Citations from
Search menu. The Citation Search window contains a list of all sources in the Source library, an
options to narrow your search.

The search criteria are displayed at the top of the search window as you make your selec
This information is also added to the History window after a search is complete.

1. Select Any in the Source box. Choose Selected to include only a specific source in the se

2. If you chose Selected in step 1, select the source you want to include in your search from
Source list. The Source list includes all the sources in the Source library. The list shows th
Abbreviation 1 name for each source.

3. Narrow your Citation search by specifying where the citation was used. Three location op
are provided:

• Individuals — Searches for the selected source when used in citations for information in th
Individual Record window

• Events — Searches for the selected source when used in citations for events

• ALL — Searches for the selected source when used in any citation

4. Complete the search as described in “Conducting a Search” on page 113.

Figure 4-3: Citation Search Window
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Duplication Search
Use the Duplication Search to find individual records that may be duplicates. Duplicate records
result from importing and merging two projects. Open the Duplication Search window by choos
Individuals from the Search menu, then choosing Duplicates.

The search criteria are displayed at the top of the search window as you make your selec
This information is also shown in the Summary window after a search is complete.

In addition to the options available in other search windows, the Duplication Search windo
contains the following fields:

• Duplication Tests

• Tolerance Level group

• Records group

• Again and Reset buttons

Finding Potential Individual Record Duplicates Open the Duplication Search window by choos
ing Individuals from the Search menu and then choose Duplicates.

Note The following steps find potential duplicates, but do not move those individuals into
Duplication Search list. Refer to the numbered steps below to transfer the results to the D
tion Search list.

The following options are available in the Duplication Search window.

• Records group — Choose the Next radio button to search on a record-by-record basis. Cho
the All radio button to search the entire project for potential duplicates.

Figure 4-4: Duplication Search Window
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• Again button — Click Again to run the search using the current search criteria. This option 
allows you to make a change in the search tolerances, rerun the last search and see the e
before clicking Preview.

• Reset button — Click Reset to start the search over at the beginning of the project. Reset is
active when the Next radio button is selected.

• Preview button — Click Preview to view the list of duplicate individual records before comm
ting the results to the search list. After clicking Preview, the Update button becomes active

• Update button — Click Update to move transfer the results of the search to the search list.

Transferring Results to the Duplication List Select your criteria for the search as listed below.

Note For a more detailed description of the tolerance levels corresponding to the fields li
in the Duplication Tests list, see “Tolerance Levels” on page 119.

1. Select names and the desired tolerance level. Next, select Birth Dates, and so on, repeat
the remaining fields to be searched in the Duplication Test box.

2. Select the appropriate option for the resulting search list:

• Replace the list with those found

• Add them to the name list

• Remove them from the name list

• Keep if already in name list

3. Click Preview.

4. With the Preview list open, bring the Duplication Search window to the top by clicking the 
mouse button on the Duplication Search window. Click Update to transfer the resulting du
cates from the Preview list to the Duplication list.

5. Click Results to view the current Duplication Search list.

6. Click Group to replace the Grouping list with the results of the current search. 

Duplication Tests Potential duplicate records can be found using eight tests: Names, Birth dat
Death dates, Birth places, Death places, Parents, Sex, and Reference. The list of duplication te
the left side of the window is used in conjunction with the Tolerance radio buttons to determine 
potential duplicates are found. Any of the eight tests can be used alone or in combination with o
by specifying a Tolerance Level for each test.

To conduct your search on a record-by-record basis, choose the Next radio button. This op
useful because it allows you to review potential duplicates thoroughly before going on. Choose 
search the entire project for potential duplicates.

Click Again to rerun the last search cycle whether Next or All was selected in the Records g
This option allows you to make a change in the search tolerances, rerun the last search, and se
effects. Click Reset to reset the search back to the beginning, starting with the first record. Res
active only when the Next radio button is selected.
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Tolerance Levels The Tolerance selection determines how closely two records must match bef
they are considered duplicates. Six tolerance levels are provided. The lowest tolerance, 0, requi
two records match exactly for them to be considered duplicates. The highest tolerance, 5, remo
selected duplication test from the search. The tolerance level is used differently in each duplica
test. Definitions of the tolerance levels used for each test are given below:

Names
5 — The name test is not used.

4 — The surname SOUNDEX codes and the first character of the given name SOUNDEX c
for the two individuals must match.

3 — The surname SOUNDEX codes and the first two characters of the given name SOUND
codes for the two individuals must match.

2 — The surname SOUNDEX codes and the first three characters of the given name SOUN
codes for the two individuals must match.

1 — The surname SOUNDEX codes and the given name SOUNDEX codes for the two indi
als must match.

0 — The names of the two individuals must match exactly.

Birth Dates
5 — The birth date test is not used.

4 — The birth years for the two individuals must match within five years.

3 — The birth years for the two individuals must match within one year.

2 — The year of birth for the two individuals must match.

1 — The month and year of birth for the two individuals must match.

0 — The birth dates for the two individuals must match exactly.

Death Dates
The tolerance levels are the same as for birth dates.

Birth Places
5 — The birth place test is not used.

4 — The level 2 birth place for the two individuals must match (usually level 2 is a county—
ferent states can have the same county names).

3 — The level 3 birth places must match (usually level 3 is a state).

2 — Levels 3 and 4 of the birth place name must match (usually a state and country).

1 — Levels 2, 3, and 4 of the birth place name must match (usually a county, state, and cou

0 — The birth places for the two individuals must match exactly.

Death Places
The tolerance levels are the same as for birth places.
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Sex
5 — The sex test is not used.

4 — The sex test is not used.

3 — The sex test is not used.

2 — The sex test is not used.

1 — The sex of the two individuals must match exactly, or the sex of one or both individuals
unknown.

0 — The sex of the two individuals must match exactly.

Parents
5 — The parents test is not used.

4 — Parents for one or both individuals are unknown.

3 — Surname SOUNDEX codes and given name SOUNDEX codes must match for one pa

2 — Surname SOUNDEX codes and given name SOUNDEX codes must match for both pa

1 — The mother’s name or the father’s name for both individuals must match.

0 — The names of both the mother and father for both individuals must match.

Reference
5 — The reference test is not used.

4 — At least one of the two individuals has an empty reference field.

3 — The first two characters of the SOUNDEX codes for the reference fields must match.

2 — The first three characters of the SOUNDEX codes must match.

1 — The SOUNDEX codes of the contents of the reference field must match.

0 — The contents of the reference field for both individuals must match exactly.

Note Previewing in the Duplication Search window operates differently from other search
windows. Click Preview to find potential duplicates, then click Update to transfer the result
duplicates from the Preview list into the Duplication list. The Update button is disabled unl
Preview has been chosen.

Individual Events Search
The Individual Events Search looks for individuals connected to events in your project based on
events entered in the Individual Record window. The search criteria are displayed at the top of t
search window as you make your selections. This information is also added to the History wind
after a search is completed.

1. Choose Individuals, and then Events from the Search menu.

2. Choose Selected Event or All Events in the lower-left corner of the window.
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3. If you chose Selected Event in step 2, select an event from the Possible Events list that sh
the event types used in the current project. Scroll through the events using the up and dow
arrow keys or by typing the first letter of the event you want to search.

4. To search for events that happened in a selected place, check Selected in the Places gro
then click Place to open the Find Place window. If you are not including places in the sear
teria, skip to step 9.

5. Type in the first few characters in a place name.

6. Choose Exact for all place names with an exact match or choose Like and use any chara
including wildcard characters. The question mark wildcard (?) is used to substitute for a si
unknown character. The asterisk wildcard (*) is used to substitute for more than one conse
character.

7. Click Show to see the list of places found.

8. Select a place and click OK to close the Find Place window. The place to be included in th
search is added to the criteria at the top of the window.

9. To search for an event that took place in a certain time period, enter dates for the time peri
one of the following:

• Enter the date in the After field in the Dates group to search for events occurring after a give

• Enter the date in the Before field to search for events occurring before a given date.

• Leave both the After and Before fields blank to search for events that occurred on an unkn
date (the event date fields are blank).

Note If a date is entered in the Before field and the After field is left blank, the search incl
events with a blank date field and events having dates after 1/1/100. If a date is entered in
After field and the Before field is left blank, the Before date defaults to today’s date.

Figure 4-5: Individual Events Search Window
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10. Use the Roles drop-down list to choose one of the following:

• All — to include individuals connected to any role

• Principal — to include only those individuals who had a principal role in the event

• Undefined — to search for individuals participating in any events where no roles have been
assigned

• Selected — to search for individuals connected to specific roles. Choose Selected, then clic
Role button to open the Specify Role window. Select the role you want to include in the se
and click OK.

11. Enter the Role Sure level numbers, Min and Max (0–4).

12. To narrow the search with Event Sure levels, enter the minimum sure value for the search
Event Sure Min field and the maximum Sure value for the search in the Max field. This fea
searches the main sure level field from the top of the Event Edit window.

13. Complete the search as described in “Conducting a Search” on page 113.

Flags Search
The Flags Search locates individuals whose Individual Records contain specific user-defined fla
information. The search criteria are displayed at the top of the search window as you make you
tions. This information is also added to the History window after a search is complete.

1. Choose Individual, and then Flags from the Search menu.

2. Select a flag from the list of individual flag fields. All flag labels assigned to the project are
included in the list.

Figure 4-6: Flags Search Window
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3. In the Status group, select True to search for flags marked True, or select False to search f
marked False. Select Either to search for individuals linked to the selected flag marked as
True or False.

4. Complete the search as described in “Conducting a Search” on page 113.

Mail Search
The Mail Search window locates individuals by information entered in the Mail Label window ope
from the Miscellaneous Individual Information window. The search criteria are displayed at the t
the search window as you make your selections. This information is also added to the History w
after a search is completed.

1. Choose Individual, and then Mail from the Search menu.

2. Scroll down the list of options in the label field and select the criteria to be used in the sea

3. If you select one of the label fields that contains text, such as an addressee, enter the wo
search in the Text field.

4. Select a mailing list from the Label Fields (such as Family Association, Newsletter, Birthda
Holiday, and Other 1 and 2) to enable the buttons in the Included in Mail List box.

5. Select Yes to search for individuals included in the selected mailing list, or No to find those
included in that mailing list.

6. Complete the search as described in “Conducting a Search” on page 113.

Media Search
The Media Search searches for individuals who are connected to a selected image or audio rec
The search criteria are displayed at the top of the search window as you make your selections.
information is also added to the History window after a search is complete.

Figure 4-7: Mail Search Window
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1. Choose Individual, and then Media from the Search menu.

2. Select the audio or image you want to include in the search from the Media list.

3. Complete the search as described in “Conducting a Search” on page 113.

Medical Search
The Medical Search looks for individuals for whom you have entered medical information. The M
cal History window is opened from the Individual Record window. The search criteria are display
the top of the search window as you make your selections. This information is also added to the
tory window after a search is complete.

1. Choose Individual, and then Medical from the Search menu.

Figure 4-8: Media Search Window

Figure 4-9: Medical Search Window
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2. Select one of the three options located under the Medical Conditions list: Selected, All, or
Ignore. If you choose Ignore, the Medical conditions are ignored and only the Measure an
Misc. groups are available to be searched.

3. If you chose Selected in step 2, select the medical condition from the Medical Conditions 
Scroll through the list by using the up and down arrow keys or by pressing the first letter o
condition you want to search.

4. Select Any Text in the Text group to search for text entered in the Medical Condition text w
dows, or select Specific Text and enter the words you want to search for.

5. Type a weight and/or height to search for. Enter a minimum and maximum number for ea
teria. You can specify either pound/foot/inch (pd/ft/in) or kilogram/meter/centimeter (kg/m/c

6. Type specific criteria such as hair color, eye color, skin color, or blood type.

7. Complete the search as described in “Conducting a Search” on page 113.

Miscellaneous Search
The Miscellaneous Search window locates individuals with information entered in the Miscellan
Individual Information window. The Miscellaneous Individual Information window is opened from
within the Individual Record window. The search criteria are shown at the top of the search wind
you make your selections. This information is also added to the History window after a search i
plete.

1. Choose Individual, and then Miscellaneous from the Search menu.

2. Select a field from the Miscellaneous Fields list. Use the scroll bar or the up and down arr
keys to move through the list.

3. Type in the text you wish to search for, or if you have selected Ancestral Interest or Desce
Interest, type the low and high interest limits in the fields below the Search box.

4. Complete the search as described in “Conducting a Search” on page 113.

Figure 4-10: Miscellaneous Search Window
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Modifications Search
The Modification Search window provides three ways to search for individuals:

• Search on the Edit Status of Individual Records.

• Search on Record Number ranges linked to individuals. Individual, place, event, source, o
image record types can be searched.

• Search on the Edit Date of Individual Records.

Open the Modification Search window by choosing Individuals from the Search menu, and
Modification.

The search criteria are displayed at the top of the search window as you make your selec
This information is also entered into the Summary window after a search is completed.

1. Select an Edit Status from the Edit Status list and choose Selected to search on a specific
status. Select Blank to search for individuals with a blank edit status, Not Blank to search 
individuals with any text at all in their Edit Status field, or Ignore to exclude the Edit Status 
in the search.

2. Use the Record Numbers Linked to Indiv group to specify the type and range of record nu
to be included in the search. For example, you can locate all individuals who are linked to
images 7 through 9 by selecting Image and entering 7 for Low and 9 for High.

3. Select the Individual, Place, Event, Source, or Image radio button to specify the type of rec
be searched. To use this search option, select the As Below radio button, then enter the ra
record numbers you wish to search using the Low and High fields. Select the Not Searched
button to ignore this search option.

Figure 4-11: Modification Search Window
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4. Use the Indiv. Edit Date group to specify the edit dates to include in your search. For exam
you can specify all records edited After and/or Before a given date. The date searched is th
Edit date in the Miscellaneous Individual Information window.

Note Enter a date in the After field in the Dates group to search for individuals edited afte
certain date. Enter a date in the Before field to search for individuals edited before a given
or leave both the After and Before fields blank to search for individuals with no Last Edit D

5. Complete the search as described in “Conducting a Search” on page 113.

Presence Search
The Presence Search window provides a way to search for individuals who are associated with
selected place. Choose Place Search from the Search menu to search for places rather than ind
The resulting list of individuals can be combined with other individual lists using the Grouping fu
tion. Individuals in the Grouping list can be used as the basis for new databases or printed repo

1. Open the Presence Search window by choosing Individuals and then Presence from the S
menu.

2. Enter the full or partial place name, including wildcards if desired, in the Place text field, if
applicable.

3. To search on only short place names (the recommended search), select the Short Place r
ton.

4. To search a selected place level label, select the Selected Level radio button in the Use g
Next, select the place level label you wish to search from the Place Levels list. 

Figure 4-12: Presence Search Window
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5. To search all five medium-length place levels, select the All Levels radio button in the Use
group. To search on long place names, select the Long Places radio button. These options
include the Short Place field.

6. To include only a selected event, select the Selected check box to activate the Event butto
Click the Event button. Select the event you want to include in your Presence search. Clic

If you do not wish to narrow the place search using event dates, skip to step 10.

7. To search for events occurring after a given date, enter the date in the After field in the Da
group and leave the Before field blank.

8. To search for events occurring before a given date, enter the date in the Before field in the
group and leave the After field blank.

9. To search for events that occurred on an unknown date (the date fields are blank), leave b
After and Before fields blank.

Note If no After or Before dates are entered, the search looks for only those events with 
unknown dates.

10. Select the edit status (new, quick, etc.). Select ignore to ignore the Edit Status in your search. 
Select blank to find all records where the edit status field is blank.

11. Complete the search as described in “Conducting a Search” on page 113.

Ranges Search
To search for individuals who participated in two selected event types, use the Ranges Search w
Open the Ranges Search window by choosing Individuals from the Search menu, then choosin
Ranges.

Figure 4-13: Ranges Search Window
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The Ranges Search window includes lists for First Event and Second Event. The Date gro
allows you to specify a date range for the search. You can also use the Roles group to specify t
the individual played in the two event types.

The search criteria are displayed at the top of the search window as you make your selec
This information is also entered in the Summary window after a search is complete.

First and Second Event Lists Two Event Lists are provided from which starting and ending eve
can be selected. Begin by selecting the two events you want to search. For example, if you sele
birth event in the First Event List and the marriage event in the Second Event List, Ultimate Fam
Tree locates all individuals who participated in both a birth and a marriage event.

Entering a Date You can further refine your search by specifying dates for the events searched
Date group on the right side of the Ranges Search window includes a field for entering a date, a
time-frame options:

• Before — Both events occurred before the specified date.

• After — Both events occurred after the specified date.

• Bracket — The first event occurred before, and the second event after, the specified date.

• Ignore — The date is not used. The search finds individuals who participated in the two ev
types regardless of when they occurred.

Enter the date you want, then select the appropriate radio button.

Specifying a Role The search can be further narrowed by specifying the roles you want to loca
Select one of three role options in the Roles group on the bottom right side of the Range Search w

• Principal — Only individuals who had a principal role in both events are included.

• Any — Individuals who played any role in both events are found in the search.

• Not Principal — Only individuals not having a principal role in both events are included.

How Roles Affect the Search The result of a Range Search varies considerably depending on t
role option you choose. For example, if a birth event is selected and Not Principal is used, the m
and father in the event are found, but not the child. If the birth event is chosen for both the First
Second Events, and Not Principal is used, individuals who had children in the date range specifi
found. If birth is chosen for both the First and Second Events, but Principal is specified, no indiv
are found since it is not possible for a child to be born twice.

1. From the Search menu, choose Individuals and then Ranges.

2. Select an event from the First Event field and an event from the Second Event field.

3. Enter a date (if desired) in the date field and choose one of the following radio buttons:

• Before — Both events occurred before the specified date.

• After — Both events occurred after the specified date.
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• Bracket — The first event occurred before, and the second event after, the specified date.

• Ignore — The date is not used. The search finds individuals who participated in the two ev
types regardless of when they occurred.

4. Select one of the following options from the Roles group:

• Principal — Only individuals who had a principal role in both events are included.

• Any — Individuals who played any role in both events are found in the search.

• Not Principal — Only individuals not having a principal role in both events are included.

5. Complete the search as described in “Conducting a Search” on page 113.

Relationship Search
The Relationship Search searches for individuals who are related directly or through collateral li
a specified person. The search criteria are displayed at the top of the search window as you ma
selections. This information is also shown in the History window after a search is complete.

1. Choose Relationship from the Search menu.

2. Press F10, or click the Find button on the toolbar to find a new starting person for the sea

3. Select one of the following Relationship Options:

• Ancestors Only — Searches for ancestors to a specified generation limit

• Ancestors Plus Their Descendants — Searches for ancestors and their descendants to speci
generation limits

• Descendant Only — Searches for the selected individual’s descendants to a specified gene
limit

Figure 4-14: Relationship Search Window
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• Descendants Plus Their Ancestors — Searches for descendants to a specified generation lim
and ancestors of those descendants to a specified ancestor limit

• Ancestors Plus Descendants — Searches ancestors and descendants to a specified generat
limit in either direction

• Siblings — Searches for the start person’s siblings (generation limit not used)

4. Use the Limits group to specify the number of generations (up to 999) to include in your se
The Limits group includes three fields:

• Generation — The number of generations to search in the direction you are searching (anc
tors, descendants or both)

• Descendant — The number of generations of descendants to include when Plus Their Des
dants is selected

• Ancestor — The number of generations of ancestors to include when Plus Their Ancestors
selected

5. Check the Add Other Spouses box to add spouses not already included in the search.

6. Complete the search as described in “Conducting a Search” on page 113.

Note The starting individual is always included in the list.

Text Search
The Text Search locates individuals whose records contain any or specific text in a free-form tex
The search criteria are displayed at the top of the search window as you make your selections.
information is also added to the History window after a search is complete.

1. From the Search menu, choose Text.

Figure 4-15: Text Search Window
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2. To search on a specific field, select the Individual, Event, or Media text field from the Text 
list. Scroll through the list using the up and down arrow keys or by typing the first letter of 
event you want to search. Choose Selected Field below the Text Field list.

3. To search all fields, choose All Text Fields below the Text Field list.

4. Choose Any Text or Specific Text.

5. If you chose Specific Text, type the specific text you want to search in the Text box.

6. Complete the search as described in “Conducting a Search” on page 113.

Vital Statistics Search
The Vital Statistics Search locates individuals on the basis of their vital statistics, such as age. T
search criteria are shown at the top of the search window as you make your selections. This inf
tion is also added to the History window after a search is complete.

1. From the Search menu, choose Vital Statistics.

2. Select a vital statistic from Vitals Search Options list.

3. Enter the appropriate search code or limit in the Search group.

Note Vital statistics can be specified either by code (such as Y for yes, N for no) or limits (such 
as low age and high age). Appropriate search conditions are available for each vitals sear
option.

4. Use the vitals search options, Age at first (event) and Age at last (event) to choose any eve
wish. For instance, you can choose Age at first (event) from the Vitals Search Options and
select an event included in your project from the Possible Events list. Enter the age to be 
searched in the limit box.

5. Complete the search as described in “Conducting a Search” on page 113.

Figure 4-16: Vital Statistics Search Window
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Events Search
Events Search looks for events and roles in your project based on information entered in the Ind
Record and Event Edit windows. The resulting list of events and roles can be used as the basis
selected editing or for printed reports that focus on events. Open the Events Search window by
ing Events from the Search menu.

1. Choose Events from the Search menu to open the Events Search window.

2. To search for all events, select the All Events radio button. To search for a selected event,
the Selected Event radio button.

3. If you chose Selected in step 2, select an event from the Possible Events list.

4. To search for events that happened in a selected place, check the Selected check box in 
Places group. Click the Place button to open the Find Place window. Locate the place you
to include in the events search and click OK to close the Find Place window and return to 
Events Search window. 

5. To search for events that are linked to a selected source, check the Selected check box in
Source group. Click the Source button, select the source you want to use in the search an
OK.

6. In the Roles group, select Selected to narrow the search based on roles. Click the Role bu
open the Role Selection window. From that window, select All if you want to search for eve
regardless of roles. Select Principal if you want to search for only events that have Princip
roles. Select Undefined to search for events having undefined roles. Select the Selected r

Figure 4-17: Events Search Window
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button to search for events having a specific role. Select a role and click OK to return to th
Events Search window.

7. To search for an event that took place at a certain time period, enter dates for the time peri
are searching. The following rules apply:

• Enter a date in the After field in the Dates group to search for events occurring after a given

• Enter a date in the Before field to search for events occurring before a given date. Or,

• Leave both the After and Before fields blank to search for only those events that occurred
unknown date (the event date fields are blank).

Note If a date is entered in the Before field and After field is left blank, the search include
events with a blank date field AND events having dates after 1/1/100. If a date is entered i
After field and the Before field is left blank, the Before date defaults to today’s date.

8. Use the Event Sure group to narrow the search using Sure Levels.

• Enter the minimum sure value for the search in the Min field.

• Enter the maximum sure value for the search in the Max field.

Note This feature searches the main sure level field from the top of the Event Edit windo

9. To narrow the search using Flags, choose Selected in the Flags group. Click the Flags bu
display a list of event flags used in the current project. Select the flag you wish to use in th
search and click OK to return to the Events Search window.

Note Only events with flags marked (T)rue can be found with the Flags search option.

10. To narrow the search using individuals, use the Individual Link group. The Link group prov
a way to find events that are linked to a single individual or a group of individuals.

11. Select Ignore to search for events independently of whether they are connected to individ
Select Individual to focus on events linked to one person. Click the Find button to open a s
window to find the desired individual. Select Grouping to use the results in the Grouping li
find events. The number of individuals currently in the Grouping table is displayed to the rig
the Grouping radio button.

12. Choose one of the options from the drop-down list (see “Using Search Windows” on page

13. Complete the search as described in “Conducting a Search” on page 113.

14. To edit a displayed list, double-click a selected event to open the Event Record window.

Place Search
Place Search looks for places used in your project based on information in the Place library. Th
resulting list of places can be used as the basis for selected editing or for printed reports that fo



PL A C E  SE A R C H 1 3 5

ections. 

 

adio but-

roup. 

 
 do not 

n. 
K. 

tes 

 Dates 
places. The search criteria are displayed at the top of the search window as you make your sel
This information is also shown in the Summary window after a search is complete.

1. Open the Place Search window by choosing Places from the Search menu.

2. Enter the full or partial place name, including wildcards if desired, in the Place text field, if
applicable.

3. To search on only short place names (the recommended search), select the Short Place r
ton.

4. To search a selected place level label, select the Selected Level radio button in the Use g
Next, select the place level label you wish to search from the Place Levels list. 

5. To search all five medium-length place levels, select the All Levels radio button in the Use
group. To search on long place names, select the Long Places radio button. These options
include the Short Place field.

6. Enter the Place Sure level numbers, Min and Max (0–4). 

7. To include only a selected event, select the Selected check box to activate the Event butto
Click the Event button. Select the event you want to include in your Place search. Click O

8. If you do not wish to narrow the place search using event dates, skip to step 12. 

9. To search for events occurring after a given date, enter the date in the After field in the Da
group and leave the Before field blank.

10. To search for events occurring before a given date, enter the date in the Before field in the
group and leave the After field blank.

Figure 4-18: Place Search Window
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11. To search for events that occurred on an unknown date (the date fields are blank), leave b
After and Before fields blank.

Note If no After or Before dates are entered, the search looks for only those events with 
unknown dates.

12. Select the edit status (new, quick, etc.). Select ignore to ignore the Edit Status in your search. 
Select blank to find all records where the edit status field is blank.

13. Complete the search as described in “Conducting a Search” on page 113.

14. Double-click a place in the results list to open that Place Record window.

Using the Find Place Window
1. To find a place, type the record number (if known) or any portion of the place name in the

Place window.

2. If you type a record number, either click Exact or press Enter to find and display that place
you enter a portion of the place name, you have three options:

• Click OK. The portion of the place name you entered is used in the Events search to find 
whose names include the characters you entered.

• Click Exact to find a list of all place names that match the characters you typed (regardles
case). Click Show to display the list of names found, then select the place you want from th
or press F4 (Go Down List) or F3 (Go Up List) to scroll through the list.

• Click Like if you have included wildcards in the place name. The wildcard ? is used to subs
for one character, while the wildcard * is used to substitute for more than one consecutive
acter. For example, searching for fran*o finds Franklin County and San Francisco.

Figure 4-19: Find Place Window
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Source Search
1. From the Search menu, choose Sources.

2. To search all sources, choose Ignore in the Source Field list and skip to step 7.

3. To search for sources using selected fields, make a selection from the Source Field List a
tinue with step 4. The Source Field List contains the fields that may be searched. These ar
in alphabetical order by component, field and type.

4. Enter up to 40 characters to be searched in the Search Text field, if you select a field which
text (the Search Text box will be active).

5. If you select a flag from the Source Field List, the Flag group is active. Select the True rad
ton to find all sources where the selected flag is set to (T)rue, and the False radio button t
all sources where the selected flag is set to (F)alse.

6. If you select indexed from the Source Field List, the Index group is active. Indexed informati
is found in the Source Miscellaneous Info window. Select Yes to find all sources with Index
set to Yes, No to find all sources with Indexed set to No, Unknown to find all sources with 
Indexed set to Unknown, and, N/A to find all sources with Indexed set to N/A.

Note If you select a template type from the Source Field List, only the Edit Status list is a

7. To restrict your search to sources having a specific edit status, select the appropriate stat
the Edit Status list. Select ignore to ignore the Edit Status in your search. Select blank to find all 
records where the edit status field is blank.

Figure 4-20: Source Search Window
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8. To limit the sources to those that are connected to one individual or a group of individuals
the Individual Link group. Select Ignore to ignore links to individuals in the search. Select 
Grouping to search for sources attached only to individuals in the Grouping list. To find all
sources that are connected to a specific person in your project, select Individual, then clic
to locate that person.

9. Complete the search as described in “Conducting a Search” on page 113.

10. Double-click a source in the Results list to open that Source Record window.

Tasks Search
The Task List Search searches for tasks connected to individuals, events, places, sources, citati
media. The search criteria are displayed at the top of the search window as you make your sele
This information is also added to the History window after a search is complete.

1. From the Search menu, choose Tasks.

2. Enter text to include in the search in the Task Description Text field (optional).

3. To search on Milestone text, enter the Milestone text in the Milestone Description Text fiel
Select any of the Date options (optional).

4. To limit the search to Milestone dates, choose Created, Started, Progress, or Due from th
stone drop-down list and enter dates in the Before and After date fields.

Figure 4-21: Task List Search Window
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5. To search for completed or unfinished tasks, choose completed and select the Yes or No 
button (optional).

6. To search for tasks that are connected to specific record types, select Individuals, Events, 
Sources, Citations, or Media from the Linked to drop-down list. Choose Anything to search
all tasks.

7. To search for tasks connected to Document Repositories, choose Repository and click th
button to find the place (optional).

8. Select a priority option in the Priority field (optional).

9. Complete the search as described in “Conducting a Search” on page 113.

Note The Group button adds tasks found in the Tasks Search to the Task Grouping list. T
list can be used to print specialized Task Summary or Task List reports.

Grouping
The Grouping option merges search lists generated through the various search routines. Use th
Grouping list to hold the names of individuals on whom you want to focus. It can also be used a
basis for printed reports and new projects. Each search window has a Group button that replac
Grouping list with the results of the selected search. Use the Grouping window to merge the co
of several searches.

1. From the Search menu, choose Grouping.

2. Select a search routine from the Individual Search list. The Individuals In group displays t
number of individuals in each of three categories:

Figure 4-22: Grouping Window
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• Selected Search — Displays the number of individuals in the search routine selected from th
Individual Search list

• Entire Project — Displays the total number of individuals in the project

• Grouping List — Displays the number of individuals in the current Grouping list

Note You must run a search in the selected routine before you can add it to the Grouping
The number of individuals found in the selected search appears next to Selected Search i
Individuals In group. If this number is zero, a search has not been run and a Grouping list c
be created.

3. Choose History for Selected to see a summary of how the results were obtained for the s
search.

4. Check the Invert Selected box to include all individuals not in the selected search.

5. Select one of the options from the drop-down list for the resulting search list (see “Using S
Windows” on page 112).

6. To check the search without committing the results to the permanent search list, click Pre
Press Escape to return to the Grouping window.

7. Click Search to create the Grouping list.

Note Click Results to show the list. Double-click a name to open the Individual Record fo
that person. Click History to see a summary of how the Grouping list was built. Click Close
press Escape to close the Grouping window.

Transferring a Grouping List to a Flag
1. After updating the grouping list, click the Transfer button to open the Transfer Grouping w

dow. Unused flags are listed in the Unused Flags group.

Figure 4-23: Transfer Grouping Window
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2. Select an unused flag radio button and enter a label for the flag.

3. Click OK to complete the transfer.

Note If you choose a flag which is already in use, a warning message will appear. If you 
ceed, information already in this flag will be overwritten.

Adding an Individual to the Grouping List
You can add an individual to the Grouping list.

1. From the Search menu, choose Grouping.

2. Click Results to open the Grouping list.

3. Press F10 or click the Find button on the toolbar to open the Find Individual window.

4. Find the person and click OK. The Grouping list will close. Click Results to open the Grou
list again with the individual’s name highlighted.

Removing an Individual from the Grouping List
You can remove an individual from the Grouping list.

1. Open the Grouping list by clicking Results in the Grouping window.

2. Highlight the name of the individual.

3. Press Shift+F9, or from the File menu, choose Delete Record.

Note This procedure removes an individual from the Grouping list, but it does not delete 
record from the project. When removing an individual from the Grouping list, the change is
reflected on the list until you have closed and reopened the list.

Finding an Individual Using the F10 Key or 
Find Button
A simple way to find an individual is to enter a record number or type part of a name in the Find
vidual window.

1. Press F10 or click the Find button on the toolbar.

2. Type the first few characters of the name (or the record number, if known) and press Ente
click Find to display the first occurrence of that name in your project.

Note If you type a full name, use slash (/) characters to mark the surname. See the next s
for other rules on entering names in searches. If you have typed characters, Find locates 
viduals in the project whose names contain those characters and places them in a list. Th
name found is displayed in the Find Individual window.
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3. Click the Find Next and Find Previous buttons to move through the list. To display the entir
and make a selection, click Show All.

4. Highlight the name of the individual you want in the Find list and close the window (click th
Control-menu box or press Escape), or double-click the name to return to the Find Individ
window.

5. Click Find Last Edited Record to display the last person edited.

6. Click OK to return to the original window with the focus changed to the newly found individ

Figure 4-24: Find Individual Window
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Ultimate Family Tree prints a wide variety of genealogical charts and reports, from simple lists to
indexed and documented books. Many different formats are provided which you can customize t
own preferences. You can send reports directly to a printer or to a file for printing later. Reports c
sent to ASCII files, or to Rich Text Format (RTF) files that can be imported into many word proce
programs and can include photographs. You can use Ultimate Family Tree Editor, our built-in W
WYG word processor, or launch your own word processor from within Ultimate Family Tree.

In this section you will learn how to:

✓ Use Print Setup and Page Setup

✓ Use Print and Print Preview

✓ Use Ultimate Family Tree Editor and launch your word processor from Ultimate Family Tre

You will also learn to print the following reports:

✓ Title Page, Credits, and Table of Contents

✓ Family Journal (Genealogy) Report

✓ Box Chart

✓ Fan Chart

✓ Family Tree (Pedigree) Report

✓ Ancestor Reports
1 4 3
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✓ Descendant Reports

✓ Relationship List

✓ Free-form Text

✓ Image report

✓ Footnotes as end notes

✓ Bibliography

✓ Index

✓ Family Group Report

✓ Individual, Historical, Event, Image, Place, Project Summary, Source, and Task Summarie

✓ Individual, Events, Marriage, Place, Role, Source, Mail, Tasks, and GEDCOM Exceptions

✓ Text or Box style Calendars

✓ Tiny-Tafel Report

✓ Research Log

Using the Print Setup Window
Before printing any reports in Ultimate Family Tree, use the Printer Setup window to select your
printer or the option to print to a file. Before you can print, you must install a printer through the
dows Control Panel. The default printer in Windows is displayed at the top of the Print Setup wi
in Ultimate Family Tree. Choose Print Setup from the File Menu to view a list of installed printers
instructions on installing additional printers, refer to your Windows manual.

The Print Setup window includes an option to print to Letter (8.5” ´ 11”) or A4 (international) 
size paper. The A4 option is dim if Print to File is selected.

Changing the Default Printer
1. From the Ultimate Family Tree File menu choose Print Setup.

2. Select a printer from the list and click the Set as Default Printer button. The printer name 
chose appears in the Default Printer box.

Note Changing the printer in the Print Setup window also changes the default printer in t
Windows Control Panel. Ultimate Family Tree supports Letter and A4 portrait page formats
Box Chart has additional options. You can export most reports to a word processor for othe
formats.
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Printing to a File
1. From the File menu, choose Print Setup.

2. Click the Print Setup tab.

3. Check Print to File.

4. In the File Contents group, select the radio button for the type of file to create:

• Printer Codes — Prints your report to a file containing embedded printer codes for the curre
selected printer. Use this option to print a report to a file and then later send the report from
to the appropriate printer. If you select this option, skip to step 10.

• ASCII — Creates the report in ASCII text format, 10 characters per inch, with no printer co
included. If you select this option, skip to step 10.

• Rich Text Format (RTF) — Creates reports using RTF. Ultimate Family Tree does not expor
reports via RTF that are highly structured, such as the five- and six-generation Family Tre
Charts, the Calendar, or reports such as an index that are already created by a word proce
you select this option, continue with step 5.

Note When Rich Text Format is selected, the RTF Destination options are activated. 

5. Click the External Support tab.

6. Check the Automatically Launch Editor box to automatically open the Editor when you pri
report.

7. Select the word processing application you want to use from the Editor Choice drop-down
The three options are Ultimate Family Tree Editor, Microsoft Word, and Other.

Figure 5-1: Print Setup Window
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8. Click the Browse button to locate the executable file for the word processor you have cho
The path to the word processor and the executable file are displayed in the Path to Editor
For example, \UFT\FTEDITOR.EXE.

Note If you select Ultimate Family Tree Editor, the correct path and file name will appear
automatically in the Path to Editor field.

9. Select Include Index if you want to include index codes with the RTF file.

10. In the Footnote Style drop-down list, select one of the footnote options:

• Long Form — All references are printed in full.

• Long and Short Form — End notes are printed in the long form first, and then in the abbrevia
form for subsequent references.

• Long, Short, and Ibid. — End notes are printed in long form the first time a bibliographic ref
ence appears. After the source is cited in full, the short form built from Abbreviation 1 and 
Abbreviation 2 is used. When successive notes use the same reference, the Ibid. form is u

11. Click OK to leave the Print Setup window or Cancel to leave without saving changes.

Note Table of Contents and Index codes are normally included in Ultimate Family Tree R
files. Some word processors, such as AmiPro, do not import index codes. When creating a
file for a word processor that does not import index codes, do not check the Include Index
option. Table of Contents codes can sometimes create a double section or chapter title in
processors that do not support Table of Contents data. Redundant titles can be manually 
removed using the word processor.

Figure 5-2: External Support Window
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Rich Text Format 
The RTF standard developed by Microsoft describes a method of encoding formatted text for ea
transfer between applications. With the RTF standard, documents composed under different op
systems and with different software applications can be transferred between those operating sy
and applications.

Ultimate Family Tree supports the RTF standard for exporting report formatting, text justifi
tion, font attributes (size, bold, italic, superscript), indexing, footnotes, table of contents entries,
ers, and footers. By using RTF, most Ultimate Family Tree reports can be sent to many IBM-PC
Macintosh word processing programs for further editing and formatting. Ultimate Family Tree Ed
Word for Windows, Microsoft Word, WordPerfect for Windows, WordPerfect 6.0, Professional W
Plus, and Ami Pro are examples of word processing programs that accept RTF files.

The menu options for reports that are not exported are not available when the RTF radio b
is selected. If you want, these reports can be exported as ASCII files, and then imported into an
processing program. ASCII files, however, contain only text and lack the other attributes availab
RTF files.

The following characters should not be used with the Rich Text Format feature:

\ — Used for control codes in RTF files. Do not use the backslash character in Ultimate Fa
Tree if you will be using the RTF feature.

{ } — Used for control codes in RTF files. Do not use the curly brace characters in Ultimat
Family Tree (except to mark a title in a name) if you will be using the RTF feature.

External Support Window
The External Support window allows you to export list reports to external programs such as Mic
Excel.

1. Open the External Support options window by choosing Page Setup from the File menu.

2. Choose the Type of File for export from the drop-down list.

3. If it’s not present, type the path to the application you wish to use to display the exported 
Click the Browse button to search for the executable file for the application you wish to us

4. Check the Automatically Launch Application box if you wish to have Ultimate Family Tree s
the export application with the new list in place.

See “Exporting List Reports” on page 218 for more information.

Using the Page Setup Window
To select various print options that affect how most reports appear, choose Page Setup from th
menu. The Descendant Box Chart functions independently of the Page Setup window. Use the 
Chart Page Setup window and the Chart window itself to select page and formatting options for
Charts.
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Choose any of the options to customize your report:

• Book Title — Prints as part of the header on every page in reports (limit 25 characters).

• Name Format — Capitalizes and uses bold type for given names or surnames. Select Surn
1st to print the surname before the given name. In Page Setup, you are given a first and s
choice in the selection of name preferences. If the name field for the first choice is blank, 
mate Family Tree uses the name entered in the second choice. If the second choice name
blank, Ultimate Family Tree defaults to the main name field. This gives you the option to u
woman’s married name instead of her maiden name. You can also use aliases or a religio
name. If a name is entered in the Long Name field of the Miscellaneous window, the long 
is used instead on free-form reports such as Family Journal reports.

Some reports, such as the Family Journal reports, override the Name Format selectio
comply with National Genealogical Society and New England Historic Genealogical Socie
styles.

• Name Preference — Prints the preferred name in reports.

Note In the Ultimate Family Tree Miscellaneous window (opened from the Individual Rec
window) you can enter many variations for a person’s name.

• Include Family Events in Printed Reports — The Family event overrides the birth event in som
printed reports to show nonblood or social families.

• Page Layout — Sets the page layout in reports. Select Reverse Odd/Even to use an odd/e
page number layout. Check Preparer to include the preparer’s name in the footer of the re
you check preparer, select either Name or Name/Address. Check Date to include the date
footer. Check Header/Footer Lines to insert header and footer lines on each report page. 

Figure 5-3: Page Setup Window
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Note The preparer’s name is the name you entered in the Researcher field in the Projec
mation window. You might include Prepared by: before the name to have the footer of your 
reports printed in this way.

• Index Additions (RTF) — Adds information to names in the index. Select Birth/Death Years 
add birth and death years to names in the index for RTF reports. Select Record Numbers 
record numbers.

Changing Font Style and Size
To select different fonts for the various components of a report, choose Page Setup from the File
The Ultimate Family Tree default fonts are Arial and Times New Roman. Suggested font sizes fo
component follow:

Book Title 16

Page Number 12

Chapter Name 14

Section Name 12

Text 10

Small Text 9

Notes 8

Index 9

Preparer/Date 8

Specific fonts, font styles, and font sizes can be changed for various components of a rep
Windows scalable fonts can be used in Ultimate Family Tree reports. Ultimate Family Tree, how
determines both the font style and size in Box Calendar and in all List reports. In Family Tree re
only the font size is set by Ultimate Family Tree—you can change the font style if you wish. The 
uses a fixed number of lines on a page. It is designed to use a 9-point font. White space may ap
the bottom of the page if you choose a smaller font size. Likewise, a larger font size can cause 
flow to the next page.

Figure 5-4: Page Setup Window (center)
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1. Select the report component (for example, Book Title).

2. Click the Fonts button.

3. Select a font from the Font list.

4. Select a font style: Regular (upright), Italic, Bold, or Bold Italic.

5. Select a font size.

6. Click OK to close the Font dialog window.

7. Repeat steps 1–6 for each of the remaining report components.

Figure 5-5: Page Setup Window (right side)

Figure 5-6: Font Dialog
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Basic Steps for Printing Reports
Each report window provides options for customizing and tailoring a report to your needs. Ultim
Family Tree uses the options you select to format and create the reports. Report windows shar
or all of the same options. The following basic steps are used to print Ultimate Family Tree repo

1. Use Print Setup to select the report’s destination and to decide whether to launch the Edit

2. Choose a report from the Reports menu.

3. Click the Find button on the toolbar or press F10 to find the individual you want to use as 
focus of the report. Some reports, such as Calendar, Index, End Notes, Text, and List Rep
not require a focus person.

4. Type a Chapter Title (up to 40 characters). A title is required if you want to include this rep
an index, the table of contents, or in end notes reports. A title is not required when using P
Preview. The report title is used as the chapter name and appears at the beginning of the 

5. Choose any of the available options for customizing the report.

6. Enter a number in the Generation limit field (if available) to limit the number of generation
included in the report.

7. To include an introduction in a report, check Introduction, and then click Intro Text to open
free-form text window where you can write introductory text for the report or chapter. The 
window consists of an area for entering text, and a list of command buttons for text format

8. To use a subset of the individuals in your project, locate individuals in your project that me
specific criteria using Individual Search windows and add them to the Grouping list. You ca
then use the options in Grouping to limit your printed reports to those individuals in the Gr
ing list. Check the appropriate options in the Grouping group to include the following:

• Use List (Individuals) — Prints a report which includes only those individuals in the Groupin
list.

• Add Asterisk — Prints a report including all individuals, but with an asterisk to indicate thos
the Grouping list.

• Use List (Events) — Prints a report which includes only those events in the Events Search l

• Add Asterisk — Prints a report including all events, but with an asterisk to indicate those in 
Events Search list.

Note The Grouping option is available in Family Journal, Box Chart, Family Tree (Pedigr
Indented Descendant, Descendant Text, Relationship, Family Group, Summary Reports, C
dar, Family Journal, List Reports, and Research Log.

9. Click the Print or Preview button on the report window.

Note Print Preview is not available if you choose Print to File in the Print Setup window. I
this case, click Print to print to a file. If you have not chosen to automatically launch the edi



1 5 2 SE C T I O N 5 : PR I N T I N G  RE P O R T S

ith-
 the 

direc-
 the 

rint 
3 for 

dow, 
de the 

dow, 

e 
rt in 
 and 

the 
dexed 
u are 

n rela-
 

Save As window opens when the report is formatting. Type a file name for the report file, w
out an extension. Ultimate Family Tree automatically adds the appropriate file extension to
print file. Select the drive and directory where you want to save the report file. The current 
tory will be displayed above the directory listing field. You can then preview, edit, and print
report from your word processing program.

Print Window
After selecting a destination for reports and choosing Page Setup options for printing, you can p
Ultimate Family Tree reports in two ways: Print or Print Preview. See “Print Preview” on page 15
information about previewing and printing a report.

Use the Print command to print and collect several reports in a book format. In the Print win
you can choose a starting page number for a report, collect an index for each chapter, and inclu
reports you’ve generated in a table of contents.

1. Open a report window and choose the report options you want. Click Print in the report win
or choose Print from the File menu, to open the Print window.

2. The Print window includes options for printing reports. If you want to collect an index for th
report, select Collect Index. Select Collect and Print to collect the index and print the repo
one step. Check the Table of Contents box if you want to include the report chapter name
page number in the table of contents.

Note If the selected report cannot be indexed or a chapter title has not been entered for 
report, then Collect Index and Collect and Print are not available. Reports that cannot be in
include Box Chart, Calendar, End Notes, and Index. Collect Index is also not available if yo
printing to a file.

3. Use the First Page field in the Book group to specify the first page number for the report i
tion to the entire book. This number appears in the report header. The number in this field

Figure 5-7: Print Window
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defaults to the next available page after you have printed a report. Use this field to skip on
more pages when printing multiple reports.

4. In the First Page field in the Report group, enter the page to start the report. If you want to
the fifth page of a report, enter 5 in the First Page field. The First Page field determines which
page of a report will be printed, not the page number that appears at the top of the page.

5. In the Last Page field in the Report group, enter the page number to stop the report. If you
to print only the fifth and sixth pages of the report, enter 5 in the First Page field, and 6 in the 
Last Page field.

6. Enter the number of copies of the selected report to be printed in the Copies field.

7. If you want to reset all previously collected information for reports, click the Reset buttons
clear all Table of Contents, End Note, and Index entries.

Note The Reset buttons are dim if a Table of Contents, End Notes, or Index has not bee
lected and stored in the respective report windows.

8. Click OK to start printing the report or collecting the index.

Print Preview
Print Preview shows how a report will appear when printed. While previewing the report, you can
the entire report or a single page of the report. Use Print Preview to print a single copy of a stand
report. When using Print Preview to print instead of using the Print window, be aware of the follo
differences:

• All reports start with page 1.

• The report is not included in a table of contents.

• The report is not included in the index. (An index for the previewed report can be created,
ever.)

• The footnotes are not stored in the End Notes Report window. (End notes for the previewe
report can be created.)

Using Print Preview
1. To use Print Preview, open the window for the report you want to prepare.

2. Choose the report options you want.

3. Click the Preview button in the report window or choose Print Preview from the File menu

Note If the Preview button or Print Preview from the File menu are dim, either the Report
dow is not open or the report is set (in the Print Setup window) to print to a file.
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4. Enter the first page of the report you want to view in the First Page field. If you want to view 
page five, enter 

 

5

 

 in this field. To preview from the beginning of the report, leave this field set 
to 1.

5. Enter the last page of the report you want to preview in the Last Page field. If you want to stop 
previewing at page ten, then enter 

 

10

 

 in this field. To view the entire report, leave this field set to 
99999.

6. Choose Report, Notes, or Index for the selected report. Choosing Report allows you to preview 
the selected report before printing it.

7. Select the Notes option if you want to view and/or print the end notes (footnotes) for the report. 
The Notes option is not available for reports that do not include end notes, such as the Family 
Tree (Pedigree) and Images reports.

8. Select the Index option if you want to preview the index before printing.

9. Click OK.

 

Note

 

When you preview your report, the first page of the report is displayed on the screen. At 
the top of the Preview window is a toolbar used to control the view of the report. Select the 
options for viewing the report.

10. Click the Printer button in the Print Preview toolbar to print the report you just previewed.

 

Ultimate Family Tree Editor

 

Ultimate Family Tree Editor is a powerful Windows word processor that can be used for many reports 
created with Ultimate Family Tree. In WYSIWYG (what-you-see-is-what-you-get) format, reports 
such as the Family Journal can be viewed, edited, enhanced, and printed with Ultimate Family Tree 
Editor. Ultimate Family Tree Editor also preserves end notes and individual index information from 
Ultimate Family Tree, automatically creating separate sections for each.

Figure 5-8: Print Preview Window

Figure 5-9: Print Preview Toolbar
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Ultimate Family Tree Editor can be used directly from Ultimate Family Tree, or it can be use
a stand-alone word processing program. The reports created in Ultimate Family Tree can be sa
later editing and printing. Several reports can be merged into a single document to create a com
sive family history book complete with table of contents, end notes, and index.

Note Ultimate Family Tree Editor, the internal Ultimate Family Tree report writer, or an ex
nal word processing program can all be used to create and print reports. While the internal
writer creates excellent reports, Ultimate Family Tree Editor permits you to edit and modif
your work before printing. It also provides a way to add and position images and OLE obje

The following reports are not available to Ultimate Family Tree Editor: Table of Conten
Pedigree Chart, Indented Descendant Report, Direct Drop Chart, End Notes Report, Inde
endars, and Historical Timeline. However, a table of contents, end notes, and index can b
ated from Ultimate Family Tree Editor or your choice of word processors.

Ultimate Family Tree Editor Features
Ultimate Family Tree Editor provides many of the functions of a full-featured word processing p
gram. Documents created by the editor are automatically saved in Rich Text Format (RTF) whic
be exported to most popular word processing programs for further editing. The features of Ultim
Family Tree Editor include the following:

• Character formatting and styles — The editor allows for multiple fonts and point sizes within 
document. Character styles include bold, underline, and italic.

• Paragraph formatting — Paragraphs can be left, right, or center aligned. Hanging indents a
double spacing are additional options.

• Tab support — Left, right, center, and decimal tab positions are available.

• Embedded pictures — Pictures can be imported from a disk file or from the Windows clipboa
The editor supports the standard Windows bitmap (BMP) and metafile (WMF) formats. Dr
and-drop can also be used to move BMP images into a document.

• Cut and Paste — Cut and Paste to the Windows clipboard is supported to and from other a
cations. Text formatting is preserved when you move text to or from another word process
application via the clipboard.

• Editing — Editing options include text selection, editing, formatting, and search and replac

• Multiple documents — A number of documents can be open simultaneously in Ultimate Fam
Tree Editor. The document windows can be tiled or cascaded.

• Footnotes — Footnotes can be added and edited. Footnotes are numbered sequentially an
appear at the end of the document as end notes.

• Index — Index entries for individuals can be added and edited. A two-column index appea
the end of the document after the end notes.

• Headers and footers — Headers and footers can be added and edited. Page numbering is 
automatic.



1 5 6 SE C T I O N 5 : PR I N T I N G  RE P O R T S

Ulti-
Editor.
 use 

 across 

itor. 
 view 

. To 
 docu-

te 
or 
d you 

rking 
Ultimate Family Tree Editor Desktop Overview
This overview will introduce you to Ultimate Family Tree Editor’s user interface.

Menu Bar The menu bar contains a list of menu options extending across the top of the main 
mate Family Tree Editor window. It provides easy access to all aspects of Ultimate Family Tree 

To view a menu, click once on its name. The menu appears under the name. You can also
keystrokes to display menus using one of two techniques:

• Press the Alt key followed by the underlined letter in the menu name.

• Press the Alt key to activate the menu bar and then use the right or left arrow keys to move
the bar to the name you want. Press the down arrow key to open the menu.

Toolbars The toolbars contain icons representing the tools available in Ultimate Family Tree Ed
From the View menu, check Toolbar to view the main toolbar. You can also check Font Toolbar to
that selection.

Ruler You can specify formatting features such as margins and tab settings by using the ruler
access the ruler, choose the Ruler command from the View menu. The ruler appears above the
ment window.

Status Bar Ultimate Family Tree Editor uses the status bar, located at the bottom of the Ultima
Family Tree Editor window, to display messages, information prompts, and status information. F
example, a short message in the status bar explains the purpose of the menu name or comman
have selected. To activate the status bar, check its name in the View menu.

The following list shows sample information that can appear in the status bar as you are wo
on a document:

• Pg 1 — Page 1 of the document is currently displayed.

• Ln 15 — The cursor lies in the fifteenth line of the current page.

• Col 29 — There are 29 characters between the cursor and the left margin.

Figure 5-10: Ultimate Family Tree Editor Desktop
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• INS — Characters typed will be inserted.

• OVR — Characters typed will overwrite existing characters.

Opening an Existing Document in Ultimate Family Tree Editor
The bottom of the File menu displays a list of recently used documents. To open a recently use
ment, from the File menu, click the name of the document you want. If the name is not displaye
this short list, proceed as follows:

1. From the File menu, choose Open.

2. In the File Name field, type the name of the document you want to open or select it from th

Note If you do not see the name of the file you want, select a new drive or directory, or se
different type of file from the List Files of Type drop-down list. Ultimate Family Tree Editor c
use Rich Text Format files having the extension .RTF, or plain text files, usually having the
extension .TXT.

3. Click OK.

Opening Multiple Documents in Ultimate Family Tree Editor
To compare your work, you can open several documents simultaneously, each in a separate do
window. To open multiple documents, leave the current document open and follow the steps abo
opening an existing document.

You can view multiple documents in various ways. From the Window menu, choose one o
following commands:

• Cascade — Causes the windows to overlap so that the title bar for each document is visibl

• Tile — Arranges the open windows in smaller sizes to fit next to each other.

• Arrange Icons — If you have minimized several documents to an icon, the icons will be 
arranged along the lower edge of the Ultimate Family Tree Editor desktop.

Changing the Size of a Document Window
You can change the size and position of a document window so you can view the contents of tw
more documents simultaneously.

• Maximizing a document — To enlarge a document window to its maximum size, click the Co
trol-menu box on the Document Title Bar and choose Maximize or click the Maximize butto
the upper-right corner of the window. If the document has been minimized to an icon, click 
on the icon to activate the Control menu and choose Maximize, or double-click the icon to
imize it.

• Minimizing a document — Click once on the Control-menu box to the left of the Menu bar (if
the document is maximized) to open the Control menu for the active document. Choose 
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Minimize to reduce the document to an icon. Another method is to choose the Minimize bu
in the upper-right corner of the document window.

Creating Documents in Ultimate Family Tree Editor
Ultimate Family Tree can preview and print reports directly or through an external word process
program. Reports intended for an external word processing program are formatted in Rich Text
mat. Using the Print Setup window, you can designate Ultimate Family Tree Editor, Microsoft W
for Windows, or another word processor as your primary word processing application.

To designate which word processor you want to use:

1. Choose Print Setup from the File menu.

2. Check the Print to File box.

3. Select the Rich Text Format (RTF) radio button in File Contents.

4. Click the External Support tab.

5. Check the Automatically Launch Editor box in the RTF Options group.

6. Select the word processing application you want to use from the Editor Choice drop-down
The three options are Ultimate Family Tree Editor, Microsoft Word, and Other.

7. Click the Browse button to locate the executable file for the word processor you have cho
The path to the word processor and the executable file are displayed in the Path to Editor
For example, \UFT\FTEDITOR.EXE.

Note If you select Ultimate Family Tree Editor, the correct path and file name will appear
automatically in the Path to RTF Editor field. 

8. Select Include Index if you want to include index codes with the RTF file. 

9. Select the Footnote style for the footnotes which may be included in the report:

• Long Form — All footnotes are printed in full.

• Long and Short Form — End notes are printed in the long form first, then the abbreviated Lo
Short, and Ibid.

• Long, Short, and Ibid — End notes are printed in long form the first time a bibliographic refe
ence appears. After the source is cited in full, the short form built from Abbreviation 1 and 
Abbreviation 2 is used. When successive notes use the same reference, the Ibid. form is u

10. Click Close.

Figure 5-11: Ultimate Family Tree Editor menu
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Ultimate Family Tree Editor will open automatically after you create a report.

Note To create a new, blank document in Ultimate Family Tree Editor, choose New from
File menu. Ultimate Family Tree Editor displays a blank document. Ultimate Family Tree g
the new document a temporary name, for example, UFTEdit1. You give the document a ne
name when you save it.

Editing Text in Ultimate Family Tree Editor
Here is a review of some basic text editing techniques:

• Selecting text — Before you can change text, you must select it. To select text, move the m
pointer to the beginning of the text you want to select, hold down the left mouse button and
it to the end of the section. You can also select text by holding down the Shift key and pres
the arrow buttons on the keyboard. To select a single word, double-click the word. To sele
text, from the Edit menu, choose Select All or press Ctrl+A.

• Cut, Copy, and Paste — Once you’ve selected text, you can cut or copy it to the Clipboard a
paste it elsewhere in the document. To copy text, select the text and choose Copy from th
menu, click the Copy icon on the main toolbar, or press Ctrl+C. To cut text, select it and ch
Cut from the Edit menu, click the Cut icon on the main toolbar, or press Ctrl+X. To paste t
position the insertion point where you want to place the cut or copied text and choose Past
the Edit menu, click the Paste icon on the toolbar, or press Ctrl+V.

• Undo — If you make a mistake or change your mind while you are working in Ultimate Fam
Tree Editor, choose Undo from the Edit menu or press Ctrl+Z. This will undo your last cha

Setting Fonts in Ultimate Family Tree Editor
Fonts and point sizes establish the basic look of characters in your document. Fonts can be ch
using various methods. 

Using the Fonts Toolbar With the Fonts toolbar, you can change the font or size of the text. You
also format the text as bold, italic, underlined, or superscript. Buttons are available for paragrap
tab stop alignments. 

1. Select the text you wish to format.

2. Choose a font and font size from the drop-down lists.

Using the Format Font Window

1. Select the text you wish to format.

2. Click the right mouse button, or from the Format menu, choose Font to open the Format F
window. 

3. Select a font from the list of those available.

4. Select a style from the Style list.
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5. Select a size from the Size (pts) list.

6. Select Underline, Superscript, or Hidden in the Effects group.

7. Click OK to close the window.

Paragraph Formatting in Ultimate Family Tree Editor
Change the formatting of a paragraph by first selecting the paragraph and then applying the form
you want. When Ultimate Family Tree formats a report, default settings are automatically applie
Change these by choosing Paragraph from the Format menu.

Paragraph Marks To display on your screen the marks which define the end of a paragraph, c
the Paragraph Marks button on the Main toolbar or choose Paragraph Marks from the View me

Aligning Paragraphs When you align paragraphs, you specify where you want to position the l
of text.

1. Select the paragraph to be aligned and choose Paragraph from the Format menu.

Figure 5-12: Format Font Window

Figure 5-13: Format Paragraph Window
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2. Select the Left, Center, Right, or Justify radio buttons to align the selected paragraph.

3. Click OK to close the window.

Alternatively, you can select the paragraph and choose the appropriate paragraph alignm
ton on the Fonts toolbar.

Tabs You can insert, remove, or move tab stops using the ruler. To set tab stops:

1. Select the line or paragraphs where you want to add tab stops, or position the insertion po
the text where you want the formatting to start.

2. Click a tab stop style from the Tab buttons on the toolbar or, from the Format menu, choo
Insert Tab Mode and select Left, Center, Decimal, or Right.

3. Click the ruler where you want the tab stop to be set.

To remove tab stops:

1. From the Format menu, choose Tab Clear to open the Clear Tab window.

2. Select the tab position you want to clear and click Clear Tab.

3. Repeat steps 1 and 2 for other tab stops you want to clear.

Note To remove all tab stops from a selected paragraph, choose All Tab Clear from the F
menu.

Indenting Paragraphs When you indent a paragraph, you specify how far from the margin you
want the text to print. You can choose from three types of paragraph alignment:

Left — Aligns each line of the paragraph on the left margin or paragraph indent.
Right — Aligns each line of the paragraph on the right margin or paragraph indent.
Left, First line — Aligns the first line of the paragraph on the left margin or paragraph inden

Adjusting Line Spacing within Paragraphs You can adjust the spacing between the lines in one
several, or all of the paragraphs in your document.

Figure 5-14: Clear Tab Window
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1. Select the paragraph(s) you want to adjust.

2. From the Format window, choose Format Paragraph.

3. Enter a point size in the Before field to increase the spacing before a selected paragraph.

4. Enter a point size in the After field to increase the spacing after a selected paragraph.

5. In the Spacing group, select one of the following:

• Single — Sets the selected paragraph to single spaced.

• Double — Sets the paragraph to double spaced.

• In Points — Sets the space between lines in a selected paragraph by the number of points
entered in the field.

6. Click OK to close the window.

Adjusting Text Flow You can specify that certain lines or paragraphs be kept together or that ce
paragraphs start a page. To keep lines together on a page:

1. Select the lines you want to keep together.

2. From the Format menu, choose Paragraph.

3. Under Text Flow, select Keep Together.

4. Click OK to close the window.

To keep paragraphs together on a page,

1. Position the insertion point anywhere in the paragraph you want to keep with the next para

2. From the Format menu, choose Paragraph.

3. Under Text Flow, select Keep with Next.

4. Click OK to close the window.

Page Breaks
You can insert page breaks anywhere in a document. A page break appears as a solid line in th
ment. Physical page breaks are shown as dotted lines and are determined by the size of the pa
are printing. A page break forces the text below the solid line to the next page. To insert a page
position the insertion point where you want the page break, and choose Page Break from the In
menu. To delete a page break, select the page break you want to delete, and choose Cut from 
menu, or press the Delete key on your keyboard.

End Notes in Ultimate Family Tree Editor
When you create a Family Journal, Family Group Sheet, or Text report, Ultimate Family Tree E
automatically includes its footnotes as well. A section titled Notes and References is added afte
last page of the body of the report.
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Viewing End Notes Ultimate Family Tree Editor automatically numbers end notes and places t
in the Notes and References section at the end of the current document. Notes are edited in a 
window provided for that purpose. To view the end note window, drag the window split bar, locat
the bottom of the document window, to the top. You can also choose End Notes from the View m

End notes (and the index) can be viewed by scrolling to the bottom of the document, but e
notes can only be edited through the end note window.

Editing End Notes End notes are viewed and edited through the End Note window. The End N
window can be opened in several ways:

• Double-click the footnote number for the footnote you wish to view. The footnote window op
showing that end note.

• Drag the End Note window bar up and use the scroll bar to scroll through the end notes.

• Choose End Notes from the View menu.

Inserting End Notes Move the insertion point to the position in the text where you wish to insert
end note. The End Note window opens. Add any text you want for the new end note.

Deleting End Notes End notes are deleted from the main text window, not the End Note windo
From the main text window, select the end note number. Press the delete key to delete the end

Renumbering End Notes Choose Renumber End Notes from the Tools Menu to renumber end
notes.

Figure 5-15: End Note Window
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Indexes in Ultimate Family Tree Editor
Names of individuals can be included in an index for any report created by Ultimate Family Tree
Editor. A two-column index, automatically listing individuals by surname and then given name, i
automatically generated at the end of the report. Index information can be imported directly from
mate Family Tree, plus you can edit and add index information to any document.

Marking an Index Entry Place the insertion point after the name you wish to add to the index.
Choose Mark Index Entry from the Insert menu. The Mark Index Entry window opens.

Editing Index Marks Index marks are made visible by choosing Hidden Text from the View me
Index marks are surrounded by curly brace characters {}. A typical index mark appears as follow

{XE “Kennedy:John Fitzgerald”}

The name of the individual is enclosed in quotation marks. The surname appears first, foll
by a colon, followed by the given name. The surname and/or given name may be edited as you

Removing an Index Entry To view index entries, choose Hidden Text from the View menu. Sel
the index entry you wish to delete and press the delete key.

Note You cannot edit a field that is hidden unless you activate the Hidden Text option. Th
allows you to edit index codes.

Updating the Index To update an index with added or deleted index entries, choose Rebuild In
Notes from the Tools menu.

Headers and Footers in Ultimate Family Tree Editor
You can edit headers and footers in the same way you edit any other text in your document. All
niques for selecting, inserting, deleting, and overwriting text apply here. You can use the Cut, C
and Paste commands in the headers and footers just as you do in the document. When you ed
header or footer for one section of your document, your changes will also affect any subsequen
ers or footers linked to that document.

Viewing and Modifying Headers and Footers

1. From the View menu, check Header/Footer or click the View Head/Foot button on the tool
The header on the first page is displayed allowing you to make changes.

2. From the Edit menu, choose Edit Header/Footer to activate Edit mode.

Adding Headers

1. Choose Header/Footer from the View menu.

2. Choose Edit Header/Footer from the Edit menu.

3. Add the text you want to appear in the header.

4. To add a page number, place the insertion point in the header or footer where you want th
number to appear and choose Page Number from the Insert menu.
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Removing Headers and Footers

1. Choose Header/Footer from the View menu. 

2. Choose Edit Header from the Edit menu. 

3. Select the text you want to delete from the header or footer. 

4. Press the Delete key.

Removing Lines and/or Shading in the Header or Footer

1. Place the insertion point in the space between the lines. 

2. Choose Borders from the Format menu.

3. Change the shading and side options as you wish.

4. Click OK to close the Format Borders and Shading window.

Images in Ultimate Family Tree Editor
Inserting Photos One of the most exciting features of Ultimate Family Tree Editor is the ability 
include photos in a Family Journal report. Photos can be inserted into a document with or witho
frames. When a photo is inserted in a frame, the frame and photo can be dragged to a new pos
the document and any text that would have been covered by the photo will wrap around it. Whe
inserted without a frame, the picture can be moved using paragraph formatting commands, incl
left, center, or right justify, or by inserting blank lines or spaces in front of the image.

Images can be added to an Ultimate Family Tree document in the following ways:

• Import an image directly from Ultimate Family Tree.

• Import from a file containing an image in BMP or WMF (Clipart) format.

• Import a BMP image by dragging and dropping.

• Paste an image from the clipboard.

Pictures that have been designated preferred images can be added automatically to Fam
nal reports in Ultimate Family Tree. Specify an image you wish to include by marking a linked im
as the preferred image. See Section 7 for more information on preferred images. The caption fo
image is included in the report, centered below the image. 

Note Preferred images are imported without a frame.

Linking an Image to an Individual in Ultimate Family Tree

1. Open the Individual Record for the desired individual.

2. Click the More button to open the Individual More window.

3. Click Media to open the Multimedia Link window.

4. Select an existing image from the Multimedia Links list, or link a new image to the individu
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5. Make sure the Preferred Image box is checked to specify that the selected image is the pr
image for this person.

Adding Individual Images to the Family Journal Report

1. Open the Family Journal report window by choosing Family Journal from the Reports men

2. Check the Parent Images box to have preferred images included for individuals who are p

3. Check the Child Images box to have preferred images included for individuals who are chi

Adding Event and Place Images to the Family Journal Report

1. Open the Family Journal report window by choosing Family Journal from the Reports men

2. Check the Event image and/or Place image box to have preferred images included for eve
and/or places.

Note To prevent duplication, the preferred image for each event and place is used once 
report, when it is first encountered.

Importing an Image from a File Images can be imported into Ultimate Family Tree Editor from
file. The image file must be in the standard Windows bitmap (BMP) or metafile (WMF) format.

1. Move the insertion point to the location in the document where you wish to insert the pictu

2. Choose Picture from the Insert menu to open the File Open window.

3. Locate the BMP image you wish to insert and choose OK.

Inserting a Picture from a File into a Frame

1. Move the insertion point to a line where you want to insert the photo.

2. From the Insert menu, choose Frame. A rectangular frame appears.

3. Select the frame by clicking the mouse anywhere on the frame. Make certain the sizing h
for the frame are displayed.

4. From the Insert menu, choose Picture. The File Open dialog appears.

5. Select an image to be inserted and click OK.

Figure 5-16: Inserting a Picture Frame
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Note Only image files having the bitmap (.BMP) or metafile (.WMF) format can be insert
Photos that are inserted without a frame will displace any text that is covered by the photo
photo can be positioned by selecting the photo and clicking the left, center or right justifica
push buttons.

Importing an Image by Copying and Pasting Images in any format compatible with a paint or 
image editing program can be copied to the Windows clipboard and pasted into an Ultimate Fam
Tree Editor document. Once the image has been copied to the clipboard, follow the steps below
paste it into the document:

1. Move the insertion point to the location in the document where you wish the image to be 
inserted.

2. Choose Paste Special from the Edit menu.

3. Click Bitmap Image Object from the Paste Special window.

Importing an Image By Dragging And Dropping Images can be imported into Ultimate Family 
Tree Editor by dragging the image name from a directory or file list to the opened document in 
mate Family Tree Editor. The image will be located in the document where it is dropped. The im
file must be in the standard Windows bitmap (BMP) or metafile (WMF) format.

Resizing an Image

1. Select the image you wish to resize by clicking on the image. Four sizing handles are disp
on the image frame.

2. Drag the handle you wish to change to a new position.

Moving an Image in a Frame

1. Select the image you wish to move.

2. Move the mouse pointer to a position just outside the frame. The pointer changes to a cro

3. Drag the image to its new location.

Changing the Borders of a Frame

1. Select the frame.

2. From the Format menu, choose Borders to open the Borders window.

3. Select the border options you wish.

Removing an Image from a Document

1. Click the image you want to remove to select it.

2. Press the Delete key on your keyboard.
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Inserting Objects with Ultimate Family Tree Editor
Windows objects such as sound and video clips can be inserted in Ultimate Family Tree Editor 
ments. Once an object has been inserted, it can be activated by double-clicking the object’s ico

Inserting an Object

1. Move the insertion point to the location in Ultimate Family Tree Editor document where yo
wish the object to appear.

2. Choose Object from the Insert menu.

3. Select the object type from the Object Type list you wish to use, such as Wave Sound. The
server opens, Sound Recorder, in our example.

4. Set up the object you wish to insert.

5. Close the object server window and return to Ultimate Family Tree Editor. The object is ins
at the insertion point.

Inserting a Rectangle Objects including rectangles, text boxes, and lines can be inserted in an
mate Family Tree Editor document.

1. Place the insertion point where you wish to draw a rectangle.

2. From the Insert menu, choose Drawing Obj and then Rectangle.

3. You can select the rectangle and drag the sizing handles on any side to change the size o
rectangle.

Inserting a Text Box A text box provides a way to format text within a resizable box such as a s
bar. The box can be moved to any location within the document.

1. Place the insertion point.

2. From the Insert menu, choose Drawing Obj and then Text Box.

3. Select the text box and drag the sizing handles on any side to change the size of the text 

Note The text box is not a frame, so underlying text will not wrap around the box.

Inserting a Line

1. Place the insertion point where you wish to draw a line.

2. From the Insert menu, choose Drawing Obj and then Line.

3. Drag the line to any location in the document, or select the line and drag the anchor at eith
to change its position.

Printing Documents with Ultimate Family Tree Editor
Before you can print, you must have installed a printer through the Windows Control Panel. Ref
your Windows manual for instructions on installing a printer.
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To select various print options such as margins, paper size, and orientation use the Page 
window.

1. From the File menu, choose Page Setup.

2. Select the paper size from the drop-down list.

3. Select Portrait or Landscape to set how the text will print on the page. An icon on the Page
window changes according to your selection.

4. To set margins enter the size, in inches, in the appropriate field.

Note Some printers (such as the HP LaserJet series) will not print all the way to the oute
edges of the page.

5. Click OK to close the window and save changes.

Using Print Preview in Ultimate Family Tree Editor
Print Preview shows how a report will appear when printed. From the File menu, choose Print Pr
or click the Print Preview button on the toolbar to open Print Preview and activate the Print Prev
toolbar. All page elements that appear within the printable area of the page are displayed in Pri
view.

The following options are available in Print Preview:

• A zoom list to change the zoom factor for the report

• An option to view one or two pages at a time. With a two-page display, adjacent pages are 
side-by-side. Use the scroll bars to move to adjacent pages.

• Buttons to move through the report to view the first or last page, and to move ahead or ba
page

• A Print button to print selected text or the entire file

• A Close button to leave Print Preview mode

Saving Documents in Ultimate Family Tree Editor
Ultimate Family Tree Editor documents can be saved for future use. Use the Save As dialog to s
current document with a different name. Documents are saved in Rich Text Format as supporte
Microsoft and many other software vendors. Ultimate Family Tree Editor documents work best 
Microsoft Word for Windows.

1. From the File menu, choose Save As.

2. A Save As dialog opens.

3. Specify a target directory and a file name.

4. Click OK.
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Ultimate Family Tree Editor as a Stand-Alone Program
Ultimate Family Tree Editor can be used as a stand-alone program or from within Ultimate Fam
Tree. To start Ultimate Family Tree Editor as a stand-alone program, choose one of the followin
options:

• Double click the Ultimate Family Tree Editor icon in the Ultimate Family Tree program gro

• Type \UFT\FTEDITOR.EXE in the Run window. 

• Choose Rich Text Editor from the Utilities menu in Ultimate Family Tree.

Troubleshooting Ultimate Family Tree Editor
• Text Protection Error — Ultimate Family Tree Editor cannot delete the header text with the 

body text. This occurs when you attempt to edit a header or footer if not in the Edit Heade
Footer mode. Select Edit Header/Footer in the Edit menu to activate the Edit mode.

• Device Context Error — Ultimate Family Tree Editor cannot initialize printing.

Preparing to Print a Book
Before printing the first page of your book, you should prepare an outline. It does not have to be
orate; a simple list of the reports, in order, will do. This is also the time to make decisions about
other information to include and where to place it. Use this outline to keep track of formatting an
make notes to yourself. Here is a sample outline:

✓ Title Page

✓ Table of Contents

✓ Introduction

✓ Family Tree (Pedigree) Report

✓ Map—two page spread, start on left page

✓ Reverse Register Family Journal Report

✓ Relationship List

✓ Index

Suggestions on Style
Two of the most common ways to arrange genealogical records in a book are ancestral order a
descendant order. Ultimate Family Tree is designed to automate preparation of these types of b
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Ancestral-Ordered Book An ancestral-ordered book is the history of an individual back to his o
her distant ancestors. Many people choose to prepare a book about parents or grandparents, a
include the complete history of their family or just a portion of it. Here is a typical format:

✓ Title Page

✓ Table of Contents

✓ Introduction (Text Report)

✓ Family Tree (Pedigree) Report for the target individual

✓ Reverse Register Report (Family Journal Report)

✓ Ancestor (Ahnentafel) Report

✓ Relationship List Report

✓ End Notes

✓ Index, Individuals

✓ Index, Marriages

✓ Index, Places

✓ Bibliography

Descendant-Ordered Book A descendant-ordered book singles out an ancestor and traces his o
children, grandchildren, and all other documented descendants to the present day. If you choos
format and have a large family, you might find there is so much information to be presented tha
should divide the book into separate volumes (one or two children of the ancestor per volume). H
a possible format:

✓ Title Page

✓ Table of Contents

✓ Introduction (Text Report)

✓ Descendant Report

✓ Register Report (Family Journal Report)

✓ Relationship Report

✓ End Notes

✓ Index, Individual

✓ Index, Marriages

✓ Index, Places

✓ Bibliography
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After deciding on your outline, be sure to open the Print window and reset the table of con
index, and end notes so that the final output will not contain any erroneous data from previously
printed reports. Collect the index before printing each report so that the starting page numbers 
match. After collecting the index and printing each report, print the Table of Contents and End N
Reports, edit the index (if necessary), and print the Index Report. (See “Basic Steps for Printing
Reports” on page 151 and “Collecting an Index” on page 202.)

Another option for printing a final book is to print the reports to an RTF file that can be ope
with a word processor. The table of contents and index codes are transferred with the report. P
numbering changes are reflected in the table of contents and index generated by the word proc
You can then customize your reports by changing margin sizes, moving text, rewriting sentence
adding pictures.

Front Reports
Ultimate Family Tree provides several reports designed for the front of your book. These report
include the Title Page, Credits, and the Table of Contents.

Title Page
The Title Page normally contains the book title, subtitle (if applicable), author, publisher, date, a
location of publication. To open the Title Page window, choose Title Page from the Reports men

The following fields are available in this window:

• Title — Enter the title of the book in this field (up to 48 characters). For example, you might
your book The Kennedys. The title prints centered in a large font in the upper third of the pag

• Subtitle — Enter a subtitle for the book of up to 48 characters. For example, The Descendants of 
Joseph Patrick Kennedy. The subtitle prints below the title in a smaller font.

• Title Page Text — When chosen, this check box opens a free-form text window where you c
enter text to be printed on the book title page. You can include the preparer’s name, the da
book was written, and the publisher information, or any other text you want.

Figure 5-17: Title Page Report Window
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Note The Title Page Text information is right justified and prints in the lower-right corner 
the title page. The text can be formatted with bold, italics, and underline. Ultimate Family T
prints up to ten lines of text, approximately 40 characters per line. Lines containing over 4
characters of text wrap to the next line. Any text over ten lines is cut off. To create a new li
press the Enter key twice. Click Preview to see how the text will appear. Blank lines are inc
in the ten line-limit.

• Borders — Select a border style from the Border Style drop-down list to print a border on t
Title page. Choose None in the list for no border. The borders are not available when print
A4 size paper or when printing to a file.

Credits
The Credits Report allows you to acknowledge someone or dedicate your book as you wish.

1. From the Reports Menu, choose Front and then Credits.

2. Click Intro Text to open a free-form text window where you can enter book credits or any t
that you want included in this report.

Table of Contents
The Table of Contents lists chapters and page numbers to provide a general overview of the bo
contents.

1. From the Reports menu, choose Front, then Table of Contents. The chapters you have cr
and named are listed in the Table of Contents Entries field.

Note The Table of Contents menu selection is dim until chapter titles have been added a
print reports.

2. Enter a title for the Table of Contents Report. The title is centered near the top of the first p
the printed report.

Figure 5-18: Table of Contents Report Window
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3. Select a chapter name and click Delete Selected to delete a chapter from the list. Click Del
to delete all chapters from the list.

4. Click Print or Preview in the report window. See “Basic Steps for Printing Reports” on page 

Note For proper text alignment during viewing, the text in the Table of Contents window 
appears in a different font.

Family Journal Report
The most widely accepted formats for publishing a genealogy in the United States are the New
England Historic Genealogical Society’s Register and the National Genealogical Society’s Mod
Register plans. You can use options available in the Family Journal Report window to create eit
these formats. The similarities between the two are substantial; the differences are slight but 
significant.

Family Journal Report Styles
Both formatting plans begin with one person. This person is given the number 1, indicating the 
tion of the first person in the first generation. The children of the progenitor are assigned, in ord
birth, a small Roman numeral. In addition, each child can be given an Arabic number that estab
that child’s overall placement in both the specific family and the larger family described in the re
These numbers (both Roman and Arabic) precede the name. All family members are placed in 
respective generations, with generation numbers appearing as superscripts following their first n
In the report, each primary person’s name is followed by a back reference, in parentheses. The
reference includes the given names and generation numbers of each person in the line back to
progenitor.

Here are the differences between the plans:

• In the Register Style Report format, only children whose lines continue are given Arabic n
bers. In the Modified Register format, all children receive an Arabic number. In both cases,
numbers are in birth order and begin (for the eldest child) with the next number after the la
used in the previous generation.

• In the Register format, children whose lines continue are clearly identified with an Arabic n
ber. In the Modified Register format, for all children bearing such a number, a plus (+) is p
in front of the number to indicate children whose lines continue.

• In the Register format, the main individual’s names print in bold, uppercase letters. In the 
fied Register format, the main individual’s names print in bold, upper/lowercase letters.

• In the Register format, notes are embedded in the text. In the Modified Register format, the
print as end notes.

Note Ultimate Family Tree conforms to the NGS format except that footnotes are printed
end notes at the end of the report instead of at the bottom of each page.
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Printing a Family Journal Style Report
1. Click the Family Journal button on the toolbar, or choose Family Journal from the Reports

menu.

2. Choose one of the following styles:

• Modified Register (National Genealogical Society style, NGS) — Select this style to print fo
notes as end notes, number all children, and a use a plus (+) to indicate a child whose lin
tinues. The main individual’s names print in bold upper/lowercase letters.

• Register (New England Historic Genealogical Society style, NEHGS) — Select this style to
include footnotes as embedded notes and to number only those children whose lines are 
ued. The main individual’s names print in bold, uppercase letters.

• Custom — Select this style to customize your own Family Journal report. The Custom radio
ton activates a Design button that opens the Design Genealogy Format window. See “Des
Genealogy Format” on page 177 for information on this window.

3. After establishing the style of Family Journal report, choose one of the following options to
determine the order in which your data will print:

• Descendant — The Descendant Family Journal Report starts with a progenitor (the selecte
ancestor) and traces his or her family line to the present. The individual selected is the sub
the first generation section.

• Family — The Family Report creates a descendant-style report for all families in the proje
with each family in a chapter in alphabetical order. Note that an end-of-line progenitor fem

Figure 5-19: Family Journal Report Window



1 7 6 SE C T I O N 5 : PR I N T I N G  RE P O R T S

ased on 

(the 
ystem 
everse. 

 for indi-
. The 

n-

hen 

al.

n 

 
e 
must have either a spouse or father entered to be included because the Family Report is b
male surnames.

• Reverse Register — The Reverse Register Family Journal Report starts with a descendant 
selected individual) and traces his or her line back through all ancestors. The numbering s
used in these reports is the same as that used in the Register or Modified Register, but in r
Here you begin with a selected individual and move backwards in time.

4. Check Research Report to print a research version of the report. Research notes entered
viduals and events prints as text if the Indiv Text or Event Text options have been selected
research version of footnotes are printed instead of the final version.

5. Set the number of generations to include in the report.

6. Choose any of the other options by clicking the corresponding boxes:

Events Group

• Principal Events — All events are included for the principal roles only.

• All Events and Roles — All events are included with all roles.

• Basic Events (BMDB) — Only Birth, Marriage, Death, and Burial events are included for pri
cipal roles only.

• Participants — Includes a list of participants and roles for each event.

• Text — Event text is included for each event.

• Text, Prin. Only — Active when Text is selected. Only text for Principal roles is included. 

• Estimate Missing Births — Choose this option to estimate the birth date from other events w
no birth date is available.

• REVENT Snippets — Historical events are included for main individuals (not children).

Other Group

• Indiv Record Number — Includes the Record number for each individual.

• Individual Reference — Includes the information entered in the Reference field for each individu

• Indiv Text — Includes Biographical text for individuals.

• Flags — Includes flags for individuals.

• Medical Text — Includes the information you’ve entered in the Individual Medical Informatio
window.

• All Spouse Data — Choose All Spouse data to include the information about the individual’s
spouse. (If Basic BMDB events has been chosen, only the basic events will print out for th
spouse.)

• Birth Details — Includes details entered on Detail lines for birth events.
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• Images — Choose to include Parent, Child, Event, and Place images in the report. This wi
include the images you’ve marked as preferred images. These options are dim unless you
selected to print to a Rich Text Format file in the Page Setup window.

• Introduction — Includes introductory text entered by clicking the Intro Text button.

7. Choose Section New Page to start each generation on a new page.

8. Choose Compress Footnotes to reuse footnote numbers for identical footnotes.

Note The compressed footnote style does not conform to the recommendations in Chicago 
Manual of Style or Cite Your Sources by Richard Lackey. It is provided only to reduce the num
ber of pages required to print end notes. This option is not available if you are exporting to
Rich Text Format file.

9. Print the report. See “Basic Steps for Printing Reports” on page 151.

Design Genealogy Format
The Design Genealogy Format window is used to further customize your own genealogy report. 
Custom and then Design in the Family Journal Report window to open the Design Genealogy F
window.

The following options are included:

Back Reference Group Back reference shows the path back to the progenitor and is normally 
included with each main person’s name.

• Generation — List ancestors going back as far as possible for each main individual.

• Register — Show the parent’s register number for main individuals rather than the ancesto

• None — Do not include a back reference.

Notes Group

• Endnotes — Include footnotes in the end note section (normally used for Modified Register

Figure 5-20: Design Genealogy Format Window
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• Embedded Notes —Print footnotes as embedded notes.

• None — Do not include footnotes.

Note The short form of the source citation is used for embedded footnotes, not the long 
Ibid. forms. If the short form of the source is not available, possibly because a free note wa
to document a fact, the entire reference is used. A bibliography can be prepared to show t
complete form of the source. Texts entered in the Record Footnote and Event Footnote win
however, always appear as end notes and are printed using the End Note Report window.

Child Numbers Group

• All Children — Number all children (normally used in Modified Register, NGS).

• Continued Children — Number only children whose lines continue (normally used in Regist
NEHGS).

Continued Children Group

• Birth Dates — Include birth dates for children whose lines continue (Register and Modified
Register).

• Birth and Death Dates — Include birth and death dates for children whose lines continue.

• No Dates —Do not include dates for children whose lines continue.

Event Order Group

• NEHGS — Use the event order used in the NEHGS and NGS styles. This order places, in 
of importance, birth and death information first, marriage information second, and other ev
information last.

• Chronological — Place all events in chronological order. Birth is always first, followed by no 
date events and then the remainder of the events. The event sort date is used to establish
order of events.

Other Group

• Eliminate White Space —Remove the white space between paragraphs. Spaces are retaine
before and after the line naming the parents of the children that follow.

• Generation number —Add generation numbers.

• Always Print Deaths — Include a death event if there is no information about it.

Click OK to return to the Genealogy Report window.
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Ancestor Reports
Ultimate Family Tree provides two kinds of Ancestor reports—Family Tree (Pedigree) and Ahnent

Family Tree (Pedigree) Chart
The Family Tree Chart graphically traces ancestral lines back through an individual’s parents, g
parents, and so on. It starts with an individual and traces the family lines for each parent. In Ult
Family Tree you can choose to print four, five, or six generations on each page of a report. You c
print a blank Family Tree Chart.

The Family Tree Chart allows room for a variety of data. Information on a four-generation 
ily Tree Chart includes the date and place of the birth, death, marriage, and resides events (if k
for each individual. If dates and places are unknown, the corresponding line on the chart is blan
Because of limited space, five- and six-generation charts include a subset of the above informa

A number is associated with each person’s position on the Family Tree Chart. These num
are a referencing system to keep track of a pedigree that fills more than one page. The Family 
Chart can extend back 54 generations. For a line that continues past the last generation on a pa
mate Family Tree prints continued on later chart.

Family Tree Report Wizard Ultimate Family Tree includes a Wizard to help you quickly create 
Family Tree report.

1. Open the Ancestor/Family Tree Report window. Select Wizard from the Help menu or click
right mouse button and select Wizard.

2. Enter the name of the Report title, or choose to print a blank Pedigree chart. Click Next.

3. Select 4, 5, or 6 generations to print on a page. Click Next.

4. Select the general options you want to include on the report: Place Modifiers, Omit Redun
Ancestors and/or Resides Event. 

5. Specify the number of generations you want to include on the report. Click Next.

6. Select Print or Print Preview. Click Finish.

Printing a Family Tree (Pedigree) Chart

1. From the Reports menu, choose Ancestor, and then Family Tree.

2. Select the number of generations to include per page from the Format group.

3. Select Blank Report to produce a Family Tree Chart form for use in research.

4. Check Omit Redundant Ancestors, if desired. Redundant ancestors occur when cousins m

Note If Omit Redundant Ancestors is checked, the first occurrence of a redundant ances
includes all of his or her information. Any recurrence of the redundant information is referr
back to the first occurrence, by citing the previous chart, and the redundant line is not con

5. Check Use List to include only those individuals in the Grouping List.
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6. Select Record Numbers to include record numbers on the report.

7. Check Add Asterisk to print an asterisk next to the name of each individual in the Grouping

8. Print the report.

Space available for names is limited in the Family Tree Chart. If necessary, Ultimate Fami
Tree shortens names by abbreviating the middle names, one at a time, and then the first name, 
name fits in the available space.

Abbreviations for events included in the report print before the event:

• b. — birth

• d. — death

• m. — marriage

• r. — resides (prints if the person has a Resides event or is still living)

Ancestor (Ahnentafel) Report
An Ancestor Report is a Family Tree Chart in text rather than graphic form. The Ancestor report
ancestors for up to 50 generations. All ancestors included in the Ancestor report are given a nu
from the Ahnentafel system. In this system, a unique number is assigned to each position in the
gree regardless of whether or not a person is occupying that position. Ahnentafel numbering as
the number 1 to the starting individual. The father’s number is two times his child’s number, and
mother’s number is two times her child’s number plus one.

With these position markers you can quickly determine exactly how any person on the cha
related to the starting person. For example, the label great-great-grandfather reveals that the ancestor
is four generations back and is male. A great-great grandfather can be any one of eight people.
tafel number 26, however, is the maternal grandfather’s mother’s father (for the selected individ

Figure 5-21: Family Tree (Pedigree) Chart Window
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Printing an Ancestor (Ahnentafel) Report

1. From the Reports menu, choose Ancestor, and then Ancestor Report.

2. From the Style section, select any of the three options:

• Compressed — Remove white spaces from the report.

• Generation Lines — Print lines between generations.

• Bold Ancestor — Print names in bold type.

3. In the Events drop-down list, choose one of the following options:

• Principal — Print only events where individual is marked as the principal.

• All — Print all events connected to individuals.

• Basic (BMDB) — Include only Birth, Marriage, Death, and Burial events.

• Birth/Death Dates — Print only Birth and death dates.

• None — Include no events.

Note If you select Birth/Death Dates or No Events, the option to include Event Text canno
selected.

4. Check to include any of the options in the Other Group, including an introduction.

5. Print the report. See “Basic Steps for Printing Reports” on page 151.

Figure 5-22: Ancestor Report Window
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Descendant Reports
Ultimate Family Tree provides four different styles of Descendant reports: Indented, Text, Direc
Drop, and Box Chart.

Indented Descendant Report
The Indented Descendant Report window prepares a descendant chart that starts with the proge
a family line and follows all descendant lines to their ends. Each generation is indented from the
ous generation. Up to 16 generations can be included.

Note The Indented Descendant report is not available if printing to Ultimate Family Tree Ed

1. From the Reports menu, choose Indented Descendant, or click the Descendant report bu
the toolbar.

2. Choose to include any additional options from the Contents group. Choose Other Spouse
include spouses from marriages with no children.

3. Choose Use List to include only those individuals in the Grouping List.

4. Set the number of generations (up to 16) for the report.

5. Enter a number in the Extra Indent field (0–10) if you want to increase the number of colu
that each generation is indented. When Extra Indent is 0, generations are indented three 
umns. Up to ten extra columns can be added for each generation. Use Print Preview to vi
results of using the Extra Indent option and name shortening.

Note You can change the spacing between generations for ease of reading with the Extr
Indent option. This option is useful when there are only a few generations or when names
short. The space for names is based on the options selected to be printed: generation num
birth and death dates, and record numbers. If a name does not fit in the available space, U

Figure 5-23: Indented Descendant Report Window
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Family Tree shortens the name so it will fit. If a common name has been entered in the Mi
neous Information window, the common name is used when a name is shortened.

6. Print the report. See “Basic Steps for Printing Reports” on page 151.

Descendant Text Report
The Descendant Text Report is a descendant report in text style that offers several generation n
ing styles: Generation Number, Henry Number, Modified Henry, and D’Aboville. Information 
included in the report is dependent on the options chosen in the report window.

1. From the Reports menu, choose Descendant Text.

2. Choose a numbering style:

• Generation Number — The generation number for each descendant is included with his or 
name in Descendant Text Reports.

• Henry Numbering System — A genealogical numbering system is used, where the progenito
a selected individual, is given the number 1. The oldest child is number 11, the next child 
number 12, etc. The oldest child of number 11 is number 111, the next is 112, etc. When 
are more than nine children, the numbers are placed in parentheses. Thus the tenth child 
ber 111 is 111(10) and his or her children become 111(10)1, and so on.

• Modified Henry Numbering System — A genealogical numbering system similar to the Henry
system is used, except that instead of using (10), (11), (12) in parentheses for the tenth, el
and twelfth children, the letters A, B, and C are used. If there are more than 35 children, lowe
case letters are used (for example, a, b, and c are used for the thirty-sixth, thirty-seventh, and 
thirty-eighth children).

• D’Aboville Numbering System — A genealogical numbering system is used where the proge
tor, or selected individual, is given the number 1, the first child is given the number 1.1, the
second child is given the number 1.2, and so on. This system is similar to the Henry Numb

Figure 5-24: Descendant Text Report Window
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System, except that each individual number includes periods to separate generations. Fo
ple, 1.2.2 indicates that an individual is the second child of the second child of the progenit
this family line.

3. Choose one of the options in the Events drop-down list to determine which events will be 
included in the report: Principal, All, Basic (Birth, Marriage, Death, and Burial), or None.

4. Include additional options from the Other group.

5. Include only individuals found in the Grouping list by selecting Use List.

6. Choose Add Asterisk to add an asterisk to individuals in the report who are in the Groupin

7. Print the report. See “Basic Steps for Printing Reports” on page 151.

Direct Drop Descendant Report
The Direct Drop Descendant chart shows how two people are connected through a direct line. I
with an ancestor and traces his or her direct family line to any descendant you choose.

Note The Direct Drop report is not available if printing to Ultimate Family Tree Editor.

1. From the Reports menu, choose Direct Drop.

2. After choosing a start person, click Choose to open the Choose Descendant List window.
list includes the starting person and descendants.

3. Select the descendant you want as the ending person on this report, then double-click the
or close the Choose Descendant window by pressing Escape or clicking the Close box.

4. Choose to include any additional options from the Contents group.

Note The space for names is limited. If a name does not fit in the available space, Ultima
Family Tree shortens the name so it will fit, abbreviating the middle names (one-by-one) a
finally the first name.

5. Print the report. See “Basic Steps for Printing Reports” on page 151.

Note If you choose to include introductory text, the Direct Drop report starts on the next full p

Figure 5-25: Direct Drop Descendant Report Window
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Descendant Box Chart
Ultimate Family Tree includes an option to print a beautiful family tree Box Chart as either a pag
be included in a family history book or as a wall chart. There are many styles, fonts, and border
options from which to choose. The contents of charts can be edited and saved for future sessio
to 16 generations of descendants can be included.

Creating a New Box Chart
1. From the Reports menu, select Charts and then choose Box Chart to open the Box Chart w

2. Click New in the Open Chart group.

3. Type a name of up to eight characters in the Chart Name field. This is the control name th
appears in the Charts list.

4. Type a title (optional) for the chart in the Chart Title field. This title appears at the top of th
chart window and can be included on printed charts.

Figure 5-26: Descendant Box Chart Window

Figure 5-27: New Chart Window
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5. Enter a number in the Generation limit field if you want to limit the number of generations 
included in the chart.

6. Choose Use List if you want to limit the report to only those individuals in the Grouping Lis
Use Ultimate Family Tree search routines to locate and list individuals in your project that 
specific criteria, and add them to the Grouping list.

7. Choose Design from the Contents group to open the Box Chart Design window.

8. Choose the appropriate options you want included in the chart. The sample window in the
right corner displays how the options chosen will appear in the boxes on the chart.

9. Select any of the options from the appropriate drop-down lists as described below:

Event Line 1 and Event Line 2 Groups

• Blank — Leave corresponding event line blank.

• Line — Include a line in place of corresponding event data.

• Birth — Include birth event data on corresponding event line.

• Birth and Death dates — Include birth and death dates on corresponding event line.

• Birth and Death years — Include birth and death years on corresponding event line.

• Selected Event (First) — Include event chosen from Events list. Select this option and click 
Events button. Select the event you want included in the report and click OK. Only the firs
occurrence of the selected event is used.

• Date — Include only the date for selected event.

• Place — Include only the place for selected event.

Figure 5-28: Box Chart Design Window
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• Date and Place — Include date and place for selected event if checked.

Note The birth and death dates and years options override selections in the Dates group

Marriages Group

• Blank — Do not include marriage information.

• Marriage Date — Include marriage date.

• Marriage date and place — Include date and location of marriage.

• Include Other Spouses — Include spouses for whom there are no descendants.

Dates Group

• Year — Include year of the selected event.

• Short — Include day, month, and year of selected event.

• Structured — Include date from structured date field, including the date modifier.

• Long — Include free-form date for the selected event.

Note The Dates group options are not used if the Birth and Death dates or Birth and Dea
years options are selected in the Event Line 1 or 2 groups.

Event Name Group

• None — Do not include name or abbreviation for the event.

• Short — Use short version of event name before event data (e.g., b. for birth).

• Medium — Use medium abbreviation of event name (e.g., bir for birth).

• Long — Use long version of the event name.

Places Group

• First and Last — Use first and last levels of a place name (normally city and state).

• Last Two — Use last two levels of a place name (normally county and state).

• Full — Use full place name.

• Modifier — Use place modifier (e.g., in).

10. After making your selections, click OK to return to the New Chart window.

11. Click OK in the New Chart window to open the Chart window you have designed.

Note The Box Chart Design sets the overall design of a chart. Once the chart is created,
basic design options cannot be altered. However, changes, additions, and customizing de
can be made from the Descendant Box Chart window, the Box Chart Page Setup window, 
the Box Chart itself. These changes are reversible.
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Preparing a Box Chart for Printing
Selections made in the Box Chart Page Setup window are used only for printing Box Charts. Th
not affect the default printer settings in Windows or other Ultimate Family Tree reports.

1. If a Box Chart is open, close it. Open the Descendant Box Chart window by choosing Char
then Box Chart from the Reports menu.

2. Choose Page in the Chart Setup group.

3. Select a paper size from the Paper Size list.

4. In the Orientation group, choose to print the chart in either Portrait or Landscape mode.

5. Select the default paper bin or choose a special bin in the Paper Bin group for your printe

Note You can set margins for pages on the Box Chart. This is particularly useful if you ar
printing a wall chart. Be aware that some printers (such as the HP LaserJet series) will no
on the outer edges of the pages. In these cases, setting the margin to less than 1/4 inch wi
reflected on the printed page. Type or select the distance between the top, bottom, left, an
edges of the page and the chart. Click the Reset button to return to the default settings of

6. Click OK to return to the Descendant Box Chart window.

7. Include one, two, or no events on the chart you want to print.

8. Choose whether you want to print a chart that will fit on a standard page and can be inclu
a book, or one that is designed to be displayed on a wall, by selecting either Book or Wall C
Choose Book to print charts with the Ultimate Family Tree headers and footers. Choose W
Chart to print charts without headers and footers.

Note Headers and footers can contain the book name, page number, preparer informatio
date. If you are printing in landscape oritentation, only printers that support type orientation 
mands (such as the HP LaserJet 4 and later) will print the headers and footers correctly. If 
not have a printer that supports type orientation commands, print landscape charts as wall

Figure 5-29: Box Chart Page Setup Window
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9. Choose whether or not to include individual record numbers on the printed chart.

10. To include the preferred image of an individual in the chart, select Include Preferred Imag

11. Click Preview to open the chart to be printed. With the selected chart open, choose Print f
the File menu.

Note The original Box Chart Design sets the overall design of a chart. Once the chart is 
ated, the basic design decisions cannot be altered. However, changes, additions, and cust
details can be made from the Descendant Box Chart and Box Chart Page Setup windows,
the Box Chart itself. These changes are reversible.

Chart Window
Use the toolbar at the top of the Chart window to modify the displayed chart. Three buttons on t
end of the toolbar determine which functions are available. Click the Edit Graphics button to cha
the overall design of the chart, the Edit Colors button to make color selections, and the Edit Fon
ton to change the fonts used.

Edit Graphics You can select the number of boxes across and down to be printed on each pag
box border style, the line thickness between boxes and around the outside of the report, and th
position for the chart title. View the changes on the chart as you make your selections.

1. Click the Edit Graphics button and then choose an option within the Density drop-down lis
determine the number of boxes per page.

Note The number of boxes per page in the list depends on page size and orientation cho
made in the Chart Page Setup window.

2. Select the style of box you want for the chart by clicking the Box shape button. A check m
appears next to the box style chosen for the displayed chart.

3. Select the size of the lines that connect descendants by clicking the Single Lines button. A
mark appears next to the size of the lines chosen.

4. Select the size of lines that connect spouses by clicking the Double Lines button. A check
appears next to the choice.

5. Select a border for the entire chart by clicking the Border button.

6. Choose the placement of the title of the chart on the bottom of the chart by clicking the Titl
ton. The title can be left justified, centered, or right justified.

Figure 5-30: Graphics Toolbar
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Edit Colors Click the Edit Colors button to display the Colors toolbar where you can select col
for the various boxes. For example, you can choose to have boxes for males in red and boxes f
females in green.

Note Choices appear in color on printed reports only if you have a color printer.

1. Click the Edit Colors button to display three color options: red, green, and blue.

2. Click a color button.

3. Click the down arrow next to this color to select an attribute, such as male, female, or spo

4. Repeat steps 2 and 3 for the remaining color options.

5. Click the Legend button to include the color legend on the chart.

6. View the changes on the chart as you make your selections.

Edit Fonts Click the Edit Fonts button to display the Font Types toolbar where you can make f
and formatting choices.

Available choices include:

• Record Number — The unique identifier for each individual

• Event — Any event text that has not been selected as Event, Hilite in the Chart Edit window

• Event, Hilite — Event text you have selected in the Chart Edit window by enclosing the targ
text in braces. See “Editing Names, Dates and Places in a Box Chart” on page 192.

• Names — The given name for each individual

Figure 5-31: Colors Toolbar

Figure 5-32: Fonts Toolbar
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• Names, Hilite — The surname for each individual

• Title — The title you have selected for the report

• Legend — The key for color selection in the Box Chart

1. Select a field from the drop-down list.

2. Select a font and size for the selected field.

3. Choose the i (italics) button to print the selected data in italics. Choose the b (bold) button to 
print the selected data in bold. Choose the u (underline) button to underline the selected data.

4. Repeat steps 1–3 for each data item.

5. View the changes on the chart as you make your selections.

Note Use narrow fonts to allow more information to be included in each box.

Additional Options for Display

1. Use the buttons on the Chart Display toolbar for additional options.

2. Click the Ruler button to display ruler guides for the chart.

3. Click the Page Grid button to display pages and numbers. The page layout depends on th
choices made in the Chart Page Setup window.

4. Click the Test Mode button to highlight boxes where text might overflow the boxes. These b
are displayed in red. Make changes to the font type and size or edit individual boxes until 
boxes are displayed in black.

Note The Test Mode function is most accurate when using a 100 percent or 200 percent
factor.

5. Click the down arrow next to the Zoom button to change the zoom factor for the chart.

Figure 5-33: Chart Display Toolbar
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Zooming Chart Areas

1. To drag a box over the chart boxes you want to zoom, position the mouse pointer over the
left corner of the box, press the left mouse button, and drag the mouse pointer to the lowe
corner.

2. Press the right mouse button, and then click the Zoom to Fit button.

Note Use the arrow keys to move around a chart and view parts not displayed on screen

Editing Names, Dates, and Places in a Box ChartThe contents of each box can be edited while
the chart is displayed.

1. Double-click a box to select it.

2. Click the Descendant Box Chart window to activate it. Click the Box Chart button on the to
bar, or from the Reports menu, choose Box Chart to open the Descendant Box Chart wind

3. Choose Edit.

4. Insert braces { } around any portion of the data entered in Event Line 1 or 2 to designate i
Event, Hilite. To format that portion of the text use the Font Types toolbar in the Chart wind
These braces do not appear in the report.

5. After making changes, click OK to return to the Descendant Box Chart window. Click Clos
return to the Box Chart, or simply click on the chart itself.

Note Changes made to the contents of a box are stored with the chart and do not affect 
data in the Project.

Finding an Individual in a Box Chart

1. To locate a person in the chart, press F10 or click the Find button on the toolbar.

2. Type the first few characters of the name of the individual you want to locate (or the record
ber if known) and press Enter (or click Find).

3. Click OK to close the Find window and move the focus of the chart to that individual.

Viewing Multiple Charts at One Time

1. Open an existing chart.

2. Resize the chart to a smaller size by dragging one of its borders. See the Windows manu
more information on resizing windows.

3. Move the chart, if necessary, to display the underlying Descendant Box Chart window (or 
the Reports menu, choose Charts, then Box Chart).

4. Select another chart in the list and open it.

5. Resize this chart, if necessary, so that both charts display on the screen.

Note In addition to the scroll bars, you can use arrow, PgUp, PgDn, Home, and End keys
move around a chart to view parts not displayed.
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Deleting a Chart

1. In the Descendant Box Chart window, select a chart in the Charts List.

2. Click Selected in the Delete Chart group.

3. If you want to delete all charts, click All in the Delete Chart group.

Printing a Box Chart

1. With the chart open, choose Print from the File menu.

2. See “Basic Steps for Printing Reports” on page 151.

Note Print Preview in the File menu is not available for Box Charts because the chart is p
viewed during customization.

Fan Chart
Fan Charts are ancestor charts that show the ancestors of a starting person in a circular format
chart can be a quarter circle (90 degrees), semi-circle (180 degrees) or full circle (360 degrees)

Each ring of the fan chart contains the names of individuals in one generation. The startin
son’s name appears in the inner most ring. Ultimate Family Tree allows up to eight generations
included in a fan chart.

Fan charts can be oriented on the page in different ways. Quarter circle charts can be pla
any of the four corners, semi-circle charts can be placed along any side, and full circle charts s
the center of the page. The Ultimate Family Tree charts are designed to print on a single page 
can be included in books. Many page formats are provided.

Creating a New Fan Chart
1. Select an individual for whom you want to create a fan chart. To select a new individual, us

Find window opened by pressing F10.

2. Name the chart. You can give the chart a unique name of up to eight characters.

3. Give the chart a title. The title normally appears in the lower left hand corner of the fan ch

4. Select Use List if you have individuals in the Grouping list and wish to use only that group
individuals in your fan chart.

5. Click Create New Chart.

Note Ultimate Family Tree automatically sets the font style and size for fan charts.
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Editing an Existing Chart
1. Open the Fan Chart Report window from the Report, Charts menu. This window allows yo

open existing fan charts or create new ones. A list of existing charts in the upper left corne
the window shows all charts that have been created.

2. Open an existing fan chart in this list by double-clicking the name of the chart you wish to o
or select the chart and click the Selected button.

3. Click the Layout Page button to open the Chart Page Setup window. This allows you to ch
the page layout of an existing chart before a chart is opened. The paper size, orientation (p
or landscape) and margins can be set in this window.

Figure 5-34: Fan Chart Report Window

Figure 5-35: Chart Page Setup Window
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Viewing a Fan Chart
The following controls are provided on the Fan Chart window:

1. Select the number of generations to be displayed, from three to eight.

2. Select quarter-, semi-, or full-circle formats and positions.

3. Select a border for the chart.

4. Select a ring format. Names and dates can be shown in a fan chart in an arc or radially. Th
generations have a better appearance when shown in an arc because there is more room
generation where the switch is made from arc to radial is controlled by this selection.

5. The chart quality can be set from 100 to 400 dpi (dots-per-inch). The higher dots-per-inch
tion result in higher quality prints and slower creation times.

6. Choose a point size to determine the character size of names and dates in the chart. Cho
point size that does not cause the names to overflow into adjacent cells.

7. Change the view of the chart by selecting a zoom factor.

Printing a Fan Chart
Open the Fan Chart you want to print and choose Print from the File menu to print the Fan Cha

Relationship List Report
The Relationship List report provides a list of everyone in the project related by blood to a spec
individual. Grouping allows you to customize the list. You can list those individuals with a specifi
SOUNDEX code, for example, or show those who are male and who were married more than o

Relatives are listed in order of degree of consanguinity, which is the number of steps betw
people in a family tree. Ultimate Family Tree calculates the relationships for this report through 
generations.

Figure 5-36: Fan Chart Toolbar
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1. Choose Relationship List from the Reports menu.

2. Include any additional options from the Contents group.

3. Print the report. See “Basic Steps for Printing Reports” on page 151.

Text Report
The Text Report allows you to create a free-form text report such as an appendix or an introduc
chapter for your book. This report can include a header, footer, and title.

1. Choose Text from the Reports menu.

2. Type a title for the Text report and click the Text button to open an Edit Text window.

3. You can type up to 65,000 characters of text. Click Import in the Edit Text window to impo
external text file. The indicator next to the Text button is on when text is present.

4. Click Print or Preview. See “Basic Steps for Printing Reports” on page 151.

Figure 5-37: Relationship List Report Window

Figure 5-38: Text Report Window
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Image Reports
The three Image report styles in Ultimate Family Tree are Portrait, Gallery, and Media Tree. The
trait report prints an image and text connected to the image. The Gallery report prints any comb
of up to 20 images on a single page. The Media Tree report prints up to four generations of a fa
with pictures on a single page. Ultimate Family Tree prints black-and-white or color images if yo
printer supports color. If you want to include images in the body of a report, such as the Family J
report, you must send the report to a file and import it into a word processing program.

Printing a Portrait Report
1. Choose Images from the Reports menu, and then choose Portrait.

2. Select the image you want to print from the Digitized Images list. The name of the selecte
image is displayed at the top of the window.

Note OLE objects cannot be included in Portrait or Gallery reports.

3. Choose Display Caption and Display Description to include the caption and description yo
entered for the image in the Multimedia Library. If you have not entered a caption or descri
for the image in the Multimedia Library window, you can enter one at this time. The captio
prints directly under the image and should be limited to 50 characters.

4. Choose Landscape, Portrait, or Square to determine the format of the image you’re printin

5. Click Edit and Crop to view and edit the file before printing. Click OK to close the Edit wind

Note You must edit or crop the image before printing to guarantee that the image is prop
positioned. After an image has been edited, the Ready indicator is green.

6. Click the Print or Preview button to print the report. See “Basic Steps for Printing Reports”
page 151.

Note Depending on your hardware, the image may not display with true colors or shades
Print Preview, even though the image will print correctly.

Figure 5-39: Portrait Report Window
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Printing a Gallery Report
1. From the Reports menu, choose Images, and then Gallery.

2. Specify the picture space by checking any one of the 20 image positions (1A–4E).

3. Select the image for that position from the Digitized Images list.

4. Click Select Image to place that image in the selected position.

5. Click Edit and Crop to view and edit the image file. Click OK to close the Edit window. The
Gallery report is designed for images having a 2:3 landscape aspect ratio. Use Edit and C
center the image. After an image has been edited, the ready indicator is green.

Note Check the AutoEdit box to open the Edit and Crop feature automatically as you pos
images.

6. Repeat steps 3–5 for the remaining images you want included in the report.

7. To remove an image from the report, select its position and click Edit and Crop. Click Can
return to the Gallery report window.

8. To replace an image, select the image position, select a new image from the Digitized Ima
list, and click the Select Image button. Click Edit and Crop to view and/or edit the replacem
image file.

9. Click the Print or Preview button to print the report.

Note The information entered in the descriptive name field for the selected image appea
below the image when printed.

Figure 5-40: Gallery Report Window
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Printing a Media Tree Report
The Media Tree report is a Family Tree or Pedigree report that includes photographs. This repo
accommodate up to four generations of a family on a page.

1. From the Reports menu, choose Images and then Media Tree.

2. Enter a chapter title for the report.

3. Select Birth and Death dates to include them in the report.

4. To include the caption for the image, select Captions.

5. Select Shadows to print drop shadows.

6. Select a border for the page in the Page Border Style list.

7. To preview the report, click Preview. Click Zoom In to view a close up of the report and Zo
Out to return to normal view. Click OK to exit the Preview window.

Note The Next and Previous buttons are disabled in the Preview window. The Page Field
no effect as the report is only one page.

8. Click Print to print the report. See “Basic Steps for Printing Reports” on page 151.

End Notes Report
End Notes can be printed after you create footnotes. If Ultimate Family Tree does not find footn
because they have not been created or they have been reset, the End Notes menu selection is
able. The End Notes Report is not available when printing to a file. Ultimate Family Tree gives y
choice of including footnotes at the end of each chapter or report, or at the end of the book.

Note Notes that are compiled and numbered on a chapter-by-chapter (report-by-report) 
start with number 1 for each chapter.

Figure 5-41: Media Tree Report Window
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1. Choose End Notes from the Reports menu.

2. In the Contents group, choose which chapters will be included in the notes section: All or 
Selected.

3. If you choose Selected Chapter, highlight the chapter for which you want to print End Not
the Chapters list.

4. Choose one of the footnote options in the Style group:

• Long/Short/Ibid — End notes are printed in long form the first time a bibliographic referenc
appears. After the source is cited in full, the short form built from Abbreviation 1 and Abbre
tion 2 is used. When successive notes use the same reference, the Ibid. form is used.

• Long/Short — End notes are printed in the long form first, and then in the abbreviated form
subsequent references.

• Long — All references are printed in full.

5. Click Print or Preview in the report window. See “Basic Steps for Printing Reports” on page 

Note If you have chosen embedded notes for a Family Journal format report by selecting
Register format, source citations are included in the body of the report. Individual Record 
notes and Event Footnotes always print as end notes.

The method used in Ultimate Family Tree for preparing and printing footnotes is cove
by US Patent No. 5,097,418, dated March 17, 1992.

Bibliography Report
The Bibliography Report creates a list of sources in bibliographic form drawn from one of three 
sources: Project, Source Search List, or Source Library. This report uses the bibliographic form
entered in the Source Record window. (Be sure you have created the bibliographic forms befor
ning this report.)

Figure 5-42: End Notes Report Window
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1. Open the Bibliography Report window by choosing Bibliography in the Reports menu.

2. Select one of the following options from the Bibliography Source group:

• Project — Include all sources used in the current project for the current book.

• Source Search List — Include only those sources identified by the Source Search routine.

• Source Library — Include all sources in the Source Library.

Note The Project option includes only sources which have been included in reports for th
rent book. To print a bibliography for sources in the current project which are not included i
current book, complete a source search for all sources in the library and select the Source
List option.

3. Select Annotations to print an annotated bibliography. Annotations are entered in the Sourc
Miscellaneous window through the Source Record window.

4. Select Introduction to include introductory text entered in the Intro Text window.

5. Print the report. See “Basic Steps for Printing Reports” on page 151.

Index Report
An index is a list of individuals, marriages, and places with page numbers to reference where th
names, marriages, and places appear on various reports. The Index Report provides a referenc
reports and other materials included in a book. Ultimate Family Tree reports that cannot be inde
include Images, Calendar, End Notes, Box Chart, Fan Chart, Bibliography, and Index.

You can collect an index for a report either before or after you have printed the report, but
sure to use the same set of options when collecting the index as you do when printing the repo
recommend collecting the index immediately before printing the report to prevent any errors in t
index.

Note Because of differences in how printers process fonts and commands, the index can
contain errors. To review and correct the index before printing, click Edit on the Index Rep
window. See “Editing an Index Report” on page 203.

Figure 5-43: Bibliography Report Window
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Collecting an Index
1. Open the report for which you want to print an index.

Note If you are printing the report to a Rich Text Format file, you do not need to collect th
index. The index codes are included in the file and the index is created in the word proces

2. Set the options you want to include in the report.

3. Click Print in the report window.

4. Type the page number of the first indexed page in the First Page field.

5. Select Collect Index to collect an index without printing the report, or Collect and Print to c
lect the index and print the report in one step.

6. Click OK.

Note If Collect Index and Collect and Print are not available (dim) in the Print window, a t
has not been entered in the report window, the Print to File option is selected in the Print S
window, or the report cannot be indexed. Use a unique chapter name, or the new chapter
will replace the duplicate. Indexes can be printed at any time.

Printing an Index
You can print an index for a single report, or wait until you have collected the indexes for all the
ters in your book. If you have printed the report to a file, create and print the index in your word
cessor. See your word processor manual for help generating an index.

Note The index uses a fixed number of lines on a page. It is designed to use a 9-point fo
White space will open at the bottom of the page if you use a smaller font size. A larger fon
can cause text to overflow to the next page.

1. Choose Index from the Reports menu.

Figure 5-44: Print Window
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2. In the Include group, choose the chapters to include in the Index report: All or Selected. If
choose Selected Chapter, highlight the chapter in the Chapters list for which you want to pr
index. This list displays the chapter names of all the reports for which indexes have been 
lected. When creating reports, be sure to enter different titles for each chapter to avoid con
when printing.

3. Include any other options by checking the appropriate boxes.

Note Ultimate Family Tree prints cross references to alternative names in the Index if yo
select “See” Names. For example, if you have entered a woman’s married name such
Jane  /Smith/ in the Alias 1 field, and her maiden name Jane /Doe/ in the Individual Record win-
dow, the index will print Smith, Jane, see Doe, Jane.

4. Select the type of index you want to print from the Index type drop-down list. 

Note If Ultimate Family Tree has not found an associated index entry for the report, the re
will be blank. For example, if you select the option to print a Place Index for an Indented 
Descendant report, the index report will be blank because the Indented Descendant repor
not include places.

5. Choose Use List in the Grouping group if you want to print an index for only those individu
in the Grouping list.

6. Click Print or Preview in the report window to print the report.

Note Individuals without surnames are listed at the beginning of the index in alphabetica
order by given name and indented on the page.

Editing an Index Report
Because of differences in how printers process fonts and commands, an index can contain erro
index can be reviewed and corrected before printing by clicking Edit on the Index Report windo

The Index Edit window provides a list of all individuals, marriages, or places in the selecte
chapter. Select the individual, marriage, or place you want to check from the list.

Figure 5-45: Index Report Window
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Editing Page Numbers in an Index The pages in the chapter for the selected item are shown in
Page Numbers field. You can add, change, or remove page numbers. Ultimate Family Tree reord
page numbers automatically, so don’t worry about keeping the page numbers in ascending orde
a comma between page numbers.

Deleting Page Numbers in an Index To delete the page numbers for a selected individual, click
Selected from the Delete group. To eliminate the entire chapter, click All from the Delete group.
that you must repeat this last step for individuals, marriages, and places if you want to eliminate
entire chapter from the index.

Adding Individuals and Places in an Index Individuals and places not already in the index can b
added to a chapter. Click Add, and then select from the candidates list that is displayed. The ind
or place you want to add must already be in the project to be included in the candidates list.

Family Group Report
The Family Group Report contains detailed information about a family unit, which is a father, mo
and their children. The Family Group Report is useful during the research phase of a genealogi
project because it provides a ready reference to facts about the family. You can use options on t
mate Family Tree Family Group Report window to customize the form depending on your needs
mate Family Tree provides an option to print a blank Family Group Sheet for research purposes

1. Choose Family Group from the Reports menu.

2. Press F10, or click the Find button on the toolbar to find the starting individual.

Note To print a blank Family Group report, choose Blank Report.

3. Choose from the following options:

• Basic — Includes only Birth, Marriage, Death and Burial events on the report.

• Extended — Prints all applicable events.

Figure 5-46: Index Edit Window
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• Break Child Blocks — When not checked, moves the block of information for a child to the n
page if the entire block does not fit on the current page. Ultimate Family Tree does not mo
block if doing so leaves more than 15 blank lines at the bottom of the page. When checked
blocks of child information across page boundaries to reduce white space.

• Mother/Father — Prints Mother and Father labels instead of Wife and Husband.

• Place Modifiers — When checked, the report includes the place modifier, for example, in.

• Preparer Info — Includes preparer relationship information in the report.

Note To include the preparer name and address in the footer of the report, check Prepar
the Page Setup window. When Preparer Info is selected as an option, the preparer relatio
information includes the relationship of the preparer to the husband and wife. Only blood 
tionships are included, not relationships by marriage. The preparer relationship informatio
prints above the footer on the first page. If the researcher’s individual record number is en
in the Researcher # field in the Project Information window, the blood relationship to the h
band and wife is shown. If you do not want the relationship to show, enter 0 in the Resear
field.

4. Choose one of the options from the Family section:

• Selected — Prints a single Family Group Report for the selected individual.

• Plus Descendants — Prints Family Group Reports for the selected individual plus his/her 
descendants.

• Plus Ancestors — Prints Family Group Reports for the selected individual plus his/her 
ancestors.

Figure 5-47: Family Group Report Window
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• All — Prints Family Group Reports for every individual in the project.

Note If you select Plus Descendants, Plus Ancestors, or All, use the Grouping option. Yo
should complete a Vital Statistics search for those individuals who are married and have c
dren. Move this search into the Grouping list and choose Use List in the Grouping group o
Family Group Report window. By using these features, Family Group Reports will be print
only for those individuals who are married and have children.

5. If you choose Plus Descendants or Plus Ancestors in step 4 and want to set the number o
ations to print, enter the number in the Generation limit field.

6. Choose any additional options from the Other list.

7. Choose one of the options in the Child Marriage section: First (print only the first marriage
each child), Last (prints only the last marriage for each child), All (prints all marriages for e
child), or None (excludes child marriages).

8. Choose Research to print a research version of the report. Research notes entered in the
ual Record Text and the Event Text window print as text if the Individual Text and the Event
options have been selected. The Research option is dim unless a text option has been se

9. Choose Footnotes if you want to include footnotes at the end of the report.

10. Print the report. See “Basic Steps for Printing Reports” on page 151.

Note If an individual has more than one spouse, Ultimate Family Tree asks you to select
of the spouses from a list. Single Family Group Reports contain vertical lines to separate 
umns of information. Multiple Family Group Reports do not use vertical lines.

Individual Summary Report
The Individual Summary provides a comprehensive report for individuals in your project. You hav
option of including any or all of the information that you’ve entered for selected individuals. By u
the Grouping option, you can create a customized report for whatever purposes you need. All in
tion except footnotes is included.

1. From the Reports menu, choose Summary, and then Individuals.

2. Press F10 or click Find on the toolbar to find the individual for whom you want to print the
report.

3. Select any options you want to include in the report.

Note To print multiple Individual Summary reports, place the individuals in the Grouping 
and check Use List in the Grouping group of the report window. If you do not want each ind
ual on a separate page, select No Page Break. 

4. Print the report. See “Basic Steps for Printing Reports” on page 151.
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The Preferred Image option is disabled unless you are exporting to an external word pro-
cessor or Ultimate Family Tree Editor.

 

Events Summary Report

 

The Event Summary Report prepares a comprehensive report for the events in your project. You have 
the option of including a selected event (shown at the top of the window) or all events in the event 
search list. By utilizing the Grouping option, you can create a report customized for any purposes you 
need. The report allows you to print all information, except footnotes.

1. From the Reports menu, choose Summary, then Event.

2. Check Use

 

 

 

List in the Grouping group to include only those events in the events search list or 
Add

 

 

 

Asterisk to print an asterisk next to events.

Figure 5-48: Individual Summary Report Window

Figure 5-49: Events Summary Report Window
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3. Check any of the following options:

• Event Text — Include text from the Event Edit window in the report.

• Participants — Include a list of participants and roles for the events.

• Image Info — Information about any images that are attached to a selected event is includ
This information includes the Image date, name, long name, type and caption.

• Preferred Image — Includes the preferred image for the event. This option is available only
when printing to a Rich Text Format file. See “Printing to a File” on page 145.

• Flags — Include flags for events in the report.

• Introduction — Include introductory text entered by choosing Intro Text in the report.

4. Print the report.

Image Summary Report
The Image Summary provides a comprehensive report for images stored in the Image Library. Y
have the option of including any or all of the information that you’ve entered for selected images

Printing a Summary for All Images
1. From the Reports menu, choose Summary, then Images.

2. Choose All to print a summary for all images in the Multimedia Library, or Selected to prin
summary for the selected image.

Note To select an image for the report, from the Build menu, choose Multimedia Library.
Select the image you want from the list and click OK to return to the Image Summary Rep
window.

3. Enter a Chapter Title for the report (optional).

Figure 5-50: Image Summary Report Window
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4. Select any or all of the following options:

• Image Number — Include Image Record Number.

• Size — Include size of image file.

• Location — Include data entered in the Location field of the Multimedia Library window.

• Condition — Include data entered in the Condition field of the Multimedia Library window.

• Caption — Include caption of image as entered in the Multimedia Caption window.

• Description — Include a description of the image as entered in Multimedia Description wind

5. Select Show Image to include the image in the report. This option is available only when p
ing to an RTF file.

6. Select Task Info to print information added to the Task list.

7. Click Preview or Print to print the report.

Printing a Summary for a Selected Image
1. Choose Selected.

2. From the Build menu, choose Multimedia Library.

3. Select the Image for which you want to print a Summary report.

4. Click OK to return to the Image Summary window.

5. Select any or all of the options described above.

6. Click Preview or Print to print the report.

Note The Show Image option is disabled unless you are exporting to an external word pr
sor or Ultimate Family Tree Editor.

Place Summary Report
The Place Summary report provides a comprehensive report for places used in your project. Yo
the option of including any or all of the information for selected places. By utilizing the Grouping
option, you can create a report customized for whatever purposes you need. The report allows 
print all place information except footnotes.

1. From the Reports menu, choose Summary, then Places.

2. Enter a Chapter Title for the report (optional).



2 1 0 SE C T I O N 5 : PR I N T I N G  RE P O R T S

 is 
 Group 
ters.

eneal-

ry.

ce. 

 sure 

rd.

 
nting 

 if 

ces 

51.
3. Select any or all of the following options from the Fields group:

• Short Place — Includes the place name from the short place field. This version of the name
used on structured reports where space is limited, such as the Pedigree Chart and Family
Sheet. Ultimate Family Tree automatically shortens the name if it is longer than 30 charac

• Long Place — The long place name version is used on unstructured reports, such as the G
ogy reports.

• Place Number — The place number is the identifying number of the place in the place libra

• Place Levels — Place levels identify the geographic or political level used to identify the pla
Each place can have its own levels.

• Place Years — The place years are used when a place is being linked to an event to make
the place existed at the time of the event.

• Edit Status — The edit status field can be used to show the current status of the place reco

4. Select any of the options from the Text group.

• Description — Free-form text describing the place

• Research Note — Free-form notes about research connected with this place

• Repositories — Information about research repositories at this place

• Introduction — An introduction for this report

• Intro Text — The text to be used for the introduction

5. Select any options from the Other group.

• Task Info — Include information added to the To Do Task list for the place. Select Preferred
image to include the preferred image linked to the place record. This option is dim if not pri
to an RTF file.

• Preferred Image — Include the preferred image linked to the place record. This option is dim
not printing to an RTF file.

6. To print multiple place summaries, select Use List in the Grouping group to include all pla
from the Place Search list. Use List is dim if the Place Search list is empty.

7. Click Print or Preview to print the report. See “Basic Steps for Printing Reports” on page 1



PR O J E C T SU M M A R Y  RE P O R T 2 1 1

eport 

 

 for 
Project Summary Report
The Project Summary Report contains comprehensive information on the current project. This r
can include the project information, a file list, project statistics, and a system summary.

1. Choose Project from the Summary submenu in the Reports menu.

2. Include any of the options by checking the appropriate boxes.

3. Check Introduction and click Intro Text to enter an introduction

4. Print the report. See “Basic Steps for Printing Reports” on page 151.

The following information is provided in the Ultimate Family Tree Project Summary report 
when the System Summary option is selected:

• Processor — The microcomputer chip detected by Ultimate Family Tree. Note that Pentium
processors are reported as 40486.

• Graphics Card — The graphics card detected by Ultimate Family Tree. VGA/CGA is shown
CGA and higher resolution boards.

• Default Drive — The drive where UFTREE.EXE is located

• Directory — The current directory

• Start Directory — The directory where Ultimate Family Tree was started

• Disk Size — The size of the default drive

Figure 5-51: Project Summary Report Window
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Source Summary Report
The Source Summary Report is a comprehensive report on sources in your project or library. Yo
the option of including any or all of the information on selected sources. You can print a summar
single source or a summary of all sources found in the Source Search list.

1. To print a summary for a single source, select the source you want to print from the View S
List or the Source Record window, then open the Source Summary Report window by cho
Summary and then Source from the Reports menu. The selected source is displayed at th
the window.

Note To print a summary for all sources (or several sources), use the Source Search fea
create a list of sources, then select Use List in the Grouping option in the Source Summar
Report window. 

2. Enter a Chapter Title (optional).

3. Select any of the options from the Form group:

• Footnote — Print the sources in footnote form. This form was entered in the Source Recor
window.

• Bibliographic —Print the sources in bibliographic form. This form was entered in the Advan
Editing Mode Source Record window.

4. The selections in the Text and Other groups, when checked, include the text that was ent
the associated fields in the Source Miscellaneous Information window opened through the
Advanced Editing Mode Source Record window.

5. Select Task Info to include information entered into the Task List for the source.

Figure 5-52: Source Summary Report Window
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6. Enter Introductory text and select Introduction to include an introduction on the report.

7. Click Print or Preview to print the report. See “Basic Steps for Printing Reports” on page 1

Note The Preferred Image option is disabled unless you are exporting to an external wor
cessor or Ultimate Family Tree Editor.

Task Summary Report
The Task Summary report is a comprehensive report on tasks in your current project or all proje
You have the option of including any or all of the information on selected tasks. You can limit the
information printed in the report by using the grouping options.

1. Open the Task Summary Report window by choosing Summary and then Task from the R
menu.

2. Enter a Chapter Title (optional).

3. Select any of the options from the Contents group.

4. Select the Priority Filter (High, High/Medium, or All) for the Task search from the Priority Fi
drop-down list.

5. Select Current Project to include tasks for the open project or All Projects to print a summ
tasks entered for all projects.

6. Supply introductory text by clicking Intro Text, and check the Introduction box to include a
introduction on the report.

7. Check the Active Tasks box only to include only the active tasks.

Figure 5-53: Task Summary Report Window



2 1 4 SE C T I O N 5 : PR I N T I N G  RE P O R T S

of 
dow. 

 to 

51.

d 
red 
 that 

ces, 

ght 
 

ected 
 the 

nty.
Note To print a summary for all tasks (or several tasks), use Task Search to create a list 
tasks, then check the Use List box in the Grouping group in the Task Summary Report win
Use the Grouping options for Individuals and Events to limit the report to tasks connected
specific records.

8. Click Print or Preview to print the report. See “Basic Steps for Printing Reports” on page 1

List Reports
The List Reports create tables of information for individuals, events, marriages, places, roles an
sources. They also print mailing lists or mailing labels, and provide a list of the data not transfer
into Ultimate Family Tree via a GEDCOM file. These lists can be saved in a Report Template so
customized selections can be used again later.

Individual, Event, Marriage, Place, Role, Source, and Task List Reports
1. Choose Lists from the Reports menu, and then choose Individual, Events, Marriages, Pla

Roles, Sources or Tasks.

2. To select items to include in the report, double-click items in the Field List group (or highli
and press Enter). Click the Insert button to insert an item from the Field List to the location
directly above a selected item in the Selected list. When the selected field is added to the 
Selected list, the column numbers are updated.

The fields print in the order shown in the Selected list. To remove an item from the Sel
list using the mouse, double-click the item in the Selected list, or select the item and press
Enter key to remove it.

Note The Level 2 category for Birth and Death place names is generally used for the cou

Figure 5-54: Individual List Report Window
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3. Check Skip 1st Column to omit the first column in the Selected list from what is printed. T
allows the ability to sort the list on the first column field, but not actually print the first colum
information. This will enable you to attach many reports side-by-side that are sorted using
same field without having to print the redundant column over and over.

4. Check Line Numbers to include them to the left of the first column.

5. Select one of the following font size options:

• Small — Allows the most information to be printed on a single page

• Medium — Uses a larger font size and therefore prints fewer columns

• Large — Uses the largest font size and prints the least amount of information

Note Selecting a font size determines the number of columns available for the report. Th
smaller the font, the more columns you are able to print. Ultimate Family Tree automatica
determines the font size and style for the Small, Medium, and Large options.

6. Click Modify to create or edit the Report Template if this is a list you wish to recreate at a 
date.

7. Enter a name and description for the template and click Save.

8. Select Report to print a report. To export the report to an external program such as Micros
Excel, select Export. See “Exporting List Reports” on page 218.

9. Print the report. See “Basic Steps for Printing Reports” on page 151.

Mail List Report
The Mail List Report contains a complete or selected list of mailing addresses and phone numb
individuals in your project. This list can be formatted and printed as mail labels. Enter mailing 
addresses and phone numbers for an individual in the Miscellaneous window opened through t

Figure 5-55: Report Template Window
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Individual Record. Ultimate Family Tree automatically determines the font size and style for Mail
Reports.

1. From the Reports menu, choose Lists, and then Mail.

2. Select the order in which you want the addresses to be printed in the Order group.

Note The name entered in the addressee field can be different from the name in the Indi
Record window (for example, Mr. and Mrs. Thomas Smith instead of Nancy Smith). Ultimate 
Family Tree does not differentiate between first and last names in the Mail Label window. Mr. 
and Mrs. Thomas Smith will print in the mail list before Nancy Smith, if the Label Name radio 
button is selected, because M comes before N in the alphabet.

3. Choose one of the formats from the Format list.

4. Enter a title you want to be printed at the top of the mail list. This field is available only whe
Ultimate Family Tree Report format is selected from the Format list in this window.

5. Adjust the size of the left margin on the mailing labels by entering the margin size, in inch
this field. This field is not available when the Ultimate Family Tree Report format is selecte

Note Names and addresses are cut off if the text does not fit on the label. Take note whe
entering address information.

6. To include introductory text in your report, click the Intro Text window, enter you text, and 
check the Introduction box. These options are available only when the Ultimate Family Tre
Report format is selected.

7. Print the report. See “Basic Steps for Printing Reports” on page 151. To export the report 
external program such as Microsoft Excel, select Export prior to clicking Print.

Note Ultimate Family Tree determines both the font style and size in all List reports, includ
the Mail List.

Figure 5-56: Mail List Report Window
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GEDCOM Exceptions List Report
The GEDCOM Exceptions List prepares a list of data that did not transfer into Ultimate Family T
through a GEDCOM file. You can also view the missing data on screen by choosing Projects fro
Utilities menu, and then choosing GEDCOM Exceptions to open the GEDCOM Exceptions wind

1. After importing a GEDCOM file, choose Lists from the Reports menu, and then GEDCOM
Exceptions.

2. To select items to include in the report, double-click items in the Field List (or highlight an
press Enter). To insert a selected field in the Field List to the spot above the selected item
Selected List, click the Insert button. When the selected field is added to the Selected List
column numbers are updated.

3. Click Modify to create or edit the Report Template if this is a list you wish to recreate at a 
date. Enter a name and description for the template and click Save.

4. The fields print in the order shown in the Selected List. The choices available are:

• File Position — The position (number of characters from the start of the GEDCOM file) in t
GEDCOM file where the exception is located

• Level — The level number of the exception in the GEDCOM file. For example, the BIRT tag
an individual is level 1 and the DATE tag under the BIRT tag is level 2.

• Error Tag — The GEDCOM tag to which the exception belongs, such as PLAC or DATE

• Error Text — The text or information that did not import into Ultimate Family Tree

• Indiv No — The individual record number in Ultimate Family Tree for the individual associa
with the exception

• Event Type — The name of the event in Ultimate Family Tree (such as Birth) that is associa
with the exception

Figure 5-57: GEDCOM Exceptions Report Window
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Note To remove an item from the Selected List double-click the item in the Selected List,
select the field and press Enter.

5. Check Skip 1st Column to omit the first column in the Selected List from printing on the re
You can sort the list on the first column field, but not actually print the first column informat
This enables you to attach many reports side-by-side that are sorted using the same field w
having to print the redundant column over and over.

6. Check Line Numbers to include them to the left of the first column for this report.

7. Select one of the following options for font sizes:

• Small — Prints the most information on a single page

• Medium — Uses a larger font and therefore prints fewer columns

• Large — Uses the largest font and prints the least amount of information

The selections you make determine the number of columns available for the report. T
smaller the font, the more columns you are able to print. Ultimate Family Tree automatica
determines the font style and size for the Small, Medium, and Large font options.

• Col/Page — Columns available on the report page for the font size selected. To increase th
number use a smaller font size. To decrease this number use a larger font size.

• Col Used — Total columns used when selections are made from the Field List

• Col Left — The number of columns still available

8. Click Print or Preview in the report window. See “Basic Steps for Printing Reports” on 
page 151.

Exporting List Reports
Ultimate Family Tree lists contain rows and columns of information, much like a spreadsheet. R
contain records and columns contain fields. When printed directly from Ultimate Family Tree, a 
report can have as many fields in a row as will fit on a page. To include an unlimited number of 
the list report can be exported to an external program, such as Microsoft Excel.

Following is a list of the data formats supported by Ultimate Family Tree:

• Microsoft Excel v2.0+ (.XLS file extension) — Select this option to create a Microsoft Excel
spreadsheet. Each field in the Ultimate Family Tree list becomes a column and each record
list becomes a row in the spreadsheet.

• Lotus 1-2-3 v2.0+ (.WK1 file extension) — Use this option to create a Lotus 1-2-3 spreadsh
from an Ultimate Family Tree list for Lotus 1-2-3 revision 2.x. Each field from the list becomes
a column and each record in the list becomes a spreadsheet row.

• Lotus 1-2-3 v1-A (.WKS file extension) — This option creates a Lotus 1-2-3 spreadsheet fo
Lotus 1-2-3 revision 1-A. Each field from the list becomes a column and each record beco
row in the spreadsheet.
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• Lotus Symphony (.WR1 file extension) — Choose this option to create a Lotus Symphony v
sion 1.01 spreadsheet from an Ultimate Family Tree list. Each field from the list becomes 
umn and each record becomes a row in the spreadsheet.

• Database (.DBF file extension) — This option creates a standard database file that can be
by FoxPro, dBase, Access, and many other database programs.

• Data Interchange Format (.DIF file extension) — When you specify DIF, each field from an 
Ultimate Family Tree list becomes a vector or column and each record becomes a tuple or 
a DIF file, used by VisiCalc.

• Symbolic Link Interchange Format (no file extension) — A SYLK file is a Symbolic Link inter-
change format (used by Microsoft Multiplan) in which each field from an Ultimate Family T
list becomes a column and each record becomes a row in the spreadsheet.

• Comma Delimited, Tab Delimited, or Space Delimited (ASCII) — Select one of these options to
create a file you can use in programs that accept ASCII text data, where character fields a
enclosed in quotes and separated by commas, tabs, or spaces, and records by CR/LF.

A wide variety of list reports can be created in Ultimate Family Tree, including Individual, 
Event, Marriage, Mail, Place, Role, Source, Task, and GEDCOM Exceptions Lists.

Setting up Ultimate Family Tree to Export a List

1. Open the External Support options window by choosing Page Setup from the File menu.

2. Choose the Type of File for export from the drop-down list.

3. If it’s not present, type the path to the application you wish to use to display the exported 
Click the Browse button to open an Open file dialog to search for the application you wish
use.

4. Check the Automatically Launch Application box if you wish to have Ultimate Family Tree s
the export application with the new list in place.

Exporting a List

1. Open the desired List window from the Reports, Lists menu.

2. Select the Export radio button.

3. Select a report template, or select the options you wish to appear in the report.

4. Click the Export button to generate the report and export it in the format you have chosen

Note The Tasks List report can contain information that comes from unlimited length me
fields. Up to the first 255 characters of the memo fields can be exported.



2 2 0 SE C T I O N 5 : PR I N T I N G  RE P O R T S

nts for 
t. You 
 style 

sing 

int a 
 calen-
 can it 

d only 

he 

e any 

ject 
 as 
ck 
Calendar Reports
Ultimate Family Tree produces a calendar that includes birthdays, anniversaries, and other eve
any or all individuals in your project. The calendar can be customized by using the Grouping lis
can print calendars in a box style or text style. Ultimate Family Tree determines the font size and
for text inside the day boxes in Box Calendar reports. Names in the Calendar can’t be printed u
bold type.

Note The Calendar prints as it will (or did) exist for the date you select. If you select to pr
calendar for June 1948, only events that took place on or before June 1948 appear in the
dar. The Calendar is designed as a stand-alone report and is not included in indexing, nor
be exported in Rich Text Format.

1. From the Reports menu, choose Calendar. Type in a chapter title. The chapter title is use
for the Text style calendar and is centered at the top of the first page.

2. In the Starting Month field, enter the numeric equivalent for the month in which you want t
calendar to begin. For example, October should be entered as the number 10.

3. Enter the year in which you want the calendar to begin.

4. Enter the number of months you want to print from the starting month and year. This can b
number up to 99.

5. Select any of the options in the Births group. To include birthdays of individuals in your pro
check Include. Check Alive to include birthdays for only those individuals who are still living
of the calendar date. If Alive is not checked, all individuals in the project are included. Che
Age to include individual’s ages.

Figure 5-58: Calendar Report Window
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6. Select any of the options in the Marriages group. To Include the marriage anniversaries o
viduals in the project, check Include. Check Marriage to include the marriage anniversarie
those who are still married at the time of the date on the calendar. Check Years to include
number of years married. Ultimate Family Tree uses the sort date for this number. The nu
shown is the number of years the couple has been (or would have been, or will be) married
time of the date on the calendar.

7. Choose either Box or Text in the Style group.

8. Check Use Grouping to include only those individuals listed in the Grouping list.

9. Check Addresses to include the current address and telephone number from the Mail Lab
dow for the individual shown on the calendar. For marriages, engagements, and divorces,
mate Family Tree uses the first valid address it finds for one of the two individuals involved.
option is available for the Text Style Calendar only.

10. If you do not want to include an additional event in the Calendar report, skip to step 17.

11. Select an event from the list of Available Events.

Note On the Text style calendar, both individuals are shown for engagements, marriages
divorces when one of these events is selected as the extra event. In the box style, howeve
one individual is included for events that have two individuals connected. Ultimate Family 
uses the first individual found.

12. Check Include to include the event selected from the Available Events List on the right sid
this window. The event selected is shown in the Event Group title field.

13. Check Alive to include the selected event only for individuals who are still living.

Note An individual whose Living field is marked unknown will not be included if this option is 
selected.

14. Check Years Since to include the number of years since the selected event occurred. Ulti
Family Tree uses the sort date for the selected event to calculate this number.

15. Check Abbr (box style Calendar only) to include an event name or an abbreviation for the
(if the event name is long) on the Calendar.

16. Enter the event name, or abbreviation of up to 10 characters, in the Abbr field. If nothing i
entered in this field, only the name of the person connected to this event is printed. The ab
ation is used for the box style report. The text style report uses the full name of the event 
the Event Library.

17. Click the Labels button to open the Calendar Labels window if you want to edit the names 
months.

18. Enter any text in the Month Label field (up to 35 characters) that you want printed on the b
left of the Calendar. Leave this blank if you want only the month and year to be printed.
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Note If you want to print a calendar with the months shown in a different language, edit t
month name (up to 15 characters). The month is printed on the bottom right of the Calend
along with the year. You cannot change a month in this field, but you can rename it.

19. Click OK to save changes and return to the Calendar Report window.

20. Click Print or Preview to print the report. See “Basic Steps for Printing Reports” on page 1

Historical Timeline Report
The Historical Timeline Report contains a list of all the events in an individual’s life, historical ev
from the REVENT library, and the corresponding dates.

1. From the Reports menu, choose Historical Timeline.

2. Press F10 or click Find on the toolbar to find the individual for whom you want to print the
report.

Figure 5-59: Calendar Labels Window

Figure 5-60: Historical Timeline Report Window
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Note To print a Historical Timeline for multiple individuals, place the individuals in the 
Grouping list and check Use List in the Grouping group of the report window. See Section
more information on individual searches and Grouping.

3. Choose to include all the personal events in an individual’s life, or only those events in wh
that individual was a principal role player by selecting All or Principal.

4. Choose to include a range for the historical events you want included, in relation to the ind
ual’s personal events from the Historical Range drop-down list. Some of the choices includ
events, events that occurred within 30 days, or events that occurred on the same day.

5. Print the report. See “Basic Steps for Printing Reports” on page 151.

Tiny-Tafel Report
The Tiny-Tafel Report is a shortened version of an Ancestor (Ahnentafel) list. The report contain
line of text for each family line. It also contains the surnames, time periods, and locations repre
by that family line, plus codes to signify the degree of interest in receiving information about the
ancestors or descendants of that line.

Every family consists of a number of family lines. A Tiny-Tafel family line starts with an anc
tor (with a particular surname) for whom you have assigned an Ancestor Interest (AI) level and 
extends forward in time to all descendants for whom you have set a Descendant Interest (DI) le
These interest levels are assigned in the Miscellaneous window from the Individual Record.

Note If more than one DI level is set in a family line, a new Tiny-Tafel line is created. You 
have two or more lines for the same family line with different interest levels.

For Ultimate Family Tree to establish a family line and create a Tiny-Tafel Report, you mus
the AI level for the earliest ancestor and the DI level for the latest descendant in a line.

Adding Ancestor and Descendant Interest Levels
You can easily add interest level flags to an existing project. For the AI level, use the Pedigree w
to spot the gaps in your family tree and identify the individuals whose line you want to extend ba
time. For the DI level, use the Descendant window to move forward through a family line and ide
the most recent individuals.

To get the most use out of the Tiny Tafel report, follow these guidelines when setting the A
DI levels in your project:

• 0 — The individual is not used to establish either the ancestor or descendant end of a line

• 1 — No interest, and reliability of the data is marginal, making it of little interest to others, 
used to establish one end of a family line.

• 2 — Low interest but contains high quality data that might be of substantial interest to ano
researcher.
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• 3 — Moderate interest data; quality is good or poor.

• 4 — Highest interest data; quality is good or poor.

Note AI and DI levels imported from ROOTS III are increased during import to the next 
higher number (1 becomes 2, 2 becomes 3, and 3 becomes 4, but 0 does not change).

Follow these instructions to set AI and DI levels:

1. Press F5, choose Individual Record from the Build menu, or click the Individual Record bu
on the toolbar to open the Individual Record window.

2. Press F10 or click the Find button on the toolbar to find the earliest ancestor in a family lin
are interested in.

3. Click the More button on the Individual Record, and click the Miscellaneous tab to open th
Miscellaneous Information window.

4. Enter the AI level in the Interest group.

Note Set the AI level only on the earliest ancestor in a family line you are interested in. 
Because any Descendant Interest Level setting higher than 0 will result in a separate Tiny
line for each individual so marked, set the DI level only if you are interested in receiving Ti
Tafel information for the selected individual.

5. Click OK.

6. Press F10 or click the Find button on the toolbar to select the most recent individual in the
ily line.

Figure 5-61: Miscellaneous Individual Information Window
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7. Click the More button and then the Miscellaneous tab.

8. Enter a DI level.

Note In most cases a DI level is used to indicate that you are interested in all descendan
across a family line, so you can select the most recent individual in the family line for the i
est level setting.

Note If you have a gap in a family line, use AI and DI levels to indicate that you would like
fill in the gap. Set the DI level on the older end of the gap (because that individual’s descen
are missing) to 4, and set the AI level on the younger end (you want information on that in
ual’s ancestors) to 4.

Printing a Tiny-Tafel Report
Before opening the Tiny-Tafel Report window you should specify the destination for the Tiny-Taf
the Print Setup window. The Tiny-Tafel can be sent to either the printer or to an ASCII file. If you 
to create a file, give it the extension .TAF.

1. Choose Tiny-Tafel from the Reports menu.

2. Choose one of the AI/DI Threshold options.

Note Eight radio buttons are available to select what appears in the Tiny-Tafel report—fo
radio buttons are for the AI level, and four radio buttons are for the DI level. Select the app
ate radio button in each column for the lowest interest level to be included in the Tiny-Tafe
you select 2, then interest levels 2, 3, and 4 are included. If you select 4, only interest leve
included.

3. Check Use List if you want to limit the individuals to be included in the Tiny-Tafel Report to
those in the Grouping list.

Note To create a Tiny-Tafel for one line, use Relationship Search to identify the line and 
add the results to the Grouping list. You can also use Miscellaneous Search to search for 
DI levels and add the resulting people to the Grouping list.

Figure 5-62: Tiny-Tafel Report Window
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4. Click the Submitter button. A submitter is the person offering his or her selected genealog
data, along with requests for further information.

5. Enter the submitter’s name, up to 38 characters plus spaces. Enter your name here exactl
do when you sign on to a bulletin board system. For example, if you use John Doe for the bulle-
tin board, do not use John H. Doe in the header. This field is mandatory. The report cannot b
created if the Submitter name (at a minimum) is not entered. The remainder of the header
are optional.

• Address — Your mail address, up to four lines of 38 characters each

• Telephone — Your telephone number, up to 38 characters

• Services — The communication services where you can be contacted, up to 3 lines of 38 c
ters each. Generally, these lines will be in the form Name of Service/ID Number.

• BBS — The name of the bulletin board you are using and its telephone number, up to 38 c
ters

• Remarks — Remarks about the Tiny-Tafel (for example, how to send information other than
floppy disks)

• Disk Format — The disk format that you would like to use to exchange information with oth
researchers. If you want to receive Tiny-Tafel information by telephone or in writing, state 
preference on the Remarks line.

6. Click OK to return to the Tiny Tafel Report window.

7. Print the report. See “Basic Steps for Printing Reports” on page 151.

If you have created the Tiny-Tafel as an ASCII file, you can view and edit the file while in U
mate Family Tree.

1. Choose Open from the File menu.

Figure 5-63: Tiny-Tafel Submitter Window
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2. Select Text from the File Type list.

3. Check the All Files box to view all files.

4. Change to the drive and directory of the Tiny-Tafel file.

5. Choose the Tiny-Tafel file. The Text window appears with the Tiny-Tafel file showing.

Research Log Report
The Research Log prints the contents of your research notes for individuals and events. Choos
Research Log in the Reports menu to open the Research Log report window.

1. From the Reports menu, choose Research Log.

2. Select any of the following options:

• Include Individuals — Create a report that includes research notes entered in the Research
window on the Individual Record window for all individuals in the project or Grouping list.

• Include — Include research notes entered in the Research Note window on the Event Rec
window for all events in the project or Event Search List.

• Place Research Note — Include Research Notes entered in the Place Record window. Place
research notes are then included for each place connected to an event.

• Place Repository Note — Repository Notes entered in the Place Record window are printed
the report.

Note The Place Research Note and Place Repository Note check boxes are disabled (d
unless the Events Include option is chosen.

3. Check Use List or Add Asterisk in the Grouping group for Individuals and events.

Figure 5-64: Research Log Report Window
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Note Grouping is an invaluable tool when creating a Research Log. For instance, if you a
going to a specific location to do genealogical research, you might want to search for all in
uals, places, and events that are linked to the area you are going to visit. By utilizing the G
ing list, you can print a report that helps you in your research in that location.

4. Click Print or Preview to print the report. See “Basic Steps for Printing Reports” on page 1
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Ultimate Family Tree can create Instant Web Page family histories suitable for publishing on the
World Wide Web. The Family Journal (Genealogy) Report and the Indented Descendant and De
dant Box Chart Reports are used for Instant Web Page files. Sample family histories can be see
http://www.uftree.com. In this section you will learn how to:

✓ Plan your family history Web Page

✓ Create or identify images in the Multimedia Library you want to use. Specify these as Pref
Images for each individual, event, or place you will include in your Instant Web Page.

✓ Create Family Journal and Box Chart Instant Web Pages using the Web option

✓ Preview the Instant Web Page

✓ Go online to Ultimate Family Tree’s Web site

✓ Register online with Palladium to reserve your Web space

✓ Upload your Instant Web Page

Keep in mind these cautions when preparing your Instant Web Page:

• Be sensitive to the wishes of family members who may not want certain information to be 
placed on the Web.

• Be sure to include your email address so other researchers and family members can cont

• Remember that your information is only as useful as its documentation—cite your sources
2 2 9
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File Organization
Ultimate Family Tree provides a number of options for saving a family history file. The family his
can be saved in:

• One file

• Multiple files in a single directory

• Multiple files in multiple directories

The option you choose depends on the size of the family history you wish to create and the
bilities of the Web server you will be using.

The main reason to use multiple files is to improve the access speed. A large file takes a l
time to load, while small files can be accessed by a browser much more rapidly. The multiple-dir
option allows files to be divided into separate directories. MS-DOS slows significantly when acce
a directory having more than several hundred files. Use multiple files in multiple directories for 
uploading to your Web site.

Multiple File Option
The following files are created by Ultimate Family Tree when you choose the multiple file option

• INDEX.HTM — The main family history file containing the table of contents, surname list, a
introduction

• Innnnnnn.HTM — Files for each main individual in the report. The record number of the ind
vidual uses the format nnnnnnn, padded with zeros. For example, the file for individual numb
8 would be I0000008.HTM (Family Journal style only).

• SOURCES.HTM — The source citations for the report (Family Journal style only)

• NINDEX.HTM — The name index for the family history

• HTMFILES.TXT — A list of files created for this family history

• name.TGZ — GZip compressed TAR (tape archive) is created when Web option is selected

Multiple Subdirectory Option
Ultimate Family Tree places the main individual files in separate subdirectories when you choos
option. The subdirectories are created automatically in the starting directory if they do not alrea
exist. The number of files in each directory can be set from the Options window described later.
other previously listed files are located in the starting directory.

The subdirectories created by Ultimate Family Tree have the name Dnnn, where nnn is the num-
ber of the directory starting with zero. If you have 500 files and have set the directory limit to 20
Ultimate Family Tree will create three subdirectories, D0, D1, and D2.
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Linking Files
Images If a preferred image is linked to an individual, event, or place that is included in the Fa
Journal Web Page Report, it will be extracted automatically from your Multimedia Library and pl
in the HTML\GRAPHICS subdirectory.

Additional image links are provided:

• Background — Provides a background texture for the family history. Not all browsers suppo
background images.

• Header Graphic — Displays at the top of the first page. Use this for a family picture or grap

• Title Graphic — Appears at the top of the first page under the header graphic. Use this for 
graphic version of your title. It replaces the chapter title.

• Bullet Graphic — Precedes the names of the children the first time they are introduced follo
the parents in each generation.

• GEDCOM Graphic — Precedes the Universal Resource Locator (URL) for immediate down
loading of the GEDCOM file specified on the entry line, left aligned. Available for the Web 
option only. Be sure to specify a GEDCOM file name as described later.

• Email Graphic — Appears left aligned at the end of the document preceding the URL for s
ing immediate email. Available for the Web option only. Be sure to include your email addre
described later.

• Table of Contents — Appears left aligned at the end of each page. Allows you to go back to
main HTML page. It precedes the phrase Table of Contents.

• Next Page Icon — Appears at the bottom of a page in multipage HTMLs.

• Previous Page Icon — Appears at the bottom of a page in multipage HTMLs.

• Horizontal Rule — Specifies a separator bar used to separate items in the report. Normally
short, page-width image.

• Audio Graphic — Precedes the URL for transmission of a sound file. Be sure to specify the
audio file name.

A number of graphic (.GIF) files are included with Ultimate Family Tree for your use. Thes
graphic files are located in the \UFT\IMAGES subdirectory. Templates are available to save you
graphics settings.

Sounds You can also include a sound file.

• Audio File — Links a sound file such as a narrative description.

Immediate GEDCOM You can specify a GEDCOM file so a viewer can display onscreen, or s
to disk, a specific GEDCOM file. This file can be a compressed file created with a utility such as
PKZIP.
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Creating an Instant Web Page 
Ultimate Family Tree can create Instant Web Page family histories suitable for publishing on the
The Descendant Box Chart (which includes an Indented Descendant Report) and Modified Reg
Family Journal Reports are available as Instant Web Pages.

Creating a Family Journal Instant Web Page
An Instant Web Page family history contains the following information:

• Family history name as entered in the Book Title field in the Page Setup window

• Contact information for the author of the family history including an email link, researcher’
name, address, and telephone number as entered in the Project Info Window

• Link to an optional GEDCOM file for downloading

• List of surnames included in the report

• Introduction

• Family Journal (genealogy) report in the Modified Register format, using Descendant, Fam
or Reverse Register format

• Footnotes and references linked to text in the report

• Index of names in the report

• Images connected to the title, introduction, or any individual in the report

• An audio file in any accepted format (currently these include .WAV, .AU, and .AIF)

• Links to other URLs

Figure 6-1: Miscellaneous Info Window
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A URL in the Web Link field of the Miscellaneous Individual Information window links an in
vidual to any other Internet URL. This link can be to images, sounds, or other genealogies. For 
ple, you can link John F. Kennedy to a genealogy at another Web site. If this genealogy is found
URL http://www.anothersite.com/jfk.html, enter this address in the Web Link field for John F. 
Kennedy. Someone browsing your genealogy can then click the link to move to the new page fo

The following is the sequence of steps you take to create a family history page on the We

1. From the Online menu, choose Instant Web Page, or click the Instant Web Page button on
toolbar.

2. Select Family Journal and click OK.

3. Specify the report options and starting individual for your report. The options in the Instant
Page window are similar to the options in the Family Journal report window.

4. Select the Local or Web option in the Destination group as desired.

• Local — Creates HTML files for local viewing and is not meant for the Web. This option om
any email and download links you have configured in the program, and does not archive t
files.

• Web — Prepares the HTML files for uploading to your Web server. This option inserts all U
as configured. In addition to the HTML files, it also creates a compressed file suitable for 
uploading to a Web server. This file has the extension .TGZ. When unarchived on the serv
subdirectories will be created for you and the files placed in the appropriate locations. You
server must have tar and gzip installed. If your Web server does not have these utilities ins
contact your Internet Service Provider’s system administrator.

Figure 6-2: Instant Web Page Window
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Note The MS-DOS compatible TAR.EXE file is provided for working with .TAR and .TGZ
files. From the \UFT directory, type DOTAR and press Enter to see how to use the basic func
tions of TAR with the batch file we have provided. For more in-depth instructions, type TAR and 
press Enter. For a complete reference, please read the TAR.TXT file located in the FG dir

5. Check Hide Living Info to suppress information about living family members. The names o
ing individuals and the connections to their families remain intact; however, birth and deat
years will not be included. The notation (still alive) prints next to the name.

6. Click Options to open the Instant Web Page Options window.

Select any options as described below:

• Parent Images — Checks for images for all main individuals in the report. If found, the image
inserted in the Web page describing the individual.

• Child Images — Checks for images for all children in the report. If found, the image is inser
in the Web page for the individual’s parents.

• Event Images — Checks for images for all events in the report.

• Place Images — Checks for images for all places in the report.

Note To prevent duplication, the preferred image for each event and place is used once 
report, when it is first encountered.

• Project Information — Includes information from the Project Information window in your We
page.

• Link to Palladium Interactive — When checked, creates a link in your Web page that connec
the Palladium home page. Visitors can find out more about genealogy, the Ultimate Family
program, and Palladium Interactive.

• Left Align/Center — Controls placement of images and section titles. Not all browsers supp
centering; some simply ignore it.

Figure 6-3: Instant Web Page Options Window
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• Single File — Creates one large family history Web page. Any graphics, sounds, or GEDC
files are separate.

• Single Directory — All Web page files are created and linked internally for use in a single d
tory.

• Multiple Directories — Select this and specify the maximum number of files you want in ea
subdirectory in the File Per Directory field. Do not enter a number larger than 500. Multiple
directories will be created and used to create the Web page.

• Email Address — Provides your email address. When this field is left blank, your email add
is not included in the Instant Web Page.

• FTP Address for GEDCOM File — Location displayed on Web pages from which a file can b
downloaded via file transfer protocol (FTP).

Note This is an optional way to provide a GEDCOM file for your Family History. Normally
is best to include the GEDCOM file with the Instant Web Page.

7. Click OK.

8. Click the Graphics button in the Instant Web Page window.

9. Select any field and click Browse to find an existing graphics file, or type the names of the
ous sound and graphic files in the appropriate field. Use standard DOS names, for examp
C:\UFT\IMAGES\BULLETS\BLUEDOT.GIF.

10. Select GIF files for each option you want to use, and click OK.

11. Enter a GEDCOM or audio file in the appropriate field for inclusion in the Instant Web Pag

12. Select any field with a graphic entered and click Preview to view the graphic.

Figure 6-4: Instant Web Page Graphics Window
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13. To use an existing graphics template, select one from the Templates drop-down list.

14. To create a new Template to store the selections you have entered, click Modify. To creat
Web page, go to step 18.

15. Enter a name for the Template in the Template Name field.

16. Enter a description of the Template.

17. Click Save to close the window.

Note If you are modifying an existing template, click Update rather than Save. To delete 
template, click Delete.

18. Click OK to return to the Web Page window.

19. Click Save As. Select from the existing list, or enter a name for the Instant Web Page. Ulti
Family Tree creates a subdirectory with the name you have chosen. The main Web page 
named INDEX.HTM.

20. Click OK to create the Web Page.

Figure 6-5: Graphics Template Window

Figure 6-6: Save Web Page As Dialog
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Creating a Descendant Box Chart Instant Web Page
The following are the steps to create a Box Chart Instant Web Page which includes an Indented
Descendant report and a Descendant Box Chart.

1. From the Online menu, choose Instant Web Page.

2. In the Instant Web Page window, click Box Chart.

3. Click the Options button to open the Instant Web Page Options window (see Figure 6-3). 
any of the options as described below. Options not available for the Box Chart Web Page 
dim.

• Project Information — Includes information from the Project Information window in your Web pa

• Link to Palladium Interactive — When checked, creates a link in your Web page that connec
the Palladium home page. Visitors can find out more about genealogy, the Ultimate Family
program, and Palladium Interactive.

• Email Address — Provides your email address. When this field is left blank, your email add
is not included in the Instant Web Page.

• FTP Address for GEDCOM File — Location displayed on Web pages from which a file can b
downloaded via file transfer protocol (FTP).

Note This is an optional way to provide a GEDCOM file for your Family History. Normally
is best to include the GEDCOM file with the Instant Web Page.

4. Click OK.

5. Click the Graphics button to open the Instant Web Page Graphics window (see Figure 6-4

6. Select any field and click Browse to find an existing graphics file, or type the names of the
graphic files in the appropriate field. Graphic options not available for the Box Chart Web P
are dim.

7. Select .GIF files for each option you want to use and click OK.

Figure 6-7: Descendant Box Chart Web Page Window
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8. Enter a GEDCOM or audio file in the appropriate field for inclusion in the Instant Web Pag

9. Select any field with a graphic entered and click Preview to view the graphic.

10. To use an existing graphics template, select one from the Templates list.

11. To create a new Template to store the selections you have entered, click Modify.

12. Enter a name for the Template in the Template Name Field.

13. Enter a description of the Template.

14. Click Save to close the window.

Note If you are modifying an existing template, click Update rather than Save. To delete 
template, click Delete.

15. Click OK to return to the Descendant Box Chart Web Page window.

Generating a Descendant Box Chart Instant Web Page
After setting the options in the Graphics and Options window, you can now generate an Instant
Page from an existing chart or from a new chart. If you have already created an Instant Web Pa
Chart, select the chart name, click Existing and skip to step 10.

1. Click New to create a new chart.

2. Specify the starting individual for your report. Press F10 to open the Find window.

3. Enter a name for the chart (up to 8 characters) in the Chart Name field.

4. Enter a title for the Chart in the Chart Title field.

5. Check Birth/Death Dates to include birth and death years in the report.

6. Check Hide Living Info to suppress information about living family members. The names o
ing individuals and the connections to their families remain intact, however birth and death 
will not be included. The notation (still alive) prints below the name.

Figure 6-8: New Chart Web Page Window
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Note In preparing your Web page, be sensitive to the wishes of other family members wh
may not want certain information to be placed on the Web. Ultimate Family Tree’s Web Pa
Privacy option (Hide Living Info) is designed to protect the privacy of living family members
your Instant Web pages.

7. Specify the generation limit for the report (up to 16 generations) in the Generation Limit fie

8. If you want to limit the report to those individuals in the Grouping list, check Use List in the
Grouping group.

9. Click OK. The chart is generated and opens.

10. With the selected chart open, choose Generate on the menu bar. A Save Web Page As w
opens.

11. Select from the existing list, or enter a name for the Instant Web Page and click OK. Ultim
Family Tree creates a subdirectory with the name you have chosen. The main Web page 
INDEX.HTM, is saved in the subdirectory you have specified.

12. Close the Chart window by clicking the Close box in the upper right corner of the Chart win
and choose Close.

13. Click Close to close the Descendant Box Chart Web Page window.

Editing a Descendant Box Chart Web Page The Box Chart can be edited prior to generating it as
Web page. The contents of each box can be edited while the chart is displayed.

1. From the Online menu, choose Instant Web Page, and then Box Chart.

2. Create a new chart by clicking New, or an existing chart by selecting the chart and clicking
Existing.

3. Double-click a box to select it.

4. Click the Descendant Box Chart Web Page window, the Box Chart button on the toolbar, or
the Reports menu, choose Box Chart to open the Descendant Box Chart window.

5. Click Edit.

Figure 6-9: Chart Edit Window
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6. Insert braces { } around any portion of the data entered in Event Line 1 or 2 to designate i
Event, Hilite. To format that portion of the text use the Font Types toolbar in the Chart wind
These braces do not appear in the report.

7. After making any changes, click OK to return to the Descendant Box Chart Web Page win
Click Close to return to the Box Chart, or simply click on the chart itself.

Note Changes made to the contents of a box are stored with the chart and do not affect 
data in the Project.

Deleting a Descendant Box Chart Web Page

1. From the Online menu, choose Instant Web Page.

2. In the Instant Web Page window, click Box Chart.

3. Select the chart to delete and click Selected in the Delete Chart group or click All to delete
charts.

4. Click Close to close the Descendant Box Chart Web Page window.

Previewing an Instant Web Page
1. From the Online Menu, choose Preview Instant Web Page or click the Preview Web Page 

on the toolbar.

2. Select the Web Page you want to view from the drop-down list.

3. Click OK to view the Web Page. The browser you have set up to work with Ultimate Famil
Tree opens.

4. After viewing the Web Page, exit the browser to return to Ultimate Family Tree.

5. Click Close in the Preview Instant Web Page window.

Note If you did not configure a browser to work with Ultimate Family Tree, a note appear
when you try to preview a Web Page.

Figure 6-10: Preview Instant Web Page Window
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Going Online from Ultimate Family Tree
Before you go online from Ultimate Family Tree, follow these steps:

1. Quit your browser if it is running.

2. Click the Go Online button in the toolbar, or choose Connect to Palladiumnet from the On
menu.

3. Dial your Internet service provider (ISP), manually if necessary.

4. Click OK.

Registering with Palladium Interactive
You must register with Palladium Interactive before uploading your Instant Web Page.

1. From the Online menu, choose Register Online.

2. Click Go Online. Ultimate Family Tree will automatically connect with the Palladium Intera
tive Web site. The program pauses until the connection is made. A registration window ope
user information.

Note Not all browsers will automatically dial your phone and connect to your ISP. If your 
browser does not connect automatically, you must connect to your ISP first. Once your on
session is finished, be sure to disconect from your ISP.

3. Click the Members Only icon.

4. Click the Publishing Your Family History icon, then click Register.

5. Enter a user name. This name becomes part of your personal URL that uniquely identifies
Web page.

6. Enter a password in the password field. Type any characters you want. The password is c
sensitive and cannot include spaces.

7. Enter the password again in the Verify Password field.

8. Click Register. A message appears confirming the password was registered. If the passw
already in use, click Back to return to the registration window and try another password.

Note This procedure registers you with Palladium Interactive to reserve a space for uploa
This is not for registering the program itself. Mail in your registration card or use the Ultim
Family Tree Web site to register your program.



2 4 2  SE C T I O N 6 : Y O U R FA M I L Y  H I S T O R Y O N  T H E  W E B

ur 

 
 

f 
Uploading Your Web Page
After creating a Web page and registering with Palladium, you can upload your Web page to the Palla-
dium Interactive Web site.

1. From the Online menu, choose Upload Web Page, or click the Upload Web Page button on the 
toolbar.

Note Although Ultimate Family Tree builds a compressed .TGZ file when you first create yo
Web page, it updates it from your HTML files just before printing.

2. Read the disclaimer (reprinted below). Click I Accept to accept the terms of the agreement. If
you do not want to see the disclaimer each time you upload a Web page, select that option before
choosing I Accept. If you click I Decline, you will be returned to Ultimate Family Tree.

3. Type the name and password you used to register online with Palladium.

4. Type the title of your family history.

5. Type the author’s name. This is normally your name.

6. Type a short description of the family history.

Figure 6-11:  Palladium Dis claimer

Palladium Interactive Notice
We are pleased that you want to create a “Family Tree” Web page. In order to ensure enjoyment by all of 
our customers, we must establish some basic rules.

Third Party Content In creating your World Wide Web page to be uploaded on the Palladium 
World Wide Web site (“Site”), you may not use any material that is protected by copyright of a third party 
without first obtaining permission from the copyright owner. You, not Palladium, are responsible for any 
damages such as copyright infringement or any other harm that results from Palladium’s use of any items 
submitted by you. You agree to indemnify and hold Palladium harmless from any claims, reasonable 
expenses, or attorneys’ fees relating to any violation of these rules or submission of any material to Palla-
dium. Remember that submission of such material to Palladium for use on the Site grants to Palladium 
the right to use, reproduce, modify, distribute, publicly perform and publicly display such material.

Objectionable or Defamatory Content Users are prohibited from posting or transmitting any 
obscene, hateful, defamatory, racially or otherwise objectionable language, images, software or content o
any kind, including without limitation any material that would constitute libel, slander, defamation, or 
invasions of publicity or privacy of an y third party in any jurisdiction. You will indemnify, defend, and 
hold harmless Palladium and its representatives from any and all losses, claims, liabilities, obligations, 
reasonable expenses or attorneys’ fees which arise in connection with objectionable or defamatory con-
tent in the materials submitted by you.
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Note The title, author’s name, and description are used by Palladium to create an online
catalog of family histories that are available.

7. Click Upload.

Compressing an Instant Web Page
Use this procedure to compress a selected Web page to speed up the uploading process. To co
your Web page you must have first created a Web page.

1. Choose Compress Instant Web Page from the Online menu.

2. Select an existing Web page from the Instant Web Page drop-down list.

3. Click OK.

The Web page is compressed into a .TGZ file. A message appears stating the name of the
file and the directory location. Upload this .TGZ file to your ISP’s Web server.

Figure 6-12: Compress Instant Web Page Window
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Using the multimedia features in Ultimate Family Tree, you can create and enhance family-orie
slide shows, and draw on a library of images, video clips, sounds, and Windows objects through
Object Linking and Embedding (OLE). Images can be scanned directly into the program, edited
cropped, displayed, and included in printed reports. Most image formats are supported, includin
Kodak PhotoCD.

Media (images, audio, and OLE objects) are stored and maintained in the Ultimate Family
Multimedia Library. Once entered in the library, media can be linked to as many individuals, eve
places, sources, and slide shows as you wish. The material is also available to all projects. You
enter information about an image or audio recording once, and use it an unlimited number of tim
any project. Digitized images and audio recordings that are stored in files on your computer can
played, played, or printed.

It is important to note that all media (except referenced) must be digitized for use in Ultima
Family Tree. There are myriad ways in which this can be accomplished, from using media captu
software and graphics programs to image scanners and sound boards.

In this section you will learn how to:

✓ Use referenced and direct media

✓ Use the Multimedia Library

✓ Add images and audio

✓ Scan images

✓ Add OLE files
2 4 5
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✓ Use Microsoft Object Packager

✓ Edit media

✓ Add narrative

✓ Display images

✓ Export a digitized image

✓ Play an audio recording

✓ Preview the Multimedia Library

✓ Create and edit a slide show

Multimedia Library
The Multimedia Library is the repository for all Ultimate Family Tree media files. These files are
added, edited, and deleted from the Multimedia Library window. This window contains detailed 
mation about the images and audio recordings in Ultimate Family Tree projects. You can use th
dow to enter new images and audio recordings, to modify existing media records, to export ima
files, or to delete media records. Once media is stored in the Ultimate Family Tree Multimedia Li
it can be linked to individuals and slide shows.

Adding Direct Media
Direct media are items that are digitized and stored on your hard disk. The three types of direct
are image, audio, and OLE.

Figure 7-1: Multimedia Library Window
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Images Images can be stored in a wide variety of formats, such as bitmaps (.BMP), Aldus TIF
(.TIF), or Joint Photographic Experts Group (.JPG), and can be incorporated into your Ultimate
ily Tree project. When any of these file formats containing 24-bit data are imported into Ultimate
ily Tree, they are compressed using the JPEG specification.

Images can be scanned using a TWAIN-compatible device. A scanned image is an electro
reproduction of a picture or document that you can store in a file on your computer. To scan ima
you must have a scanner and scanner software. Consult your computer dealer for more informa
scanners.

You can also import Kodak PhotoCD pictures into Ultimate Family Tree. Storing your photo
a CD-ROM is a wonderful way to preserve your favorite family photos. A CD-ROM drive is requi
Contact a Kodak processor to have your undeveloped film, old photos, or negatives placed on a
PhotoCD.

Images can be edited and modified. You can also record a narrative that is stored with that
and play it back in any image display window, including Media Tree, Slide Show, Multimedia Lin
and Multimedia Library.

Audio Audio comes from a wide variety of sources including audio CDs, tapes, records, sound
tracks, and voice recordings. When digitized, the audio file must have the extension .WAV. Audi
be played in windows containing images. A sound board is required to record and play back dig
audio.

Object Linking and Embedding OLE is a powerful Windows tool that you can use to create an
object from any type of media, including text, images, video clips, sound clips, and MIDI files, a
place it in Ultimate Family Tree.

To transfer OLE objects to Ultimate Family Tree, you need a program such as Windows O
Packager, found in the Windows Accessory Group. For a more detailed discussion of OLE techn
consult your Windows manual.

1. From the Build menu, choose Multimedia Library.

2. Click New in the Add Media group to open the New media window.

Figure 7-2: New Window



2 4 8 SE C T I O N 7 : M U L T I M E D I A

mage 
down 

ose 
K to 

ld in 
xes.

l print 

ed 

. The 
axi-

0 
ple in 
Open 
w.
3. Select Digitized Image or Audio (.WAV) in the Media Type group.

4. Click File in the Add New Media From group.

5. Select the drive and directory where you placed the image or audio recording file. A list of i
or audio files appears, depending on the File type you select in the List Files of Type drop-
list.

6. Select the image or audio recording you want to add to the library and click OK. If you cho
an image, a preview window opens where you can view the image you are adding. Click O
return to the Multimedia window, or Cancel if you change your mind.

7. In the New media window, enter a unique name (up to 20 characters) in the Ref Name fie
the Media Details group. The Ref Name is required because it is used in the Media List bo

8. Enter a descriptive name (optional) in the Name field. This becomes the title name and wil
below the image in Gallery reports. The descriptive name is limited to 25 characters.

9. Enter the date (optional) for the image (up to 30 characters) in the date field.

10. Enter the location (optional) of the media, for example, the hard drive location for a digitiz
image. Use any description you wish (up to 33 characters).

11. Enter the condition (optional) of the media, such as poor, fair, good, or excellent. Use any 
description you wish (up to 33 characters).

12. Click Caption (optional) to open a text window where you can enter a caption for the image
caption is included below a digitized image when it is printed and should be limited to a m
mum of 50 characters.

13. Click Description (optional) to open an Edit Text window where you can enter up to 65,00
characters of text describing the image. The description can include the names of the peo
the image, the location of the image, or any other information. Click Import to take you to an 
dialog where you can select external text to copy and paste into the Description text windo

Figure 7-3: Open Dialog
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14. Click OK to close the New media window.

15. The Multimedia Library window displays the name you typed in the Name Field in the Me
Library list. Click OK to close this window.

Adding Referenced Media
Much of the media that is important to a genealogist cannot be digitized. Ultimate Family Tree p
vides a way to record, retain, and display a complete reference to this material. Referenced me
records contain information about the identity and location of important external media, from boo
lithographs. You can link these easily accessible records to the appropriate individuals and stor
in the Multimedia Library.

1. From the Build menu, choose Multimedia Library.

2. Click New in the Add Media group. The New window opens.

3. Select Referenced in the Media Type group.

4. Scroll through the list of media types to highlight the type you want to reference.

5. Enter a unique name (up to 20 characters) in the Ref Name field in the Media Details grou
Ref Name is required because it is used in Media List boxes.

6. Enter a descriptive name (optional) for the media in the Name field. This becomes the title 
The descriptive name is limited to approximately 35 characters.

7. Enter a date (optional) for the image (up to 30 characters) in the date field.

8. Enter the physical location (optional) of the media (for example, the album number for a p
graph). Use any description you wish (up to 33 characters).

Figure 7-4: New Window
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9. Enter the condition (optional) of the media, such as poor, fair, good, or excellent. Use any 
description you wish (up to 33 characters).

10. Click Description (optional) to open an Edit Text window where you can enter up to 65,00
characters of text describing the media. The description can include the names of the peo
location of the media, or any other information you wish. Click Import to take you to an Op
dialog where you can select external text to copy and paste into the Description text windo

11. Click OK to close the New Media window.

Scanning an Image into the Multimedia Library
Note You must use a TWAIN-compatible device (such as a scanner) to scan images in 
Ultimate Family Tree.

1. From the Build menu, choose Multimedia Library.

2. Click New in the Add Media group.

3. Select Digitized Image in the Media Type group.

4. Click Scanner in the Add New Media From group to open the Scan window.

5. Click Scan to open the control window supplied by the manufacturer of your TWAIN-comp
ble device and begin scanning.

6. Click OK to close the window.

7. In the New window, enter a unique name (up to 20 characters) in the Ref Name field. The
Name is required because it is used in Media List Boxes.

8. Enter the optional Media Details for your scanned image.

Figure 7-5: Scan Window
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Adding an Existing OLE File in Windows 3.x
OLE objects, constructed from your media, are placed in Ultimate Family Tree. The program us
import OLE objects into Ultimate Family Tree is called the OLE server. The program in which an 
object is placed is called the OLE client. Consult your Windows manual for a more detailed discu
of OLE technology.

1. From the Build menu, choose Multimedia Library.

2. Click New in the Add Media group.

3. Select OLE in the Media Type group.

4. Click OLE in the Add New Media From group to open the OLE window.

5. From the Edit menu, choose Insert Object.

6. In the Insert Object window, select the object type and click File.

7. Change to the drive and directory that contain the file you want to add.

8. Select the file and click Insert. An OLE window opens with an icon representing the objec

9. Close the OLE window by double-clicking on the close box.

Figure 7-6: Insert Object Dialog

Figure 7-7: Insert Object from File Dialog
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steps:
10. In the New Media window, enter a unique name (up to 20 characters) in the Ref Name file

11. Enter the optional Media Details for the OLE file.

12. Click OK to close the window.

Adding an Existing OLE File in Windows 95 or Windows 3.x
1. From the Build menu, choose Multimedia Library.

2. Click New in the Add Media group.

3. Select OLE in the Media Type group.

4. Click OLE in the Add New Media From group to open the OLE window.

5. From the Edit menu, choose Insert Object.

6. In the Insert Object window, select the object type and click OK to open a server window fo
type you have chosen.

7. Carefully follow the instructions shown in the window. These instructions vary according to
individual server. When you close the server window, an icon appears in the OLE window.

8. Close the OLE window by double-clicking the close box.

9. In the New Media window, enter a unique name (up to 20 characters) in the Ref Name file

10. Enter the optional Media Details for the OLE file.

11. Click OK to close the window.

Note Some OLE servers (such as Windows Media Player) interfere with Ultimate Family
Tree. If the computer locks (freezes) when exiting Windows, press Ctrl+Alt+Del to reboot y
system. To prevent this problem, use Object Packager to link OLE objects.

Using Microsoft Object Packager with Ultimate Family Tree
Object Packager is a Windows program that converts images, text, video clips, and sounds to O
objects that can be linked to Ultimate Family Tree. Object Packager is located in the Windows A
sories Group in Windows 3.x. It is located in the Windows folder in Windows 95. Read the Object 
Packager online help to learn about its many capabilities.

Objects can be connected to Object Packager in one of two ways:

• Start Object Packager and choose Import from the File menu to import a file that can be e
ded in Ultimate Family Tree.

• Choose Paste from the Edit menu to link an object from a server where you have previous
ied that object to the clipboard.

The following procedure shows how to use Object Packager. It assumes that you have prev
installed Video for Windows on your system. Modify the instructions for the type of OLE object y
want to use. To link a video clip to Ultimate Family Tree through Object Packager, follow these 
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1. Start Media Player from the Accessories Group or type media player in the Run window in 
Windows 95.

2. Choose Video For Windows from the Device Menu. The Open dialog is displayed.

3. Choose an AVI file from the file list, and then click Open (or OK in Windows 3.1).

4. Choose Copy Object from the Media Player Edit menu.

5. Exit Media Player.

6. Start Object Packager by typing packager in the Run window in Windows 95.

7. From the Edit menu, choose Paste.

8. From the Edit menu, choose Copy Package.

9. Exit Object Packager.

10. Start Ultimate Family Tree.

11. From the Build menu, choose Multimedia Library.

12. Click New in the Add group.

13. Select the OLE Media Type radio button.

14. Click OLE in the Add New Media From group.

15. From the Edit menu, choose Paste.

16. Close the OLE Import window.

17. Type a reference name for the clip and any other information you wish.

18. Click OK.

Figure 7-8: Multimedia Library Window
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The Video For Windows clip has now been linked to Ultimate Family Tree. To play this vide
clip, double-click its name in the Media Library list in the Multimedia Library window.

Copy and paste static objects, such as text or graphics, into Object Packager and embed 
Ultimate Family Tree using similar steps. The embedded objects can then be used in slide show
linked to individuals.

Paste Special Use the Paste Special menu option to link or embed an OLE object on the clipboa
the Multimedia Library. The object retains the formatting and other characteristics it had in the a
cation that created it. For example, you can copy part of a Microsoft Excel spreadsheet and pas
an object into Ultimate Family Tree. You can then double-click the object to open it in Excel, and
or print the object.

The Paste Special menu option is not available until you copy the object you want to paste
use Paste Special, select information from the source document or application, and then use th
command from the Edit menu to place it on the clipboard.

The Paste Special dialog contains the following options:

• Source area — Displays the application, directory, and file you are pasting from.

• Data Type list — Displays the available formats for the object. Select the format for the obje
you are pasting according to what you want to be able to do with the stored object in Ultim
Family Tree. Use Object format to edit the object by opening its source application from U
mate Family Tree. Choose picture or bitmap formats to display the object and minimize th
space it occupies in Ultimate Family Tree. If you plan to change the size of the object, cho
the Picture format. If an object has a picture or bitmap format, you cannot edit it from Ultim
Family Tree.

• Paste — Embeds the object from the clipboard into the OLE Edit window.

• Paste Link — Links the object with Ultimate Family Tree as the destination so you can mod
the linked object in Ultimate Family Tree.

• Cancel — Exits the dialog without taking action.

To use Paste Special, follow these steps:

1. Copy to the clipboard the information from the server you want to embed or link.

2. Return to or open Ultimate Family Tree.

3. Click New in the Multimedia Library window.

4. Select OLE in the Media Type list.

5. Click OLE in the Add New Media From group.

6. From the Edit menu, choose Paste Special. The Paste Special dialog appears.

7. From the Data Type list, select the format you want to use.

8. Click the Paste button to embed the object or the Paste Link button to link it.
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Note Depending on the application used to create the object, or whether the object is in 
saved document, the Paste Link button may not be available.

9. Close the OLE window.

Editing an OLE File You can’t edit OLE objects in Ultimate Family Tree. They are edited using 
software program in which they were originally created. Objects that are embedded cannot be e

1. From the Build menu, choose Multimedia Library.

2. Select the OLE object you want to edit from the Media Library list.

3. Click Edit in the Image Group. The OLE window opens.

4. From the Edit menu, choose Object.

Note If you choose Clear from the Edit menu, you clear the OLE object from the window 
remove it. Choose Convert to Static to break the link between an object and its server.

5. The program in which the OLE object was created opens, and you can edit the object.

6. To exit that program, choose Exit and Return from the File menu.

Editing an Existing Digitized Image
Images can be edited in various ways. You can rotate the image and change brightness, contra
sharpness. You can convert an image to gray or negative, and crop it. Additionally, you can add
tive for the image. If you want, you can save the edited image to a new file, and export it to any
patible image type. In Ultimate Family Tree you can compress 24-bit images and set image qua
level.

1. From the Build menu, choose Multimedia Library.

2. Select the digitized image you want to edit from the Media Library list.

3. Click Edit in the Image Group.

4. Choose any of the options listed in the Image field.

Figure 7-9: Paste Special Dialog
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Note Image options are not available for all image types. Sharpness can be used for gray
images, but not for color images or line drawings. If you choose an image function that doe
apply to the current image, you’ll see the message, Format not allowed.

5. Click Zoom In to magnify or crop the image.

6. Click Zoom Out to shrink the image.

Note The zoomed view is saved when you close the window by clicking OK. Use Zoom a
the scroll bars to crop the image.

7. Click Full to view the entire image.

8. Click Undo to return the image to its original appearance.

9. Click Record Narrative to open the Windows Sound Recorder where you can record a nar
for this image.

10. Click OK to close the window. In the Save window click Cancel if you do not want to save 
changes, or click OK to save the changes. To confirm, click OK to continue, or Cancel to r
to the Save window to make the name changes.

If you want to save the original image and at the same time save the newly edited image, 
these steps:

1. Enter a different Reference Name for the newly edited image.

2. Enter a different Descriptive Name (optional). The descriptive name is limited to approxim
35 characters.

Figure 7-10: Edit Window
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3. Click Caption and Description (optional) to edit or enter a new caption and description for
image.

4. Click OK to save the changes in a file with the new file name.

The edited image title will appear in the Media Library list.

Adding Narrative
The narrative can be played in various view windows, preview windows, slide shows, and the In
ual Record Media window. Before you can use Sound Recorder, you must use the Windows Co
Panel to install and configure the appropriate device driver and sound hardware. See your Wind
manual for more information.

1. To record a narrative for a selected image, from the Build menu, choose Multimedia Libra

2. Select the digitized image for which you want to add narrative from the Media Library list.

3. Click Edit in the Image Group.

4. Click Record Narrative to open the Windows Sound Recorder where you can record a nar
for this image.

Note To use an existing .WAV file rather than recording a new narrative, choose Insert Fi
from the Sound Recorder’s Edit menu. Select the file you want as the narrative and click O
Choose Exit & Return from the File menu.

5. Click OK to close the window.

Note If you minimize rather than close Sound Recorder, or click the mouse anywhere on
desktop, the Image Edit window will not be active. Press Escape to close Sound Recorde
activate the Image Edit window.

Deleting Media
1. From the Build menu, choose Multimedia Library.

2. Select the media you want to delete from the Library list on the left.

3. Click Selected in the Delete Media group to delete the selected media or click All to delete
media from the Multimedia Library.

4. Click OK to delete the selected media or Cancel to return to the Multimedia window.

Note After deleting media, choose Project, Pack from the Utilities menu to permanently 
remove the deleted records and reduce the disk space used.

Displaying a Digitized Image
1. From the Build menu, choose Multimedia Library.

2. Select the digitized image you want to view from the Media Library list.
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3. Choose Display in the Image group.

4. Use the Zoom In/Out and Full buttons to view the image.

5. Play any audio attached to this image by clicking Narrative.

6. Add a caption for the image, or any descriptive text, in the appropriate fields.

7. If you want to export the image to an External file, click Export.

8. Click Close to return to the Multimedia Library window.

Note The resolution of your computer display adapter and monitor directly affects the qu
of the images you display. Resolution is determined by the number of pixels on the monito
the number of colors per pixel. An SVGA monitor, having 480 ´ 640 pixels and 256 colors is the
minimum recommended configuration for displaying images. Image quality improves dram
cally as the number of pixels and color depth increase.

If you are using a system that is limited to 256 colors, configure Ultimate Family Tree to us
Windows Colors option.

Exporting a Digitized Image
You can export a digitized image to use in other programs. Follow these steps to export an imag
the Multimedia Library window:

1. From the Build menu, choose Multimedia Library.

2. Select the digitized image to be exported from the Media Library list.

Figure 7-11: Display Window
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3. Click Display in the Image group.

4. Click Export.

5. Select the file type for the image you wish to export. Image file types include:

• BMP — Microsoft, up to 16.7 million colors (24 bits)

• GEM IMG — Digital Research, 16 colors (4 bits)

• JPG — Joint Photographic Experts Group, 16.7 million colors (24 bits)

• PCT — Apple Computer, PICT, 16.7 million colors (24 bits)

• PCX — ZSoft, 16.7 million colors (24 bits)

• TGA — Truevision, TARGA, 16.7 million colors (24 bits)

• TIF — Aldus TIFF, 16.7 million colors (24 bits)

Note Valid file types are in the File Type list. If a type is dim, it is because the file type is 
incompatible with the Ultimate Family Tree image. For example, a 24-bit format, such as .B
cannot be saved in an 8-bit format such as .GIF.

6. Click Save.

7. Enter a file name in the Save As window. Ultimate Family Tree adds the file extension.

8. Change to the drive and directory into which you wish to export the image.

9. Click Save, or Cancel if you do not want to save changes.

10. Click Close to close the Display window.

Note It is possible for several media libraries to be used, depending on the Ultimate Fam
Tree project. If you open a ROOTS IV project with Ultimate Family Tree, the ROOTS IV me
library is used. Photos contained in the ROOTS IV library can be exported to an external fi
then imported into an Ultimate Family Tree project.

Playing an Audio Recording
1. From the Build menu, choose Multimedia Library.

2. Select the audio (.WAV) recording you want to hear from the Library list.

3. Click Audio in the Play group.

Previewing the Multimedia Library
The Preview window displays media stored in the Multimedia Library. The media files are displa
in a slide format, up to eight at a time, with their control names.
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1. From the Build menu, choose Multimedia Library, and then click Preview in the Library gro
to view all media stored in the Multimedia Library.

2. Click the name under the slide in order to view the image in a larger format or play the reco
or OLE object.

3. Click the More>> button to view any additional media.

4. Click the <<More button to return to the previous window.

5. Click Close to return to the Multimedia Link or Multimedia Library window.

Linking Media
You can link an unlimited number of images, audio recordings, or objects to an individual.

1. Click the More button in the Individual Record window, and then the Media tab to open the
Multimedia Link window.

2. Make sure the name of the desired individual appears at the top of the window and click Ex
Media from the Add Media Link group.

3. If a Note window appears, click OK to open the Media Select window.

4. Click Multimedia Library in the Media Source group to add existing media found in the Mu
media Library.

Figure 7-12: Multimedia Link Window
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Note If you wish to add media which is linked to another individual or an existing slide sh
choose the appropriate option in the Media Source group. A list of individuals or slide sho
will open depending on your choice. Select the individual or slide show from the list and click

5. Select the media you want from the Media Library list.

6. Click Add or double-click the media to move the selected media to the Linked Media list.

7. Click Add All to add all media to the Linked Media list.

8. Click Remove to remove selected media from the Linked Media List or Remove All to rem
all linked media from the list.

Note A description of the media is displayed in the Description box if a description was 
entered in the Multimedia Library window.

9. Click OK to save and close the window.

Note The Insert button is active only when adding media to a slide show.

Selecting a Preferred Image for Display
You can link more than one image to an individual, event, place, or source. Ultimate Family Tree
you the option of selecting an image as the preferred one that will appear in the Media Tree, Fa
Tree, Family, and Descendant windows. Preferred images for individuals, events, and places ca
included in a Family Journal Instant Web Page Report.

1. Click More, and then the Media tab, in an Individual Record window to open the Multimed
Link window for that individual.

or

Click Media to open the Multimedia Link window from the Place Record, Event Record, or
Advanced Editing Mode Source Record window.

2. From the Multimedia Link window, select the image you want as the preferred image and c
the Preferred Image box.

Note OLE objects and audio files cannot be preferred images.

Adding New Media to an Individual
1. Click More, and then the Media tab in the Individual Record of the person to whom you wa

add media.

2. In the Multimedia Link window, click New Media to open a New media window.

3. Select Digitized Image or Audio (.WAV) in the Media Type group.

4. Click File in the Add New Media From group.
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5. Select the drive and directory where you placed the image or audio recording file. A list of i
or audio files appears in the Add Image File box, depending on the media type you select
the Multimedia window.

6. Select the image or audio recording you want to add to the library and click Open. If you ch
an image, a preview window opens where you can view the image you are adding. Click O
return to the Multimedia window or Cancel if you change your mind.

7. In the Multimedia window, enter a unique name (up to 20 characters) in the Ref Name fiel
under the Media Details group. The Ref Name (Reference) appears in the Media List box
This reference is required.

8. Enter a descriptive name for the media in the Name field. This becomes the title name. Th
descriptive name is limited to 25 characters (optional).

9. Enter the free-form date for the image (up to 30 characters) in the date field (optional).

10. Enter the physical location of the media, for example, the hard drive location for a digitize
image, or the album number for a photograph. Use any description you wish, up to 33 char
(optional).

11. Enter the condition of the media, such as poor, fair, good, or excellent. Use any description you 
wish, up to 33 characters (optional).

12. Click Caption to open a text window where you can enter a caption that is included below
itized image when it’s printed. The caption should be limited to 50 characters or less (optio

13. Click Description to open an Edit Text window where you can enter up to 65,000 characte
text describing the image. The description can include the names of the people in the ima
location of the image, or any other information. Click Import to take you to an Open dialog
where you can select external text to copy and paste into the Description text window (opt

14. Click OK to close the New Media window.

15. Click OK to close the Multimedia Link window.

Unlinking Media from a Record
1. Click the More button, and then the Media tab in the Individual Record of the person from

whom you want to unlink media. Click the Media button in the Event Edit, Place Record, o
Advanced Edit mode Source Record to open the Multimedia Link window for that record.

2. Make sure the name of the individual, place, source, or event appears at the top of the wi
and from the Multimedia Links list, select the media you want to unlink.

3. Click Selected in the Delete Media group to unlink the selected media, or click All to unlin
media from the record.

Note The Delete Media buttons do not delete the media from the Multimedia Library. The
buttons merely unlink the media from the selected record.

4. Click OK to unlink the media.
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Viewing Images Linked to a Selected Record
1. Click the More button, and then the Media tab in the Individual Record to open the Multim

Link window. Click the Media button in the Event Edit, Place Record, or Advanced Edit mo
Source Record to open the Multimedia Link window for that record.

2. Select the image you want to view in the Multimedia Links list.

3. Click Image in the Play group.

Playing Audio/OLE Recordings Linked to a Selected Record
1. Click More, and then the Media tab in the Individual Record to open the Multimedia Link win

2. Highlight the Audio or OLE recording in the Multimedia Links list.

3. Click Audio/OLE in the Play group.

Viewing All Media Linked to a Selected Record
1. Click More, and then the Media tab in the Individual Record to open the Multimedia Link w

dow. Click the Media button in the Event Edit, Place Record, or Advanced Edit mode Sour
Record to open the Multimedia Link window for that record.

2. Click Preview to view all media linked to the record in a slide show style. Each image or s
icon is displayed with its control name.

3. Select the name on the slide to view the image or play the recording or OLE object.

4. Click the More>> button to view any additional media.

5. Click the <<More button to return to the previous window.

6. Click Close to return to the Multimedia Link window.

Slide Shows
One of the most exciting features of Ultimate Family Tree is the ability to create a slide show pre
tion using the image and audio files stored in the Multimedia Library. You can also add a voice-o
narration to each slide.

To better understand how to set up a multimedia slide show, note the following:

• Slides can contain digitized images, audio files, or OLE objects. The slides are shown seq
tially during a slide show. Digitized images are shown for a length of time that is set for ea
slide. Background music from a MIDI OLE server can also be included with the slide show
depending on the server.
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• Voice-over narrations are played with their associated digitized image. Slides following a d
tized image that contain audio files are then played while the digitized image is displayed.
adapt narrations to the current slide show, arrange slides in the proper order.

Note OLE images can not play in the slide show without activating the server.

Creating a New Slide Show
1. From the Build menu, choose Slide Show.

2. Click New in the Add Show group.

3. Enter a name in the Show Name field. This required name appears in the Slide Show list.

4. To add slides, click Existing or New in the Add Slide group. If you click Existing, continue w
step 5. If you click New, see “Adding Direct Media” on page 246.

5. Click Multimedia Library in the Media Source group. Use the Selected Individual option to
select media items linked to an individual. Use Slide Show to create a new slide show from
existing slide show. In the Media List, highlight the media you want to include.

6. Click Add or Add All.

7. Repeat steps 5 and 6 until all media you want to add to the slide show has been linked.

Note Click the Remove and Insert buttons to arrange the slides in the order in which you
them to be displayed. The Remove button unlinks a selected file from the slide show. The 
button inserts a selected file above a highlighted item in the Linked Media list.

8. Click OK to return to the Slide Show window.

Figure 7-13: Slide Show Window
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9. Highlight a slide in the Selected Show list and set the time (in seconds) that you wish the s
play. Repeat this for each slide.

10. To view or hear any of the slides or view the complete slide show, click any of the following
tons in the Play group:

• Image — Displays the selected image.

• Audio/OLE — Plays the selected audio (.WAV) or OLE file.

• Slide Show — Displays the entire slide show.

• Preview — Displays all linked slides (up to 8 at one time) for the selected slide show.

Editing an Existing Slide Show
1. From the Build menu, choose Slide Show.

2. Highlight the slide show you wish to edit and click any of the buttons in the Add Slide, Mov
Slide, or Delete Slide groups to add new slides, change the order that the slides display, o
remove slides from the slide show.

3. Click OK to save changes and close the window.

Figure 7-14: Media Select Window
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Adding all Media Linked to an Individual to a Slide Show
You can create slide shows about several different people by adding all media linked to an indiv
to a new or existing slide show.

1. From the Build menu, choose Slide Show.

Note To create a new slide show, follow the steps in “Creating a New Slide Show” on 
page 264.

2. Highlight the slide show to which you want to link an individual’s linked media and click Ex
ing in the Add Media group.

3. In the Media Select window, click Selected Individual from the Media Source group. A Can
date Individuals window opens listing all individuals within the project with linked media.

4. Select the individual whose linked media list you want to use and click OK to open the Me
Select window. The media linked to the selected individual is listed in the Media list.

5. In the Media List, highlight the media you want to include.

6. Click Add, or Add All.

7. Repeat steps 5 and 6 until all media you want to add to the slide show has been linked.

Note Click the Remove and Insert buttons to arrange the slides in the order in which you
them to be displayed. The Remove button unlinks a selected file from the slide show. The
button inserts a selected file above a highlighted item in the Linked Media list.

8. Click OK to return to the Slide Show window.

9. Highlight a slide in the Selected Show list and set the time (in seconds) that you wish the s
play. Repeat this for each slide.

10. Click OK to close the Slide Show window.

Figure 7-15: Candidate Individuals Window
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Adding an Existing Slide Show to a Slide Show
1. From the Build menu, choose Slide Show.

Note To create a new slide show, follow the steps in “Creating a New Slide Show” on 
page 264.

2. Highlight the slide show into which you want to link another slide show and click Existing in
Add Media group.

3. In the Media Select window, click Slide Show from the Media Source group. A Candidate S
Show window opens listing all existing slide shows for the current project.

4. Highlight a slide show and click OK to open the Media Select window with the list of medi
linked to the selected slide show displayed.

5. In the Media List, highlight the media you want to include.

6. Click Add, or Add All.

7. Repeat steps 5 and 6 until all media you want to add to the slide show has been linked.

Note Click the Remove and Insert button to arrange the slides in the order in which you 
them to be displayed. The Remove button unlinks a selected file from the slide show. The 
button inserts a selected file above a highlighted item in the Linked Media list.

8. Click OK to return to the Slide Show window.

9. Highlight a slide in the Selected Show list and set the time (in seconds) that you wish the s
play. Repeat this for each slide.

10. Click OK to close the Slide Show window.

Slide Shows and OLE
OLE objects can be used in Ultimate Family Tree slide shows. For example, you can link and p
Video For Windows clip as part of a slide show. One interesting source of video clips is Microso
Encarta, which includes many historical video clips. Copy the .AVI files you want to use from the
Encarta CD-ROM to your hard disk. The CD-ROM need not be present when you want to play t
slide show. Be aware that video clips can be very large, and consume a significant amount of sp
your hard disk. Use Object Packager to integrate video clips with Ultimate Family Tree because
conflicts some video servers create.

Note Some OLE servers (such as Windows Media Player) interfere with Ultimate Family
Tree. If Windows locks (freezes) when you exit, press Ctrl+Alt+Del to reboot your system.
prevent this problem, use Object Packager to link OLE objects. See “Using Microsoft Obje
Packager with Ultimate Family Tree” on page 252.

If you want to use a static object in a slide show, such as a drawing created with PC Paint
use the Convert to Static option (active when editing an OLE object in the Multimedia Library w
dow) on the Ultimate Family Tree Edit menu. Convert to Static breaks the link between an objec
its server. When the object is then played in a slide show, the server is not activated.
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You might want to activate the server during a slide show. For example, you can display a
ment produced in a word processing program, or a presentation from another source (such as 
Freelance), as part of a slide show. To keep the server active (rather than being closed by Ultim
Family Tree), set the Seconds to 999 for that slide in the Build Slide Show window. The slide will
be shown until you close the server.

With a few exceptions, only one OLE object and server can be active at one time in Ultima
Family Tree. This restriction is important if you wish to play music as the background of a show. M
music objects can be linked to Ultimate Family Tree and played in a slide show, but if a new ser
activated while the music is playing, the new server overrides the one playing the music, and the
stops.

Play MIDI music in the background for a slide show that consists of digitized images that d
have narratives. Be sure to turn off the sound effects option. Narratives and sound effects are O
objects, and they will stop the music.



Section 8:

Managing Your Data
at, 
In this section you will learn how to:

✓ Merge projects

✓ Import data from another program (GEDCOM or ROOTS III)

✓ Export data from Ultimate Family Tree to another program

✓ Save a project

✓ Backup (archive) a project

✓ Restore an archived file

✓ Split a project

✓ Delete an individual from a project

✓ Combine individuals, places, and sources

✓ View project information

✓ Set desktop preferences (clock, messages, date format, toolbar, image quality, name form
Windows colors, and wallpaper)

✓ Create macros

✓ Use Tombstone Calculator
2 6 9
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✓ Access external programs

✓ Pack a project

✓ Use Check and Repair

✓ Reindex a project

✓ View a GEDCOM Exceptions List

✓ Open external text files

✓ Exit Ultimate Family Tree

Merging Projects
At some point you may want to combine one project with another.

Note You cannot merge projects that use different library files. To combine two projects t
use different library files, use GEDCOM. If you’re using Visual ROOTS, ROOTS IV, ROOTS
or Family Gathering, see Appendix B, “Using ROOTS, Family Gathering, and Ultimate Fam
Tree Together.”

1. Open the project into which you want to merge a second project.

2. Choose Open from the File menu to open the second project.

3. Select Ultimate Family Tree Project from the File Type drop-down list.

4. Select the drive and directory where the second project is located. Select the project nam
the file list. Click OK to open the specified project. The Project Merge Options window ope

5. Enter the starting individual record number for the merged records. It can be the next ava
record number, which appears automatically, or any higher number you choose. The Next
able Record Number displayed in the Project Merge window is the highest record number
in the original project, plus 1. Note that gaps will occur in the numbering of the merged rec
if gaps are present in the records of the project that is being merged.

Figure 8-1: Project Merge Options Window
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6. Click Proceed to merge the two projects. (If you change your mind, click No Merge. Clicki
No Merge closes the first project and opens the second one.)

7. A message appears stating, “The two projects you have specified will be merged if you pro
The original project will contain records from both projects. The second project will not be
changed. Click Proceed to continue or Cancel if you do not want to merge the two project

Note If you merge two projects, duplicate individuals are not combined. Manually combin
any duplicates. See “Combining Records” on page 288.

Data from Another Program
Ultimate Family Tree can import GEDCOM data from any software program that is GEDCOM 
compatible.

Important Note about GEDCOM
The GEDCOM (Genealogical Data Communications) standard defines a set of rules that allow 
grams to exchange genealogical information. The GEDCOM standard has been changed consi
since it was first introduced in 1984, and continues to evolve. Versions of the GEDCOM standard
released in October 1987 (v3.0) and August 1989 (v4.0). Versions 1 and 2 were drafts for public
cussion and were not established as standards. The Family History Department of the LDS Ch
released the latest GEDCOM standard draft proposal, Version 5.5, in December 1995. It addres
improvements in the treatment of sources and user-defined events.

Ultimate Family Tree GEDCOM is designed to conform as closely as possible to Version 5
with substantial support for the features in Version 5.5.

The GEDCOM standard, while providing an excellent starting point, can be interpreted dif
ently by software designers, resulting in incompatibilities. For this reason, the export and impor
GEDCOM information must be approached with caution. You might need to edit or update infor
tion that is not correctly converted. While tools are provided in Ultimate Family Tree to help with
process, it is extremely important to check all information imported to Ultimate Family Tree for e
and omissions. It is also important to alert those receiving a GEDCOM file from Ultimate Family 
(or any advanced genealogy software) of the possibility of these problems.

Importing a GEDCOM File
Ultimate Family Tree imports GEDCOM files that use the ANSEL and IBM-PC character sets.

1. From the File menu, choose Open.

2. In the File Type drop-down list, select GEDCOM Import.

3. Select the drive and directory where the .GED file can be found.
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4. Select the GEDCOM file to be imported and choose OK. The Import from GEDCOM Optio
window will open.

The following options are unique to the Import From GEDCOM Options window. For more infor
tion, see “Common GEDCOM and ROOTS III Import Options” on page 276.

Note If the incoming GEDCOM is Event 1.0, some options will be disabled.

Text Destination: Individual

• Biographical Text — Converts text notes attached to individuals to the Individual Biographic
Text window of the Individual Record window.

• Footnote — Converts text notes attached to individuals to the Individual Footnote Text field
the Individual Record window.

Figure 8-2: Open File Window

Figure 8-3: Import from GEDCOM Options Window
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• Research Notes — Converts text notes attached to individuals to the Individual Text Resear
Note window of the Individual Record window.

Text Destination: Event

• Research Notes — Converts text notes attached to events to the Event Text Research Note
dow of the Individual Record window.

• Text — Converts text notes attached to events to the Event Text window of the Individual Re
window.

• Footnote — Converts text notes attached to events to the Event Text Footnote window of t
Individual Record window.

Other Group

• Assume Marriage When Family — Select this option if your previous genealogy program doe
not distinguish between family records and marriage records, but instead uses a FAM tag
the case of the PAF (Personal Ancestral File) program. If selected, Ultimate Family Tree c
a marriage record for all couples with a FAM tag.

• Remove Carriage Returns from Text — Select this option to remove carriage returns from tex
notes and allow Ultimate Family Tree to correctly wrap text.

• Retain Original Record Numbers— Select this option if your GEDCOM file supports the 
NUMB tag for individual record numbers. This option retains the record number from the p
ous program in Ultimate Family Tree. If the conversion finds an individual without a NUMB 
a message warns you that if you proceed, record numbers will be unreliable. If you procee
individuals with NUMB tags receive the original record number, and those without a NUMB
receive the next available record number. Click Cancel to abort the conversion.

• Add to Open Project — Select this option to merge the GEDCOM file into the current Ultima
Family Tree project. If no Ultimate Family Tree project is open, the Add to Open Project op
is dim. In this case, cancel the Options window and open the project into which you want 
merge the new project before you import.

• Convert BOSTON, MA to Boston, Ma — Select this option if your file has place names in all 
uppercase and you want to convert the places to upper/lower case. Additional editing may
required if you choose this option. For example, BOSTON, MA will be converted to Boston, Ma 
and you may want to change Ma to MA or Massachusetts.

5. Click OK when you have made your option choices.

6. In the Save As Dialog Box, enter a file name for the project, with the extension .PRO.

7. Select a different drive and directory if you want. Use the PROJECTS subdirectory or a su
rectory other than the UFT directory.
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8. Click OK to start the conversion. When the GEDCOM conversion is complete, a message 
the conversion time in minutes and the number of exceptions. An exception is data that did not 
convert from the GEDCOM file to the Ultimate Family Tree project. See “Viewing GEDCO
Exceptions” on page 309.

9. Press any key on the keyboard or move the mouse to remove this message.

10. Enter the appropriate data in the Project Information window.

11. Click OK to close the Project Information window.

Note If you import an Event 1.0 GEDCOM file that includes media, any OLE or .WAV file
become referenced media. Only digitized images are imported in their true form and can b
viewed in Ultimate Family Tree.

Importing From ROOTS III
You can easily convert a ROOTS III database (familyname.EDB) for use in Ultimate Family Tree. 
Because of the size of temporary files created during the conversion, the .EDB file should be lo
on your hard drive before attempting the conversion.

Note If you want to include ROOTS III text (.TXT and .SRC) files, they must be located in
same directory as the .EDB file before converting.

1. From the File menu, choose Open.

2. In the File Type drop-down list, select ROOTS III Basefile.

3. Select the drive and directory where the .EDB file can be found.

4. Select the .EDB file to be converted and click Open. The Import from ROOTS III Options w
dow opens.

5. Choose the options you want.

Figure 8-4: Save As Window
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The following options are unique to the Import from ROOTS III Options window. For more inform
tion, see “Common GEDCOM and ROOTS III Import Options” on page 276.

• Convert Large Basefile — Select this option if the basefile you are importing contains more th
10,000 individuals.

• Translate Text Formatting — Select this option to convert ROOTS III dot commands to Ultima
Family Tree formatting commands. The following commands are not supported in Ultimate
Family Tree:

.. Remarks

.i Print line and set temporary indent

.# Set blank space

.e Blank page

.n Normal left margin

.s Superscript

• Translate Address Labels — Select this option if you created mailing labels in the Resides fie
in ROOTS III and you want them directed to the Ultimate Family Tree mailing label fields. 
caret (^) must be present in the ROOTS III Resides Detail Footnote for the address to be 
rected to the Ultimate Family Tree Mail Label window.

• Ignore Blank Events I3–6 & M2,3 — Select this option if you have events that are defined bu
not used in lines 3, 4, 5, or 6 of Individual Edit Records and lines 2 and 3 of Marriage Reco
ROOTS III. ROOTS III individual records have six fields for events, while marriages have th
If these fields are not used, they are considered blank events. To prevent them from being
imported into Ultimate Family Tree, select Ignore Blank Events. This prevents Ultimate Fa
Tree from creating events for an individual when they did not occur. An event is not consid
blank if it has at least a date, place, or footnote.

• Include “Ref” Text Files — Include text files that are named using the reference field.

For more information, see “Common GEDCOM and ROOTS III Import Options” on page 2

6. Click OK.

7. In the Save As Dialog Box, enter a file name for the new project, with a .PRO extension.

Figure 8-5: Import from ROOTS III Options Window
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8. Click OK to start the conversion.

9. When the conversion is complete, enter the appropriate data in the Project Information wi

10. Click OK to close the Project Information window.

For more technical information on how data in ROOTS III is converted to Ultimate Family T
see the Appendix, Notes for ROOTS III Users.

Importing Unrecognized Events Events in ROOTS III for which you either created your own leg
end (for example, identifying name) or used the Extra event legend, transfer into Ultimate Family T
with the characters #R3 directly in front of the event name (for example, #R3Name). Events from other 
genealogy programs that are not recognized by Ultimate Family Tree transfer with the # character in 
front of the event name.

When transferred, these events have a generic role text and do not include GEDCOM tags
will not be included in GEDCOM exports. To transform them into fully recognized and useable e
records within Ultimate Family Tree, you should edit the Event and Role Template for each of th
unrecognized events. See “Adding New Roles to an Event Template” on page 52.

Common GEDCOM and ROOTS III Import Options
Names

• Convert AL SMITH to Al Smith — Select this option if your GEDCOM file has names in all 
uppercase and you want to convert the names to upper/lowercase.

• Smith, Al to Al Smith — Select this option if your GEDCOM file has names entered as surna
given name, and you want to reverse them to given name before surname.

Note Additional editing may be required if you choose either of these options. If you use 
case conversion option, MCLEAN is converted to Mclean, but you may want it to be McLean. If 
the reverse surname option is used, Smith, Al Jr. is converted to Al Jr. Smith.

Free Date Format Select one of the four free-form date options. This converts dates in the 
GEDCOM file to the format selected and places them in the free-form date field of the Individua
Record window. The free-form date prints on unstructured reports such as the Genealogy Repo

You can edit free-form dates in the Individual Record window at any time. Free-form date 
options include:

• Month, day, year March 3, 1908

• Day, month, year 3 March 1908

• Day, abbreviated month, year 3 Mar 1908

• Day, abbreviated all caps month, year 3 MAR 1908

Note It is important to select the appropriate date format to ensure that Ultimate Family T
enters dates correctly. If you do not choose the correct date format now, you must manua
change dates later.
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• Build Footnotes — Select this option if you want Ultimate Family Tree to automatically crea
the footnote text that is to print on reports, such as the Genealogy Format Report.

Note The Build Footnote process increases the time required to convert a file, depending
the number of footnotes in your GEDCOM or ROOTS III database. If you do not choose to 
footnotes, evidence and sources are imported and can be converted to footnote text later. Y
also rebuild footnotes using the Check window opened from the Utilities, Project menu.

• Include Last Changed Date — Select this option if your GEDCOM file supports the CHAN ta
for the Last Edit Date for individual records. This date is placed in the Research Note text 
dow in the Individual Record window.

Importing GEDCOM from Family Tree Maker for Windows
If your family’s data has been stored in Family Tree Maker for Windows (v2 or v3), here’s how to
transfer it to Ultimate Family Tree:

1. In Family Tree Maker, from the File menu choose Copy/Export Family File.

2. In the File Format drop-down list, select GEDCOM (*.GED). Make a note of the file to whi
you are saving the data. Click the OK button.

Figure 8-6: GEDCOM and ROOTS III Import Options Windows
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Note If you receive an error message that the file already exists, click OK, type an unuse
name in the File Name box and click OK again.

3. In the Export to GEDCOM dialog, make the following selections:

• Destination: ROOTS

• GEDCOM: Version 4

• Character set: ANSEL

4. Select the Abbreviate Tags option, then click OK.

Note Before clicking OK, if you want to export data from the Title, Alias, or Address entries
your database, or have used the Facts feature of Family Tree for Windows, you must first 
Fields to Export and follow the procedures for GEDCOM export in the Family Tree Maker man

5. When the file is finished writing, close Family Tree Maker and start Ultimate Family Tree.

6. From the File menu, select File Open.

7. Follow the steps in “Importing a GEDCOM File” on page 271.

Exporting Data to Another Program
The GEDCOM standard was developed to provide a flexible format for exchanging genealogica
A program that reads and writes GEDCOM data can exchange data with other GEDCOM-comp
programs.

Ultimate Family Tree provides four GEDCOM export options: Basic (BMDB), ROOTS III 
(4.0), Family GEDCOM Version 5.3+, and Event GEDCOM Version 1.0. The first three GEDCO
options have been approved by the Family History Department of the LDS Church for submittin
GEDCOM format data to the LDS Ancestral File. Approval of Event GEDCOM is pending.

Ultimate Family Tree GEDCOM files compatible with GEDCOM Version 5.3+ and earlier c
nect individuals through families. In this sense, GEDCOM 5.3+ and its ancestors are family-orie

Creating a GEDCOM File
1. From the File menu, choose Save As.

2. Select GEDCOM from the Save As File Type drop-down list.

3. Enter a file name with a maximum of 8 characters in the Name field with the extension .G

4. Change the Drive and Directory to the location you want to send the GEDCOM file (for 
example, \UFT\GEDCOM) and click OK.

Note Use Grouping to create a GEDCOM export with only part of your project. To export
selected family line, use the Relationship Search window to define the family, and then ad
results to the Grouping list. Check Use List under Individuals in the Grouping group to exp
only the individuals found in the Grouping list.
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5. Choose a GEDCOM type from the GEDCOM Format group:

• Basic (BMDB) — Creates a GEDCOM file that contains information about the basic events
birth, marriage, death, and burial in addition to family links. Basic GEDCOM export is usef
for sending minimal data to programs, such as special purpose utilities used for creating g
logical charts.

• ROOTS III (4.0) — Creates a GEDCOM file similar to those created by COMMSOFT’s 
ROOTS III. This GEDCOM format uses the GEDCOM 4.1 specifications and exports even
accepted by ROOTS III.

• Family 5.3+ — Uses the GEDCOM 5.3 specification with substantial support for the feature
version 5.5. Use this option if you are transferring information to another genealogy progra
that currently supports the GEDCOM 5.3 or later specification.

Note Miscellaneous and Medical information, except for Flags and Ancestor and Descen
Interest levels, is not exported. On the Individual Record window, Individual Text Footnote
Event Text Footnote, and Research Notes information is not exported. Media files are not
included.

• Event 1.0 — Provides the most complete information transfer. It is an extension of Family 5
that incorporates features for transferring events, roles, sources, and images. Event GEDC
designed to be compatible with lineage-linked systems, while providing extensive support
event-oriented systems, such as Ultimate Family Tree. At present, only Ultimate Family Tr
ROOTS V, Visual ROOTS, Family Gathering, and ROOTS IV support Event GEDCOM.

Note Photo files are created for all linked images and are located in the directory in whic
GEDCOM file was saved. They normally have an extension that includes their format, suc
.PCX. If Ultimate Family Tree finds a file of the same name, it converts the extension to a 
ber from 1 to 999.

Figure 8-7: Save As GEDCOM Options Window
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Creating an Event GEDCOM File The Event GEDCOM group is unavailable unless you select
Event 1.0 in the GEDCOM Format group. An Event GEDCOM file can contain a dictionary of ev
and source types. Use the Event/Source Types radio buttons to determine how much event and
type information is included in the file.

The Data options provide a way to tailor the data content of the GEDCOM file and create s
files. For example, it is possible to create a GEDCOM file containing places for New England, o
sources useful for California research before 1900.

• Individual — Includes information about individuals.

• Family — Includes lineage-linked family information. This option is required to maintain co
patibility with lineage-linked family systems. It is not required when communicating with ot
Event Version 1.0 programs such as ROOTS IV.

• Event — Includes information about events.

• Place — Includes information for places.

• Source — Includes information for sources.

• Image — Includes information about images.

Note If you have created a media library in Ultimate Family Tree, linked media are exporte
external files that can be sent with the Event 1.0 file. These media are given a name that s
with P, followed by a linking number, and an extension that shows the type of media (for e
ple, .PCX, .TIF). Keep these media files with the GEDCOM file.

6. In the Destination group, check Ancestral File, and then click the Submitter button if you in
to submit a GEDCOM file to the Family History Center of the LDS Church. This option ind
cates that the GEDCOM transmission is intended for submission to the LDS Church Ance
File. If you are not creating a GEDCOM file to be submitted to the LDS Church, do not che
Ancestral File, and skip to step 7.

Figure 8-8: GEDCOM Options Window (right side)
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Note Use the Basic, ROOTS III or Family 5.3+ GEDCOM Formats when submitting to th
LDS Church. The Event GEDCOM is not an approved GEDCOM for submission to the LD
Church.

An LDS submission requires these steps in order:

✓ Select the appropriate radio button to choose the ancestors or descendants of the st
individual.

✓ Enter the record number of the starting ancestor or descendant.

✓ Click the Submitter button.

✓ Enter the submitter name, address, and phone number.

✓ Enter any comments concerning the GEDCOM file in the Comments field.

✓ Click OK to close the window and save changes.

✓ Prepare a label for the disk(s) with the title Ancestral File, and the submitter’s name, 
address, and phone number.

✓ Mail the disk(s) to:
Family History Data Control
50 East North Temple
Salt Lake City, UT 84150

7. Choose Indented to create a GEDCOM file in an indented format.

Note Not all genealogy programs can read the indented format. Do not choose this optio
unless you know that you are preparing a GEDCOM file for a program that can read the ind
format, such as Ultimate Family Tree, ROOTS V, Visual ROOTS, Family Gathering, or 
ROOTS IV.

8. Check Use Long Place Names to use the long as opposed to the Ultimate Family Tree sh
place names. Some programs have fixed-length place name fields that may not accommod
long place format. If you are unsure, leave the Use Long Place Names box unchecked. 

9. If saving to a floppy disk, check Erase Disk if you want to assure that the disk is empty be
copying the GEDCOM file.

10. Click OK.

Saving and Backing up Data
Always make copies of your Ultimate Family Tree project files and library files to protect against
corruption and hardware failure. Without backup files, you might lose hours, days, or even year
work.

To minimize losses due to power and machine failure, Ultimate Family Tree provides you 
backup features. These features, however, do not ensure against lost work due to damaged or w
disks.
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The Save As window allows you to save the current project as an archive. It is important to
up data regularly to prevent accidental loss of information. You should back up both project and l
files, because they are connected. You do not need to back up media files if you have not modi
Multimedia Library. If it is ever necessary to restore project, library, or media files, you will have
reenter data entered since the most recent backup. Back up your data often.

Backing up a Project
1. With the project open, choose Save As from the File Menu.

2. Select Backup from the Save file as type drop-down list.

3. Enter the file name, with the extension .SQZ, for the archive you are creating in the file na
field. Remember, enter a different file name for each backup if saving the project, library, a
multimedia files separately.

4. Select the location in which the backup file is to be saved. This file can be saved to your h
disk or to one or more floppies. If you save to a floppy, Ultimate Family Tree will request n
disks as they are required to complete the backup.

5. Click OK. The Save As Backup Options window opens.

Figure 8-9: Save As Window

Figure 8-10: Save As Backup Options Window
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6. Check Project to back up the project files.

7. Check Library to back up the library files.

Note Back up project, library, and media files separately with different file names, especia
you have more than one project. Complete the backup procedure during one editing sessio
library and media files are common to all projects and need only be archived once for all 
projects.

8. Check Multimedia only if you have modified the Multimedia Library. Media files greatly 
increase the size of your backup.

9. Click OK.

10. If you save the backup to your hard disk, use the Windows File Manager to copy the archiv
to a floppy disk to protect it. If the file is larger than one floppy disk can hold, use the DOS
BACKUP command (or MSBACKUP) to copy the file to multiple disks. Archive files have th
extension .SQZ. See your Windows and DOS manuals for further instructions on using the
COPY and/or BACKUP commands.

Restoring a Backup
A project need not be open to restore projects, but you must be in Ultimate Family Tree. If you r
a project with another project open, Ultimate Family Tree first closes the open project and then 
restores the old project. When complete, the backup project you have restored will be open. To 
a project, follow these steps:

1. From the File menu, choose Open.

2. Select Backup from the drop-down list.

3. Select the drive and directory where you placed the backup. If the backup is on a floppy d
select the drive that contains the floppy disk. The current directory name is displayed abov
directory listing box.

4. Select the backup file to be restored. Backups have the extension .SQZ, such as FILE-
NAME.SQZ.

5. Click OK. A warning message will appear, “Restore Project and/or Library files. Warning! 
Existing project of same name and/or library will be replaced.”

6. Click OK.

Note If you have more than one hard drive, a Drive Selection window appears showing th
path to which the files will be restored. Change the drive letter if you want to restore to a d
ent drive and click OK.

Note Restoring the project overwrites all existing files for the project and library being 
restored. Make sure this is what you want to do before you proceed. If you change your m
click Cancel rather than OK.

When processing is complete, the restored project opens.
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Save As Ultimate Family Tree Project
Important Saving a project under a different name affects only information in your projec
related to individuals and their events. Both projects will continue to use the same library fi
for places, sources, and media.

Use the Save As window to save the current project as an Ultimate Family Tree project wi
new name. This option is handy when you want to split part of the project, to create a working co
another directory using the same name, or to keep a working copy of the project using another 

Note This is not considered a backup of data files. Use the Save As Backup routine to ba
data files.

1. With a project open, choose Save As from the File menu.

2. Select New Project from the Save file as type drop-down list.

3. Enter a new file name for the new project, with the extension .PRO in the Name field.

4. Select the directory for saving the new project. Use a different project name to avoid confu
If you are saving the project using the same file name, place the new project in a directory
ent from that occupied by the current project.

5. Click OK. The Save As Ultimate Family Tree Options window opens if there are individual
the Grouping list.

Note Use the Grouping options if you want to split part of your project into a new project.
detailed steps on how to split a project, see “Splitting a Project” on page 285.

6. Uncheck Use List unless you want to create the new project with only those in the Groupin

7. Click OK. When the new project is created, it is the open project. The original project is clo
This procedure does not change the original project file in any way.

8. Click Cancel if you want to return to the current project without saving changes.

Note Do not save to a floppy disk. Because the Save As Ultimate Family Tree feature cre
new project, you must have sufficient disk space on the hard drive before saving the proje
Allow at least 2.5 MB of free disk space for every 1,000 individuals.

Figure 8-11: Save As Ultimate Family Tree Options Window
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Splitting a Project
The following procedure shows how to split a portion of an existing project into a new project. F
example, you can create a new project containing your spouse’s ancestors from an existing pro
The three basic steps are finding the individuals, moving those found into the Grouping list, and
ing the new project. Later you can remove the individuals in the newly created project from the 
nal project. Modify the instructions to fit your specific needs.

To find the individuals you want to use in a new project, follow these steps:

1. From the Search menu, select Individuals and then Relationship.

2. Press F10 or click the Find button on the Toolbar to find the starting person for the search

3. Select Ancestors Plus Their Descendants in the Relationship Options list.

4. Set the Generation and Descendant Limits options to 999.

5. Check the Add Other Spouses box to add spouses not already included to the Search Lis

6. Choose the option, Replace the list with those found, from the drop-down list.

7. To check the search without committing the results to the permanent search list, click Pre
Press Escape to return to the Search window.

8. Click Search to create the Search list. Press Escape to close the list.

9. Click Group to move the contents of the search to the Grouping list.

To create the new project, follow these steps:

10. From the File Menu, choose Save As.

11. Select New Project from the Save file as type drop-down list.

12. Enter a new file name with the extension .PRO for the new project in the Name field.

13. Select the directory for saving the new project. Use a different project name to avoid confu
otherwise, you must place the new project in a directory different from that occupied by th
rent project.

14. Click OK. The Save As Ultimate Family Tree Options window opens. The number of individ
in the Grouping list will be displayed.

15. Check Use List.

16. Click OK.

Note The new project becomes the open project, and the original project is closed. This 
dure does not change the original project file in any way. The description name you entere
the original project will transfer to the new project. Open the Project Information window fr
the File menu and enter a new name on the Description line.
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17. Click Cancel if you want to close the Save As window and return to the current project wit
saving changes.

Note Because the Save As Ultimate Family Tree feature creates a new project, be sure y
have sufficient disk space on the hard drive before saving the project. Allow at least 2.5 M
free disk space for every 1,000 individuals. Do not save to a floppy disk.

You might want to remove the records in the new project from the original project. If you h
not completed a new Relationship Search or created a new Grouping list, continue with the step
below. If you have created another Relationship Search or Grouping list, you will need to repea
you took previously to find the individuals for the new project.

1. Open the original project.

2. Choose Grouping from the Search menu.

3. Select Relationship from the Individual Search list.

4. Select Invert Selected.

5. Click Search.

6. Repeat steps 10 through 17 under “Splitting a Project” on page 285.

When you complete these procedures, you will have two new projects from the original pro
with the original project intact. After checking the contents of the two new projects, you may wa
delete the original project. Make a backup of the original on a floppy disk and then delete it from
hard drive.

Deleting Data

Deleting an Individual from the Project
To delete an individual from the project, click the Find button on the Toolbar, or find the name in
Individual List accessed from the View menu. Double-click the name to open that person’s Indiv
Record window. Choose Delete Record from the File menu or press Shift+F9. An “Are You Sure
message appears. Click OK to continue. Another message appears stating, “[this individual] an
references to him/her will be removed from this project. [He/she] is linked to [#] events.” Click O
delete the individual or Cancel if you want to keep the individual.

Deleting Text
Select the text to be deleted and press the Del key on the keyboard.

Deleting an Event
To delete an event, select the event in the Individual Record window and click the numbered bu
the left of the event field to open the Events window. Click the Delete button below the OK and C
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buttons on the right. The Events window closes and a message appears asking if you want to de
event. Click OK.

Another option is to select the event name, such as Birth, in the Individual Record window
press the Del key on the keyboard. To respond to the message “Delete existing event?” click O
delete that event or Cancel if you want to keep it.

Deleting a Place from an Event
To delete a place from an event in the Individual Record window, highlight the place and press th
(Delete) key, or choose Cut from the Edit menu. This procedure removes the place from the eve
not from the Place Library. If you change your mind, choose Undo from the Edit menu or press 
Escape.

Deleting a Place from the Place Library
There are two methods for deleting a place from the Place Library.

1. In the Individual Record window, select a place field and click the Find button next to the 
Spouse field.

2. Highlight the place to delete.

3. Click the Delete button in the Candidate Places window. A message appears stating whet
not this place is used in the current project.

4. Click OK.

A second method for deleting a place from the Place Library is to use the Place Record window

1. From the Build menu, choose Place Record.

2. Click Find to find the place record you want to delete.

3. With the place you want to delete displayed in the Place Record window, click the Delete b

Note Clicking the Delete button in the Candidate Places or Place Record windows perm
nently erases a selected place from the project and library. Since the Place library is comm
all projects, do not delete a place if that place is used in another project.

Deleting a Source from the Sources List in the Evidence or Proof Windows
1. Open the Evidence window that includes the source you want to remove.

2. Select the source to remove from the Source List.

3. Click Selected in the Delete or Remove group.

4. Click Proceed to delete the source and footnote reference (if present) or Cancel to return 
Evidence or Proof window without deleting the source.

This procedure removes the source from the Evidence or Proof window, but not from the S
library.
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Delete a Source from the Source Library
1. From the Build menu, choose Source Record.

2. Press F10 or click the Find button on the toolbar to open the Find Source window. See Find 
Source Window for more information.

3. Find the source and click OK.

4. Click the Delete button.

This procedure permanently erases a selected source from the project and library. Becau
Source library is common to all projects, do not delete a source that is used in another project.

Deleting a Slide Show
1. From the Build menu, choose Slide Show to open the Slide Show window.

2. Select the slide show you want to delete from the Slide Show list.

3. Click the Selected button in the Delete Show group to delete the selected slide show.

4. To delete all slide shows, click All in the Delete Show group.

Deleting a Project
1. Choose Delete Project from the File menu. A warning window opens with this message, “A

YOU SURE? ### records will be PERMANENTLY deleted if you choose OK.”

2. Click OK.

3. Another window appears with this message, “ARE YOU SURE? This project will be PERM
NENTLY erased if you choose OK.” Click OK.

Combining Records

Combining Individuals Using the Candidate Individual Window
The Combine Individuals feature is helpful when an individual is entered more than once in you
project and you want to remove the duplicate person but retain that person’s links. There are two
ods for combining individuals. One uses the Candidate Individual window to combine two individ
The other method allows to you combine two or more individuals at one time by using the Grou
option.

1. Select the name field and click the Find button in the Individual Record window.

2. Select the person you want to keep.

3. Click Identify. A note appears showing the name you selected as the surviving person and
to do.
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4. Click OK.

5. Select the individual to be merged from the Individual list.

6. Close the list by clicking the Close box or by pressing Escape.

Note If the two individuals you are attempting to combine are of different sexes or the se
marked as Unknown, you will be prompted to click OK or Cancel.

7. Leave the Candidate Individual list as is (do not select another name) and click Merge to 
bine the two individuals.

8. A message appears showing the name and record number of the individual who will be m
and the name and record number of the surviving individual. Click OK or Cancel.

9. If you proceed, another message appears asking if you would like to erase the individual 
was merged from the project. Click OK.

10. When you finish the procedure, return to the surviving person’s Individual Record and del
any duplicate events.

The parents and birth record for the surviving individual remain intact. Ultimate Family Tre
deletes parent links for the merged individual. Events and Event Evidence for the merged indivi
link to the surviving individual. Delete duplicate events. Individual Evidence for the merged indivi
transfers to the surviving individual. Click the Individual Evidence button and click the Save/Buil
Footnote button to rebuild the footnote.

Note If you started the combine feature at the main name field (not a Parent field) and th
deleted that person during the combine, a blank individual record will open. If you don’t wa
create a new record, choose Undo from the Edit menu.

Combining Individuals Using Grouping
Use the Grouping window to combine two or more duplicate individuals at one time. To combine
duplicates, you must first find them. There are two ways to find duplicate individuals in a project
is the Duplication Search. The other way is to view the Individual list in name order. 

From the View menu, choose Individual List, then By Surname. Scroll through the list until
find two names which are identical. If you scroll horizontally in the list, you will see their years o
birth and death. Highlight a name and press F5 to view the individual record for that person or 
Shift+F8 to view their events. In this manner you will be able to determine if these two individual
duplicates.

When you have duplicate records for individuals, you can either delete one of the duplicat
use the Combine Individuals feature to move the links for one or more individuals to a selected 
vidual. For two individuals, use the Candidate Individuals window.

To combine two, three or more duplicates at one time, use Grouping.
Find the individuals to be combined using the Individual Duplication Search or by viewing 

Individual List by Surname. Note the record numbers for the duplicate individuals. Now, follow t
steps:
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1. From the Search menu, choose Grouping.

2. Scroll to the bottom of the Individual Search List on the left and select Empty.

3. Select the option Replace grouping list with selected list.

4. Click the Search button. An empty Grouping list opens.

5. Press F10 or click the Find button on the toolbar to open the Find Individual window.

6. Enter the record number for one of the duplicates and press Enter. The name appears in t
Individual window. Click OK.

7. Click the Results button to open the Grouping list.

8. Repeat steps 5 and 6 for the other duplicate record for this individual.

9. If there are more than two records for this individual, repeat steps 5 and 6 until the Groupin
contains all of the duplicate records for this person.

10. Make sure the individuals in the Grouping List are the same person. You may need to scr
the list to see all the names.

11. Highlight the record in the list that you want to keep as the master individual. This is the individ-
ual selected to receive the links from all other individuals. Leave the Grouping list open.

12. From the Utilities menu, choose Project, then Combine Individuals. The individual selecte
the master individual is displayed.

13. Check the option Remove Unlinked Individuals from Project only if you want all individuals
the Grouping list, other than the master individual, to be deleted from the project. Normally
is what you will want to do.

14. Click OK to start the combine routine. You will see the message, “All individuals in the grou
list will be replaced with the master individual if you proceed. Undo will not restore the cha
HAVE YOU BACKED UP YOUR DATA?” Click OK to combine the individuals or Cancel to 
return to the Combine Individuals window without combining the individuals.

Figure 8-12: Combine Individual Window
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During the combine process, all events linked to the individuals in the Grouping List will be
linked to the individuals selected as the master individual. The birth event and parent links to the m
individual will remain. You should now delete any duplicate events. See “Deleting an Event” on page

Combining Places
The Combine feature is helpful when you have entered a place more than once and you want to
all links to one place before removing the duplicates.

There are two methods for combining places. You can use the Candidate Places window t
merge two duplicate places, or use the Place Search and Combine for merging two or more du
place records.

Combining Places Using the Candidate Places Window

1. Select any place field in the Individual Record window and click the Find button.

2. Select the place you want to keep.

3. Click Identify. A note appears showing the name you selected as the surviving place and wha

4. Click OK.

5. Select the place to be merged from the Places list.

6. Close the list by clicking the Close box or by pressing Escape.

7. Click Merge in the Places window.

8. Confirm the place names and click OK to merge. Do not delete the place if it is used in ot
projects.

9. A message appears asking if you want to erase the merged place from the Place Library.
place you choose as the surviving place remains in the Place Library and the duplicate pla
deleted. Do not delete the merged place if the place you want to combine (not the survivin
place) is used in other projects.

Figure 8-13: Candidate Places Window
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Combining Duplicate Places Using Place Search and Combine

1. From the Search menu, choose Places.

2. Enter any part of the name you wish to search for. In the Use Box, select Short Place. Se
Ignore for the Edit Status and do not check Events. The Search Criteria at the top of the w
will state “Search all places having [place name] in their short name with place Sure level 

3. Select the option Replace List with those Found.

4. Click Search. When the search is complete, the Place list will open. 

5. Scroll through the list to make sure all of the names in the Place Search list refer to the sa
place. If any places are in the list that you do not want to combine, highlight that place nam
press Shift+F9 to remove that place from the list. (This deletes a place from the Search lis
from your Place Library.)

6. After removing any places from the list, close the list and click Results to make sure only 
places you wish to combine are in the Search list.

7. When you have a final list, highlight the place name you wish to keep and into which you 
to merge the others. This is your master place.

8. From the Utilities menu choose Project, and then Combine Places. The Combine Places w
shows how many places are in the Place Search window and also the Master Place.

9. If you have no other projects, select the option Remove Unlinked Places from Place Librar
click OK. If you have more than one project, however, do not check Remove Unlinked Pla
until you have completed the Place Search and Combine for all other projects.

10. After combining, go to the Place Record window for the master place and change the Edit 
to Master. This will enable you to keep track of the master place from project to project in o
to combine other places into it.

Figure 8-14: Combine Places Window
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Combining Sources
The Combine feature is useful for transferring sources imported from ROOTS III or GEDCOM to
correct Ultimate Family Tree source template. We recommend using the Advanced Editing mod
this procedure.

1. From the Build menu, choose Source Record.

2. In the Source Record window, create a new source by clicking New.

3. Select the source type you want to use for the new source from the list of available source
plates and create a duplicate source of the ROOTS III or GEDCOM source that you are go
combine.

4. In the new source you have just created, change the Edit Status field to something unique
example we use the word Combine. Press F9 to save.

Note The Edit Status field is not available in the Normal Editing mode.

5. Press F10 or click the Find button on the toolbar to open the Find Source window.

6. Find the original source and click OK. See “Source Template Window” on page 74 for mo
information.

7. Change the Edit Status to the same thing you entered in the new source (i.e., Combine). Press F9 
to save.

8. From the Search menu, choose Sources.

9. In the Source Field List, click Ignore.

10. In the Edit Status box, scroll through the list until you find the Edit Status you entered in b
sources (i.e., Combine). The search criteria at the top of the window will state, “Find all sourc
Source Record status of Combine.”

11. Select the option Replace List with those Found.

12. Click Search. When the search is complete, the Source List opens.

13. Scroll through the list to make sure all of the sources in the Source Search list refer to the
source. If any sources are in the list that you do not want to combine, highlight that source
and press Shift+F9 to remove that source from the list. This deletes a source from the Sea
not from your Source library.

14. After removing any sources from the list, close the list and click Results to make sure only
sources you wish to combine are in the Search list.

15. When you have a final list, highlight the source name you wish to keep and combine the o
into. This is your master source. Leave the list open and from the Utilities menu choose Proje
Combine, then Sources. The Combine Sources window shows how many sources are in t
Source Search window and also the master source.
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16. If you have no other projects, select the option Remove Unlinked Sources from Source Li
and click OK. If you have more than one project, however, do not check Remove Unlinked
Sources until you have completed the Source Search and Combine for all other projects.

17. You receive the message, “All sources in the source search list will be replaced with the m
source if you proceed. (Undo will not restore the change. HAVE YOU BACKED UP YOUR 
DATA?)” Click OK to combine the places or Cancel to return to the Combine Sources wind
without combining the sources.

Viewing Information About Your Project
The Project Information window provides a summary of an open project.

1. From the File menu, choose Project Info.

Figure 8-15: Combine Sources Window

Figure 8-16: Project Info Window
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The following information is provided:

• Project Control — The name and path of the selected project control file

• Last Changed — The date the selected project was last edited and saved

• Project Version — The version number of the current project. In each session where the pr
is saved, the version number is increased by one.

• Project Title — The short name for the project

• Program Version — The Ultimate Family Tree version number

• Individuals — The number of individuals in the project

• Description — A short description of the project on the Description line. This description 
appears on the Title Bar when the project is active.

• Researcher — The name of the principal researcher for the project in the Researcher field.
feature is optional. You can choose to have this name appear in the footer on printed repo

• Researcher # — The researcher’s record number in the Researcher # field if you want the r
tionship to the husband or wife to show in Family Group Sheets. If you do not want the rel
ship to show, enter 0 in the Researcher # field.

• Address, etc. — The address and phone number of the researcher, using the Address 1 an
Address 2, City, State, Zip, and Phone fields. This information can also be included in the 
on printed reports.

• Key Families — A list of surnames found in this project, arranged in order of frequency of 
occurrence. The number of times each surname is encountered is shown to the right of the
Use the scroll bar on the right side of the Key Families box to see more.

• Update — Updates the Key Families list shown in the Project Info window. If you’ve entere
new data in a project and return to the Project Info window, click Update to get a new coun
surnames since the last edit.

• Comments — The Comments box displays the source of the data used in this project, inclu
the import method, date, and time. Enter and edit general information in this box. Use the 
bar on the right side of the Comments box to see more.

2. Click the More button to open the Additional Project Information window, which displays st
tics about the project.

Additional Project Information Window
The Additional Project Information Window provides additional information about the open proje
and the library. The information includes data about the records in the project and library, the file
for the project and library, and the quality of the project as measured by its documentation.

Project statistics in this window are broken into four major groups as follows:
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• Individuals — Number of individuals in the project

• Surnames — Number of unique surnames (names entered as /surname/)

• Titles — Number of unique titles (titles entered as {title} )

• Marriages — Number of marriages entered

• Events — Number of events entered

• Roles — Number of roles used

• Unique Roles — Number of unique roles

• Principal — Number of principal roles used

• Places — Number of places used

• Images — Number of linked images

• Chapters — Number of chapters indexed

Total File Sizes Group

• Project — Total size of all project files

• Library — Total size of all library files

• Total — Total size of files used by this project

Library Records Group

• Places — Number of records in the Place library

• Sources — Number of records in the Source library

• Source Types — Number of records in the Source Template library

• Images — Number of records in the Image library

• Event Types — Number of records in the Event Types library

• Role Types — Number of records in the Role Types library

Project Quality Group

• Sources — Number of unique sources referred to

• Evidence Records — Number of unique pieces of evidence used

• Evaluations — Number of proofs having a formal evaluation

• Research Footnotes — Number of footnotes to be used in research reports

• Final Footnotes — Number of footnotes to be used in final reports

• Possible Sures — Number of possible Sure levels in this project

• Sures Between 1–4 — Number of Sure levels used

• Percent Proven — Sure levels used divided by Sure levels possible, as a percentage

• Sure for Proven — The average of all Sure levels used (this does not include unused Sure l

• Project Sure (0–4) — Average Sure level for the entire project (this includes unused Sure le
set to 0)
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Preferences
You can customize Ultimate Family Tree in several ways.

1. From the Utilities menu, choose Preferences.

2. In the General window, select any of the following options:

• Clock — Displays a clock in the lower-right corner of the Ultimate Family Tree window. Sel
ON in the Clock group and select the 12-hour or 24-hour clock setting.

• Messages — Provides three levels of context-sensitive messages that require a response f
you before continuing. Choose one of the following options:

✓ Critical — Have Ultimate Family Tree ignore inconsistent data and information messa
Critical messages alert you to an inconsistency or error that may affect the integrity o
data in a project.

✓ Plus Inconsistent Data — Have Ultimate Family Tree display critical and inconsistent 
data messages. An inconsistent data message is used when data entry is inconsiste
rules for such items as age, but underlying data is not at risk.

✓ Plus Information — Have Ultimate Family Tree display all critical, inconsistent data an
information messages. Information messages provide a reminder that changes are a
be made.

• Image Quality — Sets image compression quality. JPEG compression is applied to 24-bit 
images imported into Ultimate Family Tree. Compressing an image reduces the storage s
required, but also reduces image quality. Experiment with the Image Quality setting to see
effect on the image. A setting of 100 provides the highest quality and the least compressio

Figure 8-17: Preferences Window
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• Date Format — Specifies the date format in the free-form date field. The date displays and
prints in this format in all text reports. You can set your preference to have dates display a
print exactly as you’ve entered them (as entered), or you can set a date format default (such a
12 JUL 1943). Scroll through the date options and select the format you want. If you selec
option other than as entered, modifiers will be converted to full words in the free-form date fiel
such as ABT to about.

Note Changes to the way dates display and print affect dates entered or changed after y
selected a preference. Dates entered before selecting a date preference remain unchang

If you set the date preference to MM/DD/YYYY (for example, 07/12/1943) and enter a
date such as 14/10/1955 for October 14, 1955, the first number will be dropped and the da
convert to 4/10/1955 (April 10, 1955).

• Toolbar — Controls balloon and bottom line help, visible when the mouse cursor is on an 
Ultimate Family Tree toolbar button or a Descendant Box Chart toolbar button. However, h
on the Box Chart takes effect after you leave and return to Ultimate Family Tree. The Box 
toolbar is set up when Ultimate Family Tree starts. Note that there are two menu bars, lon
short, in Ultimate Family Tree. The toolbar is not active when the short menu bar is displa

• Use Windows Colors — Ultimate Family Tree provides two styles for desktop display, Graph
and Windows Colors. This option sets Ultimate Family Tree to the Windows colors selecte
the Windows Control Panel.

Note Graphics mode can reduce the performance of the program. If you suspect that Ult
Family Tree is running more slowly than it should, switch to Windows Colors mode. When
open certain windows while in Graphics mode, the message, “Picture colors may be incor
Do you wish to use Windows Colors?” may appear. Click No to ignore the message and op
window. Click Yes to change the desktop display to Windows Colors. (You must exit and th
restart Ultimate Family Tree to complete the change to Windows colors.) This message w
appear if your graphics monitor is set to 256 colors. If you monitor is set to 16 colors, Wind
Colors mode will be used.

• Choose Wallpaper — Opens the Ultimate Family Tree Wallpaper window which allows you t
select a wallpaper as the Ultimate Family Tree desktop background. This option is availab
the Graphics mode only. In the Ultimate Family Tree Wallpaper window, select built-in wal
per from the Built-In Wallpaper drop-down list. If you prefer to use a different wallpaper, se
Use Custom Wallpaper and click the Browse button to find an existing .BMP file. The path
file name of the .BMP file will be displayed in the File Name (BMP) field. Click OK to return
the General Preferences window.

• Advanced Editing Mode — Select this option to change from the Normal Editing mode to the
Advanced Editing mode. The Advanced Editing mode changes the normal Events window
Advanced Event Edit window.

• Show Tips at Startup — Displays a Tip of the Day window upon entering Ultimate Family Tre
Four types of tips are available: Ultimate Family Tree Tips, Genealogical Tips, Family Eve
and Historical Events.
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3. Click OK to close the Preferences window.

4. Exit and restart Ultimate Family Tree if you changed the Windows Colors or Wallpaper set

Modifying the Name Format
To further customize Ultimate Family Tree, you can modify how names appear in windows. Nam
can appear alone or with additional information such as dates of birth and death.

Note These options do not affect how names appear in lists or in the editable name fields
Individual Record window.

1. From the Utilities menu, choose Preferences, and then the Names/Places Tab.

2. Select any of the following options from the Add to Name group:

• Nothing — Only the name

• Years — Names plus Birth and Death years

• Record Number — The name plus record number

• Image Info — The name, plus the word Image if an image is linked to the individual

• Indiv. Flag — The list of flags on the right side of the window that is activated when the rad
button is selected. Select the flag you want from the list. The name appears plus the selec
individual flag (if attached to that name).

3. Check Use Upper Case to display surnames in all uppercase letters.

Figure 8-18: Name Format Window
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4. Check Hide Slashes ( / ) to display surnames without slash marks. Checking this option a
removes the braces { } from titles. This setting does not affect the Individual Record windo

Note After changing the name format, click any open window to display the new name fo

5. Set a default place modifier for newly entered places. Enter a two-character Place Modifier
field labeled Short. Structured reports use the Short Place Modifier. Enter descriptive word
abbreviations such as at, in, or nr (for near). Enter up to 30 characters of information in the 
Long Place Modifier field. This field is used in text reports such as the Family Journal repo

6. Click OK to close the Preferences window.

External Programs
Running an external program is useful when you want to automatically start another program w
Ultimate Family Tree. For example, you may be maintaining special information about events in 
arate database. The name you enter for the external program will be displayed on the Utilities m

1. From the Utilities menu, choose Preferences and then click the External Programs Tab.

2. Enter the name in the Name field for the external program you want displayed on the Utili
menu. For example, Character Map.

3. Enter the path and file name for the external program on the Path line. For example, if you
to use the Character Map as an external program, enter charmap.exe. Click the Browse button to 
help find the external program.

4. Repeat steps 2 and 3 for Program #2 and Program #3.

5. Check Enable if you want to display the program name on the Utilities menu.

6. Click OK to save the command lines and close the window.

7. To access the external programs, press Ctrl+F1 for Program 1, Ctrl+F2 for Program 2, an
Ctrl+F3 for Program 3, or choose the appropriate name from the Utilities menu.

When you exit the external program, control is returned immediately to Ultimate Family Tree.

Adding Information to the Path Line Ultimate Family Tree provides special codes that can be 
used to tell the external program more about what you want. Record numbers and dates can be
matically added to the file name when you use the special codes listed below to create externa

• I# — Adds the letter I plus the record number for the last individual selected

• S# — Adds the letter S plus the record number for the last selected source record

• E# — Adds the letter E plus the record number for the last selected event record

• L# — Adds the letter L plus the record number for the last selected location record

• D# — D# is replaced with the last selected date. The date is provided in the YYYYMMDD 
format (i.e., October 14, 1955 appears as 19551014).

Note The letter before the # is case sensitive.
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Individual reference and source reference information can also be included in the comman
The following codes apply:

• I@ — Replaced by the contents of the individual reference field up to eight characters.

• S@ — Replaced by the contents of the source reference field up to eight characters.

Mouse Menu
Ultimate Family Tree provides a customizable context-sensitive right mouse button menu as a s
cut to data entry. Ultimate Family Tree is preset with several popular menu options, and you can
add your own favorites.

1. From the Utilities menu, choose Preferences and then click the Mouse Menu tab.

2. To add other options, highlight the option in the list of Menu options and click Add. As you
highlight an option in the list, a description of what that option does appears in the text bo
below.

Note Clicking the Add button will add the option to the end of the menu list, and Insert wi
insert the option in a specific place in the list. 

3. Click Separator to insert a line to organize your menu into blocks.

4. Remove menu options by highlighting the option and clicking Remove or Remove All. 

5. View your right mouse menu by clicking Test. 

6. Check Disable the Mouse Menu if you wish to disable the right mouse button feature.

Figure 8-19: Mouse Menu Window
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Special Right Mouse Menu Options

• Edit […] — Context-sensitive command. For example, when you click the right mouse but
over the name Patrick Joseph /Kennedy/, the Edit option says Edit Patrick Joseph /Kennedy/.

• Launch [Export App] — Launches the external application defined in the External Support 
of the Ultimate Family Tree Preferences window opened from the Print Setup option on the
menu.

• New […] — Context-sensitive New command. For example, when you click the right mous
button over the Individual Record window, the New option says New Individual.

• [External Program 1] — Launches the external application specified in the Preferences win
opened from the Utilities menu.

• [Sticky Notes] — Lists the current sticky notes by name. For example, if you have a sticky n
for the Individual Record window named IR Hints, IR Hints appears in the right mouse menu.

• What’s This — Opens a miniature help window for any item over which the right mouse but
was clicked.

Macros
A macro is a short program, or list of commands, that you can initiate by using a key combinatio
macro can be created by recording procedures as you perform them, much like the speed dial 
on a telephone. When you type the trigger keystroke, the contents of the macro are played back
they were recorded.

Macros are useful when performing repetitive tasks or long procedures, such as typing the
surname repeatedly.

Creating a Macro
1. Press Shift+F10 to open the Macro Key Definition window.

2. Press the combination of keystrokes you want to use to play back the macro. For example
Ctrl+K.

3. Enter a name for your macro in the Macro Name field.

4. Click OK to begin recording the macro. A message in the upper right corner of the desktop
“Recording macro name, press Shift+F10 to stop.”

5. Type the keystrokes you want to record.

6. Press Shift+F10 when finished recording. The Stop Recording Macro window opens.

7. Click OK. The Stop Recording Macro Dialog appears, and allows you to perform several m
recording operations. The Stop Recording Macro dialog contains these options:
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• Insert Literal — Records the literal meaning of next keystroke. To record the literal meanin
a key instead of the meaning assigned to it, choose Insert Literal, then press the desired k

• Insert Pause — Records a pause in the macro.

• Key to Resume — Specifies that the user must press a key to resume execution of the macro
a pause has occurred.

• Seconds — An alternative to Key to Resume, this option allows you to specify how long a pa
lasts before resuming the execution of macro.

• Continue — Returns to the point where you were before the Stop Recording dialog.

• Discard — Erases the macro that you were creating.

• OK — Confirms that the macro is completed and makes it available for use.

Editing an Existing Macro
1. Start the macro recorder by pressing Shift+F10. 

2. When the Macro Key Definition window opens, start the macro you want to edit by pressin
keystroke combination assigned to the macro. The macro name appears in the Macro Na
field.

3. Click OK to continue.

4. Choose one of the following buttons:

• Overwrite — Overwrites the existing macro.

• Append keystrokes — Adds keystrokes to the end of the macro.

• Cancel — Cancels editing the existing macro.

Deleting a Macro
1. Start the macro recorder by pressing Shift+F10.

2. When the Macro Key Definition window opens, start the macro you want to delete by pres
the keystroke combination assigned to the macro. The macro name appears in the Macro
field.

3. Click OK to continue.

4. Click Overwrite to overwrite the existing macro.

5. Without typing any keystrokes or clicking the mouse, press Shift+F10 to stop recording th
macro.
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Tombstone Calculator
The Tombstone Calculator allows you to calculate an individual’s date of birth from information 
entered on tombstones. For example, you might come across a tombstone that shows only the p
death date and states his age at death was 23 years, 9 months, and 4 days.

1. From the Utilities menu, choose Tombstone Calculator.

Note The Tombstone Calculator opens to the date selected from the last active window. T
after, it opens to the last date selected in the Tombstone Calculator. If no date was selecte
first time you open the window, it automatically defaults to your computer’s internal date.

2. Click the left arrow button next to the displayed month to go back a month, or the right arr
button to go forward a month. To move one year at a time, click the left and right arrow bu
next to the displayed year. Click the Today button to return to today’s date.

3. To calculate a birth date, enter the date of death on the tombstone in the Go To field.

4. In the Deviation group, select the minus radio button and enter the number of years, month
days from the tombstone.

5. Click Update Calendar to change the calendar to the calculated date of birth. The date and
the week will be displayed above the calendar on the left.

6. Click Close to close the Tombstone Calculator.

Note A numeric calculator is available by clicking the Calculator button.

Numeric Calculator
Ultimate Family Tree has a built-in calculator you can use as a desk accessory.

1. Display the calculator by choosing Tombstone Calculator from the Utilities menu, and then
clicking the Calculator button.

2. Enter the first number in the calculation.

3. Click + to add, – to subtract, ´ to multiply, or ̧  to divide.

4. Enter the next number in the calculation.

5. Click =.

Other Features

• Decimal button — Inserts a decimal point.

• C button — Clears the current calculation.

• Square root button — Calculates the square root of the displayed number.
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• Percent button — Displays the result of multiplication as a percentage. Enter one number, c
´, click the second number, and then click %. If you use any button other than ´, the calculator 
assumes that you meant ´ and multiplies the numbers.

• ± button — Changes the sign of the displayed number.

Memory Functions When a number is stored in memory, it replaces the number currently in mem

• MC button — Clears the memory.

• MR button — Recalls a displayed number.

• M+ button — Adds the displayed number to the number already in memory.

• M– button — Subtracts the displayed number from the number already in memory.

To close the Calculator, choose Close from the Control menu box.

Rich Text Editor
The Rich Text Editor option in the Utilities menu opens the word processor you have specified i
Print Setup window. If you have not specified your own word processor, Ultimate Family Tree E
opens. See Using the Print Setup window for information on selecting a word processor in Ultimate
Family Tree.

Project Utilities
Ultimate Family Tree offers several features to help you manage your project files. They are fou
under the Project option in the Utilities menu.

Pack
Packing an Ultimate Family Tree project permanently removes records that have been deleted 
your project or from a library. This is an important feature to use after deleting a number of reco
because packing reduces the total disk space used. Ultimate Family Tree also rebuilds all index
associated with the project.

Figure 8-20: Pack Message Window
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Note The Pack process replaces your original project files. Make a backup copy of your 
project files before starting Pack.

From the Utilities menu, choose Project, and then Pack. To interrupt the Pack process, pr
Escape. This stops the Pack and leaves the original file unchanged.

Note Ultimate Family Tree creates large work files during the packing process. If Ultimat
Family Tree runs out of disk space during a pack, it automatically recovers the original pro

Reindex
Reindexing rebuilds any index files that are associated with an open Ultimate Family Tree projec
should reindex in the unlikely event an error message indicates that an index file is corrupted. Fr
Utilities menu, choose Project, and then Reindex. Ultimate Family Tree informs you when the 
reindexing is complete.

Check
The Check feature tests the files in an Ultimate Family Tree project and library. Inconsistent link
repaired if possible, and unlinked events removed (for example, birth events remaining after an
vidual has been deleted). An option is provided to rebuild footnotes. Check optimizes the projec
library files.

1. From the Utilities menu, choose Project, and then Check.

2. Check any of the following boxes in the Project group:

• Events and Event Links — Removes events to which no individuals are linked. This option a
checks place links to make sure an associated place is in the Place library. If an associate
is not found (it may have been deleted while in a different project), the place is restored an
given the name Missing Place no. nn. The nn will be replaced by the place record number. Ed
the place name in the Individual Record window to change Missing Place to the correct place 
name.

Figure 8-21: Check Window
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• Remove Redundant Roles — Removes any roles that are duplicated in an event. If the same 
vidual is linked to an event twice using the same role, one of the role links is removed.

• Remove Invalid Role Types — Check all events for linked roles that are not assigned to that 
event type. The individuals linked to an event through such a role are unlinked.

• Add Birth/Death Events — Checks all individuals for birth events. If one is not found, a new 
event is added and parents are linked. If the Living status flag for an individual is N, Ultimate 
Family Tree looks for a corresponding death event. If one is not found, a death event for th
son is added.

• Find Duplicate Record Numbers — Checks individual record numbers to make sure they are
unique and reports any duplicates found. Use the Individual Record window to assign uniq
numbers. See Deleting Duplicate Record Number, below.

• Check Parent Links — Checks links to parents.

• Source Links — Checks source links to make sure an associated source is in the source libr
an associated source is not found, the source is restored to the Source library when the R
option is chosen. The new source is replaced with a ROOTS III source type and given the
Unknown source nn. The nn will be replaced by the source record number. Edit the source in
Source Record window to change Unknown Source to the correct source information.

• GEDCOM Tags — Check for GEDCOM tags in events and roles. Events and roles which a
missing GEDCOM tags will be listed in the CHECK.TXT file.

• Streamline Research Text Fields — Removes the Last Changed statement and all text following 
it from all Research Text fields. This option is most helpful for projects that have been conv
from ROOTS III or GEDCOM with the option Include Last Changed Date selected during 
import.

3. Check any of the options in the Proofs group:

• Remove Proofless Sure Levels — All Sure levels are checked to make sure there is an underly
proof. If none is found, the Sure level is set to 0.

• Add Sure=1 if Proof and Sure=0 — All proofs are checked to make sure the associated Sure
level is set to 1 or above. If the Sure level is 0, it is set to 1. This option is most helpful for 
projects that have been converted from ROOTS III. When information is imported from RO
III, all Sure values, with or without evidence, are converted.

4. Check Modify to update Role Sentences. The role sentences in the Role library will be mo
to the following selection:

• Add “!”  — The sentence codes for the date and detail fields have an exclamation point ad
This changes the way the sentence reads if there is no underlying data for the item. See t
Report Text Codes Online Help for more information on the ! sentence code.

• Remove “!” — The sentence codes for the date and detail fields have the exclamation poin
removed.
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Note The age code can also have an exclamation point added, but the sentence must be
fied further to have it read correctly after this change. The words at nn years of age are added to 
the sentence when an age is available when the exclamation point it used. Furthermore, s
tences in the Role text should be reviewed after adding the exclamation point to make sur
read correctly with the presence or absence of underlying data. See “Text Formatting” on 
page 59 for more information.

5. Check Final in the Rebuild Footnotes group if you want to rebuild all final footnotes, or che
Research to rebuild all research footnotes using the evidence in the Evidence and Proof w
as a basis.

Note The Rebuild Footnotes procedure overwrites any text you have typed directly into t
Footnote text field of an Evidence or Proof window. If you do not want this text overwritten
not choose this option. If multiple citations are linked to a Proof window, the order of footn
will be in citation number order rather than alphabetical order when footnotes are rebuilt.

6. Check Erase Evaluations to delete all text from the Proof window evaluation field.

7. Check any of the options in the Rebuild Libraries group. These include:

• Rebuild Source Types — Rebuild the Source Type library from the reference library. Source 
types you have entered manually and then deleted will not be restored.

• Add New Event/Role Types — Update the Event and Role libraries from the reference set. 
Replace Missing Event/Role must also be checked when adding new event/role types.

• Replace Missing Event/Role — Scan the Event and Role libraries for events or roles that ma
have been deleted, and replace them. If you have inadvertently erased a role or event, this
will restore the missing item. Only events and roles from the original library will be restore
Events or roles that you have added manually and then deleted will not be restored.

Note The Rebuild Libraries feature is used primarily to update the library files from ROO
IV Version 1.0. This option adds GEDCOM tags to Ultimate Family Tree events and new ce
events and roles to the ROOTS IV Version 1.0 library files. Do not run this option if you ha
made changes to your Event and Source library files as this will overwrite the event, role, 
source templates, and all changes will be lost.

8. When you select any of the Project options, the Repair button is activated. You have two w
check your data.

• Click OK to check items selected on the left side of the window and prepare a report telling
what’s wrong. Click OK to see the list of data that will be fixed when you click Repair or th
you can choose to edit yourself.

• Click Repair to check the data and repair if possible.

A text file named CHECK.TXT is created when either OK or Repair is clicked. From the U
ties menu, choose Project and then View CHECK.TXT to view the file. This text file lists problem
found and changes and repairs that have been made to the project and library. If you want to sa
file for later use, be sure to rename it before running a new Check.
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Note Running a complete set of tests on a project may take from several minutes to man
hours to complete, depending on the size of the project. To stop the Check routine, press 
Escape key.

Deleting or Renumbering Duplicate Record Numbers
If the Check routine reports that you have duplicate record numbers, you must delete or renumb
of them. To find duplicate record numbers, from the Utilities menu, choose Project, then Check. 
the option to check for duplicate record numbers. Click OK. When the Check routine is complet
CHECK.TXT file displays showing any duplicate records. If no duplicates are found, the file will
be displayed.

To delete duplicate record numbers, follow these steps:

1. Press F5 or click the Edit Individual button on the toolbar to open the Individual Record w
dow. Press F10 and enter the record number, for example, 150. Press Enter, and then clic

2. In the Individual Record window, change to a record number not being used. For example
change record 150 to 10150. Press F9 to save.

3. Press F10 and enter the record number for the duplicate. For example, 150. Press Enter and then
click OK.

4. Choose Delete Record from the File menu or press Shift+F9 to delete this record.

5. Once deleted, press F10, enter the changed record number (10150), press Enter and then click 
OK. Change record number 10150 back to the original number (150). Choose Save from the File
menu or press F9 to save.

Viewing GEDCOM Exceptions
Ultimate Family Tree maintains a list of the information that did not convert into a project from a
GEDCOM file. The GEDCOM Exceptions window appears with the GEDCOM file behind it as a
read-only file. The top left corner of the GEDCOM Exceptions window indicates the path and na
the GEDCOM file you are viewing.

1. From the Utilities menu, choose Project, and then GEDCOM Exceptions.

Note If you have deleted or moved the GEDCOM file from the directory from which it wa
imported, when you try to open the GEDCOM Exception window the message, “GEDCOM
not found,” is displayed in the upper right corner of the Ultimate Family Tree window.

2. View the contents of the GEDCOM Exceptions list.

• Individual — Indicates the individual to whom the exception belongs.

• Event — Indicates the event to which the exception belongs.

• Exception Number — Indicates the exception you are viewing.

• Total Exceptions — Indicates the total number of items that did not convert to the Ultimate F
ily Tree project.
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• GEDCOM Tag — Indicates the GEDCOM tag that was not imported.

• Exception Note field — Shows the text that was attached to the selected tag, followed by th
words ignored or not fully converted or unrecognized or ignored to indicate the text was left out
of the project. To update your data more easily, you can copy this text into a file or field usin
Copy and Paste commands from the Edit menu.

Note The words unrecognized or ignored indicate that Ultimate Family Tree correctly inter-
preted the GEDCOM information but did not use it, usually because a conversion option, su
Include Last Changed Date, was not selected. The words ignored or not fully converted indicate 
that Ultimate Family Tree could not interpret the information correctly.

3. Click the Next and Previous buttons to scroll through the Exception List in the GEDCOM 
Exceptions window.

4. Click Show to open a copy of the original GEDCOM file and view where the exception is 
located in the GEDCOM file. Click the Close box or press Escape to close the GEDCOM 
and return to the GEDCOM Exception window.

5. Click Remove to remove the GEDCOM exception displayed in the Exception Note box from
GEDCOM Exceptions list.

6. Click Remove All Like to remove the GEDCOM exception displayed in the Exception Note
and all GEDCOM exceptions like it from the GEDCOM Exceptions list.

7. Click Close to close the GEDCOM Exceptions window.

Figure 8-22: GEDCOM File Window
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Opening an External Text File
1. To open an external text file, from the File menu, choose Open.

2. Select Text from the File Type drop-down list.

3. Change to the drive and directory that contains the text file you want to open.

4. Select the file and click OK.

Saving an Open External Text File under a New Name
1. With an external text file open, from the File menu, choose Save As.

2. Select Text from the File Type list and click OK.

3. Select the drive and directory in which you want to save the file.

4. In the Text File box, enter a name for the file with a .TXT extension.

5. Click OK.

About Ultimate Family Tree
The About Ultimate Family Tree window, accessed from the Help menu, displays system and te
cal support information for Ultimate Family Tree.

1. Click the System Info button to open the System Information window.

2. Click the Ultimate Family Tree tab to view information about the current project, editing m
home directory, installed browser, and printer options.

3. Click the System tab to display information about the disk space, Windows version, proce
codepage, and operating system.

4. Click the Project tab to view a list of project file names and directory locations for the curre
project.

5. Click the Library tab to view a list of library file names and directory locations for the curre
project.

6. Click the MS Info button to open the Microsoft System Information window which displays
information about the system configuration, printers, fonts, proofing tools, graphics filters, 
play configuration, running applications, and Object Linking and Embedding (OLE) setting

7. Click Close to close the System Info window.

8. Click the Technical Support button to open the Online Help Topic for Technical Support.
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Exiting Ultimate Family Tree
You can exit Ultimate Family Tree two ways:

• Press Alt+F4 to quit Ultimate Family Tree and return you to the Windows desktop.

• From the File menu, choose Exit, or click the Close box.

Note It is not necessary to close a project before exiting Ultimate Family Tree. If you clos
Ultimate Family Tree with a project open, that project will be open the next time you start U
mate Family Tree. If you close the project before exiting, the next time you start Ultimate F
ily Tree you will need to choose Open from the File menu to open a project or select a rec
opened project from the bottom of the File menu.
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This appendix provides answers to questions users commonly ask, and solutions to problems s
times encountered in Ultimate Family Tree. See “Did You Know?” on page 26 for more informat

Installation Troubleshooting
Installation is too slow

If installation takes more than a few minutes, the directory specified by the TEMP environm
variable may be full of files. The Ultimate Family Tree installation routine stores temporary files 
directory specified by the TEMP environment variable. To determine whether your computer ha
directory designated for temporary files, type SET at the command prompt, and then check the valu
that MS-DOS displays for the TEMP variable. For example:

TEMP=C:\TEMP

Check for the directory specified by the TEMP environment variable. If it does not exist, cr
one. If it exists, check the contents of that directory. Delete any temporary files with a .TMP exte
contained in that directory. To avoid deleting temporary files that are currently in use, quit all pro
grams, including Windows, before deleting the files.

If the TEMP directory is C:\DOS, edit your AUTOEXEC.BAT file and change the TEMP var
able to point to another directory such as: C:\TEMP or C:\WINDOWS\TEMP. If the directory you
specified does not exist, create it.

Consult your Windows manual for information on deleting files, creating directories, and ed
AUTOEXEC.BAT files.
3 1 3
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General Troubleshooting
This section lists error messages and possible problems you might experience in Ultimate Fami
and what you can do if you encounter them.

General Errors
General protection (GP) faults

A GP fault signifies that something unexpected has happened in the Windows environmen
ally an improper memory access. In other words, something running in the Windows environme
trying to access memory in a location that it did not have access to. All memory management in
dows is handled by Windows. When applications and Windows components directly access me
the result is often a GP fault.

Certain video cards may cause a conflict. Set your monitor to Standard VGA in Windows S
to temporarily resolve the conflict. Contact the video card manufacturer for a new driver. For a l
video cards, screen savers, and third-party desktop applications that have been identified as ca
possible conflicts, see Troubleshooting in the online help. If you encounter a GP fault, it is best to 
restart Windows before proceeding.

To change the video driver in Windows 3.1, from the Program Manager, click on the Main 
Click on Windows Setup. The name of the video driver you are currently using is shown on the 
play line. Write this down. Click Options. Click Change System settings. In the Display drop-dow
list, choose VGA or Standard VGA. Click OK. If a message indicates that a driver for this displa
already on the system, click Current. If the driver is not on the system, use your Windows disks
install the correct driver. Follow the instructions on screen for using the current VGA driver files 
restarting Windows.

To change the video driver in Windows 95, press the right mouse button on the desktop. In
menu which opens, select Properties. In the Display Properties box, click the Settings tab. Click
Change Display Type button. In the Adapter Type box, choose Change. Select Show All Device
Scroll to the top of the Manufacturers list and choose Standard Display Adapter (VGA). Click O

Bitmap conflict
Another potential reason for GP faults is the bitmap images displayed in Ultimate Family T

These bitmap images can be disabled. To disable the bitmaps, edit the PD.INI file found in the 
directory (or whatever directory you installed Ultimate Family Tree). Enter the following lines to 
beginning of the PD.INI file:

[Settings]
NoLogo=1
FontStyle=0

Error 15: Not a database file
The file which Ultimate Family Tree is trying to open may be corrupted. Restore the most r

backup of your data.
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Error 26: Database is not ordered
This message usually means there is a problem with an index file. From the Utilities menu

choose Project, and then Reindex to rebuild the index files. If reindexing does not correct the pro
rebuild all project files by creating a duplicate project. See “Save As Ultimate Family Tree Projec
page 284 for steps to create a duplicate project. When you are certain the project has been fixe
can delete the original project. If creating a duplicate project does not correct the problem, try re
stalling the program files only (not a full installation). See “Reinstalling Ultimate Family Tree” on
page 6. If this message occurs when printing a report, reinstall the Printing Support files. See “R
stalling Ultimate Family Tree” on page 6.

Error 41: Memo file is missing/invalid
A file which Ultimate Family Tree is trying to open is either missing or corrupted. If this err

occurs when trying to start Ultimate Family Tree, exit to a command (DOS) prompt and type FIXME 
at the directory in which Ultimate Family Tree is installed or run the FIXME.BAT file in Windows F
Manager. If this error occurs while in your projects, rebuild all project files by creating a duplicat
project. See “Save As Ultimate Family Tree Project” on page 284 for steps to create a duplicate
project. When you are certain the project has been fixed, you can delete the original project. If cr
a duplicate project does not correct the problem, try reinstalling the program files only (not a ful
installation). See “Reinstalling Ultimate Family Tree” on page 6.

Error 43: Insufficient memory
Refer to your Windows manual for information on freeing additional memory. You may wan

increase the size of your swap file. To change swap file settings in Windows 3.1, from the Progr
Manager, click on the Main icon. Click on Control Panel. Click on the 386 Enhanced icon. Selec
tual Memory. Choose Change. Change Temporary to Permanent and use the Windows recommended
size for the swap file, (a minimum of 8,192 KB in size). Click OK. Windows must restart to make
these changes take affect.

It is recommended to let Windows 95 set the swap file settings. However, if you want to ch
these settings, follow these steps: Choose Start. Choose Settings. Choose Control Panel. Choo
tem. Click the Performance tab. Choose Virtual Memory. Choose “Let me specify my own…” Ch
the minimum amount to 20 MB plus 5MB per 1,000 people in your largest project. Click OK. 

Error 56: Not enough disk space
Ultimate Family Tree needs approximately 2.5 MB free disk space for every 1000 individua

the open project. Delete any programs or files that you do not use to free additional hard disk sp
you save a project or file to another drive or floppy disk, make sure the disk has sufficient space
error can also occur if you have duplicate record numbers or an individual is linked as his or he
ancestor. Check for duplicate record numbers using the Check routine found in the Utilities, Pro
menus. Check your data for incorrect links.

Error 202: Invalid path or file name
Make sure the name in the File Name field is a valid DOS file name. The name must be e

characters or fewer, with no asterisk (*) or slash (/) characters. See your DOS manual for more
mation on valid file names. Ultimate Family Tree adds the extension for the file type being creat



3 1 6 A P P E N D I X A : C O M M O N  QU E S T I O N S

ct by 
ying 
ee 
n you 
project 
Rein-

 time. 
 than 
same 
tempt-

n 
our 

when 
start a 
ish to 
e name.

ed by 

 an 
 the 
or you 

ject” 
roject 

rary 
Error 1707: Structural CDX file not found
This message indicates that an index file is either missing or corrupted. Reindex the proje

choosing Project, and then Reindex from the Utilities menu. A file that Ultimate Family Tree is tr
to open is either missing or corrupted. Rebuild all project files by creating a duplicate project. S
“Save As Ultimate Family Tree Project” on page 284 for steps to create a duplicate project. Whe
are certain the project has been fixed, you can delete the original project. If creating a duplicate 
does not correct the problem, try reinstalling the program files only (not a full installation). See “
stalling Ultimate Family Tree” on page 6 for more information.

Error Reading Drive C (D, E, etc.)
Many systems have installed a DOS utility called SHARE. Normally used on a network, 

SHARE helps manage files when the same file must be accessed by several users at the same
Some Windows programs also install SHARE so that the same document can be opened more
once at a time. For example, you might want to have two copies of the same letter open at the 
time in a word processing program. If you receive the message “Error reading drive C” when at
ing to run Ultimate Family Tree, check your CONFIG.SYS and AUTOEXEC.BAT files for the 
SHARE utility. If found, use Notepad or the MS DOS Editor to edit the file which contains the 
SHARE line. Either disable SHARE by placing the letters REM at the beginning of the SHARE line, 
or add the switches /F:5120 /L:500 to the end of the line. The line should look similar to

C:\DOS\SHARE /F:5120 /L:500

After changing the SHARE line, save the file, and reboot your computer. Uninstall, and the
reinstall Ultimate Family Tree. See your Windows manual for information on using Notepad or y
DOS manual for information on using the DOS Editor.

Event Type not found
The event type you selected from the event list is not in the library. This is usually caused 

you use a ROOTS IV library in which the event type has been deleted. It also occurs when you 
project using a library different from the one used when a new event type was defined. If you w
use this event type, create a new one by choosing New, and give the new event type a distinctiv

Format not allowed
The image file you are trying to open is either corrupted or the image format is not support

Ultimate Family Tree.

Error creating OLE object
The file you are attempting to add to the Multimedia Library is not a valid OLE file.

Some place names say place missing from library
Each place in the Place library uses an internal record number. When a place is added to

event, a link from the event to that place record number is created. If that place is missing from
place library because you deleted the place in a different project, you deleted the Place library, 
overwrote the library files by reinstalling the entire program, the link to a valid place is broken.

To restore the missing place, backup your project and library files. See “Backing up a Pro
on page 282. Choose Project from the Utilities menu and then Check. Select all options in the P
group and then click Repair. Any places used in the current project that are missing from the lib
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are restored. The new place is given the name, Missing Place no. nn. The nn represents a place num-
ber. To change this place name to the correct name, return to the Individual Record window tha
tained the missing place. Tab to the place field that contains Missing Place no. nn, and overwrite 
Missing Place with the correct place name for that event. Press F9 to save. A message appears 
that the place was Missing Place no. nn and is now the name that you just typed. Click Yes to chan
the spelling to the new name.

Be sure to enter the correct place name. The new place name will now be attached to all e
that originally used this missing place in the current project and to all other projects that use this
record.

File does not exist (upon opening Ultimate Family Tree)
If you have intentionally or accidentally deleted a program file that Ultimate Family Tree la

needs, you might see this message. You might need to reinstall the program files only. Do not re
the full program, or data entered in the library files, including places, sources, and media inform
will be lost. See “Reinstalling Ultimate Family Tree” on page 6.

File too large for Ultimate Family Tree
The external text file you are attempting to import is too large for the Ultimate Family Tree

field.

Computer locks when leaving Windows
Some OLE servers, such as Windows Media Player, interfere with Ultimate Family Tree. T

causes Windows to lock (freeze) when exiting, requiring that you press Ctrl+Alt+Del to reboot y
system. Using Object Packager to link OLE objects prevents this problem. See “Using Microsof
Object Packager with Ultimate Family Tree” on page 252.

Display Troubleshooting
Windows are distorted

The Windows display font size is too large. In Windows 95, press the right mouse button o
Windows Desktop and select Properties. In the Display Properties box, choose Settings. Chang
font size to small. You can also try changing the color setting to one which uses smaller fonts. T
change the Windows colors, click the Appearance tab in the Display Properties window. In Wind
3.1, change the display driver in Windows Setup to a smaller display size.

Individual, Event, Marriage, or Place Lists contain strange names in the column titles
If the View lists contain strange names, for example, INO instead of numbers, in the column 

titles, pack the project using Pack from the Utilities, Project menu. Be sure to backup your data 
running Pack. If packing the project does not fix the titles, exit to a command (DOS) prompt and
fixme in the directory in which Ultimate Family Tree is installed.

Individual, Marriage, or Place Lists contain strange characters
Ultimate Family Tree uses the Arial font in View lists. If Arial is not installed in Windows, 

strange characters can appear in View lists. Use the Windows Control Panel to install Arial. See
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Windows manual for further help. Other fonts used by Ultimate Family Tree windows are Sans S
Courier New, and Times New Roman.

Name fields in Individual Record contain strange characters
A font called Monotype Sorts may be corrupted. If the Monotype Sorts font is corrupted, it

affects several other fonts, including MS San Serif used in the name field. Delete this font from 
Font window in the Windows Control Panel and restart Windows.

When a Descendant Box Chart opens, List windows (Individual, Marriage, and Source) close
Ultimate Family Tree closes all browse windows before opening a new Box Chart window.

is normal.

No names are displayed in the Candidate Individuals list
There are two possibilities: Ultimate Family Tree has not found any matching individuals, o

project needs to be thoroughly indexed using the Check routine, with no options selected, from
Utilities, Project menus.

Event details are displayed twice when viewing an Individual Summary
This is normal. Because the Individual Summary shows a summary of all the information 

entered for an event, it displays the text that will be printed in the report as well as the basic dat
entered in the detail field. What you see as a duplicate detail on the computer screen will not be
cated in reports.

The windows are non-proportional, out-of-sync, or words overlap
Ultimate Family Tree uses the Arial, Sans Serif, and Courier New fonts in various windows

lists. If these fonts are not installed in Windows, strange characters and distortion can occur. Us
Windows Control Panel to install the missing font. See the Windows manual for further help.

Displaying images, and screen resolutions
The resolution of your computer display adapter and monitor directly affects the quality of

images you display. Resolution is determined by the number of pixels on the monitor and the n
of colors per pixel. A SVGA monitor having 640 ´ 480 pixels and 256 colors is the minimum recom
mended configuration for displaying images. Image quality improves dramatically as pixels and
depth increase.

If you are using a system that is limited to 256 colors, configure Ultimate Family Tree to us
Windows Colors option.

Media Troubleshooting
Problem with a server program or media device

If you run into problems with any server, sound card, or scanner, make sure you are using 
est version of the software and drivers. Contact the manufacturer for advice and information.

Error creating OLE
The file you selected to add is not an OLE file. Copy it to the clipboard and paste it into the

window.
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Image Edit window appears inactive when adding narrative
If you minimize rather than close Sound Recorder, or click the mouse anywhere on the de

the Image Edit window will not be active. Press Escape to close Sound Recorder and activate t
Image Edit window.

Link to OLE server not found appears when you try to play an OLE file
The file you selected is not on the hard drive or the file has been moved from the directory

which it originally was found when linked to the Ultimate Family Tree Multimedia library. This m
sage will also appear if the OLE file has been converted to static.

Slide Show Troubleshooting
The server is activated during a slide show

Convert the slide to static (break its link with its server). See “Editing an Existing Digitized
Image” on page 255.

MIDI file will not play during slide show
Use digitized images for the slide show without narratives. Turn off sound effects when pla

the show. To test whether your MIDI server can play while another server is active, start the MID
slide from the Multimedia window. After it starts, play a digitized image that has a narrative. If th
music stops, it’s because two servers cannot be active at one time. See “Slide Shows and OLE
page 267.

This device is being used by another application when viewing a Slide Show
This message appears when no sound board is installed. Uncheck the Sound Effects opti

the Slide Show window.

First slide flashes before each slide
Preview and Play Slide Shows flash the first image before displaying the next image. This is n

Printing Troubleshooting
If you have trouble printing or formatting reports, be sure you have the latest printer driver installe
your printer. Contact the manufacturer of your printer for the latest driver. Consult the Windows 
ual for instructions on installing printer drivers.

Cannot print an index
Before printing an index, the index must be collected using the Print window. You must en

chapter title for reports before the Collect Index option is available. 

The indexing starts on the wrong page number
Collect the index immediately before printing the report. Check the starting page number fo

report to be indexed in the Print window before collecting the index. If the index has been collec
properly and the starting page number for the report is still incorrect in the index, make sure yo
using the latest version of the printer driver used to collect the index.
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The index is slightly off
Because of differences in the way printers process fonts and commands, the index can ac

late errors. To review and correct the index before printing, click Edit on the Index Report windo
use the Ultimate Family Tree Editor or your own word processor to process and print the report
create an index.

Window says, “Now exporting” when I’m collecting an index
The index is printed to a file during the collection process. It is stored in the Index Report 

dow where it can be viewed or printed using your default printer.

The Image, Endnotes, Index, and Calendar Report menu selections are dim
If you chose the Print to Rich Text Format (RTF) file option in the Print Setup window, thes

reports cannot be sent to an RTF file. Choose a printer instead.

The Index or End Notes print option is dim
Make sure you have collected the index and the footnotes have been built. If the End Note

Report option is dim, a report which includes footnotes has not yet been printed. Index and End
will be dim if you have selected the option to print to a file in the Print Setup window.

The report Use Grouping options are dim
No individuals have been found in the Grouping list. See “Grouping” on page 139.

Box Chart printing problems
If you experience problems when trying to print a large box chart (over 50 pages), check t

About Help topic in the Ultimate Family Tree Help menu (Press F1). The percentage of system 
resources available is shown. To print a large chart, this figure may need to be at least 70–75%
sult your Windows manual for information on freeing additional memory.

Before printing a large report, be aware of the amount of available space on your hard driv
During the printing process, special temporary files are created (spool files), which can consum
considerable amount of hard drive space. A 200-page report will use approximately 9 MB. Once
printing is completed, these files are automatically deleted.

Data is cut off in structured reports
The font size is too large. Use Page Setup in Ultimate Family Tree File menu to reduce th

size.

Duplicate chapter title found
Another report has been printed using the same chapter title entered for the current repor

chapter title has not been entered, another report without a chapter title was previously printed.
proceed, all footnotes for the previous report with the same chapter title will be overwritten with
footnotes for the current report. Click the Reset buttons in the Print window to clear all previous
ters, footnotes, and indexes. No data will be lost.

Footnotes do not appear at the bottom of a Family Group Sheet
Make sure you have checked the Footnotes box in the Family Group Report window and 

you have built the footnotes. See “Adding Evidence (Advanced Editing Mode)” on page 69.
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<FROOTS> or <F font name> appears in printed reports or print preview
Ultimate Family Tree cannot find a required font. The ROOTS font is supplied with Ultimat

Family Tree. If you have just installed Ultimate Family Tree, be sure to restart Windows so Wind
will recognize and use this font. Make sure that font is installed by checking the font list using th
Windows Control Panel. Reinstall the font if necessary. If the font is installed, Ultimate Family T
might not be recognizing it because too many fonts are installed. Check the font list in the Wind
Control Panel and remove any fonts you don’t use. The list should contain no more than 150–1
fonts. See your Windows manual for information on installing fonts.

Strange characters print instead of lines in Indented Descendant report
Either the ROOTS font cannot be found (see above), or the printer driver you have selecte

Windows does not support the PC character set.

Place names are shortened or abbreviated in reports
Some structured reports, such as the Pedigree Chart, are designed with a 30-character lim

place names. Ultimate Family Tree shortens these names, if required.

Print Preview is dim
The Report window is closed or the report is set, in the Print Setup window, to print to a fil

Starting person not in individual Grouping list
Grouping is checked and the selected person for the report is not in the Grouping list. Eith

the individual to the Grouping list or uncheck Use List in the report window.

Portrait and Gallery Reports will not print
Make sure the Ready indicator is on next to each image position. Although you do not nee

edit the image, you must choose Edit and Crop for each image to turn on the ready indicator be
attempting to print the report.

Frequently Asked Questions
How can I make Ultimate Family Tree run more quickly?

Ultimate Family Tree stores and displays the facts in your family history with sophisticated 
base software that requires considerable computing power. Depending on your machine, you m
want to tune Ultimate Family Tree and your system to increase the program’s speed.

A number of techniques to accomplish this are listed below. Some are easy, others are be
by someone with experience in configuring computer systems. The only way to find out which o
may be effective on your computer system is to try the ones you are comfortable with and see w
helps.

Caution Before changing your system’s configuration, be sure to note the original config
tion so that you can restore it if necessary. Save copies of any configuration files you edit.

• Configure Ultimate Family Tree to use the standard Windows colors in the screen display.
Depending on your video card and driver, this may speed the program up considerably. 
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• Configure your video driver to use fewer colors. If your video driver is set to a 16-bit (65,53
colors) or 32-bit (16.7 million colors) mode, you will speed the program up by switching to 
colors.

• Do not use disk compression software. Use of programs such as Doublespace or Stacker
slow your system down.

• Your system’s hardware speed affects the performance of Ultimate Family Tree. All other t
being equal, a system with more memory, a faster hard drive, and faster video card will pe
faster. You can also speed up your hard drive by defragmenting it periodically, using the 
DEFRAG command in DOS 6, the Defrag tool in Windows 95, or a utility such as Norton’s
SpeedDisk.

The remaining techniques are useful for Windows 3.x only, and do not apply to Windows 95.

• Use a disk caching program such as SMARTDRV or a third-party program. This program 
be specified in your CONFIG.SYS file. Also, if your system has less than 16 MB of RAM, d
not use a cache size of more than 512 KB.

• Configure Windows 3.x to use 32-bit disk access. In the Windows 3.x Control Panel, select 
Enhanced, click Virtual Memory, then Change. Check the Use 32-Bit Disk Access and File
Access boxes.

Can I merge a Visual ROOTS, ROOTS V, Family Gathering, or ROOTS IV project with an 
Ultimate Family Tree project?

Although Ultimate Family Tree, Visual ROOTS, ROOTS V, Family Gathering, and ROOTS 
projects use the same basic file structure, you can’t merge a Visual ROOTS, ROOTS V, Family G
ing, or ROOTS IV project into an Ultimate Family Tree project unless the two projects use the s
library files. When you attempt to merge a Visual ROOTS, ROOTS V, Family Gathering, or ROO
IV project into an Ultimate Family Tree project, Ultimate Family Tree checks to make sure both 
projects are using the same library files. If they are not, the merge feature is disabled and you m
GEDCOM to merge the two projects. Print a Project Summary report for each project. In the file
look for files that are being used for both projects.

Can I Open a Visual ROOTS, ROOTS V, Family Gathering, or ROOTS IV project in Ultimate 
Family Tree?

Yes. From the File menu choose Open. Select Ultimate Family Tree or ROOTS IV Project
the drop-down list. Change to the drive and directory that contains the project you want to open
Appendix B, “Using ROOTS and Ultimate Family Tree Together.”

Why can’t I change the fonts for some reports?
Ultimate Family Tree automatically determines the font size and style in some structured re

such as Lists and the Box style Calendar. The font style can be changed for Pedigree reports, b
font size is fixed. If you wish to use a different font style or size, print the report to a file and use
word processor to edit and print the report.

Why is the Find button sometimes dim on the Individual Record?
The Find button is available only when the cursor is on a name or place field.
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How do I get events without dates to print in the proper order?
Ultimate Family Tree places all events in chronological order by the date entered in the So

Date field. Events without dates will print first, followed by those with dates. When you know the
order in which events took place, but do not have dates, enter a date in the Sort Date field for e
undated event to place the events in the proper order. For example, if you know the birth order 
children in a family, but do not know the birth dates, enter an approximate date for each child in
Sort Date fields for their births, making sure the oldest child has the earliest Sort Date. The Sor
will not print in the report, but Ultimate Family Tree uses it to place events in chronological orde
edit the Sort Date, press F8 on an event or choose the numbered button to the left of the event 
the Individual Record window to open the Events window.

How do I edit place names in Ultimate Family Tree?
The Place Record window, accessed through the Build menu is used to edit place records

ever, you can also edit place names in the Place field of the Individual Record or the Events (no
or Event Edit (advanced) window.

When you edit a place in the Individual Record or Events windows, only the Short Place fi
updated. To edit the Long Place fields, select the place and choose Place Record from the Buil
or press Shift+F6.

How do I add a sibling when I don’t know the parents for an individual?
To use the New Sibling button on the Individual Record, you must enter a parent in either 

Mother or Father field. If you do not know the parents for a group of siblings, enter a name for t
father or mother in the one of the parent fields. For example, for an individual named John Smit
could enter a mother or father named Unknown /Smith/, or (-----) /Smith/. With at least one parent 
named, you can enter siblings.

How can I turn off the note messages?
Ultimate Family Tree provides three levels of context-sensitive messages that require a res

from you before continuing. To turn off all but the most critical messages, from the Utilities men
choose Desktop Preferences, and then Miscellaneous. In the Messages group, select Critical. C
to close the Desktop Preferences window.

How do I turn off graphics and wallpaper?
Ultimate Family Tree runs faster without the default graphics and wallpaper. To turn them 

from the Utilities menu choose Preferences. Select Use Windows Colors.

How do I switch to a different editing mode?
From the Utilities menu, check Advanced Editing Mode to access the advanced editing win

of Ultimate Family Tree. Uncheck Advanced Editing Mode to switch to Normal Editing mode.

What should I do when I get the message “At least one other source has the same first abbrevi
tion” when creating new sources?

Abbreviation 1 is used to identify the source in lists. If possible, change Abbreviation 1 to s
thing unique so that the source is easily identifiable in lists. If not possible, leave the duplicate, 
aware of this duplication when adding sources to evidence windows.
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How does Ultimate Family Tree store data?
Ultimate Family Tree organizes family history information into projects. If you are research

your own family, keep all your research data in one project. If you are a professional genealogis
will probably have at least one project for each client.

When you begin a family history project, Ultimate Family Tree asks you to give your projec
name. If, for example, you call your project SMITH, Ultimate Family Tree creates two project contro
files: SMITH.PRO and SMITH.FPT. The information Ultimate Family Tree needs to manage you
project files is stored in these two files.

Specific information about individuals and events in their lives is stored in several files man
by the project control files. Approximately 25 to 30 numbered files belong to each project, and b
with the same two or three numbers. Each numbered file has two or three different extensions: 
(database files), .FPT (memo files), and .CDX (index files). You can print a Project Summary rep
show how each numbered file is used and the drive and directory that contains the file.

Some of the information you enter can be used in more than one family history project. Ult
Family Tree stores this information in special libraries that can be accessed by any project you’
working on. Ultimate Family Tree maintains libraries for places, sources and source types, even
role types, and multimedia. These common libraries save you time and increase the consistenc
reliability of your data.

Note Because the library files are common to all projects, do not delete places, sources,
multimedia that might be used in other projects. Deleting an item from a library will remove
links to that item in the current project, but will not remove links in unopened projects. If yo
ever need to reinstall Ultimate Family Tree, be sure to back up your library and multimedia
libraries before you reinstall, or install only the program files.

How do I start Ultimate Family Tree with a selected individual?
To set up Ultimate Family Tree to open a project with a selected individual, follow these st

1. Select the Ultimate Family Tree icon.

2. Duplicate the icon by copying and pasting.

3. In Windows 95, click the icon with the right mouse button, choose Properties and then Sho
In Windows 3.1, select the icon and choose Properties from the File menu.

4. At the end of the Target line (Command Line in Windows 3.1), add a space, the project na
(with path), a space, and then the record number with which you want to start.

Example: C:\UFT\UFTREE.EXE  C:\UFT\SAMPLE\KENNEDY 4

The above example will start the Kennedy project with record number 4.

How do I add existing children to existing parents?
Open the Individual Record for the child. Select -unknown- in the Father or Mother field. Either

type the record number of the individual you want to connect as the parent and press the Tab k
simply click the Find button next to the spouse field and select the correct parent from the list.
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Why do the children’s birth events print in the parents’ block in the Family Group Sheet?
The Principal Roles option is not checked. If Principal Roles is selected, only events in wh

the person is marked as the principal will print. Since parents are not normally marked as the pr
in the child’s birth event, checking Principal Roles will cause the childrens birth events not to ap
in the parents’ block.

Why are the OK and Express buttons dim?
You’re using ROOTS IV library files which were not updated with version 1.1 of ROOTS IV.

update them now, from the Utilities menu, choose Project and then Check. Select the options to
New Event/Role types and Replace Missing Event/Role. Click OK.

How do I print multiple Family Group Sheets including only people who are married or have 
children?

To print this type of report, you must first find everyone in the project who is married and/o
children. To complete this search, from the Search menu, choose Individuals and then Vital Sta
In the Vitals Search Options list, select Married. Place a Y in the Search Code field in the middle of th
window. Select the option to “replace the list with those found.” Click the Search button. When t
search is complete, a list of all married individuals will appear. Press Escape to close the list. N
the Search Options list, choose Children. Again, place a Y in the Search Code field and then choose t
option to “add them to the name list.” Click Search. When the list appears, press Escape to clos
Now place those individuals into the Grouping list: while in the Vital Statistics Search window, c
the Group button (you might need to click it twice, once to select the window and once to actua
depress the button). This places all of the people in your project who are married or have childre
the grouping list.

When you return to the Family Group report window, check Use List in the Grouping group
when you print multiple Family Group reports, only those individuals in the Grouping list will hav
report printed for them. Any children of those individuals, whether or not they are in the Grouping
will be included in those reports as children.
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Even though Ultimate Family Tree, ROOTS V, Visual ROOTS, Family Gathering, and ROO
IV share the same databases and underlying design, they are not the same program. ROOTS V
ROOTS IV, Family Gathering, and Ultimate Family Tree provide more control and flexibility for s
ing and manipulating genealogical data. Some data from an Ultimate Family Tree project is hid
when the project is opened by Visual ROOTS or Family Gathering. Most hidden data can be view
the Individual Summary and included in printed reports but it cannot be edited in Visual ROOTS
Family Gathering. To modify this hidden data, open the project with Ultimate Family Tree and m
any appropriate changes.

Ultimate Family Tree data that cannot be edited in Visual ROOTS or Family Gathering incl

• Links connecting individuals to events other than through principal roles

• Sure levels

• Evidence except for the overall event and individual evidence

• Most event details

• Event flags

• Place levels

• Source details

It is important to note that no data is lost when opening a project with any of these five 
programs. If ROOTS V, Visual ROOTS, ROOTS IV, Family Gathering, and Ultimate Family Tree
installed on your hard disk, projects can be opened and used by all four programs. The followin
tions provide guidelines for the coordinated use of these programs.
3 2 7
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Using ROOTS and Ultimate Family Tree Together

Installing Ultimate Family Tree When Visual ROOTS, ROOTS IV, ROOTS V, or 
Family Gathering Is Already Installed
The ROOTS IV installation program usually installs ROOTS IV in the ROOTS4 subdirectory, Vis
ROOTS in the VROOTS subdirectory, Family Gathering in the FG subdirectory, and ROOTS V i
ROOTS5 subdirectory. Ultimate Family Tree is usually installed in the FG directory. Do not insta
ROOTS IV or Visual ROOTS in the same subdirectory because important control files will be ov
written. 

If you are currently using ROOTS IV, ROOTS V, Visual ROOTS, or Family Gathering, we re
ommend that you install Ultimate Family Tree as an update to that program. Doing so will repla
program files with the Ultimate Family Tree version, while preserving all data files. Be sure to ba
all data files before proceeding, to prevent unlikely loss of data.

Ultimate Family Tree, ROOTS IV, ROOTS V, Visual ROOTS, and Family 
Gathering
Genealogical data is stored in an Ultimate Family Tree, ROOTS V, ROOTS IV, Visual ROOTS, o
Family Gathering project. The project control file, extension .PRO, keeps track of the files used 
project. The files managed by the project control file include those containing data unique to the
project, such as names and family links, and those containing data shared with other projects, s
places and sources. The latter files are referred to as library files.

Under normal operation, new projects opened by Ultimate Family Tree, ROOTS V, ROOTS
Visual ROOTS, or Family Gathering use the library files associated with their respective program
you open a new project with Ultimate Family Tree, ROOTS V, ROOTS IV, Visual ROOTS, or Fam
Gathering, and then open a second new project with Ultimate Family Tree, the two projects will
different library files. Once a project is created, you can’t merge its library files with another libra
unless you export the project via GEDCOM and then import it into another project that has the d
library files.

Maintaining a single set of library files when using ROOTS IV, ROOTS V, Visual ROOTS, o
Family Gathering and Ultimate Family Tree together has the following advantages:

• Data consistency — Items such as event definitions, GEDCOM tags, event sentences used
reports, locations, and source data are identical for all projects.

• Merge flexibility — Library files must be identical to merge two projects.

• Storage efficiency — Multiple libraries can consume considerable disk space.

Using ROOTS IV Library Files in New Ultimate Family Tree Projects
Ultimate Family Tree and ROOTS IV have separate library files but you can use the ROOTS IV li
files with Ultimate Family Tree, if you wish.

The following procedure uses a ROOTS IV library. To use your ROOTS IV library files in a 
Ultimate Family Tree project:
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1. Choose New from the Ultimate Family Tree File Menu.

2. Choose ROOTS IV in the New File window. The ROOTS IV library files are normally locate
the ROOTS4\LIBRARY subdirectory. If the ROOTS IV library files are in a different directo
Ultimate Family Tree will not find them to use for the new project and the Ultimate Family T
library files will be used instead. 

Note To import a GEDCOM or a ROOTS III file using the ROOTS IV library files, start a n
ROOTS IV project in Ultimate Family Tree and choose the Add to Open Project option in t
GEDCOM Import Options window.

Opening a ROOTS IV, ROOTS V, Visual ROOTS, or Family Gathering Project 
from Ultimate Family Tree
From the File menu, choose Open. Change to the directory that contains your project. Note tha
ing projects can be opened by choosing Family Gathering, Ultimate Family Tree, or ROOTS IV.
first time you open a ROOTS IV project in Ultimate Family Tree, the project is updated to include
eral fields required by Ultimate Family Tree. This one-time procedure can take a long time depe
on the size of your file.

Before a ROOTS IV project can be opened in Ultimate Family Tree, you must open it at le
once using Version 1.1 or later of ROOTS IV. If you attempt to open a ROOTS IV project in Ultim
Family Tree without success, return to ROOTS IV. From the Help menu, choose About ROOTS
the Version number displayed is 1.0, contact technical support.

Opening an Ultimate Family Tree Project from ROOTS IV, ROOTS V, Visual 
ROOTS, or Family Gathering
Ultimate Family Tree projects can be opened from ROOTS IV, ROOTS V, Visual ROOTS, or Fam
Gathering. Choose Open from the File Menu, and then choose ROOTS IV, Family Gathering, o
Visual ROOTS.

Warning While in ROOTS IV, do not merge an Ultimate Family Tree project with a 
ROOTS IV project unless they use the same library files. To see what library files are being
by a project, print a File List from the Project Summary Report window while you are in th
project. Check the path and file names of the library files. The ROOTS IV library files are u
ally in the ROOTS4\LIBRARY directory and named X_??BOOK.*. The Ultimate Family Tre
library files are usually in the ROOTS4\LIBRARY directory, or the \VROOTS\LIBRARY dire
tory if Ultimate Family Tree was installed as an update to Visual ROOTS, FG\LIBRARY if 
installed as an update to Family Gathering, or ROOTS5 if installed as an update to ROOT
and named V_??BOOK.*. Ultimate Family Tree has safety checks to ensure that two proje
using different library files cannot be merged. ROOTS IV Versions 1.0 and 1.1 do not have
checks. ROOTS IV Version 1.2 and later include the safety checks.
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Restoring a ROOTS IV, ROOTS V, Visual ROOTS, or Family Gathering Archive 
Project from Ultimate Family Tree
If your ROOTS IV backup files have the extension .ZIP, use PKUNZIP to restore the files from D
ROOTS IV v.1.2, ROOTS V, Visual ROOTS, Family Gathering, and Ultimate Family Tree backup 
have a .SQZ extension. You can restore .SQZ backup files from Ultimate Family Tree, ROOTS 
v.1.2, ROOTS V, Visual ROOTS, or Family Gathering.

Events and Roles
Ultimate Family Tree can link an unlimited number of individuals to events through roles. A marr
event might have the bride, groom, best man, maid of honor, and minister linked as participants
Family Gathering and Visual ROOTS provides linking for only the principal role players, for exam
the bride and groom in a marriage.

If an event from ROOTS IV does not appear in Ultimate Family Tree, make sure at least o
principal is marked in ROOTS IV for that event. The event will then be included in that individua
event list in Ultimate Family Tree. If you have marked all roles as principal in ROOTS IV, the eve
will be included in all participants’ Individual Records in Ultimate Family Tree. Select the event a
view the bottom line help to see what role the individual plays in that event.

You can create new event types in all five programs, but in Visual ROOTS and Family Gath
just one principal role player is assigned to new events. You can assign additional roles in Ultim
Family Tree.

Ultimate Family Tree does not require a birth event. If you delete a birth event in Ultimate 
ily Tree and attempt to view that birth in ROOTS IV, an Undefined Event will appear. To restore 
events that have been deleted, run Check and Repair in either Ultimate Family Tree or ROOTS

Event Details
Ultimate Family Tree provides two detail fields per event. Visual ROOTS and Family Gathering 
vide one detail field for the following events:

Event Detail

burial cemetery

graduation and education institution or school

resides street address

resided street address

employment occupation

emigration point of origin

immigration destination

baptism religion

LDS events temple code
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GEDCOM and ROOTS III Import
Except for differences in options, Ultimate Family Tree, Visual ROOTS, ROOTS IV, ROOTS V, a
Family Gathering projects created by importing a GEDCOM or ROOTS III file will have identical d
when they use the same library files. Some imported data will be hidden in Visual ROOTS and F
Gathering. In other words, it doesn’t matter whether you import data to Ultimate Family Tree, 
ROOTS IV, ROOTS V, Visual ROOTS, or Family Gathering, except for options you have chosen

GEDCOM Export
Multimedia ROOTS IV does not support audio recordings, OLE, or slide shows. Digitized ima
stored by either program are compatible. Audio and OLE data stored by Ultimate Family Tree is
den in ROOTS IV.

Note In Ultimate Family Tree, if you open a ROOTS IV project where the Image library h
not been accessed, the Open Dialog box will ask for the location of the Image library. Acce
Image library in Ultimate Family Tree to make full use of the multimedia features available
Ultimate Family Tree. In the Open Dialog box, change to the UFT\IMAGES directory, sele
V_PHBOOK.DBF, and click Open. If you prefer to access the Image library in ROOTS IV, 
change to the ROOTS4\IMAGES directory, select X_PHBOOK.DBF, and click Open.

Notes for ROOTS III Users
All ROOTS III data is imported directly into Ultimate Family Tree and can be used as is without 
ther editing. If you wish to take advantage of some of Ultimate Family Tree advanced features, 
may wish to make changes to your data as suggested below.

Converting ROOTS III Text Files
ROOTS III text files are converted to Ultimate Family Tree text files as follows. In the following li
bb represents the first two letters of the ROOTS III basefile name and nnnnn represents the record 
number of the individual to whom the text is attached.

• bbRnnnnn.TXT — Converts as biography text in the Individual Text window of the Individua
Record. If you also have a #E.TXT file, this file is appended to it. Files of this type print as
in the Genealogy reports.

• bbRnnnnn.SRC — Converts as footnote text in the Individual Text window of the Individual 
Record. Files of this type print as footnotes in the Genealogy reports and as text on the Fa
Group Sheets.

• bbEnnnnn.TXT — Converts as biography text in the Individual Text window of the Individua
Record. Files of this type print as text in the Genealogy reports.

• bbFnnnnn.TXT — Converts as research notes in the Individual Text window of the Individua
Record. Files of this type print as text in the Family Group Sheets.
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• [ref].TXT — Converts as biography text in the Individual Text window of the Individual Reco
If you also have a #R.TXT file, this file is appended to it. Files of this type print as text in th
Genealogy reports. [ref]  is the contents of the ROOTS III Individual Edit reference field. It is 
used primarily in ROOTS II to link text files.

• [ref].SRC — Converts as footnote text in the Individual Text window of the Individual Recor
Files of this type print as footnotes in the Genealogy reports and as text on Family Group S
If you also have a #F.TXT file, this file is appended to it.

Converting Footnotes from ROOTS III to Ultimate Family Tree
Major Footnotes in ROOTS III are converted into the Ultimate Family Tree Source library using 
ROOTS III source type. If there is an #R.SRC file attached to a Major Footnote, it is placed in th
ROOTS III source type note field in Ultimate Family Tree.

Text on the Detail and Record footnote lines of each record in ROOTS III is converted to F
Notes in the Evidence window.

The Major Footnote is listed in the Source List by the Abbreviation 1 name, and the text is 
as a Free Note. Any text preceding or following a Major Footnote becomes a separate Free No
you have two Major Footnotes with text attached, two Free Notes are created. If you did not use
Abbreviation field in the ROOTS III Major Footnote, Ultimate Family Tree enters R3 import 
#nnnnnnnn in the Abbreviation 1 field instead. Use the Source Record window to replace R3 import 
#nnnnnnnn with a unique abbreviation for the source.

What to Check after Converting a ROOTS III .EDB File
To take advantage of the longer name fields available in Ultimate Family Tree, or add aliases or
gious names, press F2 to open the Individual List and double-click the left mouse button on any
that you’d like to edit. The Individual Record for that individual opens. Click the More button. En
long names, common names, aliases, and religious names by clicking the Long Name button.

Edit place names that appear next to events on the Individual Record to remove any unnec
commas that ROOTS III may have required. Edit places from the Place field on the Individual R
or Events window. See “Did You Know?” on page 26, and “Combining Places” on page 291 for more 
information.

Choose View, and then Source List to check for ROOTS III type sources and those that di
have an abbreviation in ROOTS III. Those without abbreviations are shown as R3 import #nnnnnnnn 
in the Abbreviation field. Edit the sources to take advantage of the source templates provided in
mate Family Tree. Double-click the left mouse button on the name of any source you’d like to e
open the Source Record window for that source.

Review any text in the Ultimate Family Tree text windows and edit, move, or format if need
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Where to Find ROOTS III Data in Ultimate Family Tree

ROOTS III Ultimate Family Tree

Individual Record Individual Record

Record number Record number
Name Name
Sex Sex
Parent Code N/A
Birth Code Birth, Miscellaneous window
Ancestor Interest Ancestor Interest, Miscellaneous window
Descendant Interest Descendant Interest, Miscellaneous window
Occupation Employment event
Events (lines 1–6) Appear as separate events
Event date Event Date field
Event Sure level Event Sure level
Event place Event Place field
Event detail footnote Event Evidence window
Flags Flags, Miscellaneous window
Father’s name Father field
Mother’s name Mother field
Revision date Last Edit Date, Miscellaneous window
Record footnote Individual Evidence window
#R.TXT files Individual Text, Biography
#R.SRC files Individual Text, Footnote
#F.TXT files Individual Text, Research
@.TXT files Individual Text, Biography
@.SRC Files Individual Text, Footnote

Marriage Record Individual Record

Husband’s name Spouse, Marriage event
Wife’s name Spouse, Marriage event
Event type Events
Event date Event date
Event Sure level Event Sure level
Event place Event place
Event detail footnote Event Evidence window
Record footnote Event Evidence window
Revision date N/A
Marriage flags Marriage event flag

Major Footnotes ROOTS III Type Source

Title Title component
Reference Reference component
Library call number Call number component
Abbreviation Abbreviation 1 field
Publisher info Publisher component
Author Author component
Repository Repository component
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IMPORTANT—READ CAREFULLY BEFORE USING THIS PRODUCT

LICENSE AGREEMENT AND LIMITED WARRANTY

BY USING THE SOFTWARE INCLUDED WITH THIS AGREEMENT (“PROGRAM”) YOU ACCEPT THE TERMS OF THIS LICENSE 
WITH PALLADIUM INTERACTIVE™ INC.  IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT,  AND YOU ARE ALSO 
THE ORIGINAL PURCHASER OF THIS PROGRAM LICENSE (“ORIGINAL PURCHASER”), PROMPTLY RETURN THE SOFTWARE 
TOGETHER WITH ALL ACCOMPANYING ITEMS TO YOUR DEALER FOR A FULL REFUND.

LIMITED USE LICENSE.  Palladium Interactive and its suppliers grant you the right to use one copy of the Program for your personal us
All rights not expressly granted are reserved by Palladium Interactive or its suppliers.  You must treat the Program and associated materials and any 
elements thereof like any other copyrighted material (e.g., a book or musical recording).  This Agreement is governed by the internal substantive 
laws of the State of California.

YOU MAY NOT:

• Use the program, or permit use of the program, on more than one computer, computer terminal, or workstation at the same time

• Make copies of the materials accompanying the Program, or make copies of the Program or any part thereof.

• Copy the Program onto a hard drive or other device and you must run the Program from the CD-ROM (although the Program itsay 
copy a portion of the Program onto your hard drive during installation in order to run more efficiently).

• Use the Program, or permit use of the Program, in a network or other multi-user arrangement or on an electronic bulletin board system or 
other remote access arrangement.

• Rent, lease, license or otherwise transfer this Program without the express written consent of Palladium Interactive except that you may 
transfer the complete Program copy and accompanying materials on a permanent basis, provided that no copies are retained ane recip-
ient agrees to the terms of this Agreement.  

• Reverse engineer, decompile, disassemble, or create derivative works of, the Program.

LIMITED WARRANTY. Palladium Interactive warrants to the Original Purchaser only, that the Program shall perform substantially in ac
dance with the accompanying written materials for ninety (90) days from the date of purchase.

EXCLUSIVE REMEDY.   The original Purchaser’s exclusive remedy for the breach of this license shall be, at Palladium Interactive’s opt
either (a) the repair or replacement of the Program that does not meet Palladium Interactive’s Limited Warranty and which is returned to Palladium 
Interactive with a copy of your receipt; or (b) a refund of the price, if any, which you paid for the Program and associated materials.  This Limited 
Warranty is void if the failure of the Program has resulted form accident, abuse, misapplication, or use of the Program with incompatible hardware.

NO OTHER WARRANTIES. PALLADIUM INTERACTIVE AND ITS SUPPLIERS, IF ANY, DISCLAIM ALL WARRANTIES WITH 
RESPECT TO THE PROGRAM AND ACCOMPANYING MATERIALS, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIM
ITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OF THIRD PARTY RIGHTS, AND FITNESS FOR A 
PARTICULAR PURPOSE.  THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.  DEPENDING UPON WHERE YOU 
LIVE, YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE/COUNTRY TO STATE/COUNTRY.

LIMITATIONS ON DAMAGES.  IN NO EVENT SHALL PALLADIUM INTERACTIVE OR ITS SUPPLIERS, IF ANY, BE LIABLE FOR 
ANY CONSEQUENTIAL OR INCIDENTAL DAMAGES WHATSOEVER ARISING OUT OF THE USE OF OR INABILITY TO USE THE 
PROGRAM OR PROGRAM PACKAGE, EVEN IF PALLADIUM INTERACTIVE OR ITS SUPPLIERS, IF ANY, HAVE BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. PALLADIUM INTERACTIVE’S LIABILITY SHALL NOT EXCEED THE ACTUAL PRICE 
PAID FOR THE LICENSE TO USE THE PROGRAM.  BECAUSE SOME STATES/COUNTRIES DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO 
YOU.

US. GOVERNMENT RESTRICTED RIGHTS. The Program and documentation are provided with restricted rights.  Use, duplication, or lo-
sure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer Software 
clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CF 52.227-19, as 
applicable.  The Contractor/Manufacturer is Palladium Interactive, Inc., 900 Larkspur Landing Cir., Suite 295, Larkspur, CA 94939.

SAVE THIS LICENSE FOR FUTURE REFERENCE
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Glossary

Abbreviation 1 The first abbreviation used to identify a source. Usually, the name of an author
compiler is used.

Abbreviation 2 The second abbreviation used to identify a source. The identifier can be a title,
name, and is italicized in printed reports unless italics are not supported by the printer.

acquire To digitize an image by using a scanner, frame grabber, video digitizer, or other electr
device.

active window The window affected by a current action, such as typing text or viewing a List.

Ahnentafel A German word meaning ancestor table. This report uses a text format rather than
Family Tree (Pedigree) form.

Ahnentafel number A unique number assigned to each position in a Family Tree (Pedigree) 
whether or not you have an individual to fill that position. These numbers do not vary from 
to chart. Ahnentafel numbers can tell you exactly how a particular ancestor is related to th
selected individual.

American Standard Code for Information Interchange (ASCII) This standard defines the codes
for a character set used for information exchange between computer systems of different 
facturers. ASCII is a common coding standard used in the computer industry.

Ancestral File A compilation of records submitted to the LDS Family History Center by individu
doing genealogical research.

ancestral-ordered book The history of an individual back to his or her distant ancestors.

back up To copy data, typically the data on your hard drive, to a floppy disk.

backup A compressed file used to back up the current project.

Bulletin Board System (BBS) A computer running communications software and connected to 
telephone line through a modem that can be accessed by remote users.

canon law A code of law in which degrees of consanguinity are defined. In canon law, the deg
indicates the number of steps on a consanguinity chart from one individual to the closest a
tor shared in common by a second individual. This number produces the degree of consan
between these individuals.

cascading menu A menu that opens from a command on another menu. A command that has 
cading menu has a right arrow next to it.

check box A small square in a dialog or window that can be selected or cleared. When a chec
is selected, an X or check appears in the box. A check box represents an option that you ca
enable.
3 3 5



3 3 6 G L O S S A R Y

om 
 indi-

o-

 aunt, 

t not 
tional 

ood. 

u 
.

m 

ren, 

irect 

 disk.

uble-

ted, 
d that 
citation Detailed information that documents a pedigree, a genealogy, or a statement of fact.

civil  law A code of law in which degrees of consanguinity are defined. In civil law, as distinct fr
canon law, the degree depends on the number of steps on a consanguinity chart from one
vidual to another.

click To quickly press and release the left mouse button. See double-click.

clipboard A temporary storage location used to transfer data between fields, windows, and pr
grams.

Close box A box found in the upper-left corner of most windows in Windows 3.x. In Windows 95, 
the Close box is in the upper-right corner. Clicking the Close box closes the window. See Con-
trol Menu box.

collateral Descended from a common ancestor, but through a different line, such as a cousin,
uncle, nephew, and so on.

command A word or phrase, usually found in a menu, that you choose to initiate an action.

Compact Disk, Read-Only Memory (CD-ROM) A data storage medium that uses laser optics 
rather than magnetic heads to read data. Information can be read from CD-ROM disks, bu
recorded on them. They are capable of storing 600–700 MB compared to 1–2 MB for tradi
floppy disks.

consanguinity A legal description of the distance between two individuals who are related by bl
Consanguinity is defined differently under civil and canon law.

Control Menu box The Control Menu box is at the left of the title bar. It opens the Control Men
for the window. This menu contains commands that you can use to manipulate the window

Copy An Edit menu command that copies selected text to the clipboard without removing it fro
the original location. See Cut and Paste.

Cut An Edit menu command that removes selected text and places it on the clipboard. See Copy and 
Paste.

descendant-ordered book A type of book that singles out an ancestor and traces his or her child
grandchildren, and all other documented descendants to the present day.

desktop The working area on the computer screen in which windows and other items appear.

dialog A window that requests information. A dialog is a stepping stone to initiating an action.

digitized image A photo or picture that has been converted into an electronic (digital) format.

direct media Media items that are digitized and stored on your hard disk. The three types of d
media are images, audio, and OLE.

directory A collection of files and other directories (called subdirectories) stored together on a

double-click To rapidly press and release a mouse button twice without moving the mouse. Do
clicking selects an object and carries out an action. See click.

double dating If you encounter dates prior to 1752, you will find that a double year might be lis
such as 1725/26. Double dating is due to an alteration to the calendar. In 1582 it was foun
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the Julian calendar, which had begun with Julius Caesar, was off by 11 minutes and 14 se
each year according to the cycles of the sun and moon. Beginning when the Julian calend
first used in 46 BC, the error accumulated yearly, and in 1582 Pope Gregory XIII corrected
discrepancy. The calendar lost ten days as the Pope decreed that October 4 would be follo
October 15.

Countries accepted the new Gregorian calendar at different times, and England and t
American colonies did not do so until 1752. By then the discrepancy between the Julian a
Gregorian calendars was 11 days. This difference was compounded by the celebration of
New Year’s Days by England and its colonies. The government celebrated New Year’s on M
25, and the masses celebrated the holiday on January 1. Depending upon which calenda
used and when you celebrated New Year’s Day, there would be a difference in dating. To s
both conventions—until 1752 when the January New Year’s celebration was made official—
double dates sometimes were recorded.

You can enter the double date year in the free-form date field. The double date will pri
text reports, such as the Genealogy Report. The structured date will display the second ye
the double date and will print on structured reports such as the Family Group Report.

drag To move an object on the screen by holding down the mouse button while moving the m
For example, you can move a window to another location on the screen by dragging its tit

drop-down list A single-line dialog that opens to display a list of choices.

embed To insert information (or an object) that was created in one document, into another doc
ment. (Most often the two documents were created with different applications.) The embe
object can be edited directly from within the second document. To embed, you must be us
applications that support Object Linking and Embedding (OLE).

emigrant A person who departs from a country to settle elsewhere.

Event GEDCOM The Event GEDCOM Version 1.0 specification was designed by COMMSOF
Inc. to provide the most complete transfer of event-oriented genealogical data. It is an exte
of Family Version 5.3 that incorporates features for transferring events, roles, sources, and
images. Event GEDCOM is designed to be compatible with lineage-linked systems, while
viding extensive support for event-oriented systems, such as Ultimate Family Tree. At the 
rent time, only Ultimate Family Tree, ROOTS IV, ROOTS V, and Visual ROOTS support Ev
GEDCOM.

event text footnote Free-form text that can be used to record explanatory notes or other refere
about an event that are best reported as a footnote rather than in the body of printed repo

evidence Relates to or provides proof of a claim. In genealogy, most evidence comes from rec
documents, and circumstances.

Family GEDCOM This current GEDCOM standard, version 5.5, is a family-focused, lineage-
linked format. It uses cross-referenced pointers to connect each child to a family and each 
to its children. It does not provide for the transfer of as much data as Event GEDCOM, versio

Family Group Sheet A genealogical form summarizing genealogical data for a single family un
The Family Group Sheet contains detailed information about a family unit—husband, wife
children. The Family Group Sheet begins with the husband and wife, and then lists their ch
in birth order.
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field A specific area set aside for a given type of information. For example, a name field, date 
place field, and so on.

Find key (F10) The F10 key brings up a window designed to find an individual in your project. 
also function key.

flag A method for keeping track of special information that can be answered true or false. Ten flags 
are available for each individual in your project. They can be defined differently for each pe
Examples of flags include needs more research, attendance at a certain college, or cause of 
death.

font A complete set of characters including numerals, symbols, and letters in a single design,
and style (for example, 10-point Times Roman italic). The character set is used on the com
screen and in printed reports.

footer Text printed at the bottom of every page of most Ultimate Family Tree reports. It can inc
the name and address of the preparer and the date the report was printed.

footnote Provides the evidence to support a fact. Footnotes can be either explanatory text or e
dence presented in a more structured format (such as author or title).

format The way text appears on the pages of a report.

free-form field A fields that allows you to enter names and dates as they appear in their origin
source without formatting constraints.

free-form text Text that does not conform to a structured or rigid format.

function key The F keys are generally located on the top or side of the computer keyboard. Th
keys serve to help you use Ultimate Family Tree more efficiently. They assist in data entry
help you move up or down lists, find people or places, and access context-sensitive help.

GEDCOM A standard to provide for genealogical data exchange between programs. GEDCO
stands for GEnealogical Data COMmunications. Ultimate Family Tree supports two GEDC
forms: Family and Event.

group A cluster of related radio buttons or check boxes, located in a window, from which you c
make selections.

Grouping Grouping provides a way to generate specialized lists of individuals who match cert
criteria. These lists can be manipulated or merged in a variety of ways.

header Descriptive text printed at the top of every page on most Ultimate Family Tree reports. I
include book name and page number.

highlighted Highlighted text appears in black-on-white (reverse video) on monochrome display
and in color on color displays. Highlighted objects may be indicated by a change in color o
selection cursor. In general, highlighted selections will be affected by the next command o
action.

icon A small picture which can represent various types of applications and files (programs, gro
documents) on the desktop.
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ignore case A search criterion that instructs Ultimate Family Tree to ignore the case of letters w
executing a search.

image Photographs, movies, videos, digitized images, and any other type of image that might
used to document a family history.

immigrant A person who comes to a country to take up permanent residence.

import To convert a non-Ultimate Family Tree file into an Ultimate Family Tree project.

inactive window Any open window in which you are not currently working.

index A list of all individuals and marriages in the project with page number references to wher
names appear on charts and reports. The index must be collected before it can be printed

international characters Alphabetic characters with diacritical marks commonly found in lan-
guages such as French, Spanish, and German.

invert selected Grouping command which exchanges everyone in the Grouping list for everyon
previously excluded from the Grouping list.

link, OLE To create a reference in a destination document to an object in a source document.
you link an object, you are inserting a visual representation of the object into the destinati
document. When the object changes in the source document, the changes appear in the d
tion document.

list box Within a dialog, a list of available choices (for example, a list of files in a directory). If a
the entries will not fit, the list box has a vertical scroll bar.

list window List windows show information from your project in a table format, using rows and
columns.

lock A check box on some windows which allows you to lock the starting individual in the wind
The individual will be in the window when it is next activated.

long name The long name can contain up to 65,000 characters for the selected individual. The
name is not displayed on screen in Build or View windows, but is used in Family Journal 
Reports. Slash characters (/) define the surname and curly braces { } define the title.

Maximize button The small box containing an up arrow to the right of the title bar. Click the but
to enlarge a window to its maximum size. Keyboard users can use the Maximize comman
the Control menu.

media All types of information from text to sound, but used here to refer specifically to pictures
graphics, animation, sound recordings, and video.

memory Random access memory (RAM). The memory in a computer is designed to store dat
porarily. The data in RAM is lost when you turn off the computer. Permanent data storage
achieved on floppy and hard disks.

menu A list of commands from which you can choose. Menu names appear in the menu bar a
top of the Ultimate Family Tree main window.

menu bar A horizontal bar containing the names of all the menus at the top of the main windo
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message dialog Contains messages, warnings, and critical information about the operation of 
Ultimate Family Tree.

MIDI files Musical instrument digital interface (MIDI) is a standard protocol for communication
between musical instruments and computers. A MIDI file can contain all the information 
required to play a song using a MIDI device or sound card.

Minimize button The small box containing a down arrow at the right side of the title bar. Click 
button to reduce a window to an icon. Keyboard users can use the Minimize command on
Control menu.

Modified Register A genealogy format that conforms with the style used in the National Genea
ical Society’s Quarterly. It is sometimes called the Record plan.

mnemonic characters An alphabetic shortcut that allows direct keyboard access to Ultimate Fam
Tree functions when combined with the Alt key. Each mnemonic character is a unique and
tinctive letter which is underlined in the name of the command.

multimedia A combination of media, such as sound, graphics, animation, and video.

narrative Voice accompaniment to selected media items (specifically pictures) telling about an
vidual, his or her family, experiences, important events and people, and any interesting an
nificant details.

NEHGS New England Historic Genealogical Society, 99-101 Newbury Street, Boston, MA 021

NGS National Genealogical Society, 4527 17th Street North, Arlington, VA 22207-2399.

object Information such as a picture, chart, text, or sound that can be linked to or embedded i
another document.

Object Linking and Embedding (OLE) Windows technology to create items in one software pr
gram and place and access them in another software program. OLE objects include pictu
text, images, video clips, sound clips, and MIDI files.

option A choice in a dialog. An option affects the way in which a command is carried out. Dial
have several kinds of options including radio buttons (you can select only one) and check 
(you can select as many as you wish).

parental partner A parent who is not married or does not have a marriage record.

Paste An Edit menu command that moves text from the clipboard into a text file or text window
the cursor position. See Copy, Cut.

preferred image The selected image that can be displayed from the Media Tree, Pedigree, Fa
and Descendant windows.

radio button The small round button in a window that acts like the buttons on a car radio. In a g
of related radio buttons, only one can be chosen at a time.

RAM See memory.

record A collection of related data items, for example, an Individual Record.

record footnote Free-form text that can be entered about an individual and prints out as a foot
Not recommended for formal source citations.
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Record plan A genealogy format that conforms with the style used in the National Genealogic
Society’s Quarterly. Also called the Modified Register.

Redo Edit menu command that repeats a cut or copy that you make.

redundant ancestors When there is more than one line from an individual to his or her ancestor
ancestor is considered redundant. This normally occurs when cousins marry.

referenced media Media of and kind that can not be digitized.

Register A genealogy report that conforms with the style used by the New England Historic G
logical Society.

Replace All Substitutes new text for all text found in a Find search.

Replace and Find Again Substitute new text for text located in a Find search, and then repeat 
Find and Replace commands.

research note Free-form text that can be entered about past, ongoing, or future research on an
individual.

reserved characters A set of characters used by Ultimate Family Tree for internal processing. T
shoud not be used in data entry.

Reverse Register The Reverse Register was created by COMMSOFT, Inc. to provide a genealo
report format that uses a numbering system similar to the Register and Modified Register 
Reports, but follows ancestral rather than descendant lines.

REVENT (ROOTS Events) An historical database of United States holidays and world events 
stored in a library that can be used by many projects.

Rich Text Format (RTF) A standard developed by Microsoft which allows easy transfer of text 
between applications. Ultimate Family Tree supports RTF.

Save A File menu command used to save changes made to an active window.

scanned image An electronic reproduction of a picture or document that is stored in a file on th
computer. Images can be scanned directly into Ultimate Family Tree. A TWAIN-compatible
scanner is required.

scroll bars The navigation bars at the bottom and right edges of a window. Each scroll bar con
a scroll box and two scroll arrows.

scroll box Contained in scroll bars. Dragging the scroll box up or down displays information in a
or document.

search criteria The choices selected in the search routines that tell Ultimate Family Tree what
look for when searching.

selection cursor The selection cursor shows where you are in a window.

shortcut keys The specialized key strokes (a combination of Ctrl or Alt with a letter key) that yo
press to perform a command or action. If a command has a shortcut key, the key combina
listed to the right of the command name in the menu.

sibling Brother or sister, first-generation relationship with one or both parents the same.
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sort date The date used to establish the order of events and to calculate information such as a
the time of a specific event. Normally the sort date does not appear on reports.

SOUNDEX A code meant to minimize spelling variations. Used by the United States governme
index early census records.

structured date A date in fixed form (dd mmm yyyy) used on fixed or structured reports such as t
Pedigree and Family Group Reports.

structured fields Fields such as the sort date and structured date, that are used in structured r
such as the Pedigree and Family Group Reports.

submitter The individual creating a Tiny-Tafel or GEDCOM file. The word submitter is also used to 
refer to information about this individual.

Sure level Used in Ultimate Family Tree and COMMSOFT’s ROOTS IV to indicate the reliabilit
of information in your family history. The Sure level can be used to cover all information co
cerning an individual.

text box A box located in a window into which you type text.

Tiny-Tafel Tiny-Tafel is a shortened variation of an Ahnentafel list. The Tiny-Tafel contains one
of text for each family line, giving the surname, locations, and the time period represented
that family line, and codes to signify the preparer’s degree of interest in receiving informat
concerning the ancestors or descendants of that line.

title bar The horizontal bar located at the top of a window and containing the title of the windo

TWAIN The software used by scanning devices to provide a consistent interface with applica
TWAIN has become an industry standard.

Undo An Edit menu command that reverses the last action that you performed on any text wit
field, record, or file. Undo deletes a new record if the record was not saved.

unusual dates Unusual or nonstandard dates (for example, Quaker or Jewish dates). In Ultima
Family Tree dates that do not fall between the limits of 100 AD to 3000 AD are considered
unusual dates. Ultimate Family Tree is able to accept dates in all of these categories.

wildcard A character used to represent one or more different characters. In DOS commands, 
tion mark (?) can be used to substitute for a single unknown character. The asterisk (*) ca
used to substitute for more than one consecutive character.

window A rectangular area on the desktop in which information is entered, selections made, o
information viewed.

window title The title of the window that is found at the top of the window.

word wrap A feature that moves text from the end of a line to the beginning of the next line as
type.
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<FROOTS> appears in reports 321
\ backslash 16
# number sign 16
.EDB file, ROOTS III 274
.SQZ 282
.WAV 247
.WAV file 257
/ forward slash 16
{ } braces 16
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A4 (international) size paper 144
abbreviation, source 63, 64
adding

Ancestor Interest levels 223
audio 247
children 76
citation 58
Descendant Interest levels 223
events 34, 35
evidence 21, 66, 67
evidence, Advanced Editing mode 69
evidence, Normal Editing mode 67
image 247
images to reports 177
individual to grouping 141
Marriage event 56
new roles to an event template 52
parents 19, 33
places 47
siblings 78
sources to text 58
spouse 20, 27, 55
Sticky Notes 87
text 57

Additional Project Information window 295
address

entering 82, 295
printing a list 215, 216

adoption 77, 78
Advanced Editing mode, setting 8, 298
Ahnentafel 180, 181

number 97, 180
report 180

alias 80
All Spouse Data option 176
ancestor, viewing, see 

 

family tree, viewing

 

Ancestor Interest 223
Ancestor Report 179–181
Ancestral File 280, 281

numbers 81
ancestral-ordered book 171
Anniversary Calendar 100–102
annotations 201
archive

creating 282
restoring 283

ASCII 61, 143, 145
audio 247

adding 247
deleting 257
playing 259, 263

automatically launch editor 145

 

B

 

B.C. dates 46, 47
back reference 174
backup

data 281–283
Library files 283
Multimedia Library files 283
options 282
project files 282
restoring 283

Family Gathering, ROOTS IV, ROOTS V, 
or Visual ROOTS backups 330

basic events 36, 176
basic steps for printing reports 151
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bibliography 75
form 65
report 200, 201

biographical text 58
birth

creating a birth event 19, 20
estimate missing birth dates 176
field 82

bitmaps (.BMP) 247
blank report 179, 204
book

ancestral ordered 171
descendant ordered 171
preparing to print 170
title 148, 150

borders 173
Box Chart

Chart window 189
colors toolbar 190
creating new 185
deleting 193
descendant 185
Design window 186
display 191
editing 192

colors 190
fonts 190
graphics 189

finding an individual in 192
graphics 189
graphics toolbar 189
preparing for printing 188
printing 193
viewing multiple charts 192
Web page 237
zooming chart areas 192

breaking child blocks 205
browser setup 5, 6
Build Footnotes option 277
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Calculator 304, 305
calendar

anniversary 100–102
Box Style Report 221
historical 102, 103
labels 221, 222
Text Style Report 221

Calendar Report 220–222
candidate

individuals 33, 34, 56, 266
places 56

CDO (consistency, directness, and origin) 71
CHAN tag 277
chapter title 151

duplicate 320
character map 16, 59
Check feature 306
check spelling 60
Child button, new 76
children

adding 76, 77
of unmarried parents 78

citation
adding to text 58
search 116

collect and print 152, 202
collect index 152, 202
combining

individuals 288, 289
places 291, 292
projects 270, 271
sources 293, 294

comma delimited 219
common GEDCOM and ROOTS III import options 

276, 277
common name 80
conducting a search 113
configuration, system 321, 322
connected individuals 37, 38, 57
consanguinity 97, 195
converting

Family Tree Maker GEDCOM 277, 278
GEDCOM 271–274
ROOTS III 274–276, 331–333
ROOTS III footnotes 332
ROOTS III text files 331, 332

creating
birth event 19, 20
event type 49–55
events, Advanced Mode 35–40
events, Normal Mode 20, 21
Fan Chart 193
footnotes 69, 73, 74
free notes 69, 72, 73
individual record 17–19
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Instant Web Page 232–240
Marriage event 20, 55, 56

Advanced mode 56, 57
Normal mode 56

new event type 50–52
new source, Advanced mode 64, 65
REVENT event 104
REVENT library 104
slide show 264, 265
source from Proof window 71, 72
source in Evidence window 67, 68
source template 75, 76
source, Normal mode 63, 64

Credits Report 173
custom, Family Journal (Genealogy) 175

 

D

 

D'Aboville Numbering System 183, 184
Data Interchange Format 219
database 219
date

double dating 47
format 298
free-form 46
preferences 298
sort 35
structured 46
unusual 46

default
printer 144
sources 70

deleting
audio 257
Box Chart 193
data 286
duplicate record numbers 309
event types 49
events 286, 287
image 257
individuals 286
macros 303
media 257
place from event 49
places 287
project 26, 288
slide shows 288

deleting 
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source templates 76
sources 287, 288
sources from Evidence window 69
text 286

descendant
Box Chart 185–193
Direct Drop Report 184
reports 182–193
Text Report 183, 184

Descendant Interest 223, 224
descendant-ordered book 171
descendants, viewing 95
design Genealogy Format 177–178
desktop preferences 8, 297–300
details, event 21, 49, 51, 54, 318, 330
document repository 139
double dating 47
duplicate, record numbers 307, 309
duplicate records 117
duplication search 117–120

tolerance level 119
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editing
Box Chart 192
Box Chart names, places, dates 192
citation text 59
existing event 46
Fan Chart 194
footnotes 74
images 255
places 49
source from Evidence window 69
source template 76

editor, launching 145
editor choice 145
embedded note 175, 178
end notes 73, 199, 200
End Notes Report 199, 200
error message 314–317
Evaluation window 71
event

adding 34–40
definition 51
deleting 286, 287
details 21, 49, 51, 318, 330
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evidence 21, 22
flags 38
list 34, 108
List Report 214, 215
search 133, 134
unrecognized 276

Event Summary Report 207
event type

deleting 49
new 49–52
new, Normal Editing mode 49, 50

evidence 66
adding 21, 66–69
evaluating 70
event 21

exiting Ultimate Family Tree 312
exporting List reports 218
exporting text 62
express data entry 40–42
external programs 300, 301
External Support window 147
external text file

importing 61, 62
opening 311

 

F

 

FAM tag 273
Family event 77, 78, 148
family group, viewing 92, 93
Family Group Report 204–206
Family Group window 92, 93
Family History Data Control 281
Family Journal Report 174–178
Family Tree Chart 179, 180
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